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INTRODUCTION
Thank you for purchasing Yamaha's cutting-edge music sequencing software-- XGworks Version 3.0.
XGworks V3.0 is MIDI sequence software for Windows 95/98 that makes genuine DTM (desktop music)
both easy and fun. Naturally, XGworks shines at recording your performances on an external MIDI
keyboard, and helping you fine-tune your arrangement with tools for detailed editing. If you are using a
Yamaha XG tone generator, the XG Editor Window gives you the power to apply effects to any desired
part, or to the entire song, and edit the sound of the voices with utmost precision. But XGworks can do a
whole lot more than just work with MIDI performance data.You can record the sounds of actual musical
instruments and voices (Wave recording), add the recorded Wave data to your song, and play it back
simultaneously with MIDI data.A revolutionary new function of XGworks lets you record your singing as
Wave data, then convert it into MIDI data (Voice To Score function). Even people who can't play a
keyboard can simply sing a melody and use it as the basis for a creating a song.
As you master the many functions of XGworks, you will find yourself enjoying a completely new level of
music making power and fun.
This owner’s manual consists of a Fundamentals section and a Reference section.The Fundamentals
Section covers topics from installation of the software to basic operations.The Reference Section offers
helpful explanations like a dictionary.
To ensure proper use of the software, please read this owner’s manual carefully, and be sure to keep it in
a safe place for future reference.

SPECIAL NOTICES
● The software and this owner’s manual are exclusive copyrights of Yamaha Corporation.
● Use of the software and this manual is governed by the license agreement which the purchaser fully
agrees to upon breaking the seal of the software packaging. (Please read carefully the Software
Licensing Agreement at the end of this manual before installing the application.)
● Copying of the software or reproduction of this manual in whole or in part by any means is
expressly forbidden without the written consent of the manufacturer.
● Yamaha makes no representations or warranties with regard to the use of the software and
documentation and cannot be held responsible for the results of the use of this manual and the
software.
● This disk is a CD-ROM. Do not attempt to play the disk on an audio CD player. Doing so may result in
irreparable damage to your audio CD player.
● Copying of the commercially available music sequence data and/or digital audio files is strictly
prohibited except for your personal use.
● The company names and product names in this Owner’s Manual are the trademarks or registered
trademarks of their respective companies.
● The screen displays as illustrated in this Owner’s Manual are for instructional purposes, and may
appear somewhat different from the screens which appear on your computer.
● Future upgrades of application and system software and any changes in specifications and functions
will be announced separately.

WINDOWS OPERATION
This owner’s manual assumes that you are already familiar with basic Windows operation. If you are not,
please refer to the owner’s manual which came with your Windows software before using XGworks.
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New Functions in XGworks V3.0
The new features described below have been added as part of the upgrade to XGworks V3.0.

● Track View Window
•
•
•
•

Multiple wave tracks can now be played back simultaneously.
Wave tracks can now be played back starting at any desired location in the track.
Pan and volume for Wave tracks can now be set in the Track Parameter Section.
An “Instrument Type” item has been added to the Track Parameter Section.This feature is used to
select the printing format for the staves (such as transposing instrument staves, drum staves, guitar
tab staves, or the Electone (Yamaha’s electronic organ) staves).

● Piano Roll Window
• A cursor edit function has been added.
• A Pitch Bend Window has been added as a sub-window.This allows easy input of guitar performance
techniques.

● Staff Window
• The scores of several different blocks can now be displayed simultaneously.
• Settings can now be made for the number of staves in the score and the clef to be used.
• When “Transposing Instrument” is selected as the Instrument Type in the Track View Window (Track
Parameter Section), the score will be displayed as a transposing instrument score in the Staff Section.
• Staff printing will be done in the format (such as transposing instrument staves, drum staves, guitar
tab staves, or the Electone staves) that goes with the Instrument Type set in the Track View Window
(Track Parameter Section).
• A cursor editing function has been added.
• A Pitch Bend Window has been added as a sub-window.

● Drum Window
• A cursor editing function has been added.

● Mixer Window
•
•
•
•

Movements of the knobs and sliders can now be recorded in realtime.
Functions other than volume can now be assigned to the former volume fader.
Settings made in the mixer window can now be inserted into the song.
Settings made in the mixer window can now be sent to a connected XG tone generator.

● XG Editor Window
• Tone generator selections can now be made. Doing this ensures that the parameters supported by
the tone generator in use will be edited within an appropriate range.
• When using a plug-in board (PLG100 series), the parts assigned to the plug-in board can be selected
in the Part Unit.
• Movements of the knobs and sliders can now be recorded in realtime.
• The quick edit screen for the Part Unit and the Drum Unit has been redesigned.
• A quick edit screen has been added to each of the following: the Insertion 1/2 Units, the Variation
Unit, the System Variation Unit, the Reverb Unit, and the Chorus Unit.

● Saving Songs
• When saving songs as .XWS files, the Wave data itself can be included in the file.

System Setup Dialog
•
•
•
•
•

The MIDI Out ports on the Device page have been increased from four to six.
The Wave Out ports on the Device page have been increased from one to six.
A Realtime Message item has been added to the MIDI Out Filter page.
A MIDI In Filter page has been added.
A System Exclusive page has been added. Here settings can be made for reception buffer size,
transmission buffer size, and interval time.
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● Jobs
•
•
•
•

The following new jobs are now standard in version 3.0 of XGworks:
Voice To Score
XF Information Editor
Wave Editor TWE

● Plug-ins
•
•
•
•
•
•
•

The following new plug-ins are now standard in version 3.0 of XGworks:
Auto Arranger
Voice To Score R
Guitar Arranger
SW1000XG Mixer
Auto Play
Importer

XGworks V3.0 Specifications
● Number of Tracks

100 tracks (MIDI/Wave tracks) + Style and Chord Tracks

● Maximum Measures

9,999

● MIDI Ports

Maximum 6 ports

● Audio Ports

Maximum 6 ports

● MIDI channels

1 - 16/port (Can be freely set for each MIDI track)

● Edit Windows

Track View Window, Piano Roll Window, Staff Window, Drum Window,
List Window, Master Track Window, Mixer Window, XG Editor Window

● Entry Format

Realtime recording, step recording (mouse, external MIDI keyboard),
digital audio (wave) recording

● Resolution

Quarter note = 480 clocks

● Compatible File Formats

Song files:
.XWS (XGworks Original File/XGworks Original File with Wave)
.MID (Standard MIDI File format 0/1 and XF file)
Wave (digital audio) files:
.WAV
XG parameter files:
.XGP (for Loading only)
.SYX (for Saving and Loading)

*In addition, depending on the edit window and plug-in, settings unique to a particular file format
can be saved or read.
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Package and Minimum System Requirements
Package Contents
The XGworks V3.0 package includes the items listed below. Before beginning, please take a moment to
make sure you have everything you need.
● CD-ROM x 1
● Owner's Manual x 1
The included Owner’s Manual book covers the explanation of preparation before using XGworks
software and the fundamentals only. For detailed information on XGworks, please read the PDF Owner’s
Manual.To open the PDF manual, click on the Windows [Start] button, then select it from the [YAMAHA
XGworks ver. 3.0] of the [Programs] menu.
n To view PDF files, you must install Adobe Acrobat Reader previously as shown on page 11.

Minimum System Requirements
Proper use of the Yamaha XGworks V3.0 software requires at minimum the following:

Computer (IBM PC/AT compatible)
Memory
Requires a Pentium/75MHz or higher internal CPU (Pentium/166MHz or upper is recommended) with a
minimum of 16MB RAM (32MB or upper is recommended).
Hard Disk
Proper software installation and running XGworks V3.0 requires at least 30MB of free space on your
hard disk. If you use .WAV files, more free space is required.
CD-ROM/Floppy Disk Drive
To install the application software, a CD-ROM Drive is necessary, and to save and load your own data, a
Floppy Disk Drive should be available.
Mouse
Requires a Windows compatible mouse.

Software
Windows
Requires Windows95 or Windows98.

Others
Additional hardware as listed below will permit maximum enjoyment of the XGworks.
XG Tone Generator
If you want to make the most of the versatile functions of XGworks V3.0,Yamaha strongly recommends
that you use an XG compatible MIDI Tone Generator.The XG Editor Window of XGworks lets you easily
apply effects and edit the voices precisely on the connected Tone Generator instead of entering
complicated MIDI system exclusive messages.
MIDI Keyboard
If you connect a MIDI keyboard/synthesizer such as Yamaha CBX-K2, CS1x or QS300 to your computer,
you can record your performance in realtime or do step recording through the connected keyboard.
Sound Card
To record or playback WAV files, a sound card is required.
n Wave recording is possible using the MIC terminal on the computer. However, if the sound quality is bad or if there is no
MIC terminal on the computer, use a separately installed sound card for recording.
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Powered Speakers
You can enjoy powerful and dynamic stereo sound by connecting powered speakers or other stereo
audio components to the MIDI Tone Generator.

Software Included with Your XGworks Program
The CD-ROM with your XGworks program also includes the following software:
● MIDI driver (Yamaha CBX driver)
This driver software is necessary to play sounds from an external XG tone generator, like the MU
series.To install this driver, see page 9.
● Acrobat Reader
With the Acrobat Reader program, you can use your computer screen to view the electronic owner’s
manual files that came with XGworks.The manuals are saved in PDF format.To install the Acrobat
Reader, see page 11.
Adobe and Acrobat are trademarks of Adobe Systems Inc.

● Demo Songs
Several demo songs have been included that showcase the outstanding expressive power of XGworks
V3.0.They feature MIDI + Wave song data, and can be found in the Demo folder on the CD-ROM.
n In addition to the MIDI + Wave song data, there are also several demo songs that are standard MIDI files.These standard
MIDI files are automatically placed on your hard disk when XGworks V3.0 is installed.

About the Connections
To enjoy the full capabilities of XGworks V3.0, the peripheral devices mentioned below must be
connected to your computer.When making the connections, refer also to the information in the owner’s
manual for each peripheral device.
If you are using a keyboard that has a built-in XG tone generator, and is equipped with a TO HOST terminal
(like the Clavinova or Portatone), follow the method in Example 2 when making the connections.

Caution
Before making connections, be sure to unplug the power supply cords of all devices.After making connections,
switch on the power of each device in the following order: External MIDI keyboard and the computer first, then
the tone generator, then external audio devices. (Note: Make sure to turn down the volume levels of the external
audio devices before turning them on.) When turning off the power of each device, simply reverse the process.

Example 1: Using an external XG tone generator (MU series) for tone generation
Use a cable (D-SUB 9-pin to 8-pin mini DIN) to connect the TO HOST terminal on the XG tone generator
(MU series) to the serial port on your computer. Install the MIDI driver (Yamaha CBX driver) following
the instructions on page 9, and set the HOST SELECT switch on the rear panel of the tone generator to
PC2.Your tone generator is ready to use. Connect speakers with built-in amps (or headphones) to the
tone generator.You can also do realtime recording by connecting a MIDI keyboard to the MIDI IN
terminal on the tone generator.
Powered Speakers

[ex.1]

MIDI OUT

Serial Port

OUTPUT
(LINE OUT)
1

EDIT

UTIL

EFFECT

MODE

EQ

A/D INPUT
XG
TG300B
PERFORM

2

STAND BY
ON

VOLUME

MIDI IN A

Piano

PART

PART

ENTER

SELECT

SELECT

EXIT

VALUE

VALUE

BANK/PGM# VOL EXP PAN REV CHO VAR KEY
PART
Organ
Guitar
Bass
Strings
Chorm. prec.

Ensemble

Brass

Reed

Pipe

Synth effect

Ethnic

Percussive

SFX

Synth lead

Synth pad

Model excl.

Drum

SELECT

PART GROUP

PLG-1 PLG-2 PLG-3

TO HOST

MIDI IN

MU128
(XG Tone Generator)

Connecting Cable
(D-SUB 9-pin - 8-pin mini DIN)

MIDI KEYBOARD CBX-K1

ALL
MUTE/
SOLO

PHONES
MU

IBM PC/AT

PLAY

MIDI Keyboard (for entering)

*Select PC-2 (38,400 bps) with the HOST SELECT switch
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n When connecting a MIDI keyboard to an XG tone generator that has two MIDI IN terminals, use the MIDI IN terminal
indicated below for your tone generator.
• MU128: MIDI IN-A terminal
• MU100, 90, 80: MIDI IN-B terminal

Example 2: Using a MIDI keyboard (such as a CS1x) that has a built-in XG tone generator
Use a cable (D-SUB 9-pin to 8-pin mini DIN) to connect the TO HOST terminal on the keyboard (such as
a CS1x) to the serial port on your computer. Install the MIDI driver (Yamaha CBX driver) following the
instructions on page 9, and set the HOST SELECT switch on the rear panel of the keyboard to PC2.Your
keyboard is ready to use. Connect speakers with built-in amps (or headphones) to the keyboard.
Powered Speakers

[ex.2]
*Select PC-2 (38,400 bps) with the HOST SELECT switch

OUTPUT

TO HOST
L

R

Serial Port

IBM PC/AT

Synthesizer
(built-in XG Tone Generator)

Example 3: Using a software synthesizer (such as the S-YXG50)
Install the software synthesizer in your computer. If needed, you can connect speakers with built-in amps
(or headphones) to your computer.
[ex.3]
Powered Speakers

Install
S-YXG50

LINE OUT

CD-ROM

Example 4: When using a sound card (such as the SW1000XG) for the tone generator
Install the sound card in the appropriate computer slot. Install the MIDI driver for the sound card.Your
sound card is ready to use. If needed, you can connect speakers with built-in amps (or headphones) to
the sound card.You can also record in realtime by connecting a MIDI keyboard to the MIDI IN terminal
(such as the joystick terminal) on the sound card.
Powered Speakers

[ex.4]

SW1000XG

Line out L
Line out R
Microphone

MIDI OUT

When connecting a microphone for Wave recording or Voice To Score recording, connect it to the MIC input
jack on the computer or sound card.
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Software Installation
To use XGworks, the XGworks application software and the MIDI driver for the Tone Generator you use
should be properly installed in your computer.Also,Adobe Acrobat Reader should be installed to read the
PDF manual.

Caution
The installation program overwrites the AUTOEXEC.BAT, SYSTEM.INI and CONTROL.INI files. If you don’t want
to lose any existing data, please save them before you install the XGworks application software and the MIDI
driver.

Installing the XGworks Application Software
All files, including the application program and the XG song files, are compressed on the CD-ROM.The
following procedure is required to run XGworks V3.0 on your computer.
n If you have installed the previous version of XGworks, uninstall it before installing the XGworks V3.0.

1. Insert the supplied CD-ROM into your disk drive.
2. Open “My Computer” by double-clicking its icon.
3. Double-click the CD-ROM icon.You can see the contents of the CD-ROM.
4. Open “XGworks” folder.
5. Double-click Setup.exe icon. Installation will start.
Please follow instructions shown on the dialog box of each step to proceed with the installation.
If the installation is successful,“Yamaha” folder will be added to the Program Files folder.You will find the
XGworks application program and “Songs” folder containing XG song files in the Yamaha folder.

Installing the MIDI Driver
In order for Windows to work with MIDI, a MIDI driver is required.The Yamaha CBX Driver allows your
PC to communicate with a Yamaha XG Tone Generator such as the MU-series and CS1x. First, you must
connect your PC to the Tone Generator via the serial port and the TO HOST port using a serial cable
(P. 7).The Yamaha CBX Driver installer is included in the CD-ROM.The following procedure is required to
install the Yamaha CBX Driver.
n If the Yamaha CBX-T3 Driver Version 1.3 or Yamaha MIDI Serial Driver Version 1.5 has been installed onto your PC, you must
first remove it.

1. Insert the supplied CD-ROM into your disk drive.
2. Open “My Computer” by double-clicking its icon.
3. Double-click the CD-ROM icon.You can see the contents of the CD-ROM.
4. Open “MidiDrv_” folder.
5. Double-click Setup.exe icon. Installation will start.
Please follow instructions shown on the dialog box of each step to proceed with the installation.
If the installation is successful, you will find the Yamaha CBX Driver icon in the Control Panel.
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Yamaha CBX Driver Setup Dialog
Double-clicking on the Yamaha CBX Driver icon in the Control Panel opens the Yamaha CBX Driver Setup dialog
as shown in the illustration.

COM Port Setting
Select the COM Port you will use by checking the appropriate radio button.
Multi Port
If you place a check in this box, you will be able to use up to 64 MIDI channels. However, this is true only when
you use a Tone Generator which supports Multi Ports such as the MU128 and MU100.
Driver Disable
If you place a check in this box, you can make the Driver inoperative without removing it.To re-enable the
driver, follow this procedure:
In the [Advanced] page on Multimedia Properties, open the “MIDI Devices and Instruments” by doubleclicking it.
Select Yamaha CBX A Driver, and click [Properties]
Click on [Settings] and open the Setup dialog. Remove the check from Driver Disable. Click [OK].

1.
2.
3.

To actually use the external Tone Generator via the installed Yamaha CBX Driver, you are required to
make some necessary settings in XGworks.
Open System Setup dialog by clicking [System Setup] in the [Setup] menu on the XGworks menu bar.
Select the following device (driver) names in the System Setup dialog.
MIDI In
Select “Yamaha CBX Driver”.When you connect an external MIDI keyboard as shown in the examples 1
and 2 on page 7, you can hear the sound of keyboard performance through the connected XG Tone
Generator (you must select “Yamaha CBX A-E Driver” for MIDI Thru and MIDI Out, as mentioned below).
You can also record the keyboard performance with this setting.
MIDI Thru
Select “Yamaha CBX A Driver”.The MIDI signal that comes in through the MIDI In device above will be
played through the connected XG Tone Generator.
MIDI Out 1
Select “Yamaha CBX A Driver”.The MIDI signal (performance data) that is output from XGworks will be
played through the connected XG Tone Generator.
n You can select “Yamaha CBX B Driver” through “Yamaha CBX E Driver” for any of MIDI Out 2 through 6, if you use a Tone
Generator which supports Multi Ports such as the MU128 and MU100.
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Installing Acrobat Reader

1. Insert the supplied CD-ROM into your disk drive.
2. Open “My Computer” by double-clicking its icon.
3. Double-click the CD-ROM icon.You can see the contents of the CD-ROM.
4. Open “Acroread” folder.
5. Open “English” folder.
6. Double-click the installer icon (.exe file). Installation will start.
Please follow instructions shown on the dialog box of each step to proceed with the installation.
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Overview
XGworks V3.0 is sequence software that makes creating and editing songs with your own personal
computer both easy and fun.When you start up XGworks, it’s like standing in front of a workbench with
all your tools in front of you.The bench itself is the Application Window, and the first thing you see on it
is the Track View Window, which is the central point for song creation.There are many other tools you
can use to build your song.The Piano Roll Window and the Drum Window let you edit MIDI notes
graphically.The Staff Window displays the notes like sheet music.The List Window and the Master Track
Window show the data for each MIDI event.The Mixer Window gives you the capability to control many
different functions in realtime while playing back your song, and the XG Editor Window lets you edit the
parameters for your XG tone generator. Every window has a multitude of functions that match its
purpose and by using these tools, you can do precise editing of your music.

This is XGworks V3.0!
Play Control
(Controls recording and playback)

Track View Window
(Song playback/realtime recording)
Master Track Window
(Time and tempo settings)

List Window
(Recording and editing of MIDI events)

Staff Window
(Step recording/editing)

Piano Roll Window
(Step recording/editing)

Note Palette
(For setting gate time/velocity
during step recording)

Mixer Window
(Mixing/controlling effects during playback)

XG Editor Window
(Setting XG parameters)

Drum Window
(Step recording/editing)

Plug-in Software (Included)
• Voice To Score R
• Auto Arranger
• Guitar Arranger
• AutoPlay
• Importer
• SW1000XG Mixer

Plug-in Software for
PLG100 series
plug-in board (Optional)
• VL Visual Editor
• DX Simulator
etc.
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About the Application Window
Every window, starting with the Track View Window, can be opened on the Application Window.You can
think of the Application Window as a workbench, where you have the tools to do any kind of song
editing job you have in mind.
The Application Window is set up with the things that are used in common by all the edit windows—the
Menu Bar, the Toolbar and the Status Bar. (For details, see page II-1)

Title Bar
Menu Bar
Toolbar

Status Bar

About each Editing Window
XGworks offers the following editing windows for working on your song.

Track View Window
The Track View Window serves as the central point for creating and editing your song and helps you
grasp its overall structure.This window is also the usual place for song playback, realtime recording, and
digital audio (Wave) recording.

Piano Roll Window
When one or more blocks (see page I-14) are selected in the Track View Window, the Piano Roll Window
displays their MIDI notes as a graphical image. In this format, notes can be entered one-by-one (step
recording) and detailed editing can be done.

Staff Window
When one or more blocks (see page I-14) are selected in the Track View Window, the Staff Window
displays their MIDI notes on standard musical staves. In this format, notes can be entered one-by-one
(step recording) and detailed editing can be done.

Drum Window
When one or more rhythm track blocks (see page I-14) are selected in the Track View Window, the Drum
Window displays the MIDI notes for each rhythm instrument as a graphical image. In this format, notes
can be entered one-by-one (step recording) and detailed editing can be done.

List Window
When one or more blocks (see page I-14) are selected in the Track View Window, the MIDI notes and
other data (events) on the blocks are displayed in a list format which shows their numerical values.
Events can be entered one-by-one into the list, and detailed editing can be done.
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Master Track Window
In the Master Track Window, all the data (events) entered into the master track (the track for time
signature, tempo, and other events that affect the entire song) are displayed in a list format that shows
their numerical values.This window can be used for writing time signature and tempo information to the
list, and for detailed editing of the information.

Mixer Window
The Mixer Window features an interface just like the mixing console used in a music studio.While a song
is playing back in XGworks, you can manipulate the volume, tone, and pan (stereo orientation) for each
instrument (MIDI channel) so that it adds exactly the right contribution to the overall balance (mix) of
the song.

XG Editor Window
In XG Editor Window, the XG tone generator parameters (the variable elements used for creating sounds)
are arranged in an easily understood and simple to use visual format.When an XG tone generator is
connected to your computer, it’s easy to apply effects to the entire song or to any part, and to fine-tune
each part’s quality of sound.
In addition, the following windows are available as plug-ins.
n For information about how to use each plug-in, refer to the help file.To open each help file, click on the Windows [Start]
button, then select it from the [YAMAHA XGworks Ver. 3.0] of the [Programs] menu.

Auto Arranger
The Auto Arranger is a plug-in that lets you to create an accompaniment part for the melody you enter by
simply specifying the atmosphere of the song and performance style.

Voice To Score R
Voice To Score R is plug-in software that takes the melody you sing through an external microphone and
converts it into MIDI notes in realtime. It is especially valuable to people who can’t play a keyboard,
because it lets them freely create a song by simply singing a melody.
n A Voice To Score function (see pages I-21, XI-32) comes standard with XGworks in its original form without plug-ins.This
Voice To Score and the Voice To Score R plug-in each have different features.We encourage you to choose the one that is
easiest to use.

Guitar Arranger
When one or more blocks (see page I-14) are selected in the Track View Window, the Guitar Arranger
displays their MIDI notes in guitar tablature format. In this format, notes can be entered one-by-one (step
recording) and edited in detail.This plug-in software is designed for creating and editing parts for
stringed instruments like the guitar and bass.

Auto Play
Auto Play is plug-in software for continuous playback of MIDI files in XGworks.When lyrics have been
added to the MIDI file, they can be displayed during playback.

Importer
The Importer is plug-in software that can import some or all of the data in an already existing song into
XGworks. Using it, copyright free phrase material can be imported and used to create your own
arrangements.
n Copying or appropriating commercial music data without prior permission from the copyright holder is forbidden except in
cases where the making of copies for personal use does not violate copyright law. Before using such material, you should
consider consulting with an expert in copyright law.

SW1000XG Mixer
The SW1000XG Mixer is plug-in software that works with an SW1000XG sound card. It can be used for
adjusting the volume of each audio part played through the sound card, and for controlling pan and
effects.
I-3

XGw3/E1.QX

3/26/99

8:33 PM

Page 4

Song Playback
A number of XG Format compatible Standard MIDI File songs are included with XGworks. (The song files
are installed together when XGworks is installed). Let’s start out by playing those song files.
Click on the Windows [Start] button, then select [Programs] and start XGworks.

Reading Song Files

1. After starting XGworks, click the open button on the Application Window toolbar, or select [Open]
from the [File] menu.The dialog box for opening files will appear.

or

2. Go to the [Look in] box and select the Yamaha folder in the Program Files folder.The Songs folder
and the XGworks folder will appear in the list at the center of the dialog box.

3. Double click the Songs folder icon in the list.The song files in the Songs folder will be displayed.
n The type of file to be displayed can be selected from the drop-down list that appears when you click on the [Files of type]
box at the bottom of the dialog. Initially, the dialog is set to display both .XWS files and .MID files.
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4. Click on the song in the list that you want to open.The file will be highlighted, and its name will
appear in the [File name] box below the list.

5. Click [Open] and XGworks will begin reading the song file.When the song is completely read, its
data (blocks) will be displayed in the Track View Window.
Song position pointer

Blocks displayed

Song position line

n If you double-click on the file you want to open in step 4 above, step 5 will be skipped and the file will be directly read into
XGworks.

About the File Formats Handled by XGworks
File format refers to the format in which a song files is saved.The file format differs according to the sequence
software and hardware.The files made in XGworks are saved in a unique file format with the extension .XWS.
XGworks also supports the SMF (Standard MIDI File) and XF format with the extension .MID.Also, the Windows
standard digital audio file format, the .WAV file, can be played or recorded in an .XWS file song. It’s not a song
file, but XG parameter settings can be saved using the XG Editor Window of XGworks.

About Standard MIDI Files (SMF)
SMF is the common file format for sequence data. If a file is saved in the standard MIDI file format, the data
created on one MIDI device can be edited or played on another MIDI device.
However, even though the data may be compatible between the MIDI sequence devices, if the tone generators
used to play back the songs are not compatible, the songs can’t be played with the proper settings. Because of
this a unified standard for MIDI tone generators is necessary. XGworks is compatible with GM (GM system level
1), the world wide standard for MIDI tone generators and with XG,Yamaha’s extensions for GM. Read below to
learn more about GM and XG.
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About GM/XG
● GM
GM (General MIDI System Level 1) is an addition to the MIDI standard which ensures that any GM-compatible
music data can be accurately played by any GM-compatible tone generator, regardless of maker.With the GM
standard, you can assign any of the 128 GM-compatible voices to each of the 16 parts, or MIDI channels.
(Channel 10 is fixed as the drum part.)
● XG
XG is a new MIDI format created by Yamaha which significantly improves and expands upon the General MIDI
standard by providing a greater variety of high-quality voices plus considerably enhanced effect operation--while
being fully compatible with GM.
Since XGworks has the XG Editor Window you can manually edit the wide parameters of the XG tone generators
(→P. X-1).

Playing Back Songs

1. Before you can play sounds from your connected MIDI tone generator, you must first check the

output device. Make sure that the driver for the connected MIDI tone generator is selected in the
output Port display for each track.

Port Display
n If you are using an XG tone generator connected as shown on page 7, install the Yamaha CBX driver and select “Yamaha CBX
A Driver” in the Port display.When using a MultiPort compatible XG tone generator like the MU128, you can select the
Yamaha CBX B through E Drivers.
n If you are using a different output device, it can be selected from the drop-down list that appears when you click on the Port
display. Selecting a different output device causes sounds to play from the tone generator that corresponds to that device. See
page III-3 for details.

2. Click on the PLAY button that is located on the Play Control.The song will begin to play back.The

Song Position Pointer/Line will move to the right in time with the song.The location indicator on the
Play Control will change along with the movement of the Song Position Pointer/Line.
Location
Indicater

Play Button

3. Clicking the STOP button will halt playback of the song.The Song Position Pointer/Line will stop at

the position where the song was halted. If the play button is again clicked in this situation, playback
will continue from the position where it was halted. Clicking the TOP button will cause the Song
Position Pointer/Line to return to the beginning of the song (0001:1:000).

Top Button

Stop Button

n For details about the Play Control, see page II-4.
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Song Recording
There are two methods of recording songs: realtime recording and step recording. In realtime recording, you use an
external MIDI keyboard connected to your computer to play the song and record it as MIDI data in realtime. In step
recording, you use the mouse or an external MIDI keyboard to enter the MIDI notes one-by-one into the XGworks
window.Whichever method you use, you can change the program (voice) for each track, set the velocity (sound
strength), and with these and other detailed modifications, you can create your song. Besides these methods of
entering MIDI data, you can also record digital audio (wave data).

Recording Procedures
Preparation for Recording (→P. I-8 )
1. System Setup

Check the MIDI/WAVE ports.

2. Set the record mode.

3. Track View Window settings.

Set realtime or step entry.

Set the channel and output ports
for the tracks you will be recording.

Set the tempo and the
recording start position.

Step Recording (→P. I-18)

Realtime Recording (→P. I-15)

Recording standby

Recording

Recording standby

4. Play Control Settings

Note entry

Note settings
Using the Play Control, switch from recording standby status to
recording status. Start playing on the MIDI keyboard.
Recording multiple tracks simultaneously
Select the track numbers needed for recording, and synchronize
as necessary with external equipment. See p. I-16 for details.

When the Play Control is used to change from recording
standby to recording status, the note palette is displayed.
Press the keys on the MIDI keyboard while using the note
palette to determine the gate time and velocity of the notes.
Step recording without using a MIDI keyboard
MIDI notes can be entered using the mouse. For details, see
the sections in this manual for the Piano Roll Window (→P. IV-13),
Staff Window (→P. V-10), and Drum Window (→P. VI-11).

Digital Audio (Wave Data) recording (→P. I-19)
Track settings

Recording
Recording standby

The basic procedure is the same as for realtime recording. Connect a microphone to the computer, and check
the Wave In/Wave Out devices in the Preparation for Recording section ( P. I-8).

Entering a melody using Voice To Score (→P. I-21)
Record Wave data

Run Voice To Score

Convert to MIDI data

This function takes a monophonic melody line (song) from a wave file recorded and coverts it into MIDI notes.

Using the Auto Arranger to add an accompaniment to a melody (→P. I-24)
Create the melody

Run Auto Arranger

An accompaniment will be
automatically created.

You can add an accompaniment to a monophonic melody line (MIDI notes) created with Voice To Score (or using
realtime or step recording). This function automatically extracts chords from the melody and uses them to create
a background accompaniment for it.

Saving the song (→P. I-26)
In addition to their original format, songs created
and edited in XGworks can be saved as
standard MIDI files.
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Preparation for Recording

1. Refer to the section called “About the Connections” (→P. 7), and check that the peripheral devices
needed for recording are properly connected to the computer.

When doing realtime recording of a performance on an external MIDI keyboard or when doing step
recording, connect the MIDI keyboard and tone generator.Also, be sure to install the MIDI driver for
the connected tone generator.
n When using a Yamaha MIDI keyboard (such as a CS1x) or tone generator (such as a MU128) connected as explained in
Examples 1 and 2 on page 7, install the Yamaha CBX Driver.

When recording digital audio (Wave data), connect the microphone and sound/wave card. Be sure to
also install the driver for the sound/wave card.
n Wave recording is possible using the MIC terminal on the computer. However, if the sound quality is bad or if there is no MIC
terminal on the computer, use a separately installed sound card for recording.

2. Display the System Setup dialog (Device page) by clicking on [System Setup] in the [Setup] menu on
the menubar of the Application Window.

When doing realtime recording of a performance on an external MIDI keyboard or when doing step
recording, check that the correct MIDI devices for your MIDI keyboard and tone generator are
selected in the MIDI In and MIDI Thru boxes.
n When using a Yamaha MIDI keyboard (such as a CS1x) or tone generator (such as a MU128) connected as explained in
Examples 1 and 2 on page 7, select the Yamaha CBX Driver for MIDI In, and the Yamaha CBX A Driver for MIDI Thru.
n When using a MultiPort compatible XG tone generator like the MU128, you can select the Yamaha CBX B through E Drivers
for MIDI Thru.

When doing digital audio (Wave data) recording, make sure that the correct wave input/output
devices for your sound or wave card are selected in the Wave In/Wave Out boxes.When needed,
select the desired wave format (sampling frequency, mono/stereo, number of bits) on the Wave
Format page.
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n The wave formats available for selection will vary according to the sound/wave card and computer being used.

When all the selections described above are finished, click on [OK], and close the System Setup
dialog box.

3. Set the Record Mode
Display the Record/Playback Settings dialog by clicking on [Record/Playback Settings...] in the
[Setup] menu on the menubar of the Application Window.When doing realtime recording of a
performance on an external MIDI keyboard or when recording digital audio (Wave data), select
“Realtime” for the record mode. Click the white circle (called a radio button) to the left of the word
“Realtime.”A black dot (●) will appear in the circle.When doing step recording, select “Step” for the
record mode. Click the white circle (called a radio button) to the left of the word “Step.”A black dot
● will appear in the circle.
Click [OK] and close the Record/Playback Settings dialog.

4. Several parameters are set in the Track View Window.You can make the Track Parameter Section

easier to see and work in by expanding the width of the display. Place the mouse pointer over the
line that separates the Track Parameter Section from the Block Section (the split bar), and move the
mouse pointer slightly until the shape of the pointer changes into the split tool.You can vary the
width of the Track Parameter Section display by dragging the split bar to the right or left using the
split tool.
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Track Parameter Split Bar
Section

Block Section

5. In the Ch (MIDI channel) box of the track you will be recording, set the MIDI channel you will be

using.The MIDI channel is the transmit channel used to send data from XGworks to the MIDI tone
generator. Click on the Ch display and a spin box will be displayed. Click on the up and down scroll
buttons to select any channel number from 1 to 16.

n Normally the MIDI channels are set in order beginning with the first track (1, 2, 3...).There is no need to change the MIDI
channel without some special reason.
n Channel 10 is specially reserved for drum data. Select it if you intend to record rhythms.When recording regular music data
like melodies, chords and bass lines, select a channel other than channel 10.
n Select a low channel number for important tracks in the song, such as melody and bass lines.When the maximum polyphony
of the tone generator is exceeded, priority will be given to channel 10 and to other channels with lower numbers, so that the
atmosphere of the song will be damaged as little as possible.
n Because there is no need to select a channel when recording digital audio (Wave data), you can proceed directly to step 6.

6. Check that the driver for the connected tone generator is selected in the Port (output port) display
for the track you will be recording on.When doing digital audio (Wave data) recording, check that
the output driver for the sound/wave card you will be using is selected.

n If you are using an XG tone generator connected as shown on page 7, install the Yamaha CBX driver and select “Yamaha CBX
A Driver” in the Port display.When using a MultiPort compatible XG tone generator like the MU128, you can select the
Yamaha CBX B through E Drivers.
n If you are using a different output device, it can be selected from the drop-down list that appears when you click on the Port
display. Selecting a different output device causes sounds to play from the tone generator that corresponds to that device. See
page III-3 for details.
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7. Select the data type in the Type display for the track you will be recording.When you click on the
Type display, a drop-down list will appear. If you will be recording a performance from a MIDI
keyboard in realtime or doing step recording, select “MIDI” from the drop-down list.When doing
digital audio (wave data) recording, select “WAVE.”

8. Select the voice for monitoring the track you are recording. Click the right mouse button over the

Trk (track number) display for the appropriate track.A pop-up menu will be displayed. Click “Select
Voice” on the menu, then select the voice you will be using from among those listed.

n Because there is no need to select a voice when recording digital audio (Wave data), you can proceed directly to step 9.

Because the voice selected in step 8 is only for checking the quality of sound, it is not permanently set as
the voice for the track.To set a particular voice for the track you are recording, program change data
must be inserted into the song.To learn how to enter program change data into a song, see page IV-25.

Voice Selection with the Voice List

1. From the CATEGORY 1 list on the left side, choose the category of the voice you want to use.The names of
the instruments will appear in the CATEGORY 2 list in the center.

2. From the CATEGORY 2 list in the center, choose one of the further extract categories.The voices included in
that category will be displayed on the right side in CATEGORY 3.
n For SFX, SFX Kit, and Drum Kit in CATEGORY 1, the final voice selection can be done in CATEGORY 2, so nothing will
be displayed in CATEGORY 3.
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3. Select one of the voices displayed in CATEGORY 3 on the right side.
n Voices that have a + (plus) mark to the left of their names on the list have a lower level below them where more
detailed voices can be set. Clicking the + (plus) mark will open the lower level, where you can select any of the voices
listed.
n If you place a check in the Click Monitor box at the bottom of the dialog, the sound for each voice will play when you
click the voice name, allowing you to monitor it.

4. When you click OK, the dialog box will close, and the voice you selected will become the program for that
track.To cancel choosing the voice, click on Cancel, and the dialog box will be closed without selecting a
voice.
n In the CATEGORY 1 list, the categories other than Melody, SFX, SFX kit, and Drum Kit are voice categories for upperlevel XG tone generators and XG plug-in boards (PLG100 series). Depending on the XG tone generator you are using,
some of these voices may not produce any sound even when they are selected. For details on the voices that can be
produced with your own tone generator, see the voice list in the owner’s manual that came with it.
n The voice names displayed on the voice list are XG voices. If you are using a general GM tone generator, some of the
voices selected here might not be available on it. In that case, the XG voice you selected will actually be played in the
closest GM voice. (If you are using a GM tone generator, select Melody or Drum kit from the CATEGORY 1 list).

9. Click the Rec display for the track you will be recording.An R mark will be displayed, and that track
will be ready for recording.

10. If you plan to do realtime recording from a MIDI keyboard or record digital audio (Wave Data)
while the metronome is playing, click the metronome button on the Play Control to turn the
metronome ON. It will be highlighted in black.

n The sound and loudness of the metronome can be freely adjusted (→P. XI-17).

11. Click the up and down buttons of the tempo indicator on the Play Control, and set the tempo.The
default setting for the tempo is 120.

n The tempo setting made here does not determine the tempo value within the song data.To fix the tempo value within the
song, make the setting in the Master Track Window (→P.VIII-3).
n The default setting for the time signature is 4/4.You can change to other time signatures in the Master Track Window
(→P.VIII-3).
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12. Set the starting position for recording. Click the up and down scroll buttons attached to the
location indicator, or click on the Master Track to move the Song Position Pointer.

Master Track

or

This completes the preparation for recording.
Proceed from page I-15 if you are doing realtime recording of a performance from a MIDI keyboard, from
page I-18 if you are doing step recording, and from page I-19 if you are recording digital audio (Wave
data).

The Concept of Tracks
In XGworks, different MIDI data can be recorded separately on each of a maximum of 100 tracks.This is very
similar to the method where the performances of various instruments are recorded one by one on each of the
multiple tracks of a multitrack recorder (as is done in a recording studio).
As each track is actually performed on an external MIDI keyboard, it can be recorded as easily as with a tape
recorder. Other methods for entering the data are also provided.An external MIDI keyboard can be used for step
entry of one note at a time, the Piano Roll Window can be used to enter the data graphically without using the
keyboard, the Staff Window can be used to to enter the notes as if writing sheet music, or the List Window can
be used for numerical entry.
Finally, when different voices and MIDI channels have been assigned to all the multiple tracks where the
different phrases have been recorded, they can all be played together at the same time, creating an ensemble
performance.

XGworks
Track 1
Track 2
Track 3
•
•
Track 10
•
•

Piano
Bass
Strings
•
•
Drums
•
•

XG/GM Tone Generator
Ch1
Ch2
Ch3
•
•
Ch10
•
•

Ch1
Ch2
Ch3
•
•
Ch10
•
•

Piano voice
Bass voice
Strings voice
•
•
Drums voice
•
•

n Actually, the track number and MIDI channel don’t need to be the same. For example, track 1 can play on MIDI channel 2.
n The programs to be played on each MIDI channel can be freely selected. However, with a XG/GM tone generator, MIDI
channel 10 is always fixed for the drum voice.
n You can also give each track its own name. (→P. III-4)
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The Concept of Blocks
The MIDI data recorded on each track, considered as the musical elements that make up each track, are called
“blocks.” In the Track View Window, each block is displayed as a rectangular bar shaped image, in the following
manner.
Basically, the song location from where recording was started to where it was finished will become one block.
The piano track in the picture shows a “single block” that resulted from continuous recording from the first
measure to the eighth. In the bass track, recording from the first measure to the second resulted in a single block
and recording from the fifth measure to the seventh made another, for a total of two blocks.The third and fourth
measures are empty, showing that no recording was done. In this way, the tracks are made up of multiple blocks
according to the conditions under which they were recorded.

Using the various edit functions, you can freely edit each track, splitting single blocks into multiple ones, moving
blocks to other locations or making multiple blocks into single ones. Mastering these functions will allow you to
set up the tracks just the way you want.
n You can also give each block its own name (→P. III-16).

About Overdubbing
If you record on a track that already has data on it, the new data will be overlaid on top of the old data.This is
called overdubbing. XGworks uses the overdubbing system, but a new, separate block is created on the track, and
the old data is not rewritten. Because this new data is on the same track during playback, it sounds as though
overdubbing was done. However, because the old data and new data are recorded in separate blocks, the new
data can be changed during editing without affecting the old data.
n When a long block is laid over a short block, in the Block Section it will look like there is only one block. See the section
on Overlapping Blocks (→P. III-14).
n Even though one of the overlapping blocks is moved to a different track, using the Ch (MIDI channel) display in the
Track View Window to set that track to the same channel as the original track will produce the same effect as
overdubbing. If you want to completely merge the two blocks into a single one, select the blocks and use the Merge
function. For details, see the section on Block Merge (→P. III-15).
n If a block has been already selected (or is open in the Piano Roll Window or similar window) data will be entered into
the selected block when step recording is done for that block, and no new block will be created.
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Realtime Recording

1. Click the REC button on the Play Control. It will turn red, and XGworks will enter recording standby
status.

REC BUTTON
n To stop recording at this point, push the REC button again or click the STOP button.The REC button will return to its original
state.

2. Click the PLAY button on the Play Control.The play button will light up, and recording will begin
after a one-measure countdown.When the metronome is turned ON, it will beat in time with the
tempo of the song.

PLAY BUTTON
n When an automatic accompaniment has already been created using the style/chord tracks (→P. III-25), the accompaniment
will begin when the PLAY button is clicked.
n If the metronome is turned off, no countdown will be sounded before the start of the song.

3. Play your MIDI keyboard.
4. When you are finished playing, click the STOP button on the Play Control, and recording will stop.

The Song Position Pointer/Line will halt at the location where the STOP button was clicked.The
newly recorded block (long rectangular bar) will be displayed in the Block Section of the recorded
track.

STOP BUTTON

5. Click the STOP Button one more time.The Song Position Pointer/Line will return to the location
where recording began.

n If you aren’t satisfied with block you just recorded, click the undo button (→P. II-2) on the toolbar to erase it, and start again
from Step 1 in these instructions.

6. Click the PLAY button and listen to the recorded track.
7. Follow the instructions above (Including “Preparation for Recording”) until you have recorded all the
tracks you need.You can record them in time with the previous tracks you made, since those tracks
will be automatically replayed as you record.

n If you don't want to hear the already recorded tracks while you are recording, click the Mute box for those tracks in the Track
Parameter Section.An “M” mark will be displayed and the sound of the tracks will be temporarily turned off (→P. III-4).
n It is a good idea to save your recorded data frequently (→P. I-26).
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Simultaneously Recording on Multiple Tracks
Multiple channels of MIDI data coming from an external MIDI sequencer or another MIDI system (like a guitar
synth) can be recorded simultaneously in realtime on multiple MIDI tracks.Although these instructions were
written primarily for recording performance data from an external MIDI sequencer, you should also read them if
you are recording from a guitar synth, since the procedure is essentially the same.

1. Correctly hook up your external MIDI sequencer or other MIDI device, referring to the
instructions in “About the Connections” (→P. 7).
n If there is no TO HOST terminal on your MIDI device, you must connect a MIDI interface between your computer and
your MIDI device, and install a compatible MIDI driver.

2. Set up for realtime recording, referring to steps 1 to 8 in “Preparation for Recording” on page I-8. Since you
will be recording simultaneously on multiple tracks, at this point you have to select the MIDI channels and
output ports for the tracks you will be using.
n In order to correctly send MIDI data from the connected MIDI device to XGworks, a MIDI input device compatible with
your MIDI device must be selected for the MIDI In device in System Setup (→P. XI-12).

3. Click the Rec button for all the tracks to be recorded (the letter R appears), which will allow
simultaneous recording for multiple tracks.

4. Display the System setup dialog box by selecting [System Setup] from the [Setup] menu on the
menu bar in the Application Window.

5. Click on the Sync. tab to open the Sync. page.

6. Click the MIDI radio button to turn it ON, then click the OK button to close the dialog box.This
setting makes it possible to start and stop XGworks recording in sync with the performance on
the external MIDI device.
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n When recording from a guitar synth, the Sync. setting should be Internal.
n If Sync. is set to MIDI, the Play button on the Play Control cannot be used for playback.The Tempo Indicator on the Play
Control will display EXT to show synchronization with an external MIDI device.

7. Click the REC button on the Play Control. It will turn red, and XGworks will enter into recording
standby condition.

n To stop recording at this point, push the REC button again or click the STOP button.The REC button will return to its
original state.
n When recording from a guitar synth (the Sync. setting in step 6 above is “Internal”), after clicking the REC button,
recording will start when the PLAY button on the Play Control is clicked. Perform on the guitar synth, then click the
STOP button to finish recording.

8. Click the PLAY button on the Play Control.The play button will light up, and XGworks will wait
for the clock signal from the external MIDI device.
n To stop recording at this time, click the STOP button.The REC and PLAY buttons will return to their original state.

9. If playback is done on the external MIDI device, XGworks will begin recording in sync with the
clock signal sent from the external MIDI device.The MIDI data sent through each channel will be
simultaneously recorded on the corresponding MIDI track.

10. When playback ends on the external MIDI device, XGworks recording will also stop
automatically.A block (rectangular bar shape) will be displayed in the block section for every
track that was recorded.
n Recording can be stopped by clicking the STOP button on the Play Control.
n To play back the recorded tracks, you must select System Setup from the Setup menu on the menu bar in the Application
Window, then click on the Internal radio button on the Sync. page.
n When you are unhappy with the recording and want to redo it, click the Undo button on the Toolbar (→P. II-2) to erase
it. Repeat the recording procedure starting with step 7 above.
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Step Recording
n This section explains step recording as it is done in the Track View Window. However, if you want to be able to verify each
note as it is recorded, it's a good idea to also have the Piano Roll Window or Staff Window open when doing step recording.
To open the Piano Roll Window or Staff Window, you must first create an empty block on the track you will be recording
(→P. III-19), then click on the Piano Roll Window or Staff Window button on the toolbar (→P. II-2).

1. Click the REC button on the Play Control. It will turn red, and XGworks will enter into recording
standby status.

REC BUTTON
n To stop recording at this point, push the REC button again or click the STOP button.The REC button will return to its original
state (gray display).

2. Click the PLAY button on the Play Control.The PLAY button will turn green, and the note palette will
be displayed.

PLAY BUTTON

3. Using the note palette, set the gate time (note length) and velocity (note strength) for the MIDI note
you will be entering (→P. II-7).

VELOCITY

GATE TIME

4. When you strike a key on the MIDI keyboard, the note you struck will be entered with the gate time
and velocity you set.The Song Position Pointer/Line will advance the distance of the note length set
on the note palette, to the next input position.As long as you continue to strike keys on the MIDI
keyboard, MIDI notes will be recorded with the same gate time and velocity. If the note palette
settings are changed before a key is struck, the notes will be entered with the changed values.

At any time, a new entry location can be selected with the Song Position Pointer or Play Control, and
recording will continue from that point.
n Chords can be entered by striking multiple keys simultaneously.
n To enter a rest, press the space bar on the computer keyboard.A rest will be entered with the same length as the note length
set on the note palette.

5. When you have finished entering all the notes you need, click the STOP button on the Play Control
to finish recording.The block (rectangular bar display) you just recorded will be displayed in the
block section of the track in which it was recorded.

STOP BUTTON
n If you were recording on a track where there was already data, the newly recorded data will be overlaid on the previously
recorded data. See the previous section on overdubbing (→P. I-14).
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Step Recording Without Using a MIDI Keyboard
In XGworks, MIDI notes can also be entered without using a MIDI keyboard, by directly writing them using the
mouse. This method can be used when either the Piano Roll Window, Staff Window, or Drum Window is opened.
For details, see the following:
* Piano Roll Window ............P. IV-13
* Staff Window ......................P.V-10
* Drum Window ....................P.VI-11
n Before the Piano Roll/Staff/Drum Window can be opened, you must first create an empty block to enter the MIDI notes
into (→P. III-19). After the block selected, click the Piano Roll Window, Staff Window, or Drum Window button on the
toolbar (→P. II-2).

Recording Digital Audio (Wave Data)
In XGworks you can also record digital audio.After recording digital audio on any of the tracks through
an external microphone, the wave data can be played simultaneously with MIDI tracks. Song files that
have wave data (digital audio) and MIDI data mixed together can be saved as .XWS files.

1. Refer to the section “Preparation for Recording” on page I-8, and make the necessary settings for
recording.

2. Click the REC button on the Play Control. It will turn red, and XGworks will enter into recording
standby status.

REC BUTTON
n To stop recording at this point, push the REC button again or click the STOP button.The REC button will return to its original
state.

3. Click the PLAY button on the Play Control.The play button will light up, and recording will begin.
METRONOME BUTTON

PLAY BUTTON
n If you turn ON the metronome button on the Play Control, you can record your music while hearing the metronome play
through the connected MIDI tone generator.

4. Record your song or instrument performance through a microphone or other external sound
pickup.
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5. When you are finished performing, click the STOP button on the Play Control, and recording will

stop.The Song Position Pointer/Line will halt at the location where the STOP button was clicked.The
newly recorded block (long rectangular bar) will be displayed in the Block Section of the recorded
track.The symbol at the left edge of the block tells you it is a wave block and helps you to
distinguish wave blocks from MIDI sequence blocks.

WAVE BLOCK SYMBOL MARK

6. Click the STOP Button one more time.The Song Position Pointer/Line will return to the location
where recording began.

n If you aren't satisfied with block you just recorded, click the Undo button (→P. II-2) on the toolbar to erase it.
n You can edit the waveforms in your wave block using the Wave Editor TWE program found on the [Job] menu. See P. XI-38 for
details.
n When your song data includes tracks with wave data, make sure to save the song as an .XWS file (→P. I-26). If the song is
saved as .MID file, the wave blocks created on wave tracks will be deleted.
n The wave data itself can be saved within the song.To do this, save the data as an “XGworks Original File with Wave (*.XWS)”
file.

About WAV Files
There is actually no Wave data entered into the Wave blocks recorded in the Track View Window.The actual Wave
data is recorded in a separate file (.WAV file) from the song file and saved on the hard disk (in the XGworks
folder of the Yamaha folder in the Program Files folder).The only thing that is recorded in the Wave block of the
song file is a message about which Wave file to play and with what timing.
For this reason, several .WAV files can be prepared beforehand, and can be freely chosen for playback when
creating a song.The message about which Wave file to play and with what timing can be written for the block by
opening the Wave block’s List window. For details, see page VII-20.
n The directory for saving .WAV files when recording them can be changed using [Record/Playback Settings] from the
[Setup] menu on the Menu Bar in the Application Window (→P. XI-17).
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Using the Voice To Score Feature to Enter Melodies
Voice To Score converts a melody recorded as a wave file into MIDI notes. Using this function, you can
create a song from a melody in your mind, without having to play a keyboard or other MIDI instrument.
n There are limitations to the accuracy of voice to score conversion. It's best to execute the Voice To Score feature using the
simplest possible melody.After conversion, you can make detailed improvements to the MIDI notes using the Piano Roll
Window or Staff Window.

1. Record the melody as wave data on any desired track.While recording, keep the following points in
mind:

• Wave recording is possible using the MIC terminal on the computer. However, if the sound quality is bad
or if there is no MIC terminal on the computer, use a separately installed sound card for recording.
• The accuracy of the conversion will depend on the quality of the wave format during recording. It's best
to select 44,100 Hz, Mono, and 16 Bit on the Wave Format page of the System Setup dialog.
• Because the Voice To Score function can only detect and covert monophonic melody line, be careful to
avoid adding any harmony when recording the melody.
• In order to convert into the correct MIDI notes, based on the Quantize Grid setting in Voice To Score,
turn ON the metronome on the Play Control while recording and sing in time with it.Also, set the Tempo
Indicator on the Play Control to the same tempo as that entered on the master track (if a tempo is
entered in the Master Track Window).
• Because the conversion accuracy will suffer if any distinct noise is mixed into the wave data, listen with
headphones connected to the tone generator when recording along with a MIDI performance or
metronome, so that the sound isn't picked up by the microphone. It's also a good idea to use a
windscreen on the microphone so that the sound of your breath isn't recorded.
• Although it's possible to convert the notes when singing lyrics, conversion will be better if you sing
simple, crisp sounds like “ta, ta, ta . . .” or “da, da, da. . .” while keeping intonation in check.
• Sing as loudly as possible. If you can't sing very loud, set the audio recording volume on the Windows
Control Panel (Multimedia Properties) to its maximum. (For details, see your Windows owner's manual.)
• If the song you sing is too long, a huge amount of memory will be used during conversion to MIDI notes
with Voice To Score. It's better to record your melody in short phrases of about 4 to 8 measures, then
convert them one-by-one with the Voice To Score feature.
• If a wave recording is a failure, the wave data (.WAV file) will remain on the hard disk, even though the
wave block is erased from the Track View Window. In order to save hard disk space, it's a good idea to
delete unneeded .WAV files from time to time.
• After recording and before continuing to Step 2, listen to the wave data to make sure that the melody has
been clearly recorded.

2. Select the recorded wave block.
3. From the [Job] menu of the Application Window menu bar, select [Voice To Score].The Voice To Score
dialog box will be displayed.
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4. In the Input display at the lower-left corner of the dialog box, information (such as the track number
where the wave recording was done and the wave format) will be displayed for the wave block that
will be the source for the conversion to MIDI data. Check that the correct information is displayed
for the wave block you selected before opening the dialog box.

5. In the Output display at the upper-left corner of the dialog box, the output track number for the
converted MIDI data will be displayed. Click on the spin box control buttons to set the desired
output track for the converted data.You may also enter a block name when necessary.

n When this dialog box opens, the closest empty MIDI track will be selected automatically.

6. Set each conversion parameter as necessary.
n Since an appropriate default setting has already been made for each parameter, you can proceed to step 7 without making
any changes.As you get used to using the Voice To Score feature, you'll probably want to experiment with many different
settings for the conversion parameters.

Click on a radio button for the Quantize Grid to select a grid for fixing the note-on timing of the
converted MIDI notes. Basically, this should be set to the minimum size of the melody notes to be
converted in the wave data.
Click on one of the radio buttons for the Pitch of Converted Notes to select “All” or “Key Scale”. If
Key Scale is selected, XGworks will automatically guess the key of the melody, and convert the
melody into MIDI notes that are on the scale for that key.
Check the range of note pitch for detection on the Pitch Range display. Clicking on [Setup] will
open the Pitch Range dialog box.There you can fine-tune the note pitch range as needed.
Using the Adjustment sliders, you can make detailed adjustments to MIDI note detection. For details,
see page XI-34.
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7. Click on [Convert] and the conversion process will begin. During conversion, a dialog box will be
displayed.A few moments later, the conversion will be finished.

8. Before closing the Voice To Score dialog box, listen to the results of the conversion. Check the

[Converted MIDI Track] box and click on [Start].You can hear the MIDI notes detected in the wave
data. Click [Stop] and playback will end.

n When necessary, you can hear the [Input Wave Track] (the source wave track for the conversion) or [Other MIDI Tracks]
either together with the converted track, or by themselves.

n If the conversion does not go as expected, change the parameter settings and try it again.

9. Click on [Close] and the Voice To Score dialog box will close.
n For more detailed information on the Voice To Score feature, see page XI-32.

Adding Accompaniment to the Melody
The melody created using the Voice To Score feature can be polished by overdubbing with drum, bass, guitar, and
piano parts. Of course, you could make these parts using realtime recording or step recording. However, the
work of creating accompaniment can be much easier if you take advantage of the Auto Arranger feature in
XGworks.With this feature, all you have to do is specify the song type and accompaniment style (type of
rhythm, such as 8 beat or 16 beat).The song's chord progression will be automatically detected and an
appropriate accompaniment part will be created.When you use Voice To Score to create your melody and the
Auto Arranger to create the accompaniment part, you can create an entire song without playing a single note on
a keyboard or other MIDI instrument.
For more information on the Auto Arranger, see below.

In addition to the Voice To Score explained here, XGworks also has a plug-in function called Voice To
Score R.When using the Voice To Score R plug-in, there is no need to record the digital audio (wave data)
in advance.The singing that is input into XGworks through the microphone will be converted to MIDI
notes in realtime. In addition, the parameters are simplified, and easier to use, but along with the ease of
use come limitations in the way in which the melody must be sung. Since there are good points and
limitations to both the Voice To Score feature on the Job menu and Voice To Score R on the Plug-in
menu, it’s a good idea to experiment with both of them until you find the one that is easiest to use for
your purpose.
For details about Voice To Score R, Start the Voice To Score R and refer to the help file on the [Help]
menu.
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Adding Accompaniment to a Melody using Auto Arranger
By simply specifying the type of song and accompaniment style, you can easily create accompaniment
parts (style track and chord track) for a melody you have created using realtime/step recording or the
Voice To Score feature.

● What is Auto Arranger?
Based on a specified song type (atmosphere of the song), the Auto Arranger extracts several suggested
chord progressions that appear to match the melody line of a song, and offers them for your use.You can
select the chords that match your ideas about the song from among the offered candidates, and
complete the chord progression.The completed progression and the style you select are used to create
the automatic accompaniment.

Building an Accompaniment Using the Auto Arranger

1. In the Track View Window, drag the melody block you created using realtime/step recording or Voice
To Score until the first measure is at measure 10 or later.

n This dragging operation is necessary because an introduction will be added when Auto Arranger creates an accompaniment
part for the melody.

2. Select [Auto Arranger] from the [Plug-in] menu on the Application Window menu bar.Auto Arranger
will open.

3. Click on the [Atmosphere] box at the upper-left of the Auto Arranger window, and select the song
type you prefer.The Accompaniment Style Setup dialog will open.

Atmosphere

4. Click on a style category in the Category list to select it.
5. A list of recommended performance styles names for the category you selected will be displayed in
the Style list. Select one of the styles by clicking on it.

6. Click [OK].The Accompaniment Style Setup dialog will close and the display will return to the Auto
Arranger window.The song type (atmosphere of the song) and accompaniment style you selected
will be displayed

7. Click the [Auto-Arrangement Start] button at the upper right of the Auto Arranger screen.The Auto

Arranger will begin extracting an appropriate chord progression for the melody.When the chord
progression has been extracted completely, the extracted chord names will be shown in the [Current
Chords] display.
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8. Bring the Track View Window to the front without closing the Auto Arranger window.You can check
if the chord names and style blocks have been entered into the chord track and style track at the
lower part of the Track View Window.These chord names and style blocks are the accompaniment
parts just now created by the Auto Arranger.

CHORD NAMES
STYLE BLOCKS

9. Click the PLAY button on the Play Control, and listen to the accompaniment part that was created.
When doing this, you should mute any tracks besides the style and melody tracks.

How did it sound? The accompaniment style and chord progression you hear are the ones suggested
by the Auto Arranger.There may be some parts of the chord progression that don't fit your ideas
about the song.When that happens, see the next section,“Finding a Chord in the Recommendable
Chords.”

Finding a Chord in the Recommendable Chords

1. Bring the Auto Arranger window you were using back to the front. Click or drag the scroll bar at the
bottom of the screen until the measure you want to correct is displayed.

2. Move the mouse pointer to any of the chord names displayed in the [Recommendable Chords] in the
center of the Auto Arranger window.A message such as “There are some recommendable chords for
these x measures” will appear in the message box at the upper-right of the window.

3. The purple blocks in the Recommendable Chords are those belonging to the currently valid chord

progression (the ones you heard in the Track View Window).Try clicking any of the white chord
blocks you see here.The block you clicked will turn purple, and the name of that chord will appear
in the Current Chords display immediately above.This Current Chords display shows the currently
valid chord progression. It is also reflected in the Chord Track in the Track View Window.

4. If you move the mouse pointer to the right edge of any of the chord blocks in the Recommendable

Chords, the pointer will change to a ▼ symbol. Click there and a drop-down list will be displayed
showing other suitable chords suggested for that block.When you select one of the chords from the
list, the chord name display on the chord block will change to that chord. If you click on the block
with the changed name, it will change to purple (become valid), and will appear in the Current
Chords display immediately above the Recommendable Chords.

The method above is used to select the suggested chords.After finishing, move the Song Position
Pointer/Line to the appropriate position, and click the Play button on the Play Control.You can hear
the part of the accompaniment that you have changed.
n Suggested chords can also be selected while the song is being played.

For a detailed explanation of the Auto Arranger and hints about using it, start the Auto Arranger and
refer to the help file on the [Help] menu.
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Saving Your Song
This section describes how to save the song you have created or edited in XGworks.

1. Click on [File] on the menu bar in the Application Window, and open the File menu.

2. Select [Save As] or [Save]. When you are saving a newly created song, or when you want to change
the file name of an already existing song, select [Save As]. Choose [Save] when you want to save an
existing song without changing the file name.

n If [Save] is selected when saving a newly created song, the Save As dialog will appear, just as though [Save As] was selected.

If [Save] was selected, the file is now saved. If [Save As] was selected, continue to Step 3 below.

3. In the [Save As] dialog box (→P. XI-4), specify the save location (drive and folder).

4. In the [Save as type] box, select the type of file you will be saving (see below).
5. In the [File name] box, type in the file name, using the computer keyboard.
6. Click [Save].
About File Types
In XGworks, any of the following five file types can be selected for saving your file:
• XGworks Original File (extension: .XWS)
• XGworks Original File with Wave (extension: .XWS)
• SMF File Format 0 (extension: .MID)
• SMF File Format 1 (extension: .MID)
• XF File (extension: .MID)
See also the information on page I-5 about the file formats handled in XGworks.
n SMF format 0 saves data on a single track, then transmits it through multiple MIDI channels.
n SMF format 1 saves data on multiple tracks, then transmits it through multiple MIDI channels.
n Songs that include automatic accompaniment styles or wave data must be saved as .XWS files. If they are saved as .MID files
(SMF files), the style, chords and wave data will be erased.
n If you want to save the wave data itself in the file, save it using the XGworks Original File with Wave format.
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Application Window
Every window, starting with the Track View Window, can be opened on the Application Window.You can
think of the Application Window as a workbench, where you have the tools to do any kind of song
editing job you have in mind.
The Application Window is set up with the things that are used in common by all the edit windows--the
Menu Bar, the Toolbar and the Status Bar. By clicking or dragging on the Menu Bar or Toolbar, you can
select or execute a variety of different functions.The Status Bar constantly reports the current mouse
location and displays information about many other conditions in written form.
Tittle Bar
Menu Bar
Toolbar

Status Bar

n You can display or hide the Toolbar and Status Bar whenever you need to.When you click on the [Window] menu, a pulldown menu appears. If you click on [Toolbar] or [Status Bar] and a check mark appears, the Toolbar or Status Bar will be
displayed. On the other hand if the check mark is already displayed next to [Toolbar] or [Status Bar], clicking on it will
remove the check, and the bar will disappear from the Application Window.

n The active editing functions on the Menu Bar/Toolbar/Status Bar will differ in number according to the active editing window
(the window that is the target for current operations).
n None of the edit windows can be moved outside of the Application Window.
n Whenever a file is open, at least the Track View Window will be displayed on the Application Window.
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Title Bar
The name of the file that is currently opened in XGworks is displayed on the Title Bar of the Application
Window. If the file is a newly created one that hasn’t been saved yet, [Untitled] will be displayed.The
name of every edit window will be displayed on its own Title Bar.
n To learn about the other functions of the title bar, see page XI-1.

Menu Bar
The Menu Bar has all the various editing functions and setting functions used by the active edit window.
When you click on any of the menu names, a pull down menu appears, and from there you can choose
the function or command you need.To find out about each of the menus, see page XI-2.

Toolbar
The Toolbar is the place where the buttons for opening the edit windows and for starting the functions
you’ll use most often are laid out ready to use. Just click on any button to make it work.When you move
the mouse pointer over a button, a small pop-up help window appears with a simple explanation of the
button’s function.
1 2 3

4 5

6 7 8 9 )

! @ # $ % ^ & *

( º

¡ ™

1 New Button
This opens a new file. If the song that’s currently being edited hasn’t been saved, a dialog window will
appear asking if you want to save that song before opening the new file.This button has the same
function as the [New] command on the [File] menu.

2 Open Button
This opens an existing file. If the song that’s currently being edited hasn’t been saved, a dialog window
will appear asking if you want to save that song before opening another file.This button has the same
function as the [Open] command on the [File] menu.

3 Save Button
This saves the file currently being edited, overwriting any previous version.When saving a new file for
the first time, the “Save As” dialog will open.This button has the same function as the [Save] command on
the [File] menu.

4 Undo Button
This button lets you undo edit operations after they are executed. Each time you click on it, you can
trace back from your most recent edit operation through past ones, undoing each in turn.This button has
the same function as the [Undo] command on the [Edit] menu.
n If you have saved your file, you can’t undo any of the edit operations you did before you saved it.

5 Redo Button
This button lets you redo edit operations you have undone with the undo button.You can redo as many
operations as you have undone with the undo button, up to the most recent edit operation.This button
has the same function as the [Redo] command on the [Edit] menu.
n Using the Undo/Redo buttons, you can go back and forth between newly edited data and previous versions and compare
them as many times as you like.

6 Arrow Button
Clicking on this button selects the Arrow tool and changes the mouse pointer to an arrow.

7 Pencil Button
Clicking on this button selects the Pencil tool and changes the mouse pointer to a pencil.
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8 Eraser Button
Clicking on this button selects the Eraser tool and changes the mouse pointer to an eraser.

9 Scissors Button
Clicking on this button selects the Scissors tool and changes the mouse pointer to scissors.

) Glue Button
Clicking on this button selects the Glue tool and changes the mouse pointer to glue.
n In every editing window, the way to use each tool is different. See the explanation for each of them.

! Style/Chord Track Button
When the current window is the Track View Window, each time you click this button the display of the
Style/Chord Track (the automatic accompaniment creation track) will switch between on and off. If the
Track View Window isn’t the current window when this button is clicked, it will become the current
window.

@ List Window Button
This opens the List Window for the block currently selected in the Track View Window.

# Piano Roll Window Button
This opens the Piano Roll Window for the block currently selected in the Track View Window.

$ Staff Window Button
This opens the Staff Window for the block currently selected in the Track View Window.

% Drum Window Button
This opens the Drum Window for the block currently selected in the Track View Window.

^ Mixer Window Button
This opens the Mixer Window.

& XG Editor Window Button
This opens the XG Editor Window.

* Master Track Window Button
This opens the Master Track Window.

( Horizontal Zoom-in Button
Each time you click on this button, the display area of the current window gets magnified horizontally.
When the display can’t be magnified any further, the button turns gray and the function stops working.

º Horizontal Zoom-out Button
Each time you click on this button, the display area of the current window gets reduced horizontally.
When the display can’t be reduced any further, the button turns gray and the function stops working.

¡ Vertical Zoom-in Button
Each time you click on this button, the display area of the current window gets magnified vertically.
When the display can’t be magnified any further, the button turns gray and the function stops working.

™ Vertical Zoom-out Button
Each time you click on this button, the display area of the current window gets reduced vertically.When
the display can’t be reduced any further, the button turns gray and the function stops working.
n Depending on the window you are using, there won’t be any need to use some of the functions on the Toolbar. In this case,
their buttons automatically turn gray and the functions won’t work.The functions of the Toolbar are also provided in the
Menu Bar.
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Moving the Toolbar
By moving the mouse pointer to the margin around the Toolbar (the place where there are no buttons), and
dragging it, you can move the Toolbar wherever you want.
If you drag the Toolbar to the right or left edge of the Application Window, you can place it vertically along the
frame of the Application Window. If you drag it over to the Status Bar, you can place it on top of the Status Bar.
You can also place it outside of the Application Window.
Even when all the windows are opened on top of each other, the Toolbar will still be displayed over the highest
window.

Status Bar
The position of the mouse in almost every window is displayed on the center and on the right side of
the Status Bar.Whenever you move the mouse pointer over a button or function, a simple explanation of
it will appear on the left side of the Status Bar. Depending on the window, the Status Bar display area
might be divided into two or three parts.There are also times when the display method is different. For
details, see the explanation for each window.

About the Play Control
In the Play Control there are a variety of buttons for controlling the playback and recording of songs, and
also indicators for showing things like the song position and tempo numerically. By clicking on them
with the mouse, you can turn them off or on, or change the values of the numbers.Also, by doubleclicking on any of the number indicators, you can type in a new number on the computer keyboard.
1

6

7

2

8

3

9

45

)! @

1 Location Indicator
The current location in the song is displayed here as a numerical value.You can display the location
either in Measure/Beat/Clock units or in Min/Sec/Msec units, according to which suits your purpose at
the moment.

Changing the Display Format

1. Click the right mouse button with the mouse over the Location Indicator.
2. A pop-up menu [Display Format] will appear, with two choices, [Measure No.] and [Time]. Click the one you
want with the mouse.A check mark will appear. If you select [Measure No.], the location indicator will
display in Measure/Beat/Clock units. If you select [Time] it will display in Min/Sec/Msec units.

Measure No. Display

Time Display

II-4

XGw3/E2.QX

2/1/99

4:42 PM

Page 5

About Beats and Clocks
When discussing positions in songs, we usually speak of “the X beat of the X measure.” However, a finer unit than
the “beat” exists which is called the clock. In XGworks, a quarter note is 480 clocks long. Incidentally, an eighth
note is 240 clocks, and a sixteenth note is 120 clocks.This idea of counting the number of clocks in a quarter
note is generally called “note resolution.”The note resolution varies according to every company’s sequencer and
sequence software.The subtlety of the impression the song creates depends on the fineness of the resolution.

To change your location in a song, you can use any of the methods written below.
● By clicking on the 6 Top button or the ! End button, you can move the location to the beginning
or end of the song.
● By continuing to press the left mouse button on the ) FWD button, you will “fast forward” the song
location.
● Click on the up and down arrows on the Location Indicator scroll buttons.You can change the
location measure by measure. If you click the arrows while holding down the <Shift> key, you can
change beat by beat, and by holding the <Ctrl> key while clicking the arrows, you can change the
song position by clock units.
● Double-click on the location indicator and enter the numbers for the new position from the
computer keyboard, then push the <Enter> key.
n By clicking on the Master Track section of the Track View Window, or in the location section at the top of the Piano Roll,
Drum, or Staff windows, the song position pointer can be moved and the song location changed (→P. IV-4).The new location
you’ve moved to will be displayed on the Location Indicator.

2 Transpose Indicator
This displays the transpose value (how high the key is) when playing a song.At anytime, without
stopping playback of the song, you can click on the up and down scroll arrows of the Transpose
Indicator and change the key by semitones.You can also double-click on the indicator and enter a new
value by typing on the computer keyboard and pushing the <Enter> key.The setting range is from -36 to
0 (the original pitch of the song) to 36.
n This transpose function can’t be used to transpose or modulate the actual song data and exchange it for the old data.To learn
the method to actually transpose the MIDI notes in the song, see page XI-24.

3 Tempo Indicator
This displays the tempo when playing a song.At anytime, without stopping playback of the song, you can
click on the up and down scroll arrows of the Tempo Indicator and change the tempo.You can also
double-click on the indicator and enter a new value by typing on the computer keyboard and pushing
the <Enter> key.The setting range is from 20 to 300. (The figure shows the number of quarter note beats
per minute).
n If there is data in the song that sets the tempo value (tempo change data), that value will also be displayed on the tempo
indicator.The tempo changes made here are temporary. Even though you change the tempo here on the Play Control, it
doesn’t rewrite tempo change data in the song data. If you want to enter the tempo change data into the song data, you can
do it with the Master Track Window (→P.VIII-1).
n When playing a song that has tempo change data inserted part-way through, changing the tempo with the Tempo Indicator
produces a relative result. For example, a song has an original tempo of 100, which changes to 150 at the 20th measure. If the
Tempo Indicator is set at 200, the song will start playback at 200.When the song gets to the 20th measure, the tempo will
change to 300.The tempo change data in the song increased the tempo from 100 to 150, which is 1.5 times. Based on that,
the 200 tempo set on the tempo indicator also changed 1.5 times: 200x1.5=300.

4 Reset Button
If you have changed the tempo, clicking this will return the tempo back to the original figure.

5 Metronome Button
By clicking here, you can turn the metronome function on and off.When it’s on, the button turns black,
the metronome picture turns green, and a click sound will be played in time with the song.The
metronome is also handy when doing realtime recording, since you can use its sound to keep your
playing in time with the beat.
n You can adjust the sound and loudness of the metronome clicks to suit your taste (→P. XI-17).

II-5

XGw3/E2.QX

2/1/99

4:42 PM

Page 6

6 Top Button
Clicking here will return the song location to the beginning. If it is clicked while a song is playing,
playback will stop and the location will return to the beginning.

7 Stop Button
When clicked, this button stops the playing or recording of the song. If clicked again, the starting
position for playing and recording will shift to the position previously set by the Location Indicator or
Song Position Pointer (the upside-down triangle shaped pointer near the top of the windows like the
Master Track of the Track View Window).

8 Play Button
When clicked, this button causes the song to start playing from the position currently displayed by the
Location Indicator. If the 9 REC button is on, recording will begin.

9 Rec Button
When clicked, this button turns red, and the program goes into recording standby. Clicking it again will
cancel recording standby.
n To turn the REC button on, the track to be recorded on must first be selected (→P. III-4).

) FWD Button
No matter whether the song is stopped or playing, holding the mouse button down over this button will
cause the song to fast forward while playing at high speed. Fast forwarding will stop at the point where
the mouse button is released.

! End Button
When clicked, this button will shift the Location to the end of the song.

@ Loop Button
Each time this button is clicked, the loop function cycles between on and off.When on, the button
changes to green and the currently set loop range of the song will play repeatedly.
n See page III-22 to learn more about the Loop Function.

Moving the Play Control
By clicking on an area of the Play Control between the buttons and indicators (where there is nothing) and
dragging it while holding down the mouse button, you can move it wherever you want, even outside the
application window.
The Play Control is displayed on the screen from the time when XGworks is started, and usually remains until
the finish. Even if all the windows are displayed on top of one another, the Play Control is always displayed
above all the other windows, and it can’t be hidden.

n By pressing <F7> key while holding the <Alt> key, you can switch the Play Control to be shown/hidden.
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About the Note Palette
This is a palette for setting the gate time and velocity of the new MIDI notes that are entered when
doing step recording. It is displayed whenever XGworks is in a state for step recording (when the Piano
Roll, Drum, or Staff Windows are active, or when it is possible to do step recording from an external
MIDI keyboard with the Track View Window).

Note Palette
Gate time and velocity settings for entering new MIDI notes are set using the buttons on this palette. It’s
used when doing step recording. Since it’s a floating-style palette, you can set it anywhere when you use
it, even outside of the Application Window.
1

2 3 4

5

6

1 Note Buttons
When you are entering new MIDI notes, you can set the note length here. Clicking on the appropriate
button sets the gate time for the MIDI notes to whole note, half note, quarter note, eighth note, sixteenth
note or thirty-second note.

2 Accidental Button
When you click this button, you will be able to enter accidentals (sharps, flats, or naturals). Use it
together with any of the Note buttons.The default is sharp, but you can change to flat or natural by
clicking on the button with the right mouse button.
n This button can only be used in the Staff Window.

3 Dotted Note Button
When you click here, the gate time for newly entered MIDI notes will be set for the dotted note value.
Use it together with any of the Note buttons. For example, if you use this button together with the eighth
note button, the gate time will be set for the length of a dotted eighth note, and new MIDI notes will be
entered with that length.

4 Tuplet Button
When you click here, you will be able to enter triplets, quintuplets or septuplets. Use it together with any
of the Note buttons. For example, if you click the triplet button together with the eighth note button, the
gate time will be set for the length of an eighth note triplet, and new MIDI notes will be entered with
that length.To switch to quintuplets or septuplets, click the Tuplet button with the right mouse button.

5 Gate Time Control
This box is used for fine adjusting the gate time set with the Note button. Using this box, you can set a
range of 1 to 100 percent of the gate time set with the Note button, and when the notes are actually
entered, their gate time will be adjusted by that value. For example, when you are entering MIDI notes
with the gate time set for entering eighth notes, and the value here is 90 percent, the MIDI notes will
actually have a value of only 90 percent of an eighth note.You can enter the value by clicking the spin
control or by typing from the computer keyboard, then pressing <Enter>.
n By using this function creatively to control the gate time, you can easily create crisp staccato or smooth legato performances.

6 Velocity Buttons
By clicking on the appropriate button, you can set the velocity of the MIDI notes using preset values for
eight different levels from pianississimo to fortississimo.The preset value will be shown in the box to the
right of the velocity buttons. New MIDI notes will be entered with the value shown here.Also you can
enter whatever value you like between 1 and 127 into the box from the computer keyboard, then set it
by pressing the <Enter> key.
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Track View Window
In this window you can get a handle on every aspect of song creation. It’s the center of every editing
job, and it has a lot of different functions to help you arrange songs at the track level.

Title Bar
Master Track
Track
Parameter
Section

Block Section

Style/Chord
Track

Style Block
Section

Style Parameter
Section

Split Bar

● The Track Parameter Section displays a list that shows all the many parameters for each track (you
can have as many as 100), starting with each track’s assigned output port and MIDI channel.You can
set or adjust the settings for each item, track by track, when recording or playing songs.
● In the Block Section, long, horizontal bars are used to represent the blocks (MIDI or Wave data:
P. I-14) that make up each track.You can do a lot of different editing jobs with the tools provided
here, such as cutting some parts, moving them to another place, or pasting them in. By selecting a
MIDI sequence block you can open the related window such as the Piano Roll Window or Staff
Window, for example, and change over to doing more detailed editing of individual notes or MIDI
events.
● You can easily create auto accompaniment data using the Style/Chord track. In the Style Parameter
section on the left side, you can turn ON and OFF Solo playback and the Mute function for auto
accompaniment.You can also make transpose settings. In the Style Block section on the right side,
you can select auto accompaniment styles, paste style blocks, and arrange chord progressions for
style accompaniment.
● When you are editing or moving blocks, you can be sure of doing it exactly where you want by
checking the mouse pointer position display on the right of the Status Bar.
n When you open a song file (.XWS file or .MID file) it always opens in the Track View Window. Creating a new file will also
cause it to be displayed in the Track View Window, but with the Block Section blank.
n To learn more about the Menu Bar and Toolbar of the Application Window, see page II-2.

III-1

XGw3/E3.QX

2/1/99

4:47 PM

Page 2

The Name and Function of Every Part
Title Bar
On the left of the Title Bar there is the application icon and on the right are the Minimize, Maximize and
Close buttons. For details, see page XI-1.

Split Bar
If you place the mouse pointer over the line (Split Bar) that divides Track Parameter Section from the
Block Section, the pointer will change shape into the split tool.With this tool, you can drag the Split Bar
back and forth and change the widths of the two sections.

n You can change the size of any of the windows by placing the mouse pointer on the top, bottom, left, or right border lines of
the window, then dragging the line until the window is as big or small as you like.

Track Parameter Section
In the Track Parameter Section, the following parameters are displayed for each track:Trk (Track
Number), Port (Output Port), Ch/Pan (MIDI Channel/Wave Pan), Rec (Recording ON/OFF), Name (Track
Name), S (Solo ON/OFF), M (Mute ON/OFF),Trns/Vol (Transpose/Wave Volume),Type (Track Type) and
Instrument Type.
1

2

3 4 5 67 8

9

)

!

@
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1 Trk (Track Number)
The number for each track is displayed (from 1 to a maximum of 100).
By dragging the track numbers up and down with the mouse, the tracks can be arranged in any desired
order.

2 Port (Output Port)
The output driver to be used by each port is displayed.The MIDI data for each track will be transmitted
to the MIDI tone generator that corresponds to the driver selected here. If you click on the name of the
driver that is displayed, a drop-down list will appear showing all the available drivers and you can select
whichever one you need.

n If you connect a Yamaha XG tone generator as shown on page 7, install the Yamaha CBX Driver and select [Yamaha CBX A
Driver] for the Port (output device).When a Multiport compatible XG tone generator (such as the MU128) is connected,
using also the [Yamaha CBX B - E Driver] will allow playback on 17 channels or more.
n When you want to set the same driver for multiple tracks, you can drag over the Port display to specify a range.A drop-down
list will appear for the bottom Port display in the range you specified. Choosing a driver from that list will cause it to become
the specified driver for all the tracks you have selected.

n The drivers displayed in the drop-down list will vary according to the hardware you are using. For information about driver
settings, see also page XI-12.

3 Ch/Pan (MIDI Channel/Wave Pan)
When MIDI is selected as the Type parameter for a track, the MIDI channel for that track will be
displayed here. If you click on the channel number, a spin box will appear. Clicking on the up and down
control buttons lets you select any channel number from 1-16.
When WAVE is selected as the Type parameter for a track, this location will display the wave pan (stereo
orientation) value for the track. If you click on the value, a spin box will appear. Clicking on the up and
down control buttons lets you select the stereo output orientation within a range from L7 (left edge) to
C (center) to R7 (right edge).
You can also type in the MIDI channel or wave pan value from the computer keyboard.
MIDI

WAVE
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4 Rec (Recording ON/OFF)
This is the switch on each track that is used to turn recording on or off. Click in the switch column for
the track you want to record.An “R” mark will be displayed, and you will be able to record MIDI or digital
audio data on the track. If you click it once more, the “R” mark will disappear, and the track will return to
normal playback condition.

n When Realtime is selected for the Record Mode in the Record/Playback Settings in the Setup menu, multiple tracks can be
recorded at the same time (→P. I-16).
When you want to turn OFF recording for all the tracks at the same time, click the right mouse button on the Rec button
(top of the display) and select “All Off.”

5 Name (Track Name)
You can give any of the tracks its own name. Click in the Name column for the track you want to name,
and you can enter the desired name using the computer keyboard.Typing in the name of the instrument
or program used by each track makes them easy to tell apart.

6 S (Solo ON/OFF)
This is the Solo Playback ON/OFF switch for each track. Click in the Solo column for the desired track
and an “S” mark will appear.The track will begin solo playback. MIDI notes from all the other tracks will
temporarily stop playing. If you click once more, the “S” mark will disappear and the other tracks will
begin playing as usual.

n The solo function is always temporary, and does not erase any actual MIDI data (on the tracks where the sound disappears).

7 M (Mute ON/OFF)
This is the Mute ON/OFF switch for each track. Click in the Mute column for the track you want to
mute, and an “M” mark will be displayed, and the track will be muted.The MIDI output for that track will
temporarily be canceled. If you click once more, the “M” mark will disappear and the track will return to
normal playback status.You can also mute multiple tracks at the same time.

n If you want to turn off muting for all the tracks at the same time, click the right button of the mouse over the “M” parameter
button at the top of the parameter section, and select “All Off.”
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n If you want to turn on muting for all the tracks at the same time, click the right button of the mouse over the “M” parameter
button at the top of the parameter section, and select “All On.”

n The mute function is always temporary, and does not erase any actual MIDI data.

8 Trns/Vol (Transpose/Wave Volume)
When MIDI is selected as the Type parameter for a track, the transpose value for the track is displayed
here. If you click on the value, a spin box will appear. Clicking on the up and down control buttons lets
you easily set the desired value.Transposition can be turned Off, or set within a range from -36 to 0 (the
default pitch) to 36. Each change in value of +/-1 raises or lowers the pitch of the song by one semitone.
For example, if the value for a track is set at 12, the MIDI notes on that track will all be played with a
note number 12 semitones (one octave) higher. If the value is set to zero, they will return to the original
pitch. Multiple tracks can also be transposed separately.The default setting for the drum track on channel
10 is Off.You'll probably want to also set Off for other tracks that don't need transposition (rhythm or
SFX tracks).
When WAVE is selected as the Type parameter for a track, this location will display the wave volume
value for the track. If you click on the value, a spin box will appear. Clicking on the up and down control
buttons lets you select the wave output volume within a range from 0 to 127.With this feature you can
balance the volumes of the wave tracks.
You can also type in the transpose or wave volume value from the computer keyboard.
MIDI

WAVE

n If you want to return all the transposed tracks back to their original pitch at the same time, click the right button of the
mouse over the Trns/Vol parameter button (at the top of the parameter section) and select [Default Settings].

n The transpose settings made here are only temporary and don’t change the actual data in the song.When you want to actually
insert transpose data into the song data, execute the [Transpose] command from [Job] on the Menu Bar (→P. XI-24).
n The note numbers defined in MIDI go from 0 to 127. Be careful not to exceed the limits for playing notes by setting the
transpose value too high or too low.
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9 Type (Track Type)
This is used to select the track type.There are two kinds, MIDI tracks and Wave tracks. Select the MIDI
type when you are going to do MIDI recording and select the WAVE type when you are going to do Wave
recording (digital audio).The type can’t be set or changed for a track where blocks already exist (already
recorded tracks).
Click in the Type column for the appropriate track, and a drop-down list will appear. Select either MIDI
or WAVE as the type.

n The default type setting is MIDI. If you start recording on a track without changing the setting, it will automatically be treated
as a MIDI track.When recording Wave data, select WAVE as the track type beforehand.

) Instrument Type
This parameter is used to select the instrument type for the track.The type selected here will be
reflected when the score is printed out in the Staff Window (→P.V-14).When the Instrument Type box is
clicked for any track, the Instrument Type dialog will be displayed.The setting becomes valid when you
click [OK] to close the dialog.To cancel the operation before finishing it, click on [Cancel].

n You can open the Instrument Type dialog for multiple tracks by dragging over those tracks with the mouse in the Instrument
Type column.

Instrument Type Dialog

Type
Select one of the following as the type of instrument being used for this track:
Normal ................................General instrument.
Transposing Instrument ..Transposing instruments, such as wind instruments.
Drum....................................Drums, percussion.
Gtr Tab (Single Track) ......Guitar (when all the strings are displayed together on a single track).
Bass Tab (Single Track) ....Bass (when all the strings are displayed together on a single track).
Gtr Tab (Multi Track) ........Guitar (When each string is displayed on a separate track).
Bass Tab (Multi Track) ......Bass (When each string is displayed on a separate track).
Electone ..............................Electone (Yamaha's electronic organ).
n When Transposing Instrument is selected, the key signature displayed on the Staff window will match the Group settings
below.
n When Gtr Tab (Multi Track) or Bass Tab (Multi Track) are selected, guitar or bass tablature can be displayed using the
Guitar Arranger plug-in.
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Group
The following settings are made according to the Type selection:
Transposing Instrument ..Select the instrument type and tuning (such as Piccolo in C, or Alto Flute in G).
Gtr Tab (Multi Track) ........Select the group in the upper box. Each group refers to a single guitar part.You can
select groups from A to H. In the lower box, select the string number within the
group (single guitar part) for this track.
Bass Tab (Multi Track) ......Select the group in the upper box. Each group refers to a single bass part.You can
select groups from A to H. In the lower box, select the string number within the
group (single bass part) for this track.
Electone ..............................Select the group in the upper box. Each group refers to a single Electone part.You
can select groups from A to H. In the lower box, select the keyboard within the
group (single Electone part) represented by this track.The Upper, Lower, or Bass
keyboard can be chosen.
n If Normal, Drum, Gtr Tab (Single Track) or Bass Tab (Single Track) is selected for the Type, no group settings can be made.

Tuning (Left Side)
You can set the type of guitar or bass tuning when the Instrument Type dialog is opened for multiple tracks (by
dragging in the Instrument Type column of the Track Parameter Section), and Gtr Tab (Multi Track) or Bass Tab
(Multi Track) is selected as the Type.Tunings other than the normal ones can be selected, such as open tunings.
Tuning (Right Side)
When a single track is clicked in the Instrument Type column of the Track Parameter Section, the Instrument
Type dialog will open.You can specify the tuning for the track you clicked (single string) by selecting Gtr Tab
(Multi Track) or Bass Tab (Multi Track) as the Type. Click on the up and down scroll buttons, or by type directly
from the computer keyboard to change the tuning as required.

Changing the Order of the Parameters
By dragging any of the parameter buttons (Port, Ch/Pan, Rec, etc. at the top of the window) to the left or right,
you can move the whole column that is under that button to wherever you want. Use this feature to arrange the
columns into the order that you find easiest to use.
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Changing the Width of Parameters
If you place the mouse pointer on the right side of any parameter buttons (top of the display), the pointer will
change into the split tool.With this tool, you can drag the parameter border line right and left and change the
width of the parameter display.

When you want to return the display width to its original state, double click on it when the mouse pointer has
become a split tool. However, the Port (output device), Name (track name) and Instrument Type parameters will
change width to match the number of characters that have been entered into them.

Using the Computer Keyboard to Select and Modify Values
Any parameter can be selected or changed using the computer keyboard.The cursor (light blue box) can be
moved around the screen using the four arrow keys (<á>, <â>, <ß>, <à>) on the computer keyboard.After
moving the cursor to the position you wish to change, pressing the <Enter> key will prepare the value to be
selected or modified.The value can be typed in or selected from a drop-down menu using the <á> and
<â>keys. Pressing the <Enter> key once more determines the value.

! Scroll Bar
If a part of the Track Parameter Section you need to use is currently hidden beyond the edge of the
window, you can scroll it into view by clicking or dragging the scroll bar.

@ Style Parameter Section
Make parameter settings related to the auto accompaniment style and chord track.The track that has a
“C” displayed for the track number is the chord track.The track that has an “S” displayed is the style track.
In the style track, the following can be done: Port (output device) settings made, Name (track name)
entry, Solo play and the Mute function turned ON and OFF, and Trns (transpose) settings made. Because
the methods for entry and setting are the same as for tracks 1 to 100, refer to item numbers 2, 5, 6, 7,
and 8 on page III-3 to 5 for details.
n For details about the Style/Chord track, see page III-25.
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Block Section
The data that makes up each track is arranged in units called blocks (→P. I-14).The block section
provides a graphical interface for you to cut, paste and otherwise edit these blocks using the various
commands and editing tools available to you.
4

3
1

5
6
7
2

1 Master Track
The Master Track is the special track for controlling things like the tempo and time signature which
apply to the song as a whole.Vertical lines form a grid of one measure units, and the number of every
fourth measure is displayed.This helps you to check your current location in the song and it also acts as
a yardstick for selecting ranges when doing block editing.The triangular Song Position Pointer, which
shows the current song location, and the markers for moving immediately to any desired location in the
song, are also displayed on the Master Track, as are the “S” (Start) and “E” (End) marks which indicate the
range for song loops.

2 Song Position Pointer/Line
This shows your current position in the song.When you record or play a song, the Song Position Pointer
and Song Position Line automatically move forward along with the song.You can move the Song Position
Pointer/Line wherever you want by clicking anywhere on the Master Track or using the Play Control
Location Indicator or TOP/FWD/END buttons.This way, you can easily set the location to start playing or
recording your song. For information about the Play Control, see page II-4.

3 Loop S (Start) and E (End) Marks
These two symbols are used to set and display the points where playback and recording of song loops
will start and end.The “S” mark shows the starting position of the loop range and the “E” mark shows the
end.

4 Markers
This function places a marker at any desired location in the song. Because this function allows you to
immediately move the song position to the marker location, it’s really useful for jobs like inserting a
marker at the place where you want to do realtime recording over and over again until you are satisfied,
or separating the parts of the song (such as where the bridge begins or the key changes).

5 Block Display
The blocks in every track are displayed using long, rectangular bars.With the editing tools provided there
are lots of different ways you can edit the contents of each track. For example, you can cut off parts of
the blocks or paste them in different locations. Every block has a block name displayed on it and short
vertical lines mark each measure, helping you to know where the block is located.
n Multiple blocks can be intermixed in one track, and can overlap one another.
n You can name each block whatever you want, according to your needs (→P. III-16).You can also change the colors of the
blocks as necessary (→P. XI-20).

6 Scroll Bar
If a part of the Block Section you need to use is currently hidden beyond the edge of the window, you
can scroll it into view by clicking or dragging the scroll bar.

7 Style Block Section
Displays the auto accompaniment style blocks and the chord progressions used for style accompaniment.
n For details about the Style/Chord track, see page III-25.
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Editing in the Track View Window
Track Parameter Section Operations
In the Track Parameter Section, you can make settings and do editing operations that apply to each
individual track.

Changing and Setting Track Parameters.
By clicking on any of the track parameter displays, it becomes possible to edit the settings there.The
methods for making the settings vary somewhat, depending on the parameter. Some display spin boxes,
while others require a selection to be made from a drop-down list. Some settings call for information that
is typed in directly from the computer keyboard. see page III-2 for details.

Track Pop-up Menu
If you click the right mouse button on the track number, a pop-up menu for that track will be displayed.
By selecting commands from this menu, you can execute various functions.

Copy ........................................Copy all the data (blocks) in the track to the clipboard.
Paste ........................................Paste all the track data (blocks) that is currently copied onto the clipboard.You can
paste at the same location (position in time) as the end position of the source blocks
you copied.
Erase ........................................Erase all the data (blocks) on the track.
Select All..................................Select all the blocks on the track.
Select Voice ............................Open the Voice List dialog and select a voice for the track.
Properties ..............................Open a properties dialog about the track’s parameters.
n For details about the voice list, see page I-11.The voice selected here will be played through the connected XG tone
generator. However, the voice selection made here is temporary and program change data won’t be entered into the song
data.To learn how to enter a program change, see page IV-25.

Track’s Properties Dialog

The Track’s Properties Dialog shows all the currently set parameters for the track it belongs to.Any of the
parameters can be changed by clicking with a mouse or typing.When you click [OK], the properties dialog will
close and all the changes you have made will be reflected in the Track Parameter Section. If you decide not to
change the parameters, click on [Cancel], and the dialog will close, leaving the parameters as they were.
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Block Section Operations
The Block Section presents you with a nice graphical interface that makes changing the track contents
easy.The blocks that make up the tracks are represented by long rectangular bars and you can copy
them, cut out a part and move it somewhere else, merge one block with another and do other editing
tasks until your tracks are just the way you want. For example, you can shorten the introduction or
lengthen the main theme, changing the actual song data as you work on its arrangement.
n There are two kinds of blocks, sequence blocks (MIDI data blocks) which are placed in MIDI tracks, and Wave blocks (digital
audio blocks) which are placed in Wave tracks. For either type, you can create a link block, a kind of copy block that doesn’t
exist on its own, and use it in editing or arranging. In this section, you will learn about the edit operations that apply in
common to any type of block. For information about the concept of blocks, see page I-14.

Toolbar
On the Toolbar of the Application Window, there are several useful buttons ready for you to use in your
editing.
Undo

Eraser
Arrow

Horizontal Zoom-in
Glue

Pencil
Redo

Scissors

Horizontal Zoom-out

n If the Toolbar isn’t being displayed, click on [Toolbar] in the [Window] menu on the Menu Bar.A check mark will appear and
the Toolbar will be displayed.

The Edit Undo/Redo Function
Using the Undo and Redo buttons on the Toolbar, you can easily undo and redo editing operations after
you have executed them.With these two functions, you can go back and forth between newly edited
data and previous versions and compare them as many times as you like. However, once you have saved a
file, you can’t undo any edit operations that were done before the file was saved.
n You can also execute the Undo and Redo functions by selecting the Undo or Redo commands on the [Edit] menu.You can
also select [History] from the [Edit] menu and trace back along a list of past edit operations and Undo or Redo those
operations up to any desired point (→P. XI-7).

Edit Tools
Using the Arrow, Pencil, Eraser, Scissors, and Glue tools on the Toolbar, you can edit blocks in a lot of
different ways.To learn the use of each tool, see the following explanation of each type of editing.
Block Section Zoom-in and Zoom-out
Using the horizontal Zoom-in and Zoom-out buttons on the Toolbar, you can change the scale of the
block section display to make it easier to see according to the task at hand.
n For information about each of the Toolbar buttons, see page II-2.
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Tool Pop-up Menu
If you click the right mouse button over the Block Section, the Tool pop-up menu will be displayed.You
can choose whichever tool you need from this menu.

Arrow ......................................Select the Arrow tool.
Pencil ......................................Select the Pencil tool.

Eraser ................................Select the Eraser tool.
Scissors....................................Select the Scissors tool.
Glue..........................................Select the Glue tool.
Paste ........................................Paste the block copied to the clipboard at the paste line (vertical white line) for the
track where the right button of the mouse is clicked.To display the paste line, click
the mouse with the pointer on any empty region (area with a black background) in
the Block Section.

Paste Line

Properties ..............................Open the properties dialog.This brings the same properties dialog that appears when
you right-click on the track number and then select properties from the track pop-up
menu, as mentioned above. For details, see page III-10.

Block Selection
In order to edit a block, you first have to select the block that you want to edit.There are several ways to
select blocks, from selecting them individually to selecting multiple blocks at once, with each method
being suited to different purposes.
Individual Block Selection
When you want to select one of the blocks individually, just click on the block.The block you have
selected will turn red. (If the selected block contains no data, slant lines will be displayed on it.)
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Multiple Block Selection (A)
To select multiple blocks, click on each of the blocks while holding down the <Ctrl> key.

n If you click on an already selected block while holding down the <Ctrl> key, selection of that block will be canceled.
n You can select multiple blocks by clicking on them while holding down the <Shift> key.When this is done, all the blocks
between the two blocks you clicked on will be selected at once.

Multiple Block Selection (B)
Pressing the mouse button on an empty region of the Block Section (black background) and then
dragging the mouse pointer specifies a particular region of the Block Section. If you include the blocks
you want to select within the four corners of that area, then release your finger from the mouse, those
blocks will be selected in one move.

Multiple Block Selection (C)
When you want to select all the blocks in a track (including overlapping ones), double click on the track
number.

Multiple Block Selection (D)
After clicking on the Block Section for the track 1-100, execute the [Select All] command in the [Edit]
menu or push the<A> key while holding down the <Ctrl> key.This selects every block in the block
section in one move.
n If you want to cancel selection of every block, click in any empty area (black background) of the Block Section.
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Moving Blocks
By dragging selected blocks with the mouse, you can move them anywhere you want.As shown by the
picture below, you can either move the blocks within their own track, or you can move them to other
tracks.You can move blocks by single measure units.When you move the block, it automatically aligns
with the grid on the block section and you can be sure of aligning the block exactly with the start of the
measure.

Moving a block within an
individual track

Moving a block to another track

If you select multiple blocks you can move them all together.
n You can’t move a block to a track of a different type. For example, you can’t move a MIDI type block (sequence block) to a
Wave type track.

Overlapping Blocks
When moving blocks around, you can overlap them anyway you want even among the different tracks, as
shown in the pictures below.The effect of overlapping two or more of blocks will be just as though the
sounds had been mixed. Unlike the merge function mentioned later, the data from the two blocks
doesn’t actually become a complete single unit, and you can still separate them again or overlap them
differently if you want.
Overlapping blocks can be really handy when you are thinking about building an entire rhythm track.
You can set a fill-in block several places over a block that has a main drum pattern in it.Another way you
can use it is to create separate blocks for rhythm instruments like snare, bass drum, and hi-hat, edit each
block separately, then use the overlap function to test them mixed together before finally merging them
into a single drum track.You can probably think of a lot of other ways to use this feature.

Block three will be laid over block four,
shifted two measures ahead

It becomes two blocks overlapping in the
same track, shifted by two measures.

When we drag it with the mouse...

When two blocks are overlapped in
the same position, it looks like a single
block on the screen. Check it by playing it
through the tone generator.
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Block Copy
If you drag the selected block while holding down the <Ctrl> key of your computer, the selected block
will be copied to the new location without affecting the original (source) block. If you select multiple
blocks as mentioned before, all of them will be copied at the same time.

n You can also copy by selecting [Copy] from the [Edit] menu, or by pressing <C> key on the computer keyboard while
holding down the <Ctrl> key.You can also copy by selecting [Copy] from the block pop-up menu explained below.

Block Merge
If you hold down the <Ctrl> and <Alt> keys at the same time when dragging a block, laying it over
another block will cause the data from the two blocks to mix and they will become one single block.The
block that you dragged will remain in its original place, and a copy of it will be added to the other block.
The size of the block after merging will be the same as the size of the longest of the two blocks that
were merged.

n The merge function can only be used for sequence blocks.You can’t merge Wave blocks.

Block Pop-up Menu
If you click the right mouse button on a selected block, a pop-up menu related to that block will be
displayed.You can execute various functions by selecting commands on that menu.

List............................................Open the List Window for the currently selected block.
Piano Roll ..............................Open the Piano Roll Window for the currently selected block.
Staff..........................................Open the Staff Window for the currently selected block.
Drum ......................................Open the Drum Window for the currently selected block.
Copy ........................................Copy the currently selected block onto the clipboard.After copying, paste the copied
block by selecting [Paste] from the tool pop-up menu or from the [Edit] menu.
Delete ......................................Delete the currently selected block.
Create Link Block ..................Create a linked block for the currently selected block after the original block.
Convert to Normal Block ....Make the currently selected link block into a block that exists on its own (normal
block). (This command only appears on the pop-up menu that is displayed when you
click on a link block.)
Change Name ........................This opens a name edit box for the currently selected block.
Properties ..............................Open a properties dialog with information about the currently selected block.
n When a Wave block is selected, you won’t be able to open the Piano Roll, Staff or Drum Windows.
n This pop-up menu is different from the one that appears when you click anywhere in the Block Section. Be careful you have
the right one.
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Block’s Properties Dialog

Track Number ....................Displays the track number for the currently selected block.
Block Name ........................Displays the block name for the currently selected block.
From ....................................Displays the start location for the currently selected block.
Thru ....................................Displays the ending location for the currently selected block.
Block Type ..........................This displays whether the currently selected block is a sequence block,Wave block
or link block.
Source Block ......................If the currently selected block is a link block, the original block’s name is displayed
here.
The Block’s Properties Dialog displays information about the selected block.You can change settings for the
block’s name, and its starting and ending locations by clicking with the mouse or typing in the new information.
When you click [OK], the Properties Dialog will close and the changes you made will be applied to the selected
block. Clicking on [Apply] will cause the settings to be immediately applied without closing the Properties
dialog. If you want to cancel your changes, click on [Cancel] and the Properties dialog will close, and the block’s
settings will remain in their original state.

About Block Names
Newly created or recorded blocks are automatically named.The names follow the pattern of Block 1, Block
2.....and so on, according to the order in which they were recorded or pasted. If you wish, you can change the
names of your blocks to anything you want. Click once on the block you want to rename and select it, then click
once more to open the name editing box.After typing in the new name with the computer keyboard, press the
<Enter> key and the name you have chosen will be set.
You can also change the name using the Block Pop-up Menu ([Change Name]) mentioned earlier or the Block
Properties dialog.Another way to change the block name is to select [Rename Block] from the [Edit] menu.You
might like to name the blocks after their contents—“Melody A” or “Main Theme”—making it easy to tell one from
the other.

III-16

XGw3/E3.QX

2/1/99

4:47 PM

Page 17

Link Block Function
XGworks can make one more type of block besides MIDI blocks for sequence data and Wave blocks for Wave
(digital audio) data.This type of block is called a link block, and it actually doesn’t exist as a separate block.
The link block is completely linked to the original source block from which it was created, and when changes
are made in the original block the link block will be changed in the same way.Therefore the original block and
the linked block will always contain exactly the same MIDI data or Wave data.Whenever it suits your purpose,
you can convert the linked block into a normal block that has its own separate existence.This function is handy
when you need to make multiple blocks that have the same final content.
For example, link blocks are a useful way to make a rhythm track using many copies of the same rhythm pattern
or fill-in pattern.You can also use it to create layer sound (a thick, warm sound effect using two layered voices)
by using the same phrase with different MIDI channel and program change settings.
n Since you can’t edit the actual content of a link block, you won’t be able to set different program change or control data
until you convert it to a normal block.

If you drag the selected block while holding down the <Alt> key of your computer, the selected block will be
copied to the new location as a link block without affecting the original (source) block. If you select multiple
blocks as mentioned before, all of them will be made into link blocks at the same time.An arrow mark and a *
mark will be displayed to the left of the block name on the newly created link block.

n You can also create a link block using the [Create Link Block] command on the block pop-up menu.Another way to
create a link block is to select the [Create Link Block] command from the [Edit] menu.

You can move or overlap link blocks just like actual blocks.You can also use the Copy Block or Create Link
Block functions to create a child link block from another. In that case the child blocks will have additional *
marks added to the right of the arrow mark in the order of their creation (*, **, ***), as shown in the picture.

In any case, the first block and all of the child blocks you create from it and the children of those blocks will still
be linked to the original normal block.
You can change link blocks to normal blocks by following these steps:

1. Click on the link block to select it.
2. Click the right mouse button over the selected block.The block pop-up menu will open.
3. Select [Convert to Normal Block] from the menu, and the link block will change to a normal block.

III-17

XGw3/E3.QX

2/1/99

4:47 PM

Page 18

Deleting Blocks
You can delete blocks you don’t need by following these steps:
Delete Method (A)

1. First select the block you want to delete.
2. Press the <Delete> key on the computer keyboard.
Delete Method (B)

1. First select the block you want to delete.
2. Select the [Delete] command from the [Edit] menu.

Delete Method (C)

1. First select the block you want to delete.
2. Click the right mouse button over the selected block.
3. Select the [Delete] command from the pop-up menu.
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Erase Method (Eraser Tool Function)

1. Select the Eraser tool from the Toolbar (→P. II-3).
2. Click on the block you want to delete.

n The Eraser tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the tool pop-up menu
(→P. III-12).

Creating an Empty Block (Pencil Tool Function 1)
You can easily use the Pencil tool to create a block with no data in it. Once you have created it, you can
enter the MIDI notes and values to create a song (step recording) by using the Piano Roll, Drum, Staff, or
List Window.

1. Select the Pencil tool from the Toolbar (→P. II-2).
2. Drag the tool to the right or left in an empty area of the Block Section (black background).
n If the empty block you are creating is a Wave block, the Open file dialog will automatically open, and you can insert an
already existing .WAV file into the block. Select the .WAV file you want and click [Open]. For details about the Open file
dialog box, see page XI-3.

Empty blocks are created in units of one measure or more. By following the grid (short vertical lines
marking each measure) in the block section, you can easily align the block you are creating at exactly the
start and finish of the measures.
n The Pencil tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the tool pop-up menu
(→P. III-12).
n You can also create empty blocks by using the [Create Block] command on the [Edit] menu (→P. XI-8).

Changing Block Length (Pencil Tool Function 2)
Using the Pencil tool, you can easily change the length of blocks as though you were using graphics
software.

1. Select the Pencil tool from the Toolbar (→P. II-2).
2. Click on the block you want to extend with the Pencil tool, and drag it towards the right.The block

will extend from its final position and empty measures will be added.Also, by dragging towards the
left, you can shorten the block from its final position. However, you can’t make the block any shorter
than the location of its final MIDI event.

n The Pencil tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the tool pop-up menu
(→P. III-12).
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Separating Blocks (Scissors Function)
You can separate a block into two separate independent blocks using the Scissors tool.

1. Select the Scissors tool from the Toolbar (→P. II-3).
2. Click the Scissors tool over the block at the place where you want to separate it.

n The block can be cut by single measure units.
n The Scissors tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the tool pop-up menu
(→P. III-12).

Connecting Blocks (Glue Tool Function)
Using the Glue tool, you can connect two blocks lined up on the same track, and make them into a
single block.

1. Select the Glue tool from the Toolbar (→P. II-3).
2. First click with the Glue tool on the block that is the farthest forward of the two blocks you want to
connect.

3. Click on the second of the two blocks with the Glue tool.The two blocks will be connected and
become a single block.

n The two blocks will be connected whether they are overlapping or are exactly next to each other. If the two blocks are
overlapping when you click with the glue tool, they will merge to become one block. If there is empty space between the
blocks, empty measures will automatically be added in the empty space when they are connected. If there is another block
between the two blocks to be connected, the space between the connected blocks will be filled with empty measures and
nothing will happen to the other block (it will be skipped).The skipped block will lie under the newly connected block.
When you want to connect three or more blocks existing in the same track, click with the glue tool on the edge block on
one side, then click with the glue tool on the edge block on the other side while simultaneously pressing the <Shift> key.
You can also drag the glue tool so that it encloses all the blocks you wish to connect.
n The Glue tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the tool pop-up menu
(→P. III-12).
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Editing with the Edit Commands
You can move or copy a block to another place within the same track by using the [Cut], [Copy] and
[Paste] commands in the [Edit] menu on the Menu Bar.

1. Select the block you want to move or copy.
2. If you want to move the block, choose the [Cut] command from the [Edit] menu. If you want to
copy the block, choose the [Copy] command from the [Edit] menu.

When you choose [Cut], the block you selected will be erased from the Block Section and temporarily
copied to the clipboard.When you select the [Copy] command, the selected block will remain in the
same place and its contents will be copied on to the clipboard.
n Pushing the <X> or <C> key on the keyboard while holding down the <Ctrl> key will also cut or copy the block.

3. Click in an empty area of the Block Section (black background) and move the Paste Line (white
vertical line) to the location (measure unit) where you want to move or copy the block.

n Clicking in alignment with the grid (short vertical lines) in the Block Section lets you align the Paste Line exactly with start of
the measure.

4. Select the [Paste] command from the [Edit] menu or push the <V> key while holding down the

<Ctrl> key.The block on the clipboard will be pasted in the same track aligned with the position of
the Paste line.

Paste Line
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About the Master Track Window
If you double-click on the Master Track section, the Master Track Window will be displayed.You can set the
tempo, time signature, etc. for the song in this window, which displays data in a list format. For details, see page
VIII-1.

Master Track Pop-up Menu
If you click the right button of the mouse over the Master Track, a pop-up menu for the Master Track will be
displayed.

Open ....................................Open the Master Track Window (→P.VIII-1).
Copy ....................................Copy the entire Master Track to the clipboard.
Paste ....................................Paste the entire Master Track from the clipboard.
Initialize ..............................Remove the entire Master Track data except the tempo and time signature settings
recordedat the beginning of the song.
Add Marker ........................Displays the Add Marker dialog box, and inserts a new marker.
Marker Name......................If markers have already been inserted, the marker names are displayed here.When
you click on the name of a marker, the song position moves to the marker location.
Marker List..........................The marker list is displayed, and you can change the names and positions of already
inserted markers, or delete them.
n For details about the marker function, see page III-23.

Loop Function
The Loop function lets you decide a starting location and ending location in the song and repeat
playback of the area as many times as you want. It’s really handy when you are recording things like
rhythm patterns. Playback will repeat between the location of the “S” mark and the location of the “E”
mark on the Master Track.

Specifying the Loop Range
Drag the “S” mark on the Master Track window to the location where you want the loop range to begin
and drag the “E” mark to the location where you want it to end.The “S” and “E” marks will line up along
the measure unit grid, and the loop range will be set.

n When the loop range isn’t specified, the “E” mark will be on top of the “S” mark and you won’t be able to see the “S” mark.
n You can’t place the “S” mark after the “E” mark or put the “E” mark before the “S” mark.
n You can also set the loop range using [Record/Playback Settings] on the [Setup] menu (→P. XI-17).
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Loop Playback Operation

1. Define the range of the loop using the “S” and “E” marks (see above).
2. Click on the Loop button on the Play Control (→P. II-4), and turn on the loop function (the button
changes to green).

3. With the Song Position Pointer inside the loop range, click on the Play button, and loop playback will
begin.

n If you begin playback with the Song Position Pointer positioned before the loop range, the song will play normally until the
loop range is reached.After reaching the selected range, the loop will begin to play repeatedly. If playback is begun with the
Song Position Pointer positioned after the loop, repeat playback won’t happen.
n You can change the loop range anytime during playback by moving the “S” and “E” marks.

About Loop Recording
You can also use the loop function during recording. If there is already data in the loop, you can add to
record new data while listening to the previously recorded data. It’s especially handy when you are doing
things like adding sounds to drum patterns.

Marker Function
The Marker function places a marker at any desired location in the song. Because this function allows
you to immediately move the song position to the marker location, it’s really useful for inserting a marker
at the place where you want to do realtime recording over and over again until you are satisfied, or to
separate the parts of the song (such as where the bridge begins or the key changes).

Inserting a Marker

1. Click the right mouse button over the Master Track, and select [Add Marker] from the pop-up menu

that will be displayed.You can also select the [Add Marker] command from the [Edit] menu.The Add
Marker dialog box will be displayed.

2. Enter the location to insert the marker, using the spin box, and type the name of the marker from
the computer keyboard.

3. Click the [Add] button.
Editing Markers (Changing Name or Position, Deleting)

1. Click the right mouse button over the Master Track, and select [Marker List] from the pop-up menu
that will be displayed.You can also select the [Marker List] command from the [Edit] menu.The
Marker List dialog box will be displayed.

2. Click on the marker you wish to edit and select it.
3. To change the position or name of the marker, click [Change].The Change Marker dialog box will be
displayed. Enter the new position or name and click [Change].To delete the marker, click [Delete].
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n The position of a marker can also be changed by dragging it horizontally on the Master Track.

Moving to a Marker
Click the right mouse button over the Master Track, and select the name of the marker you want to move
to.You can also select the marker you want to move to from the Marker List, and then click [Move].
n You can also move to a marker by double clicking directly on that marker on the Master Track.

About the Default Window
You can open a window such as the Piano Roll Window or List Window for any block just by double-clicking on
it, then easily change over to doing detailed editing of individual notes or MIDI events.The window that opens
when you do this is called the default window, and it can be chosen from among the List Window, Piano Roll
Window, Staff Window, or Drum Window, according to which most suits your purpose.To set the default window,
put a dot next to its name on the [Default Window] display of the [Setup] menu.
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Operations on the Style/Chord Track
Using the style/chord track, you can easily enter auto accompaniment data.
In the Style Track, you can enter auto accompaniment styles (rhythm types like 8 beat or 16 beat) and
their sections (Intro, Main, Fill In, Ending) as style blocks.
In the Chord Track, you can enter chord progressions.The style track accompaniment will automatically
playback following the chord changes.
n If you use the Auto Arranger plug-in, you can automatically detect the chord progression for a MIDI track melody by simply
entering the song type and accompaniment style.This feature makes it easy to create style and chord tracks.

Style/Chord Track

n You can switch between displaying and not displaying the style/chord track by clicking on the Style/Chord Track button in
the Application Window toolbar.

A single style is made up of a maximum of eight parts on channels 9 to 16 (→P. III-26). Once the style
blocks have been arranged on the style track, they can be expanded to regular MIDI tracks on channels 9
to 16, and each part can be edited (→P. III-32).

Operations in the Style Parameter Section
Parameter settings for styles are made in the Style Parameter Section.
The track that has a [C] displayed is the Chord track, while the track that has an [S] is the Style track.
In the Style track, you can select the output port, set the style name, turn the Solo and Mute functions
ON and OFF, and make transpose settings.The operations are the same as for the track parameter section
for tracks 1 to 100. Refer to item numbers 2, 5, 6, 7, and 8 on page III-3 to 5 for details.There are no
special parameter settings that can be made for the Chord Track.
Pop-up Menu for the Style/Chord Track
If you click the right mouse button on the track number [C] or [S], a pop-up menu for each track will be
displayed. By selecting commands from this menu, you can execute various functions.

Copy ........................................On the chord track copy all chords, and on the style track copy all style blocks, to the
clipboard.
Paste ........................................Paste all data (styles or chords) currently copied onto the clipboard to the end of their
respective tracks.
Delete ......................................Delete all chords on the chord track, or all style blocks on the style track.
Select All..................................Select all chords on the chord track, or all style blocks on the style track.
Properties ..............................Open a properties dialog showing information about the style track.This is displayed
only on the pop-up menu for the style track.
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Style Track Properties Dialog

Ch9 ......................................Rhythm1
Ch10 ....................................Rhythm2
Ch11 ....................................Bass
Ch12 ....................................Rhythmic Chord1
Ch13 ....................................Rhythmic Chord2
Ch14 ....................................Pad Chord
Ch15 ....................................Phrase1
Ch16 ....................................Phrase2
The Style Track Property dialog shows the style track parameter contents for each part that makes up the style.
Settings for Port and Transpose, and the OFF/ON status of the Solo and Mute functions are displayed separately
for each part from Ch9 (Rhythm1) through Ch16 (Phrase2).They are not displayed in the Style Parameter
Section.
Each parameter can be changed by clicking with the mouse, or by entering information from the computer
keyboard.When you click [OK], the properties dialog will close and all the changes you have made will be
reflected in the Style Parameter Section. If you decide not to change the parameters, click on [Cancel], and the
dialog will close, leaving the parameters as they were.
Name ....................................Sets the Style Track Name.
Port ......................................Sets the output port for each part (→P. III-3).
Ch ........................................Displays the MIDI channel for each part (→P. III-3).
Trans ....................................Makes the Transpose settings for each part (→P. III-5).
Solo ......................................Sets Solo playback ON or OFF for each part. Checking the box turns ON Solo
playback for that part.
Mute ....................................Sets Mute ON or OFF for each part. Checking the box turns ON the Mute function
for that part. Multiple parts can have Mute ON at the same time.
Setup ....................................Turns Setup ON or OFF. If turned ON, setup data (system exclusive messages with
settings such as style effects or drum setups) that has been entered into style blocks
will be sent to the connected MIDI tone generator. Each time the style is changed,
appropriate setup data for the new style will be sent to the tone generator.
Depending on the amount of data, there may be a delay before the new style begins
to play.When this happens, by selecting the OFF radio button for Setup you can
reduce the amount of data sent to the tone generator, and cut down the delay in
playing.
Style Tempo SW ................Turns the Style Tempo Switch ON or OFF.When turned ON, the particular tempo
for each style that has been entered into the style track will be made valid, and that
tempo will be used during song playback.When you want the style track to play at
the tempo of the song, set this Style Tempo SW to OFF.
n In order to make valid the particular tempo for each style that has been entered into the style track, the Tempo Switch in
the Create Style Block dialog must also be set to ON (→P. III-28).
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Operations in the Style Block Section
In the style track, various styles (accompaniment patterns) from the intro to the ending can be entered
in order, making it easy for you to create the accompaniment for an entire song.The styles you enter are
displayed on the Style Track as style blocks (colored rectangles). Furthermore, by entering the chords that
match the song into the Chord Track, you can add chord changes to the style accompaniment. Because
the style blocks and chord you enter can be moved and copied, you can easily change the structure of
the style and chord tracks to suit your song.
Entering Styles (Creating Style Blocks)

1. Select [Create Style Block] from the [Edit] menu.The Create Style Block dialog will be displayed.
2. Select the category (music genre) for the style you want to create by clicking on the appropriate
category tab.Then select the style file and section you want.

n Specify the style of accompaniment in the file list and the pattern within the song structure (such as Intro or fill In) in the
section list. For details, see below.

3. Using the Start Point/End Point display, specify the position where you want the selected style to be
inserted.After selecting the other necessary parameters, click on the [Create] button and the Create
Style Block dialog will close.The style you selected will be entered, and displayed on the Style Track
as a style block.
To cancel the operation before finishing it, click on [Cancel].The dialog will close and no style will
be inserted.

n Before entering the data, you can click [Audition] and listen to the selected style and section.
n The section name is displayed on the style block.This is handy because it helps you to easily distinguish the structure of the
song.Also, by using the [Style Block Color Setup] command in the [Setup] menu you can set different colors for different
sections of the song (→P. XI-20).

Create Style Block Dialog

Category tab........................Select the style category (music genre).When you choose a category, the style file
names that are in that category will be displayed in the file list.
Scroll buttons ....................Scroll through the categories horizontally.You can use these buttons to display
categories that cannot be seen.
File List ................................Displays the file names in the currently selected category. Select the style file you
want to enter by clicking on it.
Section List..........................Select the desired section by clicking on it. Section refers to the classification of the
patterns provided for each style.The following 10 types of section are available:
■Main A ................................The most orthodox, fundamental pattern.
■Fill In AA ............................Meant to be a fill in for the Main A pattern.
■Fill In AB ............................Meant to be a fill in for shifting from the Main A pattern to the Main B.
■Intro A ................................Specially meant to be an intro for shifting into the Main A pattern.
■Ending A ............................Specially meant to be an ending for shifting out of the Main A pattern.
■Main B ................................A variation pattern meant to be used in parts of the song, such as the bridge, where
the sound gets livelier.
■Fill In BA ............................Meant to be a fill in for shifting from the Main B pattern to the Main A.
■Fill In BB ............................Meant to be a fill in for the Main B pattern.
■Intro B ................................Specially meant to be an intro for shifting into the Main B pattern.
■Ending B ............................Specially meant to be an ending for shifting out of the Main B pattern.
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n The number displayed in parentheses to the right of each section name in the section list indicates the number of
measures in that pattern.The number of measures varies depending on the style selected in the file list.

Style Name ..........................Displays the name of the currently selected style file.
Time Signature ..................Displays the time signature of the currently selected style file.
Tempo..................................Displays the tempo of the currently selected style file.
Tempo Switch ....................When turned ON, the particular tempo for the style selected here will be made
valid, and that tempo will be used during song playback.When you want the style
track to play at the tempo of the song, set this Tempo Switch to OFF.
n In order to make valid the particular tempo for each style that has been entered into the style track, the Style Tempo SW
in the Style Track Properties dialog must also be set to ON (→P. III-26).
n Style blocks created here with the Tempo Switch set to ON will display a “T” mark.

Start Point ..........................Set the insert starting position by measure, beat and clock units.
End Point ............................Set the insert end position by measure, beat and clock units.
Audition ..............................Click this button and you can listen to the currently selected style and section.
Create ..................................Click this button and the dialog will close, and the selected style and section will be
entered.
Cancel ..................................Click this button to close the dialog and quit the task of entering a style and
section.

Inserting Chords

1. Select [Insert Chord] from the [Edit] menu.The Insert Chord dialog will be displayed.
n You can also open the Insert Chord dialog by clicking the chord track with the pencil tool.

2. Specify the root and type for the chord to be inserted. If you also need to make an On Bass

specification, click the Bass tab, switching over to the Bass page.There you can specify the bass note
and chord.

3. On the location display, specify the insertion position for the chord you selected.
4. When you click on the [Insert] button, the Insert Chord dialog will close, and the chord will be
inserted.The name of the chord will be displayed on the chord track.

To cancel the insertion before finishing it, click on [Cancel] and the dialog will close and no chord
will be inserted.

Insert Chord Dialog

Root/Bass Tabs ..................Switches between the root page and the bass page. On the Root page, you can
specify the basic chord, and on the Bass page, you can specify the On Bass note and
Chord.

Root Page

Root......................................In the column on the left, you can specify the root of the chord (C to B), and on the
right, you can specify the existence of sharps and flats when necessary. For
example, If C is checked in the left column, and # is checked on the right, the root
will become C#. If there is no need for sharps or flats, check natural.
Type......................................Specify the chord type.There are 35 types available.
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Bass Page

Bass Note ............................When you are using On Bass chords, select the bass note (C to B) in the left
column, and when necessary, specify the existence of sharps and flats in the right
column.When no bass note are to be used, select None.
Bass chord ..........................When any Bass Note besides None is selected, this is the place where you can select
the chords that make up the bass line.The bass accompaniment for the style will be
done based on the Bass Note and the Bass Chord specified here.When the bass
accompaniment is to be done only using the note specified in Bass Note, select
None here.
Location ..............................Set the insert starting position for the selected chord by measure, beat and clock
units.
Chord Name Display ........Displays the currently selected Root/Type and Bass Note/Chord.
Insert....................................Click this button and the dialog will close and the selected chord will be entered.
Cancel ..................................Click this button to close the dialog and quit the insertion of a chord.

Style Block/Chord Editing
Tool Pop-up Menu
If you click the right mouse button over the Style Block Section, the Tool pop-up menu will be displayed.
You can choose whichever tool you need from this menu. Each tool has a different function, and you can
use them to edit the style blocks and chords in many different ways.To learn how to use each tool, see
the following explanation of each editing operation.
n All of the tools here—arrow, pencil, eraser, scissors, and glue—can be selected from the Toolbar in the Application Window.

Arrow ......................................Select the Arrow tool.
Pencil ......................................Select the Pencil tool.
Eraser ......................................Select the Eraser tool.
Scissors....................................Select the Scissors tool.
Glue..........................................Select the Glue tool.
Paste ........................................Paste the style block/chord copied to the clipboard, aligned with the paste line.To
display the paste line, click the mouse with the pointer on any empty region (area
with no style block or chord displayed) in the Style Block Section.

Paste Line

Properties ..............................Open the properties dialog that displays information about the style track.This menu
appears only when you click on the style track.This brings the same properties dialog
that appears when you right-click on the “S” track number and then select properties
from the displayed pop-up menu, as mentioned above. For details, see page III-26.
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Style Block/Chord Selection
Before you can edit a style block/chord, you first have to select the one you are going to work on.There
are several ways to select style blocks/chords, from selecting them individually to selecting multiple style
blocks/chords at once, with each method being suited to different purposes.
Individual Style Block/Chord Selection
When you want to select one of the style blocks/chords individually, just click on it.The style
block/chord you have selected will turn red.

Multiple Style Block/Chord Selection (A)
To select multiple style blocks/chords, click on each of them while holding down the <Ctrl> key.

n If you click on an already selected style block/chord while holding down the <Ctrl> key, selection of that block/chord will be
canceled.
n You can select multiple style blocks/chords by clicking on them while holding down the <Shift> key.When this is done, all
the blocks/chords between the two you clicked on will be selected simultaneously.
n A mixture of style blocks and chords cannot be selected at the same time.

Multiple Style Block/Chord Selection (B)
Pressing the left mouse button on an empty region of the Style Block Section (area in which no style
blocks/chords are displayed) and then dragging the mouse pointer specifies a particular region of the
Style Block Section. If you include the style blocks/chords you want to select within the four corners of
that area, then release your finger from the mouse, those blocks/chords will be selected in
simultaneously.
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Multiple Style Block/Chord Selection (C)
When you want to select all the style blocks in the Style Track, double click on the “S” track number.Also,
when you want to select all the chords in the Chord Track, double click on the “C” track number.
Selecting Style Blocks

Selecting Chords

Multiple Style Block/Chord Selection (D)
After selecting any of the Style Blocks/Chords, execute the [Select All] command in the [Edit] menu or
push the <A> key while holding down the <Ctrl> key.This selects every style block/chord in the style
block section simultaneously.
n If you want to cancel selection of every style block/chord, click in any empty area (area in which no style blocks/chords are
displayed) of the Style Block Section.

Moving Style Blocks/Chords
By dragging selected style blocks/chords with the mouse, you can move them anywhere you want.
You can move style blocks by single measure units and chords by single beat units.When you move the
selected item, it automatically aligns with the grid on the style block section and you can be sure of
aligning it exactly with the start of the measure or beat.
n Chords can be moved by beat unit, but the job is a lot easier if you use the horizontal zoom-in button on the toolbar to
expand the style block section.This shows the grid in more detail, making the beat units more easy to see.

If you select multiple style blocks/chords you can move them all together.
Moving a style block

Moving a chord
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Chord Pop-Up Menu
If you click the right mouse button on a selected chord, a pop-up menu related to that chord will be
displayed.You can execute various functions by selecting commands on that menu.

Copy ........................................Copy the currently selected chord onto the clipboard.After copying, use the [Paste]
function from the pop-up menu on page III-29 or from the [Edit] menu as described
on page III-39.
Delete ......................................Delete the currently selected chord.
Properties ..............................Open a properties dialog with information about the currently selected chord.
n Keep in mind that this pop-up menu is different from the one that opens when you click the right mouse button anywhere in
the Style Block Section.

Chord Event Properties Dialog

In the Properties dialog, information is displayed for the chord you selected.You can change settings for the
chord by clicking with the mouse or typing in the new information.When you click [OK], the Properties Dialog
will close and the changes you made will be applied to the selected chord. Clicking on [Apply] will cause the
settings to be immediately applied without closing the Properties dialog. If you want to cancel your changes,
click on [Cancel] and the Properties dialog will close, and the chord’s settings will remain unchanged.The
contents of the dialog box are the same as for the previously explained Insert Chord dialog (→P. III-28). Refer to
that section for details.

Style Block Pop-up Menu
If you click the right mouse button on a selected style block, a pop-up menu related to that block will be
displayed.You can execute various functions by selecting commands on that menu.

Copy ........................................Copy the currently selected block onto the clipboard.After copying, use the [Paste]
function from the pop-up menu on page III-29 or from the [Edit] menu as described
on page III-39.
Delete ......................................Delete the currently selected style block.
Expand to MIDI Track ............Expand contents of the currently selected style block into MIDI tracks (channels 9 to
16). By doing this you can separately edit each of the parts making up the style.The
expanded contents and track number will differ depending on the style block you
have selected.
Replace Style ..........................Placing the mouse pointer on this menu item will cause a sub-menu to be displayed to
the right.
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By selecting a section name from the submenu, you can replace the current section. By choosing [Select
Style], you can open the Change Style dialog.

In the Change Style dialog, you can specify a different style, then by clicking the [Change] button, you
can replace the current style with the new style you have selected.The contents of this dialog are the
same as the Create Style Block dialog (→P. III-27). See that page for details.
Properties ..............................Open a properties dialog with information about the currently selected Style Block.
n Keep in mind that this pop-up menu is different from the one that opens when you click the right mouse button anywhere in
the Style Block Section.
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Style Block Properties Dialog

Track ....................................Shows that the currently selected style block is entered in the Style Track.
Style File ..............................Shows the style file name for the currently selected style block.
Style......................................Show the style name of the currently selected style block.
Section ................................Shows the currently selected section.
Time ....................................Shows the time signature for the currently selected style block.
Measure ..............................Shows the number of measures for the currently selected style block.
Style Tempo ........................Shows the tempo for the currently selected style block.
Style Tempo SW ................Specifies ON/OFF for the style tempo switch.When turned ON, the particular
tempo for the style selected here will be made valid, and that tempo will be used
during song playback.When you want the style track to play at the tempo of the
song, set this Style Tempo SW to OFF.
n In order to make valid the particular tempo for each style that has been entered into the style track, the Style Tempo SW
in the Style Track Properties dialog must also be set to ON (→P. III-26).
n Style blocks created here with the Style Tempo SW set to ON will display a “T” mark.

Start Point ..........................Displays/sets the starting position of the currently selected style block.
End Point ............................Displays/sets the end position of the currently selected style block.
Mute ....................................Sets Mute ON or OFF for each part of the selected style. Checking the box turns
ON the Mute function for that part.
The Style Block Properties dialog displays information about the selected style block.You can change settings for
the block’s starting and ending locations or turn Mute ON/OFF by clicking with the mouse or typing in the new
information.When you click [OK], the Properties Dialog will close and the changes you made will be applied to
the selected style block. Clicking on [Apply] will cause the settings to be immediately applied without closing
the Properties dialog. If you want to cancel your changes, click on [Cancel] and the Properties dialog will close,
and the style block’s settings will remain in their original state.
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Deleting Style Blocks/Chords
You can delete style blocks/chords by following these steps:
Delete Method (A)

1. First select the style block/chord you want to delete.
2. Press the <Delete> key on the computer keyboard.
Delete Method (B)

1. First select the style block/chord you want to delete.
2. Select the [Delete] command from the [Edit] menu.

Delete Method (C)

1. First select the style block/chord you want to delete.
2. Click the right mouse button over the selected style block/chord.
3. Select the [Delete] command from the pop-up menu.
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Erase Method (Eraser Tool Function)

1. Select the Eraser tool from the Toolbar (→P. II-3).
2. Click on the style block/chord you want to delete.

n The Eraser tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the Tool Pop-up Menu
(→P. III-29).

Creating a Style Block (Pencil Tool Function 1)
You can easily use the Pencil tool to create a Style Block.

1. Select the Pencil tool from the Toolbar (→P. II-2).
2. Click the left mouse button in an empty area of the Style Track (area where there are no style

blocks), at the position where you want to create a new style block.The Style Selection pop-up menu
will be displayed.

3. If you choose [Select Style] from the style menu, the Create Style Block dialog will open. From this

dialog, you can specify the style and section for the new style block you want to create.The contents
of this dialog are the same as the Create Style Block dialog (→P. III-27). See that page for details.
When you only want to change the section for a style block you have already entered, without
changing the style, choose the desired section name from the pop-up menu.You can create a style
block with a new section for the already entered style.
You can specify the entry range of the style block in the Create Style Block dialog. However, when
opening the pop-up menu, you can also automatically specify the starting and ending positions for
the Create Style Block dialog by dragging the mouse in the Style Block Section. Use the grid
displayed there (vertical dashed line for each measure) as a guideline.

n The Pencil tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the Tool Pop-up Menu
(→P. III-29).
n You can also create a new style block by using the [Create Style Block] command on the [Edit] menu (→P. XI-9).

III-36

XGw3/E3.QX

2/1/99

4:47 PM

Page 37

Entering Chords (Pencil Tool Function 2)
Using the Pencil tool, you can easily enter new chords.

1. Select the Pencil tool from the Toolbar (→P. II-2).
2. Click the left mouse button in an empty area of the Chord Track (area where there are no chords

entered), at the position where you want to enter a chord.The Insert Chord dialog will be displayed.

3. You can enter the new chord by specifying the root and on bass.The contents of this dialog are the
same as the Insert Chord Dialog (→P. III-28). See that page for details.

You can specify the entry position of the chord in the Insert Chord dialog. However, when opening
the dialog, you can also easily specify the chord entry position by clicking the mouse in the chord
track. Use the grid displayed there (vertical dashed lines) as a guideline. It’s especially handy to
expand the Style Block Section horizontally using the Horizontal Zoom-In button on the toolbar.
Because the grid will be displayed in beat units, inserting chords will be a lot easier.
n The Pencil tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the Tool Pop-up Menu
(→P. III-29).
n You can also insert a new chord by using the [Insert Chord] command on the [Edit] menu (→P. XI-9).

Changing Style Block Length (Pencil Tool Function 3)
Using the Pencil tool, you can easily change the length of blocks as though you were using graphics
software.

1. Select the Pencil tool from the Toolbar (→P. II-2).
2. Click on the style block you want to extend with the Pencil tool, and drag it towards the right.The

style block will extend from its final position.Also, by dragging towards the left, you can shorten the
style block from its final position.

n The Pencil tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the Tool Pop-up Menu
(→P. III-29).
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Separating Style Blocks (Scissors Tool Function)
You can separate a style block into two separate independent style blocks using the Scissors tool.

1. Select the Scissors tool from the Toolbar (→P. II-3).
2. Click the Scissors tool over the style block at the place where you want to separate it.

n The style block can be cut by single measure units.
n The Scissors tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the Tool Pop-up Menu
(→P. III-29).

Connecting Style Blocks (Glue Tool Function)
Using the Glue tool, you can connect two style blocks, and make them into a single style block.

1. Select the Glue tool from the Toolbar (→P. II-3).
2. First click with the Glue tool on the block that is the farthest forward of the two blocks you want to
connect.

3. With the Glue tool, click on the last of the two style blocks.The two style blocks will be connected
and become a single block.

n If there is blank space between the two style blocks to be connected, the measures in the blank space will be automatically
included in the connected style block, with the same style and section added.
n If two style blocks with different styles/sections are to be connected, they will be unified to contain the style and section of
the first block.
n If connecting blocks will result in a separate block being underneath another block, the connected style blocks will not play
correctly. Be careful not to overlap blocks when using the glue tool.
n The Glue tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the Tool Pop-up Menu
(→P. III-29).
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Editing with the Edit Commands
You can move or copy a style block/chord to another place by using the [Cut], [Copy] and [Paste]
commands in the [Edit] menu on the Menu Bar.

1. Select the style block/chord you want to move or copy.
2. If you want to move the style block/chord, choose the [Cut] command from the [Edit] menu. If you
want to copy the style block/chord, choose the [Copy] command from the [Edit] menu.

When you choose [Cut], the style block/chord you selected will be erased from the Style/Chord Track
and temporarily copied to the clipboard.When you select the [Copy] command, the selected style
block/chord will remain in the same place and its contents will be copied on to the clipboard.
n Pressing the <X> or <C> key on the keyboard while holding down the <Ctrl> key will also cut or copy the style
block/chord.

3. Click in an empty area of the Style Block Section (where there is no style block/chord) and move the
Paste Line (black vertical line) to the location (measure unit) where you want to move or copy the
style block/chord.

n Clicking in alignment with the grid (short vertical lines) in the Style Block Section lets you align the Paste Line exactly with
start of the measure.

4. Select the [Paste] command from the [Edit] menu or push the <V> key while holding down the

<Ctrl> key.The block on the clipboard will be pasted in the Style Block Section aligned with the
position of the Paste line.

Paste Line
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Piano Roll Window
The Piano Roll Window lets you see all the MIDI notes in any block as a graphical image. It gives you an
ideal interface for doing precise editing of individual MIDI notes.
Title Bar
Toolbar
Location Section
Piano Roll Section
Split Bar
Control Section

Control Section Toolbar
Note Palette

● You can display multiple blocks at the same point in the song simultaneously in the same Piano Roll
Window. However, actual editing can only be done on the block that is selected in the Block Name
display on the Toolbar.
● In the Piano Roll Section, each MIDI note’s pitch, location (position in relation to time) and gate time
(note length) is displayed in a note bar form that’s easy to grasp at a glance. Editing the MIDI notes is
simple. Just use the edit tools to move or copy the note bars, or change their lengths. Simply by
clicking on any note bar, you can audition (listen to) it, a feature that helps you quickly find the MIDI
note you are looking for.You can also enter new MIDI notes anywhere you want.
● You can easily check the pitch of all the MIDI notes by looking at their vertical position in relation to
the keyboard that is on the left edge of the Piano Roll Section.
● The Control Section at the bottom of the Piano Roll Window uses a graphic format that makes it easy
to understand the velocity for each note and the control change data events. Special tools are
provided that let you edit these events just like you were using graphics software. Up to three
different Control Sections can be displayed and used at the same time.
● Various guitar techniques can be simulated using the Pitch Bend Window.A variety of guitar nuances
like choking (bending) can be easily applied using this feature.
n For information about the Menu Bar and Toolbar in the Application Window, see page II-2.
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How to Open the Piano Roll Window
Opening Method (A)

1. In the Track View Window, select the sequence block (MIDI data block) that contains the data you
want to display or edit.

2. Click on the [Window] menu in the Menu Bar of the Application Window, then select [Piano Roll]
from the pull down menu.

n If you select multiple blocks at the same time, you can have them all displayed in a single Piano Roll Window. In this case, you
can only edit one block at a time, but by clicking on Block Name displayed on the Toolbar of the Piano Roll Window, you can
switch to another block and begin work on it.
The name of the block that is the current target for editing operations will be displayed in Block Name.

Opening Method (B)
After selecting the block in the Track View Window, click on Piano Roll Window button on the
Application Window Toolbar. Just as in Opening Method (A), if you select multiple blocks at the same
time, you can have them all displayed in a single Piano Roll Window.

Opening Method (C)
After selecting the block in the Track View Window, click the right button of the mouse and select Piano
Roll from the pop-up menu that is displayed. Just as in Opening Method (A), if you select multiple blocks
at the same time, you can have them all displayed in a single Piano Roll Window.

Opening Method (D)
If you have previously checked Piano Roll as the [Default Window] in the [Setup] menu (→P. XI-20), all
you have to do is double-click on the sequence block (MIDI data block) that you want to display, and that
block will be directly opened in the Piano Roll Window.Also, when you want to open multiple blocks in
a single Piano Roll Window, select any number of blocks while holding down the <Ctrl> key, then
double-click while holding the <Ctrl> key when you are selecting the final block.
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The Name and Function of Every Part
Title Bar
On the Title Bar, there are the application icon and the Minimize, Maximize and Close buttons. For
details, see page XI-1.

Toolbar
On the Toolbar, there are functions related to the Piano Roll Window display.
1

2
" 3

4

5

6 7

’
8

1 Block Name
The name of the block that is currently the target for your edit operations is displayed here.When two or
more blocks are opened at the same time in the Piano Roll Window, you can click on the Block Name
arrow and choose the block you want to edit from the drop-down list that appears.

2 Add Control Section Button
When you click this button, one more Control Section will be added to the display.You can have as many
as three Control Sections displayed at the same time.

3 Delete Control Section Button
When you click this button, it will delete one Control Section.
n When there is only one Control Section displayed, this button will turn gray and won’t function.

4 Free Button
When you click here the grid (recording position) on the Piano Roll Section will be cleared.You will be
able to move the note bars or place them anywhere you want.

5 Grid Buttons
Depending on which of these buttons you click, you can set the grid (recording position) in the Piano
Roll Section for quarter note units, eighth note units or sixteenth note units.When you move or place
note bars, it will happen in alignment with those units.The number of gray vertical grid lines displayed
on the screen will also change to match the grid setting you choose.

6 Dotted Note Button
When you click here the grid on the Piano Roll Section will be set to dotted note units.You can use this
button together with whichever of the grid buttons you want. For example, if you use this dotted note
button together with the eighth note button, the grid will be set to dotted eighth note units.You’ll be
able to move or place note bars, in alignment with dotted eighth note units.

7 Triplet Button
When you click here the grid on the Piano Roll Section will be set to triplet note units.You can use this
button together with whichever of the grid buttons you want. For example, if you use this triplet note
button together with the eighth note button, the grid will be set to eighth note triplet units.You’ll be
able to move or place note bars in alignment with triplet eighth note units.

8 Pitch Bend Button
When you click this button, it opens the Pitch Bend Window.This window helps you easily enter various
guitar techniques. See page IV-30 for details.
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Location Section
The measure numbers and the vertical lines showing individual measures help you to see the location
(position in time) of all the note bars currently displayed in the Piano Roll Section.The Song Position
Pointer, an upside-down triangle, shows you the present position in the song. If you use the Horizontal
Zoom-in button to magnify the Piano Roll Section, the beat numbers will be displayed in addition to the
measure numbers.You can also change the display format to time (Min:Sec:Msec) by using the display
format change function.

Changing the Display Format

1. Click the right mouse button over the Location Section.
2. Choose [Measure No.] or [Time] from the [Display Format] pop-up menu.A check mark will appear next to
the item you’ve chosen.
Location Section

Piano Roll Section
The Piano Roll Section takes the notes from the block or blocks you’ve selected in the Track View
Window and “imagines” them.This means it changes them into note bars–like the holes in a piano
roll–and displays them graphically in the Piano Roll Section.The pitch is displayed by their vertical
position in relation to the keyboard on the left of the screen, and the notes’ location (in time) in the song
is indicated by their horizontal position on the screen. Every measure is marked by a blue vertical line
and you can easily check each note’s location in the song by looking at the measure numbers and grid
lines (gray vertical lines) in the Location Section at the top.This graphical setup makes it easy to edit the
note bars by clicking and dragging, and to use the many commands available to you.
The flashing black box on the screen is the cursor.
4

1

2

3

1 Song Position Pointer/Line
This shows your current position in the song.When you record or play a song, the Song Position Pointer
and Song Position Line automatically move forward along with the song.You can move the Song Position
Pointer/Line wherever you want by clicking anywhere on the Location Section or by using the Play
Control Location Indicator or TOP/FWD/END buttons.This way, you can easily set the location to start
playing or recording your song. For information about the Play Control, see page II-4.

2 Note Bar
You can easily judge the gate time of each note (the time from note-on to note-off), its pitch, and its
location (in time) in the song, because the notes are changed into images called note bars, which look
just like the holes in a real piano roll.The length of the note bar indicates the gate time of each note. By
comparing each note’s vertical position with the keyboard to the left of the Piano Roll Section, you can
know its pitch.A note displayed in a higher position has a higher pitch, while a note in a lower position
has a lower pitch.The horizontal direction on the screen indicates the time base of the song, and each
note’s horizontal position corresponds to its location in the MIDI song.
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About Note Bar Colors and Types
The Piano Roll Section can display the MIDI notes from multiple blocks at the same time.The note bars
displayed in a solid color belong to the block that is currently the target for editing operations. Note bars that are
shown in outline belong to blocks that are not targets for current editing operations. Since only one block can
be edited at any time, even though the data from many blocks can be displayed at once, you can use the Block
Name function on the tool bar to switch to the block you want to work on.
The colors of the note bars in the Piano Roll Section will correspond to the color of their source blocks in the
Track View Window. For example, if a block is set as blue in the Track View Window, the note bars that represent
its data will also display blue in the Piano Roll Section.To learn how to change block colors, see page XI-20.
n When using the Vertical Zoom-Out function, data in blocks that are not the current target for editing may appear as solid
colors (not outline).

3 Scroll Bar
If a part of the Piano Roll Section you need to use is currently hidden beyond the edge of the window,
you can scroll it into view by clicking or dragging the scroll bar.

4 Keyboard
The pitch of every note bar can be determined by comparing its vertical position with the keyboard to
the left of the screen. Each octave on the keyboard is marked with the note name (....C2, C3, C4...).The
key marked C3 is the middle C key found in the center of a normal keyboard.The pitch of each key is
shown by its position on the screen.A key in a higher position has a higher pitch; a key in a lower
position has a lower pitch. Click on a key, and the key’s note will play, allowing you to check its pitch.
Dragging the mouse pointer up or down the keyboard will cause the Piano Roll Section itself to scroll,
bring into view parts of the display that are currently hidden beyond the edge of the window. Doubleclicking on any of the keys will automatically select all the note bars that have the same pitch as that key.

About Note Name and Note Number Display
When you move the mouse above the Piano Roll Section, the note name and note number of the key
corresponding to the pointer’s position will be displayed in center of the Status Bar of the Application Window.

Split Bar
If you place the mouse pointer over the line (Split Bar) that divides the Piano Roll Section from the
Control Section, the pointer will change shape into the split tool.With this tool, you can drag the Split
Bar up and down and change the widths of the two sections.

Split Bar

Split Tool

n You can change the size of any of the windows by placing the mouse pointer on the top, bottom, left, or right border lines of
the window, then dragging the line until the window is as big or small as you like.
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Editing with the Piano Roll Window
Working in the Piano Roll Section
In the Piano Roll Section, each MIDI note’s pitch, location (position in relation to time) and gate time
(note length) is displayed in a note bar form that’s easy to grasp at a glance. Editing the MIDI notes is
simple. Just use the edit tools to move or copy the note bars, or change their lengths. Simply by clicking
on any note bar, you can audition (listen to) it, a feature that helps you quickly find the MIDI note you
are looking for.You can enter the new MIDI notes anywhere you want.
n You can display link blocks in the Piano Roll Window just like normal blocks, however you can’t do any editing on them.
When you want to change the contents of a link block, display the original source block (normal block) for the link block,
and edit it instead.

Tool Pop-up Menu
If you click the right mouse button over the Piano Roll Section, the tool pop-up menu will be displayed.
You can select the tool you need from the menu.

Arrow ......................................Select the Arrow tool.
Pencil ......................................Select the Pencil tool.
Eraser ......................................Select the Eraser tool.
Scissors....................................Select the Scissors tool.
Glue..........................................Select the Glue tool.
Paste ........................................Paste the note bars copied to the clipboard at the paste line (vertical green line).To
display the paste line, click the mouse with the pointer on any empty region (area
with no note bars) in the Piano Roll Section.

Paste Line

Properties ..............................This will open the Block’s Properties dialog for the block that is the target for your
current editing. For information about the contents of the Block’s Properties
dialog,see page III-16.

Note Bar (MIDI Note) Selection
Before you can edit a MIDI note bar, you first have to select the one you are going to work on.There are
several ways to select note bars that you can use according to the job at hand, from selecting single note
bars to selecting multiple note bars at the same time.
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Single Note Bar Selection
When you want to select only one of the note bars, just click on it.The selected note bar will turn red.

n If you move the mouse pointer above the note bar, the Arrow tool will change to one of three shapes: +, ↔, ↕. However, the
shape of the pointer when you click will not effect selection. For information about each of the pointer shapes, see below.
Since the note bar will immediately play its note the instant you click on it, you can audition (listen to) it.

Multiple Note Bar Selection (A)
To select multiple note bars, click on each note bar one by one while holding down the <Ctrl> key.

n If you click an already selected note bar while still holding down the <Ctrl> key, you can cancel selection of that note bar.

Multiple Note Bar Selection (B)
After pressing the mouse button in an empty area of the Piano Roll Section (white and gray background),
drag the mouse while holding the button and specify a range.After including the multiple note bars you
want select within the four corners of that range, release the mouse button and all the note bars in the
range you specified will be selected at one time.

Multiple Note Bar Selection (C)
After pressing the mouse button anywhere on the Location Section, drag the mouse to any other position
and release the button.All the note bars between the grid line where you started dragging the mouse, to
the grid line where you released the mouse button will be selected at one time.

n The fineness of the specified range will vary according to the current grid setting. It’s better to set the grid small if you are
selecting in a location where there are a lot of note bars with short gate times, and better to set the grid large if the location
includes a lot of note bars with long gate times (→P. IV-10).
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Multiple Note Bar Selection (D)
(a) ....If you double-click on the keyboard to the left of the Piano Roll Section, all the note bars with the
same pitch as the key you double-clicked (one horizontal line) can be selected at one time.
(b) ....If you click with the right mouse button on the keyboard and select the [Select All] command that
is displayed, all the note bars with the same pitch as the key can be selected at one time.
(c) ....To select multiple pitches, hold down the <Ctrl> key while double-clicking on the keys for each of
the pitches you want to select.
(d) ....You can also drag the mouse above the keyboard, selecting in one move all the note bars for the
pitches included in the range you dragged over.
(a)

(b)

(c)

(d)

n For each octave on the keyboard, the note name is displayed, showing the pitch of the note. C3 is the middle C key found in
the center of a normal keyboard.You can also check the note name and note number by looking at the Status Bar on the
Application Window. For information about the keyboard, see page IV-5.
n Because the methods mentioned above make it easy to select all the notes for a particular pitch at one time, they can be
really handy. For example, you might want to separate the right hand part and the left hand part of a single piano track into
two different tracks, or you might want to select rhythm instruments one by one from one rhythm track and copy them into
other tracks.

Multiple Note Bar Selection (E)
Select the [Select Note] submenu of [Select All] in the [Edit] menu and all the note bars in the Piano Roll
Section will be selected at one time.
n To cancel selection of all the notes at one time, just click in an empty area of the Piano Roll Section (white and gray
background).

Using the Computer Keyboard to Select
A single notebar can be selected by moving the cursor to its location using the arrow keys (<á>, <â>,
<ß>, <à>) on the computer keyboard. Multiple notebars can be selected by enclosing them in a
rectangular area.To do this, hold down the <Shift> key while using the arrow keys (<á>, <â>, <ß>,
<à>).
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Moving the Note Bars
Moving the Note Bars Vertically (Changing the Pitch)
If you move the mouse pointer near the center of the note bar as in the picture, the Arrow tool will
change into this shape: ↕ . If you drag the note upward or downward in this situation, you can change the
note bar’s pitch by semitone units.The location of the note (position in time) and its gate time (length)
won’t be changed.

n Each time you click the note bar or drag it to a new pitch, it will immediately play the note and you can audition (listen to)
the pitch.
n You can check the note name and note number when moving the note bar, by using the keyboard on the left as a guide or
looking at the display at the center of the Status Bar of the Application Window.They both come in handy.

When multiple note bars are selected, you can move all of them at the same time in one operation by
moving the mouse pointer over any one of them and dragging it.

n Notebars selected at the cursor position can be moved up and down by using the up and down arrow keys (<á>, <â>)
while pressing the <Ctrl> key. If the <Page Up> and <Page Down> keys are used instead of the arrow keys, the notebars will
move up and down by octaves.
n If you use the [Transpose] command from the [Job] menu on the Menu Bar, you can enter a number and move note bars up
or down (change their pitch). For details, see page XI-24.
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Moving the Note Bars Horizontally (Changing the Location)
If you move the mouse pointer on the left side of the note bar, as in the picture, the Arrow tool will
change into this shape: +. If you drag the note left or right in this situation, you can change the note bar’s
location (position in time).The pitch of the note and its gate time (length) won’t be changed.The units
of the movement will be decided by the currently set grid (see below).

n Each time you click the note bar, it will immediately play the note and you can audition (listen to) the pitch.
n You can check the location when moving the note bar by looking at the measure:beat (or Min:Sec:Msec) display in the
Location Section, the right side of the Status Bar of the Application Window, or by using the grid lines in the Piano Roll
Section as a guide.They are all very handy.

When multiple note bars are selected, you can move all of them at the same time in one operation by
moving the mouse pointer over any one of them and dragging it.

n Notebars selected at the cursor position can be moved left and right in grid units by using the left and right arrow keys
(<ß>, <à>) while pressing the <Ctrl> key.
n If you use the [Shift Clock] command from the [Job] menu on the Menu Bar, you can move note bars very precisely using
clock units. For details, see page XI-27.

About the Grid
The “grid” refers to the smallest units by which you can move the note bars when changing their location
(position in time). For example, if you set the grid for eighth note units, you can easily drag the note bars by
eighth note units just by using the eighth note unit grid lines (gray vertical lines) displayed on the Piano Roll
Section as a guide.The same applies to entering new notes.
You can set the grid for quarter note, eighth note or sixteenth note units by clicking on the appropriate button
on the Piano Roll Window Toolbar.You can also set the grid for dotted note units or triplet units by clicking on
the Dotted Note button or the Triplet button.When you are editing, you can change the grid units to the size
that is appropriate for each task. If you click the Free button, the grid will be canceled and you can move the
note bars freely wherever you want.The number of grid lines shown in the Piano Roll Section changes
according to the grid setting.Also, you can use the [Grid] command in the [Setup] menu on the Menu Bar of the
Application Window for special grid unit settings such as whole note or thirty-second note units, or quintuplet
or septuplet units (→P. XI-19).
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Copying Note Bars
If you drag a note bar while holding down the <Ctrl> key on the computer keyboard, you can create a
copy note in another place with the same gate time, while the original note remains in its original
position. If you have selected multiple note bars, as mentioned previously, all of them can be copied at
the same time.

n You can also copy by selecting the [Copy] command on the [Edit] menu or by using the note bar pop-up menu shown
below.

Note Bar Pop-up Menu
If you right-click the mouse over a selected note bar, a pop-up menu relating to that note bar will be
displayed.You can execute any necessary command by selecting it from the menu.

Copy ........................................Copy the currently selected note bar to the clipboard.After copying, paste the
copied note by selecting [Paste] from the tool pop-up menu (→P. IV-6) or from the
[Edit] menu (→P. IV-15).
Delete ......................................Delete the currently selected note bar.
Properties ..............................Display a note properties dialog with information about the currently selected note
bar.
n This pop-up menu is different from the one that appears when you click anywhere else in the Piano Roll Section. Be careful
you have the right one.

Note’s Properties Dialog

Location ..............................Displays the location (starting position) for the currently selected note bar by
Measure/Beat/Clock.
Pitch ....................................Displays the pitch for the currently selected note bar by note name and note
number.
Gate Time ............................Displays the gate time for the currently selected note bar using Beat/Clock units.
Velocity ................................Displays the velocity value for the currently selected note bar.
The properties dialog of a note bar displays information about it.Any of the values can be changed by clicking or
typing from the computer keyboard.When a value has been changed, clicking [OK] will close the properties
dialog and the changed values will immediately be applied to the note bar. If you click [Apply], the changed
values will immediately be applied, but the properties dialog won’t be closed.To cancel the operation before
finishing, click [Cancel] and the properties dialog will close, leaving the settings as they originally were.
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Deleting Note Bars
You can delete note bars you don’t need by following these steps:
Delete Method (A)

1. First select the note bar you want to delete.
2. Press the <Delete> key on the computer keyboard.
Delete Method (B)

1. First select the note bar you want to delete.
2. Select the [Delete] command from the [Edit] menu.

Delete Method (C)

1. First select the note bar you want to delete.
2. Click the right mouse button over the selected note bar.
3. Select the [Delete] command from the pop-up menu.

Delete Method (Eraser Tool Function)

1. Select the Eraser tool from the Application Window Toolbar (→P. II-3).
2. Click on the note bar you want to delete.

n If you select multiple note bars by dragging and then use the Eraser tool to click on one of them, you can delete all of the
selected note bars at one time.
n The Eraser tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the tool pop-up menu
(→P. IV-6).
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Entering Note Bars (Pencil Function)
Using the Pencil tool, you can easily enter new note bars (MIDI notes).
n When you want to create notes starting from a new block, make a new empty block in the Track View Window beforehand
(→P. III-19), then display it with the Piano Roll Window.

1. Select the Pencil tool from the Toolbar (→P. II-2).
n The Pencil tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the tool pop-up menu
(→P. IV-6).

2. Set the gate time and velocity for the notes you want to enter using the Note Palette.
3. Click on the Piano Roll Section at the place where you want to enter the note.The note will sound

at the same time as you click, and a new note bar will be entered.The location where you can enter
the note will be decided by the currently set grid. For information about the grid, see page IV-10.

When entering the note, if you move the Pencil tool right or left while still holding the mouse button,
you can make the note as long as you want, increasing the gate time.

n A notebar can be entered at the cursor position by pressing the <Enter> or <Insert> keys on the computer keyboard.This
feature is especially useful when you are moving the cursor using the arrow keys (<á>, <â>, <ß>, <à>), and entering the
same notebars one after another.
n You can enter a notebar at the paste line (green vertical line) that is the same pitch as the notebar immediately before the
paste line by simply pressing the <Enter> or <Insert> key while holding down the <Ctrl> key.
n You can decide the location of the note bar by the Measure:Beat (or Min:Sec:Msec) display in the Location Section or by
using the Piano Roll Section grid lines as a guide.The keyboard on the left side can be a guide to help you decide the pitch.
It’s also handy to check the location and pitch values by looking at the Application Window Status Bar.
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Changing the Length of Note Bars (Changing the Gate Time)
If you move the mouse pointer on the right side of the note bar, the Arrow tool will change into this
shape: ↔. If you drag left or right in this situation, you can extend or shorten the length of the note bar.
Since the pitch of the note and the location where it starts playing will remain as they were, only the
gate time of the note bar will be changed.

n The units for changing the gate time will be decided by the currently set grid. For information about the grid, see page IV-10.

Dividing the Note Bars (Scissors Tool Function)
Using the Scissors Tool, you can divide a single note bar into two separate parts.

1. Select the Scissors tool from the Toolbar (→P. II-3).
2. Click the Scissors tool over the note bar at the place where you want to divide it.

n You can accurately know the location for dividing the note bar by using the display at the right of the Status Bar as you are
working. If the grid is set, the location for dividing the note bar will be decided by the grid.
n The Scissors tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the tool pop-up menu
(→P. IV-6).

Connecting Note Bars (Glue Tool Function)
Using the Glue tool, you can connect two note bars lined up at the same pitch, and make them into a
single note bar.

1. Select the Glue tool from the Toolbar (→P. II-3).
2. First click with the Glue tool on one of the note bars you want to connect.
3. Click on another note bar at the same pitch with the Glue tool.The two note bars will be connected
and become a single note bar.
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n The two note bars will be connected whether they are overlapping or are exactly next to each other. If there is empty space
between the note bars, gate time will automatically be added to make up the gap. If there are other note bars between the
two note bars you want to connect, all those other note bars will be skipped. (The skipped note bars will lie under the newly
connected note bar.) If you want to connect three or more note bars of the same pitch all into a single note bar, click on the
farthest note bar on one side with the Glue tool, then while holding the <Shift> key, click with the Glue tool on the note bar
farthest on the other side of the series of note bars.You can also drag the glue tool so that it encloses all the note bars you
wish to connect.
n The Glue tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the tool pop-up menu
(→P. IV-6).
n You can connect the notebar selected at the cursor position to the notebar (of the same pitch) immediately behind or in
front of it by pressing the <V> or <B> key while holding down the <Alt> key.

Editing with the Edit Commands
You can move or copy a note bar to another place within the same pitch by using the [Cut], [Copy] and
[Paste] commands in the [Edit] menu on the Menu Bar.

1. Select the note bar you want to move or copy.
2. If you want to move the note bar, choose the [Cut] command from the [Edit] menu. If you want to
copy the note bar, choose the [Copy] command from the [Edit] menu.

When you choose [Cut], the note bar you selected will be deleted from the Piano Roll Section and
temporarily copied to the clipboard.When you select the [Copy] command, the selected note bar
will remain in the same place and its contents will be copied on to the clipboard.

n Pressing the <X> or <C> key on the keyboard while holding down the <Ctrl> key will also cut or copy the note bar.

3. Click in an empty area of the Piano Roll Section (white background) and move the Paste Line to the
location (grid unit) where you want to move or copy the note bar.

n Clicking in alignment with the grid (vertical lines) in the Piano Roll Section lets you align the Paste Line exactly with the
currently set grid.The paste line can also be moved using the (<ß>, <à>) keys on the computer keyboard.

4. Select the [Paste] command from the [Edit] menu or push the <V> key while holding down the

<Ctrl> key.The note bar on the clipboard will be pasted in the same pitch aligned with the position
of the Paste Line.

Paste Line
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Control Section
Control sections are displayed at the lower part of the Piano Roll, Staff, and Drum Windows.
Besides showing the velocity value for every MIDI note that is displayed in the Piano Roll/Staff/Drum
Section, the Control Section also displays channel messages such as control change data and program
changes.There is also a function for entering and displaying the lyrics to the song. By changing the data
on the graph through clicking and dragging, you can easily change each event data.

1
2

3

1 Control Select Box
This determines the type of MIDI event which is currently selected and displayed in the Control Section
graph. Click the downward arrow for the Control Select box, and select the MIDI event you want to see
displayed on the graph.

2 Control Value Box
This displays the value associated with the currently selected velocity, control change, or other data.The
value can be changed by clicking the up and down scroll buttons or by typing it in directly with the
computer keyboard.

3 Graph Display
Here the values for the currently selected MIDI event are displayed in a graph format, corresponding to
the note positions in the Piano Roll/Staff/Drum Section.The form of the graph varies according whether
velocity, control change data, program change data or lyrics are being displayed.

Control Section Toolbar
The tool buttons you’ll need for editing the graph displayed in the Control Section are arranged on this
Toolbar.
1

2

3

1 Tool Buttons
Click on the appropriate button and you can select the Arrow tool, the Pencil tool, or the Eraser tool.

2 Edit Buttons
When you have selected the Pencil tool, you can click on one of these buttons and set the graph editing
method.There are buttons for Linear edit, Free edit, Parabolic edit and Sine Curve edit.

3 Interval Display
Presets, in clock units, the interval of data to be recorded.
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Working in the Control Section
The Control Section is used for editing operations that center on the velocity for each note and the
control change data events.Any of the data can be displayed in a graphical form corresponding to the
position of each note in the Piano Roll Section, and graphically edited using the provided tools.The
Control Section also allows you to enter program change data (change voices), and to enter the lyrics and
chords of the song.
n The editing method varies according to the type of MIDI event.After explaining common operations for all MIDI events,
further editing methods for each MIDI event (velocity, control change, program change, entering lyrics or chords) will be
explained from page IV-23.

Tool Pop-up Menu
If you click the right mouse button over the Control Section, the tool pop-up menu will be displayed.You
can select the tool you need from the menu.

Arrow ......................................Select the Arrow tool.
Pencil ......................................Select the Pencil tool.
Eraser ......................................Select the Eraser tool.
Paste ........................................Paste the MIDI event copied to the clipboard, at the position in the Control Section
where the right mouse button was clicked.
Delete All ................................Delete all MIDI events displayed in the current Control Section.
Edit Point ................................This is used for showing or hiding the ■ mark (Edit Point) at the top of the graph
display for each MIDI event shown in the Control Section. Editing of each individual
setting value displayed on the graph can be done by clicking and dragging this ■
mark.
Font ........................................Opens the Font dialog.This dialog only opens when the currently displayed MIDI
event type is Lyric or Chord.
n By clicking on the three tool buttons prepared on the Control Section Toolbar, you can select each of the tools:Arrow tool,
Pencil tool, and Eraser tool.

Selecting the MIDI Event Type
In order to edit MIDI events, first you have to select the type of event that will be the target for your
editing, and display it in the Control Section.

1. Click on the Control Select box.A drop-down list will appear.

2. Select the MIDI event you want to display from the list. Using the scroll bar, you can scroll the list to
see items that aren’t displayed.

n The display in the Control Section will differ according to the MIDI event selected.
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MIDI Event Selection
Even though the display method differs for each type of MIDI event, basically the value of the event will
be displayed in a graphic style, as shown below.

n To edit, click the right button of the mouse over the Control Section, select [Edit Point] from the pop-up menu, and then
check [Show].An edit point ■ will be added to the top of each graph.After selecting one or more of them, as explained
below, you can change the event values by dragging the marks with the mouse.

Single MIDI Event Selection
When you only want to select one MIDI event, just click on its ■ mark.The selected MIDI event will turn
red.Also the current value for that MIDI event will be displayed in the Control Value box.

Multiple MIDI Event Selection (A)
To select multiple MIDI events, click on each MIDI event’s ■ mark while holding down the <Ctrl> key.

If you click an already selected MIDI event while still holding down the <Ctrl> key, you can cancel
selection of that MIDI event.
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Multiple MIDI Event Selection (B)
After pressing the mouse button in an empty area of the Control Section (white background), drag the
mouse while holding the button and specify a range.After including the multiple MIDI events you want
select within the four corners of that range, release the mouse button and all the MIDI events in the
range you specified will be selected at one time.

Multiple MIDI Event Selection (C)
Select the [Select Control Section #] submenu of [Select All] in the [Edit] menu and all the MIDI events
in the Control Section will be selected at one time.
n The # symbol represents the number when multiple Control Sections are being displayed. Because you can have up to three
Control Sections displaying at the same time, there are separate commands prepared for each of them, from [Select Control
Section 1] to [Select Control Section 3].The lowest Control Section is [Control Section 1] with the ones above it numbered in
order [Control Section 2] and [Control Section 3].
n When you want to cancel selection of all events at one time, just click on any empty area of the graph display.
n Since both the Control Section and the Piano Roll/Staff/Drum Section are linked to the same time base, whenever you scroll
one of them right or left, both sections scroll together at the same time.You can also use the Location Section and note
display as a reference during editing. Especially, since velocity is a note event, by selecting a note in the Piano Roll/Staff/Drum
Section, you can also select its velocity graph in the Control Section.

Changing the Values of MIDI Events
By dragging the selected MIDI event up or down, the graph of the MIDI event will move and the value
will change. Check the accuracy of the value with the Control Value box.You can change the timing of
control change data such as volume or pan, and pitch bend data by dragging the selected MIDI events
horizontally with the mouse.

n You can change the values of multiple MIDI events all at the same time by selecting multiple MIDI events and dragging them.
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Entering MIDI Events (Pencil Tool Function)
You can enter new MIDI events as though you were using graphics software, just by dragging the Pencil
tool across the screen and drawing a graph with it. Using this feature, you can easily enter things like
crescendos and diminuendos.
n You can enter MIDI events using the pencil tool even in locations where MIDI events are already entered.When you do this,
the setting values of the originally entered MIDI events will be overwritten and changed to the number values newly entered
by dragging with the pencil tool.

1. Select the Pencil tool from the Control Section Toolbar.
2. Set the interval for the data you will enter in the Interval box.You can click on the up and down
scroll buttons, or type directly from the computer keyboard, and set the value in clock units.

3. Click on one of the edit buttons from the Control Section Toolbar to select the graph curve you will
draw. After selecting the curve, you can drag anywhere over the Control Section graph, and enter
new MIDI events following one of the five curve types shown in the pictures below.
Linear Edit

Linear button

Free Edit

Free button

Parabolic Edit (A)

Parabolic (A) button

Parabolic Edit (B)

Parabolic (B) button

Sine Curve Edit

*After dragging the sine curve, you can
change the number of mountains and valleys
in it by clicking the right mouse button while
continuing to hold the left one. Each click of
the right button will switch between two, four,
and eight peaks on the curve.

Sine Curve buton

n The Pencil tool can also be selected from the tool pop-up menu (→P. IV-17).
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Copying MIDI Events
If you drag a selected MIDI event while holding down the <Ctrl> key on the computer keyboard, the
original MIDI event will remain in its original place, while a copy of the event will be made in another
location. If you select multiple MIDI events as mentioned previously, those MIDI events will all be copied
at the same time.

n You can also select the [Copy] command from the pop-up menu explained in the next section.

MIDI Event Pop-up Menu
If you click the right button of the mouse over a selected MIDI event, a pop-up menu for that MIDI event
will appear. By selecting the necessary command from the menu, you can copy or delete.

Copy ........................................Copy the currently selected MIDI event onto the clipboard.After copying, paste the
copied event by selecting [Paste] from the tool pop-up menu (→P. IV-17) or from
the [Edit] menu.
Delete ......................................Delete the currently selected MIDI event.
n This pop-up menu is different from the one that appears when you click anywhere else. Be careful you have the right one.

Deleting MIDI Events
You can delete MIDI events you don’t need by following these steps:
Delete Method (A)

1. First select the MIDI event you want to delete.
2. Press the <Delete> key on the computer keyboard.
Delete Method (B)

1. First select the MIDI event you want to delete.
2. Select the [Delete] command from the [Edit] menu.
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Delete Method (C)

1. First select the MIDI event you want to delete.
2. Click the right mouse button over the selected MIDI event.
3. Select the [Delete] command from the pop-up menu.

Delete Method (Eraser Tool Function)

1. Select the Eraser tool from the Control Section Toolbar.
2. Click on the MIDI event you want to delete.

n If you select multiple MIDI events through dragging and then use the Eraser tool to click on one of them, you can delete all
of the selected MIDI events at one time.
n The Eraser tool can be selected from the tool pop-up menu (→P. IV-17).

Editing with the Control Value Box
When you select any MIDI event, its value will be displayed in the Control Value box.You can change the
value in the box by either typing directly from the computer keyboard or by clicking on the up and
down scroll buttons.

* Select a MIDI event

n If you select multiple MIDI events, you can change their values at the same time by using the Control Value box. If you have
selected multiple graph points, the value of the one located farthest to the left will be displayed in the Control Value box.
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Changing Velocity
The value showing the strength of touch used when playing the keyboard is called velocity. It is
displayed in the form of a bar graph. Since each one corresponds to a MIDI note displayed in the Piano
Roll/Staff/Drum Section, the velocity graph you want to edit can be selected in either section.
Changing the Velocity Value 1

1. Select Velocity in the Control Select box and the velocity graph will be displayed in the Control
Section.

2. By using the Arrow tool to move the ■ mark up and down through dragging, you can change the
velocity value within a range of 1-127.You can also change the value by directly typing into the
Control Value box, or by clicking on the up and down scroll buttons.

n You can change the velocity values for multiple MIDI notes at the same time by selecting multiple velocity graph points.

Changing the Velocity Value 2
Using the Pencil tool, you can edit velocity values as though you were using graphics software.

1. Select the Pencil tool from the Control Section Toolbar or tool pop-up menu (→P. IV-16, 17).
2. Click on one of the edit buttons to set the curve type you will draw (→P. IV-20).
3. Change the MIDI note velocity values by dragging.
Linear graph

Parabolic graph

Changing Gate Time
Although you can change gate times by dragging the note bars (→P. IV-14), the job can also be done by
using the velocity graph in the Control Section.

1. Move the arrow tool to the upper right corner of the velocity graph corresponding to the note

where you want to change the gate time, and click the left mouse button.The velocity graph will be
selected.
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2. While continuing to press the left mouse button, drag the arrow tool horizontally.The gate time will
change, and the corresponding note bar will automatically grow longer or shorter.

Deleting MIDI Notes
By using the Eraser tool or Delete command after clicking on an unneeded velocity graph point, you can
delete the MIDI note itself (→P. IV-22).
n Since the velocity value is note information, if the velocity graph is deleted, the corresponding note will be deleted from the
Piano Roll/Staff/Drum Section.

Editing Control Change Data
Control change data refers to MIDI events like volume control and effects that are used to express a
subtle nuance or dynamic change in the performance. Since the control change data can be continuously
used, a line graph is usually used to display it.
The frequently used control change functions are the following:
Bank Select (Bank MSB/Bank LSB) ..Used for specifying the program bank.
Modulation (Mod) ..............................Used for adjusting the depth of vibrato, etc.
Volume ................................................Used for adjusting the volume.
Pan........................................................Used for adjusting the panning position of the stereo image.
Expression (Exp) ..............................Volume adjustment for performance expression.
Hold (Hold 1)......................................Used for sustaining the sound. Has the same effect as a piano damper pedal.
Reverb (RevSend) ..............................Used for adjusting the depth of the reverb effect of the MIDI tone generator.
Chorus (ChoSend) ............................Used for adjusting the depth of the chorus effect of the MIDI tone
generator.
Variation (VarSend)............................Used for adjusting the depth of the variation effect of the MIDI tone
generator.
n There may be some incompatible items, depending on the MIDI tone generator.

Changing Control Change Data

1. When you select the control change data with the Control Select box, that data will be displayed in
the Control Section as a graph.

2. By using the Arrow tool to drag the ■ mark of any MIDI event up or down, you can change the value
for that MIDI event.You can also change the value by typing directly into the Control Value box. By
dragging the ■ mark right or left, you can change the location (position in time) of the MIDI event.

n You can change the values of multiple MIDI events at the same time by selecting multiple MIDI events.
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Entering Control Change Data
Using the Pencil tool, you can edit just as though you were using graphics software.

1. Select the Pencil tool from the Control Section Toolbar or tool pop-up menu (→P. IV-16, 17).
2. Click on one of the edit buttons to set the curve type you will draw (→P. IV-20).
3. Use the Interval box to set the interval for entering data (→P. IV-16).
4. Enter the new events by dragging.
Linear graph

Parabolic graph

Deleting Control Change Data
By using the Eraser tool or Delete command after clicking on unneeded control change data, you can
delete the data. (→P. IV-22)

Editing Program Change Data
Program change data is information for changing the program (voice).You can add data to the song that
automatically changes the program during the song. Using the Voice List in XGworks, you can easily
choose the voice you want from the huge number of XG voices.
Entering Program Change Data

1. Select Program from the Control Select box. If there already is program change data in the song, that
data will be displayed in the Control Section.

2. Select the Pencil tool from the Control Section Toolbar or tool pop-up menu (→P. IV-16, 17).
3. Click with the Pencil tool at the location in the Control Section where you want to enter program
change data.The Voice List Dialog will be displayed.

4. Choose the voice from the voice list, following the instructions in “Voice Selection with the Voice
List” on page I-11.

5. When you click [OK], the dialog box will close, and the voice you selected will be entered as

program change data at the location you clicked in step 3.The program change data will be displayed
in the Control Section as a box containing the name of the voice you have chosen.
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n The positions where the data can be entered will be determined according to the currently set grid (→P. IV-10).

Moving Program Change Data
You can easily change the location of the program change data (the box with the voice name) by
dragging it.

Changing Program Change Data 1
You can change just the contents (voice) of the program change data without changing its location.

1. Double-click on the program change data (the box with the voice name) and the Voice List Dialog
will be displayed.

2. Using the Voice List Dialog, choose whichever voice you want, following basically the same method
explained previously for voice selection. Click [OK] and the display will change to the newly
selected voice name.

n Refer to the instructions in “Voice Selection with the Voice List” on page I-11.

Changing Program Change Data 2
Using the Control Value box, you can change just the contents (voice) of the program change data
without changing its location.You can select from 128 different GM voices here.

1. Click on the program change data (the box with the voice name) to select it.
2. Click on the up and down scroll buttons for the Control Value box, or type in a program number
from 1 to 128 directly from the computer keyboard.The voice name will change to that of the
number you entered.

n The voices corresponding to program numbers between 1 and 128 are predetermined for GM tone generators.The voices in
bank number 0 in the XG normal voice list for the XG tone generator are the general GM voices. For details, see the owner’s
manual for the XG/GM tone generator you are using.

Deleting Program Change Data
By using the Eraser tool or Delete command after clicking on the unneeded program change data box,
you can delete the data. (→P. IV-22)

Editing Chords
You can enter chords.You can also edit chords already entered in the Chord Track of the Track View
Window by changing or moving them.
Inserting Chords

1. Select Chord from the Control Select box. If there are already chords entered in the song, the chord
names will be displayed in the Control Section.

2. Select the Pencil tool from the Control Section Toolbar (→P. IV-16) or Tool Pop-up Menu (→P. IV-17).
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3. Click with the Pencil tool at the location in the Control Section where you want to enter chords.The
Insert Chord dialog will be displayed.

Specify the root and type for the chord to be inserted.You can also enter On Bass when needed.The
contents of this dialog are the same as the Insert Chord Dialog (→P. III-28). See that page for details.
Moving Chords
By dragging the chord names with the arrow tool, you can move the chords anywhere you want.

Changing Chords

1. Double click with the arrow tool on the chord you want to change.The Insert Chord dialog will be
displayed.

2. Specify the new root, type and On Bass information for the chord you want to change.The contents
of this dialog are the same as the Insert Chord Dialog (→P. III-28). See that page for details.

Deleting Chords
By using the Eraser tool or Delete command after clicking on an unneeded chord, you can delete that
chord.
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Editing Lyrics
You can type in the lyrics for your song and have them displayed.
Entering Lyrics

1. Select Lyric from the Control Select box.
2. Select the Pencil tool from the Control Section Toolbar or Tool Pop-up Menu (→P. IV-16, 17).
3. Click with the Pencil tool at the location in the Control Section where you want to enter lyrics.The
Insert Lyrics dialog will be displayed.

4. Type the letters for the lyrics into the insert field with the computer keyboard.
n To have the lyrics display following the timing for MIDI note-on, enter the letters like this:“Somebody | is | calling | ...” using
“|” to mark off the words, and at the bottom of the Insert Lyrics dialog, click the “Yes” radio button for “Following Note On” so
that a dot appears.

5. If necessary, you can specify the location for the lyrics in Measure/Beat/Clock units using the

Location box. If you don’t change the location, the lyrics will be inserted where you clicked in step
3, and that location will be displayed in the Location box.

6. Check “Yes” or “No” for “Following Note On.” If you check “Yes,” the word(s) will be assigned to each
note.

7. Click [OK] and close the dialog.The letters you entered will be displayed in the Control Section.

To cancel entering the lyrics, click on [Cancel] and the dialog will close without inserting any letters.
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Moving Lyric Data

1. Select the letters you want to move by clicking on them with the Arrow tool.They will turn red.
2. By dragging the selected letters, you can move their display anywhere you want.

Changing Lyric Data

1. Double-click with the arrow tool on the letters you want to change, and the Inset Lyrics dialog will
be displayed.

2. Make the necessary changes in the insert field by typing with the computer keyboard. Click on
[OK].The lyric dialog will close, and the lyrics will reflect the changes you entered.

Deleting Lyric Data
By using the Eraser tool or Delete command after clicking on the unneeded lyric data, you can delete the
letters (→P. IV-22).

Editing with the Edit Commands
You can move or copy some MIDI events to another place by using the [Cut], [Copy] and [Paste]
commands in the [Edit] menu on the Menu Bar.The procedure is the same as that used to edit note bars
with the edit commands. See page IV-15.

Editing other MIDI Events
You also can edit other things like Pitch Bend or Tempo Change using the Control Section.The editing
for each is done in basically the same way as previously mentioned.To find out whether or not the MIDI
tone generator you are using can receive the MIDI event messages set in the Control Section, see the
MIDI data format of the tone generator’s manual.
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Pitch Bend Window
The Pitch Bend Window, which can simulate a wide variety of guitar techniques, has been added as a subwindow. From orthodox techniques like choking (bending) and bottleneck to dynamic techniques like
trill and arming, many different kinds of guitar nuances are now easy to add to your music.
Title Bar
Rate (Vertical)

Pitch Bend
Display

File

Display
Offset
(Horizontal)
Rate
(Horizontal)
Offset (Vertical)

How to Open the Pitch Bend Window
Opening Method (A)
Click on the Pitch Bend button on the toolbar in the Piano Roll or Staff Window.

Opening Method (B)
With the Piano Roll or Staff Window open, Click on the [Edit] Menu in the Application Window menu bar
and select [Insert Pitch Bend] from the pull-down menu.
n Before opening the Pitch Bend Window, select the note that will be the target for the pitch bend.

Title Bar
On the Title Bar, there are the application icon and the Minimize, Maximize and Close buttons. For
details, see page XI-1.
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Pitch Bend Display
The Pitch Bend Display graphically shows the pitch bend to be inserted and the already inserted pitch
bend and note.The horizontal direction shows the change in time, while the vertical direction shows the
change in pitch. From the center of pitch axis (white line), the up direction shows positive bends, while
the down direction shows negative bends. Furthermore, the following colors are also used to convey
information on the display:

Green Graph ..........................Shows the pitch bend to be inserted or processed (specified by one of the
templates provided in the File menu at the right of the Pitch Bend Window).
Gray Graph ............................Shows the already entered pitch bend.
Yellow Bar ..............................Shows the note existing in the currently displayed range.The length of the bar
shows gate time.
Blue Vertical Line ..................Shows the starting position for the change in rate in the horizontal direction.The
position can be shifted by clicking near this line, or by dragging to the right or left.
Red Vertical Line....................Shows the ending position for the change in rate in the horizontal direction.The
position can be shifted by clicking near this line, or by dragging to the right or left.

Display
The display range can be moved to the left or right.This allows you to view time positions that are not
currently displayed.

Offset (Horizontal)
Horizontal offset adjusts the time positions of the pitch bend (green graph) to be inserted. Centering on
the value set in the template (which equals zero), the position shifts forward in time as the slider is
moved to the right, and shifts backwards in time as the slider is moved to the left (negative direction).
The value can also be fine adjusted using the spin box to the right of the slider. If a positive number is
entered, the position will shift forward in time; if a negative number is entered, the position will shift
backward in time.

Offset = -50

Offset = 0
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Rate (Horizontal)
Horizontal rate magnifies the length in time of the inserted pitch bend (green graph). Centering on the
value set in the template (which equals100%), the length in time increases and the change in pitch
becomes slower as the slider is moved to the right, and the length in time decreases and the change in
pitch becomes faster as the slider is moved to the left (negative direction).The value can also be fine
adjusted using the spin box to the right of the slider. If a number greater than 100 % is entered, the
change in pitch will be slower; if a number less than 100% is entered, the change in pitch will be faster.
The magnification in time will be valid on the pitch bend graph within the range defined by the blue
vertical line (start point) and the red vertical line (end point).

Rate = 20

Rate = 100

Rate = 200

Rate (Vertical)
Vertical rate magnifies the amplitude (amount) of the inserted pitch bend (green graph). Centering on
the value set in the template (which equals100%), the magnification increases and the amount of change
in pitch becomes greater as the slider is moved upward, and the magnification decreases and amount of
change in pitch becomes less as the slider is moved downward (negative direction).The value can also
be fine adjusted using the spin box below the slider. If a number greater than 100% is entered, the
amount of change in pitch will be greater; if a number less than 100% is entered, the amount of change
will be less.

Rate = 20

Rate = 100

Rate = 200

Offset (Vertical)
Vertical offset adjusts pitch change value of the pitch bend (green graph) to be inserted. Centering on
the value set in the template (which equals zero), the pitch change value increases in the positive
direction as the slider is moved upward, and it increases in the negative direction as the slider is moved
downward.The value can also be fine adjusted using the spin box below the slider. If a positive number
is entered, the pitch change value will increase in the positive direction; if a negative number is entered,
the value will increase in the negative direction.

Offset = -2500

Offset = 0
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File
Select the template file for the pitch bend you wish to insert. First select one of the techniques in the list
on the left by clicking on it.When the technique is selected, the pitch bend types belonging to that
technique will be displayed. Select one of the types by clicking on it.A graph of the effect of the selected
pitch bend will appear as a green line in the pitch bend display.

Technique

Type

Techniques

Types

Arm (Arming)
BottleD (Bottleneck Down)
BottleU (Bottleneck Up)
Bottle Vib (Bottleneck Vibrato)
ChoD (Choking (Bending) Down)
ChoU (Choking (Bending) Up)
ChoUD (Choking (Bending) Up and Down)
HOn (Hammering On)
POff (Pulling Off)
SlideD (Slide Down)
SlideU (Slide Up)
Tril (Trill)
Vib (Vibrato)

Pitch
W = Whole tone
H = Semitone
Q = Quarter
Length
1 = Whole note length
4 = Quarter note length
8 = Eighth note length
16 = Sixteenth note length
Example: 1WH = 1 whole tone plus a semitone
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Connect
If this button is clicked On before the pitch bend is inserted, the note at the current insert position and
the next note will be connected by the pitch bend, effectively becoming one note.This makes it easy to
create a pitch bend effect where the pitch of the first note changes to the pitch of the next note.
n If three or more notes are displayed within the pitch bend display, clicking this Connect button will cause the display to
show only the two notes that are the target of this effect.

Example: Simulation of choking (bending) in 1 whole tone from G to A, then return to G.

Add
If this button is clicked On before the pitch bend is inserted, the effect of the current pitch bend (green
graph) will be added to the pitch bend already inserted (gray graph). Usually, when the pitch bend is
inserted with this button Off, any pitch bend already existing at the insertion position will be
overwritten and erased.When you want to insert a new pitch bend and have it added to an already
entered one, turn this button On.
Example: Simulation of 2 whole tones choking (bending) effect added to the sound of a G note already
choked (bent) in 1 whole tone.
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Reset
Click on [Reset] to return the pitch bend you will be inserting back to its initial state in the template.
Each offset and rate will return to its original value.

Monitor
Clicking [Monitor] lets you hear the pitch bend effect you will be inserting.

Insert
When you click [Insert], the pitch bend (green graph) you have set will be inserted into the Control
Sections of the Piano Roll and Staff Windows.After insertion, the graph in the Pitch Bend Display will
change color to gray.

Pitch Bend Insertion Procedure

1. In the Piano Roll or Staff Section of the Piano Roll or Staff Window, select the note that will be your
target for pitch bend insertion.

2. Click the Pitch Bend button on the toolbar to open the Pitch Bend Window.
n In the Pitch Bend Window, the note in the currently specified position will be indicated by a yellow bar. In addition, if a pitch
bend is already inserted into the currently displayed range, it will be indicated by a gray graph.

3. Click on one of the techniques displayed in the list on the left side of the File box to select it.
4. The pitch bend types for the technique you selected will be displayed in the list on the right side of
the File box. Select one of the types by clicking on it.A graph of the selected pitch bend will be
displayed in green in the Pitch Bend Display.

n You can adjust the display range of the Pitch Bend Display for easy viewing by moving the Display slider.

5. When necessary, adjust the offsets and rates in the horizontal and vertical directions (see above).
n When adjusting the horizontal rate, specify the adjustment range using the blue (start position) and red (finish position)
vertical lines.

6. When necessary, specify the insert method using the Connect and Add buttons.
7. When required, click the Monitor button to listen to the adjusted pitch bend effect.
8. Click on the Insert button.The adjusted pitch bend (green color) will be inserted.
9. After finishing insertion, click the close button to close the Pitch Bend Window.
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Staff Window
In the Staff Window, you can see the MIDI data from any sequence block displayed in a familiar way—on
a musical staff, like sheet music, where the data can be precisely edited at the MIDI note level.

Title Bar
Toolbar
Location Section

Staff Section

Split Bar
Control Section

Control Section Toolbar
Note Palette

● You can select multiple blocks at the same point in the song, and open a single Staff Window.
However, you can actually edit the notes for only a single block at a time, the one that has had its
name selected in the Block Name display on the Toolbar.
● When the Instrument Type is a Transposing Instrument, the key signature and clef will be
automatically changed, and the staves for that transposing instrument will be displayed.
● In the Staff Section, each MIDI note is displayed as musical notation placed on a standard musical
staff. Editing the MIDI notes is easy, using the edit tools to move or copy the notes. Simply by
clicking on any note, you can audition (listen to) it, a feature that helps you quickly find the MIDI
note you are looking for.You can also enter new MIDI notes anywhere you want.
● If you have a printer connected, you can print out the sheet music anytime you want.You can print
out several different types of staves (such as tablature staves and drum staves).
n For information about printing the music, see page V-14.

● The Control Section at the bottom of the Staff Window uses a graphic format that makes it easy to
understand the velocity for each note and the control change data events. Special tools are provided
that let you edit these events just like you were using graphics software. Up to three different
Control Sections can be displayed and used at the same time.
● Various guitar techniques can be simulated using the Pitch Bend Window.A variety of guitar nuances
like choking (bending) can be easily applied using this feature.
n For information about the Menu Bar and Toolbar on the Application Window, see page II-2.
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How to Open the Staff Window
Opening Method (A)

1. In the Track View Window, select the sequence block (MIDI data block) that has the data you want to
display or edit.

2. Click on the [Window] menu in the Menu Bar of the Application Window, then select [Staff] from the
pull down menu.

n You can also select multiple blocks at the same time, and then open a single Staff Window. In this case, you can only edit one
block at a time, but by clicking on Block Name from the Toolbar of the Staff Window, you can switch to another block and
begin work on it.
The name of the block that is the current target for editing operations will be displayed in Block Name.

Opening Method (B)
After selecting the block in the Track View Window, click on the Staff Window button on the Application
Window Toolbar. Just as in Opening Method (A), if you select multiple blocks at the same time, you can
have them all displayed in a single Staff Window.

Opening Method (C)
After selecting the block in the Track View Window, click the right button of the mouse and select Staff
from the pop-up menu that is displayed. Just as in Opening Method (A), if you select multiple blocks at
the same time, you can have them all displayed in a single Staff Window.

Opening Method (D)
If you have previously checked Staff as the [Default Window] in the [Setup] menu (→P. XI-20), all you
have to do is double-click on the sequence block (MIDI data block) that you want to display, and that
block will be directly opened in the Staff Window.Also, when you want to select multiple blocks for a
single Staff Window, select any number of blocks while holding down the <Ctrl> key, then double-click
while holding the <Ctrl> key only when you are selecting the final block.
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The Name and Function of Every Part
n Every function in the Staff Window besides the Staff Section is the same as in the Piano Roll Window. For information about
those functions, see the explanation for the Piano Roll Window (→P. IV-3).

Staff Section
MIDI notes from the selected block are displayed like notes on a music staff in the Staff Section.
Following the standard rules for sheet music, things like clefs (treble and bass), key signature, time
signature, rests, accidentals, tie marks, and triplets are all displayed. Every measure is marked off by a blue
vertical line, and at the top, in the Location Section, the measure numbers and grid lines (gray vertical
lines), make it easy to check the location of the notes in the song. By clicking and dragging in the Staff
Section, you can graphically edit each note.The flashing black box on the screen is the cursor.
1

2

3

1 Song Position Pointer/Line
See the explanation for the Piano Roll Section (→P. IV-4).

2 Notes
The MIDI notes are drawn on the screen as regular musical notes, following all the standard rules for
written music, so it’s easy to grasp their musical characteristics such as pitch, note length and location
(position in time).Also, by referring to the velocity graph in the Control Section, you can also easily know
each note’s velocity and gate time value.
n When the staff window is opened after selecting multiple blocks at the same time, all the blocks will be displayed on multiple
staves.The block name will be displayed at the beginning of every staff.The block name that is displayed in red is the current
target for editing.When you click a staff, it becomes the current target for editing.You can also select the block you want to
edit by clicking on its name in the block name box on the toolbar.

3 Scroll Bar
If a part of the Staff Section you need to use is currently hidden beyond the edge of the window, you can
scroll it into view by clicking or dragging the scroll bar.
n Looking at the Status Bar can help you a lot while you work in the Staff Section. In the center of the Status Bar, the note name
and note number are displayed for the mouse pointer’s current vertical position, and on the right the mouse’s location in the
song is displayed in Measure/Beat/Clock units.
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Editing with the Staff Window
Working in the Staff Section
In the Staff Window, each MIDI note is displayed as musical notation placed on a standard musical staff.
Editing the MIDI notes is easy, using the edit tools to move or copy the notes. Simply by clicking on any
note, you can audition (listen to) it, a feature that helps you quickly find the MIDI note you are looking
for.You can also enter new MIDI notes anywhere you want.
n You can display link blocks in the Staff Window just like normal blocks, however you can’t do any editing on them.When you
want to change the contents of a link block, display the original source block (normal block) for the link block, and edit it
instead.

Tool Pop-up Menu
If you click the right mouse button over the Staff Section, the tool pop-up menu will be displayed.You
can select the tool you need from the menu.

Arrow ............................................Select the Arrow tool.
Pencil ............................................Select the Pencil tool.
Eraser ............................................Select the Eraser tool.
Glue ................................................Select the Glue tool.
Key/Time Signature Settings ....Opens a dialog for setting the key and time signature.This feature lets you change
key or time signature in the middle of a song. Just make the settings, enter the
measure number for insertion, and click [OK]. See page V-12 for details.
Paste ..............................................Paste the notes copied to the clipboard at the paste line (vertical green line).To
display the paste line, click the mouse with the pointer on any empty region (area
with no notes) in the Staff Section.

Paste Line

Properties......................................This will open the Block’s Properties dialog for the block in the Staff Section that
is currently being edited. For information about the contents of the Block’s
Properties dialog, see page III-16.
n In the Staff Window, the scissors tool cannot be used.
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Note (MIDI Note) Selection
Before you can edit a MIDI note, you first have to select the one you are going to work on.There are
several ways to select notes that you can use according to the job at hand, from selecting single notes to
selecting multiple notes at the same time.
Single Note Selection
When you want to select only one of the notes, just click on it.The selected note will turn red.

n If you move the mouse pointer above the note, the Arrow tool will change to one of two shapes: +, or ↕. However, the shape
of the pointer when you click will not effect selection. For information about each of the pointer shapes, see below.
n Since the note will immediately play its note the instant you click on it, you can audition (listen to) it.

Multiple Note Selection (A)
To select multiple notes, click on each note one by one while holding down the <Ctrl> key.

n If you click an already selected note while still holding down the <Ctrl> key, you can cancel selection of that note.

Multiple Note Selection (B)
After pressing the mouse button in an empty area of the Staff Section (white background), drag the
mouse while holding the button and specify a range.After including the multiple notes you want select
within the four corners of that range, release the mouse button and all the notes in the range you
specified will be selected at one time.
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Multiple Note Selection (C)
After pressing the mouse button anywhere on the Location Section, drag the mouse to any other position
and release the button.All the notes between the grid line where you started dragging the mouse, to the
grid line where you released the mouse button will be selected at one time.

n The fineness of the specified range will vary according to the current grid setting. It’s better to set the grid small if you are
selecting in a location where there are a lot of notes with short gate times, and better to set the grid large if the location
includes a lot of notes with long gate times (→P.V-8).

Multiple Note Selection (D)
Select the [Select Note] submenu of [Select All] in the [Edit] menu and all the notes in the Staff Section
will be selected at one time.
n To cancel selection of all the notes at one time, just click in an empty area of the Staff Section (white background).
n When you select notes, you also select the part of the velocity graph in the Control Section that corresponds to each one.

Using the Computer Keyboard for Selection
A single note can be selected by moving the cursor to the target note using the arrow keys (<á>, <â>,
<ß>, <à>) on the computer keyboard. Multiple notes can be selected by enclosing them in a
rectangular area.To do this, hold down the [Shift] key while using the arrow keys (<á>, <â>, <ß>,
<à>).

Moving the Notes
Moving the Notes Vertically (Changing Pitch)
As shown in the picture, if you move the mouse pointer near the right side of the note, the Arrow tool
will change into this shape: ↕. If you drag the note upward or downward in this situation, you can move
the note up and down to another place.The location of the note (position in time) and the note length
won’t be changed, only its pitch.

n You can check the note name and note number for the note while you are moving it by looking at the center of the Status
Bar of the Application Window. Each time you click or drag the note, it will immediately play and you can audition (listen to)
the pitch.
n Changes made to notes by dragging them are limited to the notes in the scale of the key determined by the key signature. If
you want to change to a note outside of the scale (for example, change a C note to D flat in a C Maj song), click on the note
to select it, then click with the right mouse button to open the pop-up menu. From the menu, select either [Semitone Up] or
[Semitone Down] (→P.V-8).
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When multiple notes are selected, you can move all of them at the same time in one operation by
moving the mouse pointer over any one of them and dragging it.

n Notes selected at the cursor position can be moved up and down by using the up and down arrow keys (<á>, <â>) while
pressing the <Ctrl> key. If the <Page Up> and <Page Down> keys are used instead of the arrow keys, the notes will move up
and down by octaves.
n If you use the [Transpose] command from the [Job] menu on the Menu Bar, you can enter a number and move notes up or
down (change their pitch). For details, see page XI-24.

Moving the Notes Horizontally (Changing the Location)
If you move the mouse pointer on the left side of the note, as in the picture, the Arrow tool will change
into this shape: +. If you drag the note left or right in this situation, you can move the note to another
place.The pitch of the note and the note length won’t be changed, only its location (position in time).
The units of the movement will be decided by the currently set grid (see below).

n Each time you click the note, it will immediately play the note and you can audition (listen to) the pitch.
n You can check the location when moving the note by looking at the Measure:Beat (or Min:Sec:Msec) display in the Location
Section, looking at the right side of the Status Bar of the Application Window, or by using the grid lines in the Staff Section as
a guide.They are all very handy.

When multiple notes are selected, you can move all of them at the same time in one operation by
moving the mouse pointer over any one of them and dragging it.

n Notes selected at the cursor position can be moved left and right in grid units by using the left and right arrow keys (<ß>,
<à>) while pressing the <Ctrl> key.
n If you use the [Shift Clock] command from the [Job] menu on the Menu Bar, you can move notes very precisely using clock
units. For details, see page XI-27.
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About the Grid
The “grid” in the Staff Section refers to the smallest units by which you can move the notes when changing their
location (position in time). Just as previously explained for the Piano Roll Window, you can set the grid for
quarter note, eighth note or sixteenth note units by clicking on the appropriate button on the Staff Window
Toolbar. For details see the explanation for the Piano Roll Window (→P. IV-10).
n The location of a note on the grid in the Staff Section, and the actual location of the MIDI note (position in time) may
vary somewhat. For example, if you click the grid Free button on the Toolbar, then move the note just a little right or left,
or if you use the previously mentioned [Shift Clock] command from the [Job] menu to move the MIDI note by clock
units, the actual MIDI note data will be slightly changed, but the note in the Staff Section will appear to be aligned with
the same grid line as before.
n To graphically check the results of moving a MIDI note, see the velocity display in the Control Section.

Copying Notes
If you drag a note while holding down the <Ctrl> key on the computer keyboard, you can create a copy
note in another place with the same gate time, while the original note remains in its original position. If
you have selected multiple notes, as mentioned previously, all of them can be copied at the same time.

n You can also copy by selecting the [Copy] command on the [Edit] menu or by using the note pop-up menu shown below.

Note Pop-up Menu
If you right-click the mouse over a selected note, a pop-up menu relating to that note will be displayed.
You can execute any necessary command by selecting it from the menu.

Copy ......................................Copy the currently selected note to the clipboard.After copying, paste the copied
note by selecting [Paste] from the tool pop-up menu (→P.V-4) or from the [Edit]
menu.
Delete ......................................Delete the currently selected note.
Semitone Up ..........................Raise the pitch of the currently selected note by a semitone.
Semitone Down ....................Lower the pitch of the currently selected note by a semitone.
Properties ..............................Display a note properties dialog with information about the currently selected note.
n This pop-up menu is different from the one that appears when you click anywhere else in the Staff Section. Be careful you
have the right one.
Just like the note bars in the Piano Roll Window, the notes here are actually MIDI notes displayed as images on a musical staff.
For that reason, the Note’s Properties dialog in the Staff Window, and the information it contains about each note, is exactly
the same as the Note’s Properties dialog in the Piano Roll Window. See there for more information (→P. IV-11).
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Deleting Notes
You can delete notes you don’t need by following these steps:
Delete Method (A)

1. First select the note you want to delete.
2. Press the <Delete> key on the computer keyboard.
Delete Method (B)

1. First select the note you want to delete.
2. Select the [Delete] command from the [Edit] menu.

Delete Method (C)

1. First select the note you want to delete.
2. Click the right mouse button over the selected note.
3. Select the [Delete] command from the pop-up menu.

Delete Method (Eraser Tool Function)

1. Select the Eraser tool from the Application Window Toolbar (→P. II-3).
2. Click on the note you want to delete.

n If you select multiple notes by dragging and then use the Eraser tool to click on one of them, you can delete all of the
selected notes at one time.
n The Eraser tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the tool pop-up menu
(→P.V-4).
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Entering Notes (Pencil Tool Function)
Using the Pencil tool, you can easily enter new notes (MIDI notes).
n When you want to create notes starting from a new block, make a new empty block in the Track View Window beforehand
(→P. III-19), then display it with the Staff Window.

1. Select the Pencil tool from the Toolbar (→P. II-2).
n The Pencil tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the tool pop-up menu
(→P.V-4).

2. Set the gate time and velocity for the notes you want to enter using the Note Palette.When entering
a note that has an accidental (sharp, flat, natural), select the type of accidental by right-clicking on
the Accidental button on the Note Palette, then left-click on it.

3. Click on the Staff Section at the place where you want to enter the note.The note will sound at the
same time as you click, and a new note will be entered.The location where you can enter the note
will be decided by the currently set grid. For information about the grid, see page V-8.

n A note can be entered at the cursor position by pressing the <Enter> or <Insert> keys on the computer keyboard.This
feature is especially useful when you are moving the cursor using the arrow keys (<á>, <â>, <ß>, <à>), and entering
similar notes one after another.
n You can enter a note at the paste line (green vertical line) that is the same pitch as the note immediately before cursor
location by simply pressing the <Enter> or <Insert> key while holding down the <Ctrl> key.
n You can decide the location of the note by the Measure:Beat (or Min:Sec:Msec) display in the Location Section or by using
the Staff Section grid lines as a guide.The musical staff can also be a guide to help you decide the pitch.You can also check
the location and pitch values by looking at the Application Window Status Bar.

About Display Quantize
In the Staff Window sheet music display, the MIDI note location that is displayed in the Piano Roll Window is
automatically displayed in music notation. If there are a lot of smaller notes and rests, it might become ugly and
difficult to read. By making good use of the Display Quantize function in such a case, the notation can be made
much neater. (For example, MIDI data with xÅ xÅ entered in it can be displayed as ee on the staff.) Select [Display
Quantize] from the [Setup] menu on the Application Window Menu Bar, and check the smallest note you want
to display on the staff from Quarter note, 8th note, 16th note or 32nd note. For details, see page XI-21.
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About the Display of Rests
In accordance with the time signature and the location where notes are entered, rests will automatically be
displayed wherever they are required.Tie marks will also be inserted wherever necessary.

Adding Accidentals
You can add an accidental to any note entered into the Staff Section.

1. Select the note you want to add an accidental to by clicking on it.

2. Click the right mouse button on the note and select the [Semitone Up] or [Semitone Down] commands from
the pop-up menu.A sharp, flat, or natural will be added to the note.
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Key and Time Signature Settings
If you click the right mouse button on the area at the beginning of the staff where the time signature
and clef are displayed, the [Key/Time Signature Settings] menu will appear. If you select the menu, the
Key/Time Signature Settings dialog will be displayed, and you can set these items.You can also click with
the right button anywhere in the song and the pop-up menu that appears will also allow you to select
[Key/Time Signature Settings]. Doing so will display the same Key/Time Signature dialog as before, and
you can change the key or time signature settings midway through the song.

Each of these values can be changed by clicking or typing. If you have changed something, click [OK]
and the dialog will close.The contents of your changes will be immediately applied in the Staff Section. If
you decide to cancel without making the changes, click on [Cancel].The dialog will close with the
settings remaining as before.The values you can set are as follows:

Number of Beats (Numerator) ..............1-255
Size of Beat (Denominator) ....................1, 2, 4, 8, 16, 32
Key Signature............................................Shows major keys.The minor keys are considered as the relative keys of
each major key (See the table below).
Insert Measure ..........................................The new Key and Time Signature settings will be inserted at the start of
the measure shown here.
n This function allows you to make settings by measure units, and the settings are entered into the song as MIDI events.This
lets you change the time signature or key in the middle of the song.
n This dialog can also be opened by selecting [Key/Time Signature Settings] from the [Setup] menu on the Application Window
menu bar.
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Key Signatures and Keys
C Maj (A min)

G Maj (E min)

D Maj (B min)

A Maj (F min)

E Maj (C min)

B Maj (G min)

F Maj (D min)

C Maj (A min)

C Maj (A min)

G Maj (E min)

D Maj (B min)

A Maj (F min)

E Maj (C min)

B Maj (G min)

F Maj (D min)

Shows the major key tonic
Shows the minor key tonic

Setting the Number of Staves
You can set the number of staves that are displayed for each block in the Staff Section.When multiple
blocks are displayed at the same time on multiple staves, this settings can be made for each individual
block. Select [Layout] in the [Setup] menu in the Application Window and the layout dialog will be
displayed.The block names and the number of staves currently set will be listed for the blocks that are
displayed in the Staff Section.You can set the number of staves you need for any block by clicking on the
“Lines” column and choosing the desired number of lines from the drop-down list that is displayed. Click
[OK] to close the dialog.The settings you made will be immediately reflected in the Staff Section.The
clef on each staff will be modified to match the number of staves you selected.To cancel the operation
before finishing it, click on [Cancel].The settings will be returned to their original condition.

No.............................................Displays the numbers for the blocks currently displayed in the Staff Section.
Block Name ............................Displays the block names for the blocks currently displayed in the Staff Section.
Lines ......................................Sets the number of lines (staves) for the block. Select the setting that best fits the
block from the following: upper, lower, both (upper and lower), alto, or tenor.
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Connecting Notes (Glue Tool Function)
Using the Glue tool, you can connect two notes at the same pitch, and make them into a single note.
Internally, a single MIDI note is connected to another and the gate time (note length) is extended.

1. Select the Glue tool from the Toolbar (→P. II-3).
2. Click with the Glue tool on the notes of the same pitch that you want to connect.

n If there are rests (blank spaces) between the two notes, gate time will automatically be added to make up the gap. If there are
other notes between the two notes you want to connect, all those other notes will be skipped. If you want to connect all the
notes in between, use the Glue tool to drag through the area containing the all notes you want to connect.
n The Glue tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the tool pop-up menu
(→P.V-4).
n You can connect the note selected at the cursor position to the note (of the same pitch) immediately behind or in front of it
by pressing the <V> or <B> key while holding down the <Alt> key.
n Depending on the notes that are connected, a tie may be used on the staff display.

Editing with the Edit Commands
You can move or copy a note to another place within the same pitch by using the [Cut], [Copy] and
[Paste] commands in the [Edit] menu on the Menu Bar.The procedure is the same as for using edit
commands to edit note bars in the Piano Roll Window. See the explanation there (→P. IV-15).

Working in the Control Section
In the Control Section, the editing tools can be used for editing operations on events centering on the
velocity for each note and on control change data.Any of the data can be displayed in graph form
corresponding to the position of each note in the Staff Section, and can be graphically edited using the
provided tools.Working in the Control Section here is the same as for the Piano Roll Window. See the
previous explanation of the Piano Roll Window (→P. IV-16).
n Since the notes displayed in the Staff Section are put on the screen in line with the visible grid lines, their display can’t
strictly follow the actual locations (in time) of the MIDI notes.Therefore, when the note velocities are displayed in the
Control Section, the position of the notes in the Staff Section and in the velocity graph may vary slightly.

Printing the Staves
You can print out the music staves displayed in the Staff Window.
Because the blocks that were selected when you opened the Staff Window will be the targets for
printing, you can print out ensemble scores such as band scores by opening the Staff Window with
multiple blocks selected. In addition, depending on the Instrument Type setting for the track where the
block you will be printing is located, guitar or bass tablature staves, drum staves, or staves for the key of
transposing instruments will be automatically set, and the appropriate staves will be printed.
n Depending on the settings you make, besides the music staves shown in the Staff Window, you can print out the title of the
song, the names of the composer or arranger, measure numbers, the lyrics (if they have been entered in the Control Section),
and the page number for each page.

1. Select the [Print Setup] command in the [File] menu on the Menu bar, and set up the printer.
2. Select [Print] in the [File] menu and the Print Preview Window will open. Set up the paper layout.
3. When you click on [Print] in the Print Preview Window, the staff will be printed with the settings
you made in step 2.
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Print Preview Window

Print ........................................Click here and the Windows standard print dialog will open.
Next Page ................................Click here when there are multiple pages, and you can preview the next page.
Previous Page ........................Click here when there are multiple pages, and you can preview the previous page.
Two Pages ..............................Click here and you can preview two pages at once.
Zoom In ..................................Click here to magnify the preview display.
Zoom Out ..............................Click here to reduce the preview display.
Close ........................................Click here to close the Print Preview Window and return to the Staff Window.
Title/Composer/Arranger ....Click here to open the Title/Composer/Arranger Setup dialog.The title, composer and
arranger names entered here will be printed out with the music staves.

Setup ........................................Click here to open the Staff Print Setup dialog.You can make detailed settings for
arranging the staves on the paper.
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Staff Print Setup Dialog

Track No. ............................The number of the track that includes the block to be printed.This cannot be
changed.
Track Name ........................The name of the track that includes the block to be printed.This is the same as the
track name in the Track Parameter Section of the Track View Window.This cannot be
changed.
Print ....................................The tracks with check marks added will actually be printed. Click on this space to
turn the checkmarks ON and OFF.
Instrument Type ................This is the instrument type for the track where the block to be printed is located.
When you click on this display the Instrument Type dialog will be opened, and the
instrument type can be changed.The type of staves to be printed is also determined
by the instrument type. For example when guitar or bass tab is set as the
instrument type, tablature staves will be printed. For details about the Instrument
Type dialog, see P. III-6.
Lines ....................................Click here and a drop-down list will appear. Select which lines to print for each
track (upper only, lower only, both, or automatic).
Max Lines and Lines ........The number of lines to be printed on the page is displayed in the [Lines] box here,
according to the setting in the [Lines] space above.You won’t be able to print more
lines than the number in the [Max Lines] box.
Measures ............................Click here and a drop-down list will appear. Select the number of measures to print
on each line.
Size ......................................Select whether to print at Normal size or Small size.
Print Markers ....................Select whether to print markers if there are any in the Master Track.
Print Sections ....................Select whether to print section names (like Intro, Main, or Fill In) if there are any
style blocks in the auto accompaniment Style Track.
Print Chords ......................Select whether to print chord names if there are any chords in the auto
accompaniment Chord Track.
Print Song Name After Page 2 ..Select whether to print the song name on the second page and beyond.
Print Page Numbers ........Select whether to print the page numbers on the music staves.
Print Track Names ............Select whether to print the track names on the music staves. If you decide to print
them, you can also select whether to print them the same way on page two and
beyond.
Print Lyrics ........................Select whether to print lyrics if there is any lyric data entered into the blocks
included in the tracks being printed.
Print Measure Numbers....Select whether to print measure numbers on the music staves.
Perc. Settings ......................Opens the Percussion Settings dialog.
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Percussion Settings Dialog
The Percussion Settings dialog is used for making settings related to printing drum staves. In this dialog, settings
can be made for each drum kit and for symbols representing each of the percussion instruments included in the
drum kit.The settings made here are saved in a single percussion settings file (extension .PRC).The file and
settings may be read into XGworks and used whenever needed.

Drum Kit ............................Select the drum kit that will be used for printing.The percussion instruments
included in the drum kit selected here will be displayed on the list below.
Instrument ..........................This displays the name of each percussion instrument included in the selected
drum kit.These names cannot be changed.
Head ....................................Sets the symbol that will be used for each percussion instrument when it is printed.
Note#....................................Sets the position on the staff for each percussion instrument when it is printed.
Open ....................................Opens the dialog that is used for opening files.This is used for reading already
existing percussion setting files (extension .PRC).
Save ......................................Opens the Save As dialog.The settings made in this dialog can be saved as a
percussion settings file (extension .PRC).
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Drum Window
In the Drum Window, the MIDI notes in rhythm track blocks are displayed on the screen as drum
marks— graphical images that make it easy for you to do precise editing of rhythm patterns at the MIDI
note level.
Title Bar
Toolbar
Location Section

Instrument Buttons

Drum Section
Split Bar
Control Section
Control
Section Toolbar
Note Palette

● You can select multiple blocks at the same point in the song, and display them in a single Drum
Window. However, you can actually edit only a single block at a time, the one that has had its name
selected in the Block Name display on the Toolbar.
● In Drum Section each MIDI note in a rhythm track becomes a drum mark, and is displayed on the
screen in a special graphical format that makes it easy to grasp its assigned rhythm instrument,
location (in time) and velocity (strength) in a single glance. Editing the MIDI notes is simple. Just use
the edit tools to move or copy the drum marks. Simply by clicking on any drum mark, you can
audition (listen to) it, a feature that helps you quickly find the MIDI note you are looking for.You can
enter new MIDI notes anywhere you want.
● You can easily check the instrument assigned to every drum mark with a quick look at the
instrument buttons on the left edge of the Drum Section.
n There are some buttons among the instrument buttons that don’t have a rhythm instrument assigned to them (“*****” is
displayed, and no sound plays). Buttons with rhythm instruments assigned to them can be displayed by scrolling the Drum
Section up and down.

● The Control Section at the bottom of the Drum Window uses a graphic format that makes it easy to
understand the velocity for each MIDI note. Special tools are provided that let you edit the notes just
like you were using graphics software. Up to three different Control Sections can be displayed and
used at the same time.
n For information about the Menu Bar and Toolbar on the Application Window, see page II-2.
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How to Open the Drum Window
Opening Method (A)

1. In the Track View Window, select the sequence block (MIDI data block) that has the data you want to
display or edit.

n You can display any block with sequence data (MIDI data) in it, but the Drum Window is actually designed to edit the data of
rhythm tracks.

2. Click on the [Window] menu in the Menu Bar of the Application Window, then select [Drum] from
the pull down menu.

n If you select multiple blocks at the same time, you can have them all displayed in a single Drum Window. In this case, you can
only edit one block at a time but by clicking on Block Name from the Toolbar of the Drum Window, you can switch to
another block and begin work on it.
The name of the block that is the current target for editing operations will be displayed in Block Name.

Opening Method (B)
After selecting the block in the Track View Window, click on the Drum Window button on the
Application Window Toolbar. Just as in Opening Method (A), if you select multiple blocks at the same
time, you can have them displayed in a single Drum Window.

Opening Method (C)
After selecting the block in the Track View Window, click the right button of the mouse and select Drum
from the pop-up menu that is displayed. Just as in Opening Method (A), if you select multiple blocks at
the same time, you can have them displayed in a single Drum Window.

Opening Method (D)
If you have previously checked Drum as the [Default Window] in the [Setup] menu (→P. XI-20), all you
have to do is double-click on the sequence block (MIDI data block) that you want to display, and that
block will be directly opened in the Drum Window.Also, when you want to open multiple blocks in a
single Drum Window, select any number of blocks while holding down the <Ctrl> key, then double-click
while holding the <Ctrl> key when you are selecting the final block.

VI-2

XGw3/E6.QX

2/1/99

5:02 PM

Page 3

The Name and Function of Every Part
n Every function in the Drum Window besides the Drum Section is the same as in the Piano Roll Window. For information
about those functions, see the explanation for the Piano Roll Window (→P. IV-3).

Drum Section
Every MIDI note in the selected block is “imagined” and graphically displayed in the Drum Section. Each
MIDI note number has a rhythm instrument assigned to it, and these instruments are displayed in a
column of Instrument buttons running up and down the left side of the screen.The horizontal position
of each drum mark on the screen shows its location (in time) in the song. Every measure is marked by a
blue vertical line and you can easily check each drum mark’s location in the song by looking at the
measure numbers and gridlines (gray vertical lines) in the Location Section at the top.The graphical
setup of the Drum Section makes it easy to edit the drum marks by clicking and dragging, and to use the
many commands available to you.The flashing black box on the screen is the cursor.
3

1

4

2

1 Song Position Pointer/Line
See the explanation for the Piano Roll Section (→P. IV-4).

2 Drum Mark
Each MIDI note is made into a special image that helps you to graphically understand the note’s velocity
(strength), assigned instrument, and location (in time).
The size of the drum mark shows the velocity of the MIDI note.The size of the drum mark gets bigger as
the velocity value increases.
Since the Instrument buttons on the left of the Drum Section display the rhythm instrument names, you
can understand the instrument assigned to every drum mark with just a glance.

About the Types and Colors of the Drum Marks
In the Drum Section, you can display the MIDI notes (drum marks) from multiple blocks in the same point in
song at one time.The drum marks displayed in a solid color belong to the block that is currently the target for
editing operations. Drum marks that are shown in outline belong to blocks that are not targets for current
editing operations. Since only one block can be edited at any time, even though the data from many blocks can
be displayed at once, you can use the Block Name function on the Toolbar to switch to the block you want to
work on.
To help you distinguish the rhythm instrument assigned to each MIDI note, the drum marks are automatically
colored according to the type of instrument. By using the Drum Properties dialog (→P.VI-9), you can assign
whatever color you prefer to each of the rhythm instruments.

3 Scroll Bar
If a part of the Drum Section you need to use is currently hidden beyond the edge of the window, you
can scroll it into view by clicking or dragging the scroll bar.
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4 Instrument Buttons
The instrument buttons display the rhythm instrument assigned to each MIDI note. Each drum mark
corresponds to the instrument on its own line, and when you click its Instrument button, the sound of
the rhythm instrument assigned to the button will play, and you can audition (listen to) it.
By dragging Instrument buttons up and down, you can change their position in the display and thus
reorder the lines of instruments and drum marks.
n When you are doing mouse operations in the drum section, it’s handy to look at the Status Bar. In the center of the Status Bar,
the note name and number of the current mouse position are displayed, and on the right the current location is displayed (in
Measure/Beat/Clock units).

Editing with the Drum Window
Working in the Drum Section
In Drum Section each MIDI note in a rhythm track becomes a drum mark, and is displayed on the screen
in a special graphical format that makes it easy to grasp its assigned rhythm instrument, location (in time)
and velocity (strength) at a single glance. Editing the MIDI notes is simple, using the edit tools to move or
copy the drum marks. Just by clicking on any drum mark, you can audition (listen to) it, a feature that
helps you quickly find the MIDI note you are looking for.You can enter new MIDI notes anywhere you
want.
n You can display link blocks in the Drum Window just like normal blocks, however you can’t do any editing on them.When
you want to change the contents of a link block, display the original source block (normal block) for the link block, and edit
it instead.

Tool Pop-up Menu
If you click the right mouse button over the Drum Section, the tool pop-up menu will be displayed.You
can select the tool you need from the menu.

Arrow ..........................Select the Arrow tool.
Pencil ..........................Select the Pencil tool.
Eraser..........................Select the Eraser tool.
Paste ............................Paste the drum marks copied to the clipboard at the paste line (vertical green line).To display
the paste line, click the mouse with the pointer on any empty region (area with no drum
marks) in the Drum Section.

Paste Line
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Properties ..................This will open the Block’s Properties dialog for the block that is currently the target for
editing in the Drum Section. For information about the contents of the Block’s
Properties dialog, see page III-16.
n In the Drum Window, the Scissors and Glue tools can’t be used.

Drum Mark (MIDI Note) Selection
Before you can edit a MIDI drum mark, you first have to select the one you are going to work on.There
are several ways to select drum marks that you can use according to the job at hand, from selecting
single drum marks to selecting multiple drum marks at the same time.
Single Drum Mark Selection
When you want to select only one of the drum marks, just click on it.The selected drum mark will turn
red.

n If you move the mouse pointer above the drum mark, the Arrow tool will change to one of two shapes: +, ↕. However, the
shape of the pointer when you click will not effect selection. For information about each of the pointer shapes, see below.
n Since the drum mark will immediately play its sound when you click on it, you can audition (listen to) it.

Multiple Drum Mark Selection (A)
To select multiple drum marks, click on each drum mark one by one while holding down the <Ctrl> key.

n If you click an already selected drum mark while still holding down the <Ctrl> key, you can cancel selection of that drum
mark.

Multiple Drum Mark Selection (B)
After pressing the mouse button in an empty area of the Drum Section (white and gray background),
drag the mouse while holding the button and specify a range.After including the multiple drum marks
you want select within the four corners of that range, release the mouse button and all the drum marks
in the range you specified will be selected at one time.
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Multiple Drum Mark Selection (C)
After pressing the mouse button anywhere on the Location Section, drag the mouse to any other position
and release the button.All the drum marks between the grid line where you started dragging the mouse,
to the grid line where you released the mouse button will be selected at one time.

n The fineness of the specified range will vary according to the current grid setting. It’s better to set the grid small if you are
selecting an instrument with small gaps like the hi-hat, and better to set the grid large if selecting an instrument with
relatively large gaps like the snare (→P.VI-8).

Multiple Drum Mark Selection (D)
(a) ....If you double-click on an Instrument button to the left of the Drum Section, all the drum marks in
the same horizontal line as the button you double-clicked can be selected at one time.
(b)....If you click with the right mouse button on one of the Instrument buttons and select the [Select
All] command that is displayed, all the drum marks in the same horizontal line as the button can be
selected at one time.
(c) ....To select multiple rhythm instruments, hold down the <Ctrl> key while double-clicking on the
button for each instrument you want to select.
(a)

(b)

(c)

n Because the methods mentioned above make it easy to select all the drum marks for a particular rhythm instrument at one
time, they can be really handy. For example, you might want to select rhythm instruments one by one from one rhythm track
and copy them into other tracks. It also works when you want to edit a particular rhythm instrument, for example, the
velocity of the snare drum.
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Multiple Drum Mark Selection (E)
Select the [Select Note] submenu of [Select All] in the [Edit] menu and all the drum marks in the Drum
Section will be selected at one time.
n To cancel selection of all the drum marks at one time, just click in an empty area of the Drum Section (white and gray
background).
n When you select drum marks, you also select the part of the velocity graph in the Control Section that corresponds to each
one.

Using the Computer Keyboard for Selection
A single drum mark can be selected by moving the cursor to the target drum mark using the arrow keys
(<á>, <â>, <ß>, <à>) on the computer keyboard. Multiple drum marks can be selected by enclosing
them in a rectangular area.To do this, hold down the <Shift> key while using the arrow keys (<á>,
<â>, <ß>, <à>).

Moving the Drum Marks
Moving the Drum Marks Vertically (Changing the Rhythm Instrument)
If you move the mouse pointer near the center of the drum mark, the Arrow tool will change into this
shape: ↕. If you drag the drum mark upward or downward in this situation, you can change the rhythm
instrument for the drum mark.The location of the drum mark (position in time) will remain as it was.

n As far as the internal operation of MIDI is concerned, changing the rhythm instrument on a rhythm track is the same
operation as changing the pitch of the MIDI note on an ordinary track.This is because each rhythm instrument is actually
assigned to a different MIDI note number, which is used to show pitch on an ordinary track. If you look at the center of the
Application Window Status Bar at the bottom of the screen, you can check the note name and note numbers as you move the
drum mark.
n Each time you click the drum mark or drag it, it will immediately play the sound of its assigned rhythm instrument, and you
can audition (listen to) it.

When multiple drum marks are selected, you can move all of them at the same time in one operation by
moving the mouse pointer over any one of them and dragging it.

n Drum marks selected at the cursor position can be moved up and down by using the up and down arrow keys (<á>, <â>)
while pressing the <Ctrl> key.
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Moving the Drum Marks Horizontally (Changing the Location)
If you move the mouse pointer on the left side of the drum mark, the Arrow tool will change into this
shape: +. If you drag the mark left or right in this situation, you can change the drum mark’s location
(position in time).The assigned rhythm instrument won’t be changed.The units of the movement will be
decided by the currently set grid (see below).

n Each time you click the drum mark it will immediately play the sound of its assigned rhythm instrument, and you can audition
(listen to) it.
n You can check the location when moving the drum mark by looking at the Measure:Beat (or Min:Sec:Msec) display in the
Location Section, the right side of the Status Bar of the Application Window, or by using the grid lines in the Drum Section as
a guide.They are all very handy.

When multiple drum marks are selected, you can move all of them at the same time in one operation by
moving the mouse pointer over any one of them and dragging it.

n Drum marks selected at the cursor position can be moved left and right in grid units by using the left and right arrow keys
(<ß>, <à>) while pressing the <Ctrl> key.
n If you use the [Shift Clock] command from the [Job] menu on the Menu Bar, you can move drum marks very precisely using
clock units. For details, see page XI-27.

About the Grid
The “grid” in the Drum Section refers to the smallest units by which you can move the drum marks when
changing their location (position in time). Just as previously explained for the Piano Roll Window, you can set the
grid for quarter note, eighth note or sixteenth note units by clicking on the appropriate button on the Drum
Window Toolbar. For details see the explanation for the Piano Roll Window (→P. IV-10).

Copying Drum Marks
If you drag a drum mark while holding down the <Ctrl> key on the computer keyboard, you can create a
copy mark in another place, while the original mark remains in its original position. If you have selected
multiple drum marks, as mentioned previously, all of them can be copied at the same time.

n You can also copy by selecting the [Copy] command on the [Edit] menu or by using the drum mark pop-up menu shown
below.
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Drum Mark Pop-up Menu
If you right-click the mouse over a selected drum mark, a pop-up menu relating to that drum mark will
be displayed.You can execute any necessary command by selecting it from the menu.

Copy ............................Copy the currently selected drum mark to the clipboard.After copying, paste the copied block
by selecting [Paste] from the tool pop-up menu (→P.VI-4) or from the [Edit] menu.
Delete ..........................Delete the currently selected drum mark.
Properties ..................Display a Note’s Properties dialog with information about the currently selected drum mark.
n This pop-up menu is different from the one that appears when you click anywhere else in the Drum Section. Be careful you
have the right one.
Just like the note bars in the Piano Roll Window, the drum marks here are actually MIDI notes displayed as images. For that
reason, the Note’s Properties dialog in the Drum Window, and the information it contains about each drum mark, is exactly
the same as in the Note’s Properties dialog in the Piano Roll Window. See there for more information (→P. IV-11).

Rhythm Instrument Pop-up Menu
If you click the right mouse button over an Instrument button, the rhythm instrument pop-up menu will
be displayed. Select the necessary command from the menu and you can execute it.

Select All ....................Selects at one time all the drum marks (MIDI notes) for the rhythm instrument you clicked
on.
Properties ..................Opens the Drum’s Properties dialog showing information about the rhythm instrument you
clicked on.

Drum’s Properties Dialog

Drum Kit ................Show the name of the drum kit that the currently selected rhythm instrument belongs to.
Instrument ............Shows the name of the currently selected rhythm instrument.
Color........................Shows the color assigned to the drum marks belonging to the selected rhythm instrument.
The Drum’s Properties dialog shows information for the selected rhythm instrument.With it you can freely change the
instrument assigned to this Instrument button or the color assigned to the drum marks belonging to the rhythm instrument.
Clicking any of the boxes will cause a drop-down list to be displayed. From there you can choose the desired drum kit
or instrument belonging to that kit.You can also change the color of the drum marks. If you have changed the settings,
click on [OK] and the properties dialog will close and the settings will be applied in the Drum Window. If you want to
cancel making changes, click on [Cancel] and the properties dialog will close, leaving the settings as they were.
n If you change the drum kit using this properties dialog, the other Instrument buttons will also change to match the
selected drum kit. However, this change won’t rewrite the program change information in the MIDI data. Program
change entry is done in the Control Section.
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Changing the Display Order with the Instrument Buttons
By dragging any of the Instrument buttons up and down, you can change the display position of that line
and all its drum marks and thus rearrange the order of the lines into the pattern that is easiest to use.

Deleting Drum Marks
You can delete drum marks you don’t need by following these steps:
Delete Method (A)

1. First select the drum mark you want to delete.
2. Press the <Delete> key on the computer keyboard.
Delete Method (B)

1. First select the drum mark you want to delete.
2. Select the [Delete] command from the [Edit] menu.

Delete Method (C)

1. First select the drum mark you want to delete.
2. Click the right mouse button over the selected drum mark.
3. Select the [Delete] command from the pop-up menu.

VI-10

XGw3/E6.QX

2/1/99

5:02 PM

Page 11

Delete Method (Eraser Tool Function)

1. Select the Eraser tool from the Application Window Toolbar (→P. II-3).
2. Click on the drum mark you want to delete.

n If you select multiple drum marks by dragging and then use the Eraser tool to click on one of them, you can delete all of the
selected drum marks at one time.
n The Eraser tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the tool pop-up menu
(→P.VI-4).

Entering Drum Marks (Pencil Function)
Using the Pencil tool, you can easily enter new drum marks (MIDI notes). Since the Drum Window makes
the velocity and rhythm instrument of each MIDI note especially easy to grasp, it’s the best window for
making drum patterns.
n When you want to create notes starting with a new block, make a new empty block in the Track View Window beforehand
(→P. III-19), then display it with the Drum Window. In order to make sure that the data you enter is played with the correct
rhythm instruments, it’s necessary to set channel 10 as the MIDI channel for the track where you have created the new block
(when using a GM/XG tone generator).

1. Select the Pencil tool from the Toolbar (→P. II-2).
n The Pencil tool can also be selected from the [Setup] menu on the Menu Bar (→P. XI-18) or from the tool pop-up menu
(→P.VI-4).

2. Set the gate time and velocity for the notes you want to enter using the Note Palette.
n Drum marks don’t display gate time.When gate time editing is needed, do it in the Control Section velocity display.

3. Click on the Drum Section at the place where you want to enter the drum mark.The rhythm

instrument will play at the same time as you click, and a new drum mark will be entered.The
location where you can enter the drum marks will be decided by the currently set grid. For
information about the grid, see page VI-8.

n A drum mark can be entered at the cursor position by pressing the <Enter> or <Insert> keys on the computer keyboard.This
feature is especially useful when you are moving the cursor using the arrow keys, (<á>, <â>, <ß>, <à>), and entering the
same drum marks one after another.
n You can enter a drum mark at the paste line (green vertical line) that is the same as the one immediately before paste line
location by simply pressing the <Enter> or <Insert> key while holding down the <Ctrl> key.
n You can decide the location of the drum mark by the Measure:Beat (or Min:Sec:Msec) display in the Location Section or by
using the Drum Section grid lines as a guide.You can decide the rhythm instrument using the Instrument buttons on the left
side as a guide. It’s also handy to check the location and MIDI note number by looking at the Application Window Status Bar.
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Changing Velocity Values
An important feature of the Drum Window is that the velocity (strength) of each MIDI note can be easily
grasped by looking at the size of the drum mark.As the size of the drum mark gets bigger, it shows a
larger velocity value for the MIDI note.
You can edit velocity values graphically using the Control Section edit tools.Working in the Control
Section here is the same as for the Piano Roll Window. See the previous explanation of the Piano Roll
Window (→P. IV-16).
n If you use the [Velocity Modify] command from the [Job] menu on the Menu Bar, or the Note’s Properties dialog for the drum
mark, you can edit the velocity value precisely by entering a number.

Editing with the Edit Commands
You can move or copy a drum mark to another place by using the [Cut], [Copy] and [Paste] commands
in the [Edit] menu on the Menu Bar.The procedure is the same as for using edit commands to edit note
bars in the Piano Roll Window. See the explanation there (→P. IV-15).
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List Window
In the List Window, you can display the MIDI or Wave data of any block in a list format. The settings for
all the MIDI events, including notes, program changes, and control changes can be precisely edited one
by one.
Title Bar
Toolbar
List Section

●

You can select multiple blocks at the same point in the song, and display them in a single List
Window. However, you can actually edit only a single block at a time, the one that has had its name
selected in the Block Name display on the Toolbar.

●

In the List Section, the location (in time), type, and setting values of each MIDI event are listed by
the order of their appearance in the song.You can freely change the locations and values of the
events by clicking and typing.You can also easily move and copy the events using the edit
commands, or insert a new event anywhere you want.

●

Simply by clicking on a MIDI note in the List Window, or continuing to drag along a line of them,
you can audition (listen to) the sound of each note in turn, and quickly find the note you want.

●

By using the Display Filter function, you can display only the events you need to work with. It’s
really handy when you want to edit a specific type of event.

n For information about the Menu Bar and Toolbar on the Application Window, see page II-2.
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How to Open the List Window
Opening Method (A)

1. Select the block in the Track View Window that has the data you want to display or edit.
2. Click on the [Window] menu in the Menu Bar of the Application Window, then select [List] from the
pull down menu.

n If you select multiple blocks at the same time, you can have them all displayed in a single List Window. In this case, you can
only edit one block at a time, but by clicking on Block Name from the Toolbar of the List Window, you can switch to another
block and begin work on it.
The name of the block that is the current target for editing operations will be displayed in Block Name.The events of the
blocks besides the current target for editing will be displayed in gray.

Opening Method (B)
After selecting the block in the Track View Window, click on List Window button on the Application
Window Toolbar. Just as in Opening Method (A), if you select multiple blocks at the same time, you can
have them displayed in a single List Window.

Opening Method (C)
After selecting the block in the Track View Window, click the right button of the mouse and select List
from the pop-up menu that is displayed. Just as in Opening Method (A), if you select multiple blocks at
the same time, you can have them displayed in a single List Window.

Opening Method (D)
If you have previously checked List as the [Default Window] in the [Setup] menu (→P. XI-20), all you have
to do is double-click on the block that you want to display, and that block will be directly opened in the
List Window.Also, when you want to open multiple blocks in a single List window, select any number of
blocks while holding down the <Ctrl> key, then double-click while holding the <Ctrl> key when you are
selecting the final block.

The Name and Function of Every Part
Title Bar
On the Title Bar, there are the application icon and the Minimize, Maximize and Close buttons. For
details, see page XI-1.

Toolbar
On the Toolbar, there are the monitor and display functions related to the List Window.
1

2 34 56

1 Block Name
The name of the block that is currently the target for your edit operations is displayed here. When two
or more blocks are opened at the same time in the List Window, you can click on the Block Name and
choose the block you want to edit from the drop-down list that appears.

2 Font Button
Click here, and the Font dialog will open. You can set the font for the List Window display.
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Font..........................................The currently selected font name is displayed.
Font Style ................................The currently selected font style (Italic, Bold, etc.) is displayed.
Size ..........................................The current font size is displayed.
Sample ....................................A sample of type is displayed with the current font, style, and size settings.
Script ......................................The typeface type (Japanese, European, etc.) of the currently selected font is
displayed.

You can change the font, style, and size settings by clicking or by typing from the computer keyboard. If
you have changed the settings, click on [OK] and the font dialog will close and the settings will be
applied in the List Window. If you want to cancel making changes, click on [Cancel] and the font dialog
will close, leaving the settings as they were.

3 Mono Monitor Button
Clicking here will set the MIDI note monitor function to mono mode. If you click on a MIDI note event,
each MIDI note will play individually for you to monitor (audition).

4 Poly Monitor Button
Clicking here will set the MIDI note monitor function to poly mode. In poly mode, if you select multiple
MIDI events by dragging them, you can have all the MIDI notes play together with each other. It’s handy
because you can check chord voicing by dragging all the MIDI events at the same location in the song.

5 Wave Monitor Button
Clicking here turns ON the Wave monitor function.

6 MCI Monitor Button
Clicking here turns ON the MCI monitor function. MCI is an acronym for the Media Control Interface, a
Windows function for monitoring images and audio. XGworks can play MCI files together with MIDI data.
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Monitor Function
Monitoring the MIDI notes,Wave data, and MCI files displayed in the List Window is easy. It’s really handy when
looking for the sound or chord you want to edit.

1. Click the monitor button that fits your purpose, turning the monitor function ON. When monitoring MIDI
notes, choose either mono mode or poly mode.
n The monitor functions can also be set ON from the [Setup] menu on the Application Window Menu Bar.

2. Click on the event you want to monitor in the List Section. When monitoring in poly mode, quickly drag up
or down over the multiple notes in the same song location (such as a chord) and you can hear them played
all together as a single chord.

Instead of clicking and dragging with mouse, you can also monitor in a similar fashion by pressing the up and
down cursor keys on the computer keyboard and moving the cursor line over the note events (or wave and MCI
events).When monitoring while using the down cursor key <↓>, you can select in advance whether the note
events (or wave and MCI events) will play immediately before the cursor is over them or after (→P. XI-23).

List Section
All the events in the selected block are displayed one on each line. The up and down direction shows
the song’s progression in time. As you scroll downward in the list using the scroll bar, you can display
events that are located later in time. By clicking or typing, you can freely change things like the locations
or values of events (→P.VII-8).
2

3

4

5

6

1

7

1 Item Buttons
The item name for every column of the List Section is displayed here. There is a function to change the
display formats of the L1-L3 buttons, and the Type button has a function to change the display format and
a display filter function.
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Changing the Display Widths
If you place the mouse pointer over one of the edge lines that divide item buttons, the pointer will change shape
into the split tool. With this tool, you can drag each line right and left, changing the widths of the various
sections.

If you double-click while the mouse pointer is a split tool, the display will automatically change width to match
the number of characters that have been entered into it.

2 L1/L2/L3 (Location 1/2/3)
These items display the location of each event in Measure/Beat/Clock units. You can also change the
display format to Min/Sec/Msec units.
Changing the Display Format

1. Click the right mouse button over one of the L1/L2/L3 item buttons.
2. Place a check mark next to either [Measure number] or [Time] in the [Display Format] pop-up menu that
appears. It doesn’t matter which of the L1/L2/L3 buttons you do this operation over. All of them will switch
their display at the same time.

3 Type
Displays the type of each event.
n You can’t change the Type of already entered events. If you need a different type of event, enter or insert a new event of the
desired type (→P.VII-16).
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XG Display Function
You can display the Type and Value (things like names for MIDI events or control change types) using the names
defined in the XG format.

1. Click the right mouse button over the Type item button.
2. Select [Display XG] from the pop-up menu that is displayed and the XG Settings dialog will be displayed.
n When you are already using the names defined in the XG format for the Type and Value items in the List Section, there
will already a check mark next to [Display XG] on the pop-up menu.

3. Click on the boxes next to the names of the MIDI events for which you want to display the names defined
by XG. With each click a check will appear and the box will be selected.

4. Click on [OK] and the dialog will close. The events you checked will be displayed in the List Section with
the names defined by XG. If you want to cancel making changes, click on [Cancel] and the XG Settings
dialog will close, leaving the settings as they were.
n The MIDI events that are not selected for XG display using the [XG Settings] dialog will be displayed using the general
names defined in the MIDI standard.

Display Filter Function
When you use the Display Filter function, you can set the display so that instead of seeing many event types all
mixed together, only the events you want to edit or check will be displayed.

1. Click the right mouse button over the Type item button.
2. Select [Display filter] from the pop-up menu that is displayed. The Filter dialog will be displayed.
n If you are already using the display filter, there will already be a check mark next to [Display filter] on the pop-up menu.

Meta Event
Detail Button

Control Change
Detail Buttons

3. Click the check boxes for the types of events you don’t want displayed in the List Section. A check mark
will appear next to each one and that event will be selected for filtering. Since the filter will be ON for the
events you checked, they won’t be displayed in the List Section. For example, if you want to display only
notes (note events) in the List Section, put in check in the boxes for all event types except that one. If you
want to place checks next to all the types of events at the same time, click [Set All]. On the other hand, if
you want to remove the checks from all the types of events at the same time, click [Clear All].
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You can set the filter function to specific types of Meta Events and Control Change events. Click on one of the
[Detail] buttons to the right of those events. The Filter Meta Event dialog (A) or one of the Filter Control Change
Dialogs (B-1, 2) will be displayed. Check the particular types you want to filter. Click [OK] and the dialog will
close and you will be returned to the Filter dialog.
(A)

(B-1)

(B-2)

n Because there are so many types of control changes, there are two buttons for opening the filter dialogs for them. Click
on the [Detail 0-63] button to open the dialog for setting the filter function for control change numbers 0-63. Click on
the [Detail 64-127] button to open the dialog for setting the filter function for control change numbers 64-127.

4. Click on [OK] and the dialog will close. Only the events that have no check mark next to them will be
displayed in the List Section. If you want to cancel making changes, click on [Cancel] and the Filter dialog
will close, leaving the settings as they were.
n Even though the events being filtered won’t be displayed, their data itself will not be deleted.
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4 Value 1
This displays the first value for each event. For example, in the case of a MIDI note event, the pitch will
be displayed using the note name and number. If it is a control change event, its contents will be
displayed. In the case of pitch bend or program change event, the setting value will be displayed.

5 Value 2
This displays the second value for each event. For example, in the case of a MIDI note event, the gate
time (note length) will be displayed using a note mark and Beat/Clock units. If it is a control change
event, a setting value in the range of 0-127 will be displayed.

6 Value 3
This displays the third value for each event. For example, in the case of a MIDI note event, the strength
symbol and velocity number value will be displayed.

7 Scroll Bar
If a part of the List Section you need to use is currently hidden beyond the edge of the window, you can
scroll it into view by clicking or dragging the scroll bar.

Editing with the List Window
Working in the List Section
In the List Section, the location (in time), type, and setting values of each MIDI event are listed by the
order of their appearance in the song.You can freely change the locations and values of the events by
clicking and typing.You can also easily move and copy the events using the edit commands, or insert a
new event anywhere you want.
n You can display link blocks in the List Window just like normal blocks, however you can’t do any editing on them.When you
want to change the contents of a link block, display the original source block (normal block) for the link block, and edit it
instead.You can also select [Convert to Normal Block] from the [Edit] menu while the List Window for the link block is open
(→P. XI-10).

Event/Item Selection
Before you can edit a MIDI event, you first have to select which item you are going to work on. You can
use several ways to select events according to the job at hand, from selecting single events to selecting
multiple events at the same time.
Single Event Selection
When you want to select only one of the events, just click on the line where the event is displayed. The
cursor line will be placed on the event and the event will be highlighted. Also the item box in the place
where you clicked will turn red.
When the cursor line is over an event, it shows that the event is the target for current editing operations.
The item box will turn red to show that the value of that item can be changed.

n If the monitor function is ON when a note event (or Wave event) is clicked, the sound of that note event (or Wave event) will
play, letting you audition (listen to) it.
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Multiple Event Selection (A)
To select multiple events, click on each event one by one while holding down the <Ctrl> key. The
events you select will turn green.

n If you click an already selected event while still holding down the <Ctrl> key, you can cancel selection of that event.

Multiple Event Selection (B)
After pressing the mouse button, drag it up or down while holding down the mouse button, then release
the button wherever you want. All the events from where you started dragging to where you released
the button will be selected at one time. All the selected events will turn green.

Multiple Event Selection (C)
Click the mouse on any event line in the List Section. Next, click another event while holding the
<Shift> key. All the events from the first event you selected to the event you selected while holding the
<Shift> key will be selected at one time. The selected events will turn green.

Multiple Event Selection (D)
Select the [Select All] command in the [Edit] menu and all the events in the List Section will be selected
at one time.
h When you only want to select events of a particular type, use the Display filter function previously mentioned (→P.VII-6) to
display only the events you need, then use one of the above methods to select all of them. Since you can be certain of
selecting only the desired events to be the target of your edit operation, it’s really convenient.
n To cancel selection of all the notes at one time, just click on an event that isn’t selected or in the empty area (white part)
after the last event in the block. You can also cancel the selection by using <Esc> key on the computer keyboard.
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About the Status Bar Display
(a) ....When you have selected one of the events, the currently selected event item will be displayed on the
Application Window Status Bar.
(b) ....When you have multiple events selected, the words “Selecting Event” will appear, indicating that you are in
the process of selection. The right side of the Status Bar shows the Measure/Beat/Clock of the top
position of the block currently displayed in the List Section.
(a)
(b)

Selecting with the Computer Keyboard
The target event for editing can be selected using the < ↑ > and < ↓ > keys of the computer keyboard.
Also, the item can be selected using the <←> and <→> keys. If you hold the <Shift> while using the < ↑ >
and < ↓ > keys, you can select multiple events.
n When you press the <Tab> key, the red cursor that indicates the setting items will move to the right.When you press the
<Tab> key while holding down the <Shift> key, the same cursor will move to the left.

Moving Events (Changing the Location)
Moving a Single Event
In the List Section, each event is displayed on one line. The events progress in time going from top to
bottom. If you change the location display (L1/L2/L3), the order of the events will automatically change.

1. In the List Section, click on the one of the L1/L2/L3 (Measure/Beat/Clock) items for the event you
want to move to a new location (the item will turn red).

n You can also change the display format of the L1/L2/L3 items to Min/Sec/Msec (→P.VII-5).

2. The box displayed in red is ready to have data entered. Type in the data with the computer

keyboard, then press the <Enter> key. The order of the event will automatically change according to
the value you entered.

Moving Multiple Events

1. Select the events you want to move by dragging the mouse (the selected range will turn green).
2. Dragging in the selected area, then releasing the mouse button will cause the Insert dialog to be
displayed.
3. Use the spin boxes for Meas/Beat/Clock to set the location to where you want to move the selected
events.
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4. Click [OK] and the dialog will close. The multiple events you selected will be removed from their

original location and moved to the place you specified. To cancel the move operation before
finishing it, click on [Cancel] and the dialog will close, leaving the events in their original position.

n You can also move the events to a location beyond the last event in the current block. In that case, the block will
automatically be extended.
n You can also move the events by using the [Shift Clock] command from the [Job] menu on the Menu Bar. For details, see page
XI-27.

Changing the Setting Values of Events

1. Click on the item in the event that you want to change (it will turn red).
2. After using the keyboard to enter a value, press the <Enter> key or click on a different box. The
changed value will be set.

n When changing settings, you can increase or decrease the values using the computer keys below.

[Page Up] ................................ Each press of the key increases the value by 1.
[Page Down]............................ Each press of the key decreases the value by 1.
[Home] .................................... Each press of the key increases the value (usually by 10).
[End] ........................................ Each press of the key decreases the value (usually by 10).

Every event in the List Section has setting items for Value 1-Value 3, but depending on the event type, the
available items and values differ as shown below. Here the major ones are explained. For details, see the
MIDI data format in the owner’s manual for the MIDI tone generator you are using.
n You can’t change the MIDI event type. When you need a particular type of event, enter or insert a new one (→P.VII-16).

About the Edit Pop-up Menu
When the value of an event item is colored red, pressing the <Enter> key then pressing the right mouse button
over the box will cause the Edit pop-up menu to be displayed. By selecting the command you need from this
menu, you can execute a lot of different functions.

Undo ....................................Undoes the edit operation just executed, returning the value to its original state.
Cut ........................................Deletes the value in the box and copies it to the clipboard.
Copy ....................................Copies the value in the box to the clipboard.
Paste ....................................Pastes the value on the clipboard into the box.
Delete ..................................Deletes the value in the box.
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Note
The Note event shows information for playing MIDI notes. It contains the following information: the
note number, which indicates the pitch; the gate time, which indicates the length of time from when the
note begins to play (note-on) to when it finishes (note-off); and the velocity, which indicates the strength
of the note when it is played.
Setting Values
Value 1 .................................... Note number (note name)=0-127 (C -2 to G9)
Value 2 .................................... Gate time (note length)= Beat/Clock units
Value 3 .................................... Velocity (strength)=1-127 (ppp-fff)
n When a note number is entered for Value 1, the note name for that number is automatically displayed. In the same way, the
note mark for Value 2 and the strength symbol for Value 3 are also automatically displayed when the numbers are entered.

Poly After (Polyphonic After Touch)
This is an event that lets you make after touch effects for each individual key (MIDI note). These effects
change the sound according to the pressure you apply to the individual key after initially striking it.
Since only a few tone generators are compatible with Poly After, the Ch After (Channel After Touch)
mentioned below is more generally used.
Setting Values
Value 1............ Note number (note name)=0-127 (C -2 to G9)
Value 2............ Pressure value=0-127
n When a note number is entered for Value 1, the note name for that number is automatically displayed.

Control (Control Change)
Control change data refers to MIDI events like volume control and effects that are used to express a
subtle nuance or dynamic change in the performance. Each function is assigned a different control
number. These control values can be set in a range from 0-127.
Setting Values
Value 1............ Control number (function name)=0 (Bank Select MSB)-127 (Poly Mode On)
Value 2............ Control value=0-127
n When a control change number is entered for Value 1, an abbreviation of the function name for that number is automatically
displayed.

The most frequently used control change functions are the following:
n There may be some incompatible items, depending on the MIDI tone generator.

No.
No.
No.
No.
No.
No.
No.
No.
No.
No.

0 Bank Select MSB ........Used together with No. 32 Bank Select LSB for specifying the program bank.
1 Modulation ................Used for adjusting the depth of vibrato, etc.
7 Volume ........................Used for adjusting the volume.
10 Pan ..............................Used for adjusting the panning position of the stereo image.
11 Expression..................Volume adjustment for performance expression.
32 Bank Select LSB..........Used together with No. 0 Bank Select MSB for specifying the program bank.
64 Hold 1 ..........................Used for sustaining the sound. Has the same effect as a piano damper pedal.
91 Reverb Send................Used for adjusting the depth of the reverb effect of the MIDI tone generator.
93 Chorus Send ..............Used for adjusting the depth of the chorus effect of the MIDI tone generator.
94 Variation Send............Used for adjusting the depth of the variation ffect of the MIDI tone generator.

Program (Program Change)
This is information used for switching voices. Every number between 1-128 specifies a corresponding
voice.
n Since the numbers used for the program number (1-128) and the MIDI program change number (0-127) are each different by
one, be careful. In XGworks, don’t enter the MIDI program change number (0-127). Enter the program number (1-128)
instead.

Setting Values
Value 1 .................................... Program number=1-128
n When a program number is entered for Value 1, an abbreviation of the voice name for that number is automatically displayed.
The voices corresponding to program numbers between 1 and 128 are predetermined for GM tone generators. The voices in
bank number 0 in the XG normal voice list for the XG tone generator are the GM voices. For details, see the owner’s manual
for the XG/GM tone generator you are using.
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Ch After (Channel After Touch)
This is an event that lets you make after touch effects that change the sound according to the pressure
you apply to the keys after initially striking them. It differs from the previously mentioned Poly After
(Poly After Touch) in that its value applies in common to all the keys being pressed.
Setting Values
Value 1 .................................... Pressure value=0-127

Pitch Bend
This event conveys the operation of the pitch bend wheel installed in an ordinary synthesizer. It can be
used to bend the pitch of a MIDI note up or down while playing.
Setting Values
Value 1 ....................................Bend value=-8192 to 0 (standard pitch) to 8191
n The actual change in pitch that can be heard when using this bend value depends on the pitch bend range set on the
connected tone generator. For example, if the pitch bend range on the tone generator is set for two semitones (one whole
tone), and the bend value set here is “8191” (the highest positive value), the actual pitch will be raised by two semitones. If
the pitch bend range on the tone generator is set for 12 semitones (one octave), and the bend value set here is “8191” (the
highest positive value), the actual pitch will be raised by one octave, and if “-8192” (the lowest minus value) is set, the actual
pitch will be lowered by one octave.
When the pitch bend range on the tone
generator is set for two semitones (one
whole tone)

Bend
value

When the pitch bend range on the tone
generator is set for 12 semitones (one
octave)

+2 semitones (one whole tone higher)

+8191

+12 semitones (one octave higher)

+1 semitone

+4096

+6 semitones (perfect fourth higher)

Standard pitch

0

Standard pitch

-1 semitone

-4096

-6 semitones (perfect fourth lower)

-2 semitones (one whole tone lower)

-8192

-12 semitones (one octave lower)

n When the value is set at “0” it is the same state as when the pitch bend wheel is in the center position. When the value is set
at “8191” it is the state when the wheel is rotated all the way in the plus direction. When the value is set at “-8192” it is the
state when the wheel is rotated all the way in the minus direction.

System Exclusive
Different from the channel messages related to the performance, this event is used for exchanging
messages concerning the devices’ exclusive data such as editing the effect parameters or voice
parameters.
Setting Values
Value 1 ....................................System exclusive message content or data value
Value 2 ....................................Hexadecimal code=F0......F7
n When the hexadecimal code for Value 2 is entered,Value 1 will be displayed. For the actual hexadecimal codes that apply for
each system exclusive message, see the MIDI data format in the owner’s manual for the XG/GM tone generator you are using.
In value 2, the hexadecimal code should be entered between the starting F0 (exclusive status) code and the final F7 (end of
exclusive) code. F0 must be omitted since XGworks automatically adds it at the beginning of system exclusive messages.
Example: If (F0), 43, 10, 4C, 00, 00, 7E, 00, F7 is entered at the beginning of the song, and it is played on an XG tone generator,
an XG System ON (reset to XG initial values) message will be transmitted.
n XGworks can transmit XG native parameter changes and system exclusive messages for the tone generators such as MU
series,VL70-m, and TG100 without using complicated hexadecimal code (→P.VII-17). For information about system exclusive
messages for each tone generator, see their owner’s manuals.
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Meta Event
This is an event that can be used to record text such as Lyrics, or the Instrument Name. It’s handy for
placing a memo in the List Section.
n In the List Window, the Meta Events you can enter are divided into several types:Text Event, Sequence Name, Instrument
Name, and Lyric (→P.VII-17).

Setting Values
Value 1 ....................................Text

Event Copy/Insert
Using the <Insert> key to copy/insert
You can easily copy/insert events using the <Insert> key on your computer keyboard.
n Using this method, only one event can be copy/inserted at a time.

1. Click on the event which is to be the source for the copy (placing the cursor line).
2. By pressing the <Insert> key you can make a copy of the event and insert it into the same location.

(In the List Section, the copy event will be inserted into the next line after the source event, but the
location display will be the same as the source event.) However, if the source event is a MIDI note
event, the copy will be inserted at the end of the length of the source note, and it will have the same
pitch (note number), gate time, and velocity.

For example, when you apply this method, you can quickly copy and enter a series of MIDI notes with
the same gate time at fixed intervals, such as for a hi-hat. If you press the <Insert> key while holding
down the <Shift> key, you can copy the same MIDI note event in the same location. (In the List Section
it will appear on the line after the source note, but the location display will be the same as the source
event.) By applying this method to copy the same note a number of times, you can easily enter a chord
just by changing the pitch of the notes. If you press the <Insert> key while holding down the <Ctrl> key,
you can insert a rest after the source MIDI note that has the same note length as the source note. If you
press the <Insert> key a number of times while holding down the <Ctrl> key, the location of the cursor
line will advance by the amount that you pressed the <Insert> key.
Copy/Insertion of Events Using the [Copy] Command

1. In the List Section, click on the event which you want to place in a different location and select it.
You can also select multiple events by dragging. (The selected area will turn green.)

2. Select the [Copy] command from the [Edit] menu. The events you have selected will be copied to
the clipboard.

3. Select the [Paste] command from the [Edit] menu and the Insert dialog will be displayed.

4. Use the spin boxes for Meas/Beat/Clock to set the location for copying. When you click [OK], the
dialog will close and the selected events will be copied to the specified location. If you want to
cancel copying the events, click on [Cancel] and the dialog will close without copying them.
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Copy/Insertion of Events by Dragging and Dropping
This function works when you have multiple List Windows open. After selecting one or more events in
one List Window, you can copy them to another List Window by dragging and dropping (releasing the
mouse button). It’s handy when you want to copy setup data like effects or control changes from one
track and use them to make another track of the same pattern.

1. Select the events you want in the List Section by dragging. They will be displayed in green.
n To select just one target event and make it turn green, press the mouse button on the event, then move the

mouse up or down one line while holding the button, then still holding the button, move the pointer back to
the original event.

2. Pressing the mouse button over the selected area, then drag the selected items to the other List
Window and release the button. The Insert dialog will be displayed.

3. Use the spin boxes for Meas/Beat/Clock to set the location for copying.

4. When you click [OK], the dialog will close and the selected events will be copied to the specified
location. If you want to cancel copying the events, click on [Cancel] and the dialog will close
without copying the events.

Deleting Events
You can delete events you don’t need by following these steps:
Delete Method (A)

1. First select the event (or events) you want to delete.
2. Press the <Delete> key on the computer keyboard.
Delete Method (B)

1. First select the event (or events) you want to delete.
2. Select the [Delete] command from the [Edit] menu.
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Entering New Events
Just by clicking the mouse, you can easily enter or insert new events.
n When you want to create events starting with a new block, make a new empty block in the Track View Window beforehand
(→P. III-19), then display it with the List Window.

1. Click with the right mouse button over any location in the List Section. The Event Type Table pop-up
menu will be displayed.

2. Select the type of event you want to enter from the pop-up menu. The Insert dialog will be
displayed.

3. Use the spin boxes for Meas/Beat/Clock to set the location for entering the event, and enter each
needed value for the event using the spin boxes provided.

n The setting items will vary according to the type of event. For information about the setting items and the values that can be
set, see below.

4. Click on [Input], and an event with the values you set will be entered in the specified location. The
dialog will remain open, and if you change the location and values as necessary, you can enter more
events of the same type.

5. After entering the needed number of events, click on [Exit], and the dialog will close. You can also
close the dialog by clicking on the Close button at the top right.

n After entering events using the Insert dialog, you can also make needed settings using the Value items in the List Section. For
details about setting values, see the MIDI data format in the owner’s manual for the MIDI tone generator you are using.
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Meta Event Insert Dialog

You can enter a Text Event, Sequence Name, Instrument Name or Lyrics. For details about each
parameter, see page VIII-2.
n In the List Window, you can enter a Meta Event called “Lyric Before Note.”With this, a Lyric Event will be entered immediately
before all notes following the location you specify in this insert dialog.After that, all you have to do is type the letters for the
lyrics into the Value 1 box in the List Section for each Lyric Event, and you can enter lyrics that follow the timing of the notes.

System Exclusive Insert Dialog

You can enter XG native parameter changes and system exclusive messages for the tone generators such
as MU series,VL70-m, and TG100. For information about the types and parameters of each system
exclusive message, see the MIDI data format in the owner’s manual for the MIDI tone generator you are
using.
Device: In order to be able to send the system exclusive to the tone generator, select the device number
set in the tone generator.
Auto Step: Each time you click the [Input] button, a new system exclusive event will be entered in a
location that is advanced a certain number of clock units ahead of the previous event entered. The
number of clock units is set in the Auto Step box. If the number of clock units is zero, each new event
will be entered in the same location as the last event.
Note Insert Dialog

You can enter the note number (pitch), the velocity, and gate time.
Auto Step: If you have a check mark in the Auto Step box, every time you click on [Input], a new note
will be entered at the end of the note length of the note previously entered. If there is no check in the
Auto Step box, each new note will be entered in the same location as the previous note.
Poly After Touch Insert Dialog

You can enter the note number (pitch) and the after touch value.
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Auto Step: Each time you click the [Input] button, a new poly after touch event will be entered in a
location that is advanced a certain number of clock units ahead of the previous event entered. The
number of clock units is set in the Auto Step box. If the number of clock units is zero, each new event
will be entered in the same location as the last event.
Control Change Insert Dialog

You can enter the control change data and its setting value. See also the MIDI data format in the owner’s
manual for the MIDI tone generator you are using.
Auto Step: Each time you click the [Input] button, a new control change event will be entered in a
location that is advanced a certain number of clock units ahead of the previous event entered. The
number of clock units is set in the Auto Step box. If the number of clock units is zero, each new event
will be entered in the same location as the last event.
Program Change Insert Dialog

You can enter the program number in the Value box.
Auto Step: Each time you click the [Input] button, a new program change event will be entered in a
location that is advanced a certain number of clock units ahead of the previous event entered. The
number of clock units is set in the Auto Step box. If the number of clock units is zero, each new event
will be entered in the same location as the last event.
n Since the numbers used for the program number (1-128) and the MIDI program change number (0-127) are each different by
one, be careful. In XGworks, don’t enter the MIDI program change number (0-127). Enter the program number (1-128)
instead.

After Touch (Channel After Touch) Insert Dialog

You can enter the after touch value in the Value box.
Auto Step: Each time you click the [Input] button, a new channel after touch event will be entered in a
location that is advanced a certain number of clock units ahead of the previous event entered. The
number of clock units is set in the Auto Step box. If the number of clock units is zero, each new event
will be entered in the same location as the last event.
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Pitch Bend Insert Dialog

You can enter the pitch bend value in the Value box.
Auto Step: Each time you click the [Input] button, a new pitch bend event will be entered in a location
that is advanced a certain number of clock units ahead of the previous event entered. The number of
clock units is set in the Auto Step box. If the number of clock units is zero, each new event will be
entered in the same location as the last event.
Packed Nrpn (Nrpn Parameter Setting) Insert Dialog

You can select the NRPN (non-registered parameter number) parameter and its data entry MSB/LSB
setting. For details, see the MIDI data format in the owner’s manual for the MIDI tone generator you are
using.
Auto Step: Each time you click the [Input] button, a new Nrpn event will be entered in a location that is
advanced a certain number of clock units ahead of the previous event entered. The number of clock
units is set in the Auto Step box. If the number of clock units is zero, each new event will be entered in
the same location as the last event.
Packed Rpn (Rpn Parameter Setting) Insert Dialog

You can select the RPN (registered parameter number) parameter and its data entry MSB/LSB setting. For
details, see the MIDI data format in the owner’s manual for the MIDI tone generator you are using.
Auto Step: Each time you click the [Input] button, a new Rpn event will be entered in a location that is
advanced a certain number of clock units ahead of the previous event entered. The number of clock
units is set in the Auto Step box. If the number of clock units is zero, each new event will be entered in
the same location as the last event.
Packed Voice (Voice Setting) Insert Dialog
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You can enter voice selections (program changes) including bank select. It’s handy when selecting XG
format voices. Basically it’s the same as the Voice List dialog used when entering program change data
from the Control Section of windows like the Piano Roll Window (→P. I-11). From the top down, the
three boxes below the Meas/Beat/Clock section match CATEGORY 1, CATEGORY 2, and CATEGORY 3.
Monitor: If you place a check here, you can audition (listen to) each voice when you click and select it.
Wave Insert Dialog

You can insert digital audio data (.WAV file) into a Wave block.
You can play the .WAV file inserted with this dialog together with MIDI data.
File: The name of the .WAV file to be inserted is displayed.
Browse: If you click here, the File Open dialog will open. The .WAV file selected here will be displayed
in the File name box. (For information about using the file open dialog, see page XI-3).
n This insert dialog can’t be opened in sequence blocks.

How to Read .WAV Files

1. Select a Wave block in the Track View Window, then open the List Window.
2. Click the right mouse button over the List Section, and select Wave from the pop-up menu that appears. The
Wave Insert dialog will open.

3. Type the name of the .WAV file you want to insert into the File box. You can also click on [Browse] to open
the File Open dialog, select the desired .WAV file, and then click on [Open].

4. Specify the location in which to insert the .WAV file, then insert the file by clicking on [Input].
n If you create an empty Wave block in the Track View Window, the File Open dialog will automatically open and you can
select and insert the desired .WAV file.

Mci (Media Control Interface) Insert Dialog

MCI (Media Control Interface) is a Windows function that lets you monitor image and audio files. With
this dialog, you can select and insert an MCI file (such as .AVI). It can be played together with MIDI data.
File: The name of the MCI file to be inserted is displayed.
Browse: If you click here, the File Open dialog will open. The MCI file selected here will be displayed in
the File name box. (For information about using the file open dialog, see page XI-3).
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Master Track Window
With the Master Track Window, you can see all the events in the Master Track displayed in a convenient
list format. You can enter or change the events that relate to the song as a whole, especially ones like
tempo and time signature. You can precisely edit the numbers or text in each event one by one.

Title Bar
Toolbar
List Section

● You can open the Master Track Window with a double-click on the Master Track Section in the Track
View Window, and have all the events in the Master Track displayed in a list format.
● In the List Section, the location (in time), type, and setting values of each event are listed in the order
of their appearance in the song. You can freely change the locations and values of the events by
clicking and typing. You can also easily move and copy the events using the edit commands, or
insert a new event anywhere you want.
● By using the Display Filter function, you can display only the events you need to work with. It’s
really handy when you edit a specific type of event.
n For information about the Menu Bar and Toolbar on the Application Window, see page II-2.

How to Open the Master Track Window
Opening Method (A)
To open the Master Track Window, double-click on the Master Track Section at the top of the Track View
Window.

Master Track

Opening Method (B)
Click on the [Window] menu in the Menu Bar of the Application Window, then select [Master Track]
from the pull down menu.

Opening Method (C)
Click on the Master Track Window button on the Application Window Toolbar.
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The Name and Function of Every Part
n In the Master Track Window, the events are different, but all the operations are the same as for the List Window. For
information on those operations, see the explanation for the List Window (→P.VII-1).

Toolbar
1

2

1 Master Track Name
This shows that the current target for editing is the Master Track. Since each song only has one Master
Track, this box can’t be changed like the Block Name box in the other windows.

2 Font Button
Click here, and the Font dialog will open. You can set the font for the Master Track Window display.
n For information about the Font dialog, see page VII-2.

List Section
All the events in the Master Track are displayed one on each line. The up and down direction shows the
song’s progression in time. As you scroll downward in the list using the scroll bar, you can display events
that are later in time. By clicking or typing, you can freely change things like the locations or values of
events (→P.VII-4).

Editing with the Master Track Window
Working in the List Section
All operations for selecting events, changing values, moving, copying, deleting or entering new events are
the same as in the List Window. See the explanation for the List Window (→P.VII-8).

Events Handled in the Master Track Window
The events that can be entered or displayed in the Master Track Window are the following Meta Events:
Text Event
Used for entering text such as comments.
Use the computer keyboard to type the comment into the Value 1 column of the List Section.
Copyright Notice
Used for displaying the copyright notice.
Use the computer keyboard to type the copyright notice into the Value 1 column of the List Section.
Sequence Name
Used for entering the song name.
Use the computer keyboard to type the song name into the Value 1 column of the List Section.
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Instrument Name
Used for entering the instrument name.
Use the computer keyboard to type the instrument name into the Value 1 column of the List Section.
Lyric
Used when entering the song lyrics.
Use the computer keyboard to type the lyric into the Value 1 column of the List Section.
Marker
Used when entering a marker.
Use the computer keyboard to type a memo into the Value 1 column of the List Section.
n The markers entered here will also be displayed on the Master Track at the top line of the Track View Window.

Cue Point
Used when entering a cue point.
Use the computer keyboard to type a memo into the Value 1 column of the List Section.
Tempo
Used when entering a tempo change. You can change the tempo midway through the song. Enter a
tempo value between 20-300 into the Value 1 column of the List Section.
SMPTE Offset
Used when entering an SMPTE Offset. This is sometimes needed when the synchronization system uses
SMPTE signals.
Enter the hour (0-23): minute (0-59): second (0-59): frame (0-29): bit (0-99) into the Value 1 column of the
List Section.
Time Signature
Used when entering the time signature. You can create data that changes the time signature midway
through the song. Use the computer keyboard to type the time signature into the Value 1 column of the
List Section.
Key Signature
Used when entering the key signature. You can create data that changes the key signature midway
through the song. Use the computer keyboard to type the key (C Maj, E b min, etc.) into the Value 1
column of the List Section.
n To enter a flat, type a “b” on the keyboard.To enter a sharp, type a pound sign “#” on the keyboard.To enter [Ebmin], for
example, type “eb_min” (or “EB_MIN”) at the keyboard. (The “_” shown here means a space, not an underscore bar.)

Specific Sequencer-Meta Event
Used when entering a specific sequencer-meta event.
You can use the computer keyboard to type the event using hexadecimal numbers into the Value 2
column of the List Section.
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Mixer Window
This window presents you with an interface just like that of a mixer board in a recording studio. For
each MIDI channel, you can easily adjust volume, control pan and effects, and change voice and tone.

Title Bar
Toolbar
Channel Unit

Master
Channel
Unit

● Using faders and knobs, you can control volume and effects for each channel separately in realtime
during song playback.You can set the balance just the way you want when playing existing songs, or
check the overall balance of songs while you are creating them.
● Mixer Window settings can now be inserted into your song.
● Knob and slider movements can now be recorded in realtime.
n Wave tracks cannot be controlled in the Mixer Window.

How to Open the Mixer Window
Opening Method (A)
Click on the Mixer Window button on the Application Window Toolbar.

Opening Method (B)
Click on the [Window] menu in the Menu Bar of the Application Window, then select [Mixer] from the
pull down menu.
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The Name and Function of Every Part
Title Bar
On the Title Bar, there are the application icon and the Minimize, Maximize and Close buttons. For
details, see page XI-1.

Toolbar
Buttons for executing a variety of functions, starting with Mixer setup, are provided on the toolbar.
1 2 3 4

1 Mixer Setup button
Clicking this button opens the Mixer Setup dialog. It is used for making control related settings in the
Mixer Window. For details see below.

2 Transmit Mixer Parameter button
Clicking this button transmits the current settings for each parameter in the Mixer Window to the tone
generator. For details see below.

3 Insert Mixer Parameter button
Clicking this button opens the Insert Setup dialog. It inserts the current settings for each parameter in
the Mixer Window into the song. For details see below.

4 Record Mixer Parameter button
The movements of each control in the Mixer Window can be recorded in realtime. For details see below.
n These functions can also be executed from the [Edit] menu or [Setup] menu on the Application Window menu bar.

Channel Unit
Individual faders and knobs that let you control various things like volume, pan and effects are lined up
under each of a total of 16 channels (numbered from left to right).You can easily do each control
operation in realtime by clicking or dragging the appropriate control.Also, each control value is
displayed on the Status Bar of the Application Window, where you can check it when making
adjustments.

1 Level Meter
Here you can see the volume (velocity level) for each channel while the song is playing.

2 Program Indicator
This displays the program number for the voice on each channel. If you double-click on the
box where the program number is displayed, the Voice List dialog will appear. Using this
dialog, you can select whichever voice you like, and change the voice for each channel.
Clicking on the box will allow you to enter the voice number from the computer keyboard.
By typing in a number between 1-128, you can select another voice from the same bank.
n For information about the Voice List dialog, see page I-11.
n The numbers used for the program number (1-128) and the MIDI program change number (0-127) are each
different by one. In this Program Indicator the program number (1-128) is displayed, not the MIDI program
change number (0-127).
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About the Edit Pop-up Menu
If you click the right mouse button over any of the Program Indicators, the Edit Pop-up menu will be displayed.
By selecting the command you need from this menu, you can execute a lot of different functions.

Undo........................Undoes the edit operation just executed, returning the program number to its original state.
Cut ..........................Deletes the highlighted program number from the indicator and copies it to the clipboard.
Copy ........................Copies the highlighted program number to the clipboard.
Paste ........................Pastes the program number on the clipboard into the indicator where you clicked.
Delete ......................Deletes the highlighted program number from the indicator.

3 EQ knob (Eq)
With this knob, you can control tone quality for each of the MIDI channels while MIDI data is being
played. By clicking the Hi or Lo buttons on the Master Channel unit, the EQ knob can be switched
between High (high frequency) or Low (low frequency) control. By dragging the knob and rotating it to
the right, either High or Low can be boosted (the gain increased).

4 Reverb Knob (Rev)
This is used to set the depth of reverb for each channel during MIDI data playback. By dragging the knob
and rotating it to the right, the reverb effect can be made deeper.When the knob is all the way to the
left, the reverb effect is zero.
n The degree of the reverb effect applied to the selected voice may vary. Some tone generators may be incompatible with this
control.

5 Chorus Knob (Cho)
This is used to set the depth of chorus for each channel while MIDI data is being played. By dragging the
knob and rotating it to the right, the chorus effect can be made deeper.When the knob is all the way to
the left, the chorus effect is zero.
n The degree of the chorus effect applied to the selected voice may vary. Some tone generators may be incompatible with this
control.

6 Variation Knob (Var)
This is used to set the depth of the variation effect for each channel while MIDI data is being played. By
dragging the knob and rotating it to the right, the variation effect can be made deeper.When the knob is
all the way to the left, the variation effect is zero.
n The variation effect, one of the main features of XG tone generators, can have a variety of effects besides reverb and chorus,
such as delay, rotary speaker, auto pan, amp simulator, or auto wah. For details, see the owner’s manual for the XG tone
generator you are using.
The degree of the variation effect applied to the selected voice may vary. Some tone generators may be incompatible with
this control.
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7 Mute Button
By clicking on one of these buttons and turning it ON, you can mute playback for that particular channel.
If you click the button once more, the channel will return to normal playback.You can also mute
multiple channels.When a channel is muted, its mute button and volume fader will turn gray.

8 Solo Button (SL)
By clicking on one of these buttons and turning it ON (red display), you can have solo playback of that
particular channel. If you click the button once more, the channel will return to normal playback.When
one channel is having solo playback, all the other channels will be muted. If you click on the [Solo]
button of a muted channel, that channel will begin solo playback.

9 Pan Knob (Pan)
This button is used to control the stereo panning position for each MIDI channel. By dragging the knob
and rotating it to the right, the stereo position for playback on that MIDI channel will move to the right.
Rotating it to the left will cause the stereo position for playback on that MIDI channel to move to the
left.

)Fader (Assignable Controller)
Using the Mixer Setup dialog (→P. IX-5), you can assign a type of control change (such as volume or
expression) to the faders lined up at the bottom of the screen. This lets you control the values for that
control change separately for each MIDI channel by moving the appropriate fader up and down.The
number for each MIDI channel is displayed on its own fader.
n When no MIDI output device for the port number displayed in the Master Channel Unit has been set up in the System Setup
Dialog (→P. XI-12), the faders will be displayed in gray.

Master Channel Unit
The Master Channel Unit has setting and control functions that apply to the song as a whole.

1 Port
1

2

This shows the output port number currently selected in the Mixer Window.This number is
the same as the port number (1-6) for the MIDI OUT device that is set in the System Setup
dialog (→P. XI-12).The MIDI data from each channel will be sent to the MIDI tone generator
corresponding to this number (1-6).
n You can’t set output ports for individual channels in the Mixer Window. Please note that if there are different
output devices set for each channel with the Port parameter in the Track View Window, you will not be able
use the Mixer Window to control the channels that have ports different than the one displayed here.To set
the output port used in the Mixer Window, see below.

2 EQ Hi/Lo Buttons

3

By clicking on either of these buttons, you can change the function of the EQ knobs. If you
click the Hi button, the EQ knob on each MIDI channel will be used for high frequency
control. If you click on the Lo button, the EQ knob on each MIDI channel will be used for
low frequency control.The button which is ON will display in blue.

3 Master Fader
By dragging this fader up and down, you can control the volume of the MIDI data as a
whole.
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Working with the Mixer Window
Mixer Setup
You can specify the output destination (MIDI OUT port) for the data that is controlled using the Mixer
Window.

1. Click on the Mixer Setup button on the toolbar to open the Mixer Setup dialog.

n The dialog can also be opened by clicking [Mixer Setup] in the [Setup] menu on the Application Window menu bar.

2. Click on the MIDI Output Port box, and select the output device from the drop-down list that is
displayed.

3. When necessary, click on the Assignable Control box, and select the type of control change you want
to assign to the faders from the drop-down list that is displayed.

n If you place a checkmark in the Play Monitor box by clicking it, the events contained in the song will be read during
playback, and the knobs and sliders will be moved in realtime. If you remove the checkmark, the events contained in the song
will not be read.

4. Click [OK].The dialog will close and the settings will become valid.The port number for the output

device you selected will be displayed in the Port box on the Master Channel Unit.The settings of the
Mixer Window controls will be reflected in the MIDI tone generator corresponding to the output
device that is set here.Also, the fader for each channel will work for the control change that was
assigned in the Mixer Setup dialog.
To cancel your settings before finishing them, click on [Cancel].The settings will be returned to their
original condition, and the dialog will close.

n You can also select the output device from the pop-up menu that will be displayed when you double-click the Port box on
the Master Channel Unit.

Operations and Display in the Mixer Window
During song playback, you can drag or click any of the knobs and faders, controlling things like the
volume or sound quality in realtime.When a particular button or knob is being operated (or while it is
functioning), it will be highlighted (lit up).
n When there is MIDI control change data in the MIDI data being played, the faders or knobs will automatically move, and the
voice program will automatically change. However, if you open the Mixer Window while the data is already playing, the Mixer
Window will display its initial settings until the next control change or similar event is transmitted. In this case the position of
the faders and knobs may be different than what you are actually hearing.
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Transmitting Parameters

1. With the song halted, set the needed parameter for each knob and fader by clicking or dragging with
the mouse.

2. Click the Transmit Mixer Parameter button on the toolbar.The current setting for each parameter in
the Mixer Window will be transmitted simultaneously for every channel to the tone generator.

Inserting Parameters
Normally, Mixer Window operations control the tone generator, but the actual MIDI data in the song is
not overwritten.To use the settings in the Mixer Window to actually change the MIDI data itself, the
settings must inserted as actual MIDI data, using the following procedure:

1. With the song halted, set the needed parameter for each knob and fader by clicking or dragging with
the mouse.

2. Click the Insert Mixer Parameter button on the toolbar.The Insert Setup dialog will open.

3. Set the number of the track where you want the parameter settings to be entered. Because the data
is entered separately for each channel, the number set here will be for the first track (channel 1)
where settings will be inserted.

4. Click [OK].The dialog will close and the current settings for each parameter in the Mixer Window

will be inserted separately for each channel into the start of each track.To cancel the operation, click
[Cancel].

Recording Parameters in Realtime.
The operations of each fader and knob in the Mixer Window can be recorded in real time. By doing this
you can create data that will automatically change the volume and effects when the song is played back.

1. Click the Record Mixer Parameter button on the toolbar. Realtime recording will start.
n An empty track for each channel will be automatically selected as the track for entering realtime recorded data.

2. Use the mouse to operate the faders and knobs as you adjust the tone, effects, and other parameters.
3. Click the Record Mixer Parameter button one more time to stop realtime recording. Each control’s
operation (the settings you made in realtime) will be recorded in the track for each channel.

Checking Values with the Status Bar
If you look at the Status Bar on the Application Window, you can check the functions or values associated
with the control under the mouse pointer.The contents of each display section are as follows. (These are
not shown during playback.)
Status Bar Left ........................The function of the control under the mouse pointer.
Status Bar Center ..................The current setting value (or function OFF/ON status) of the control under the
mouse pointer.
Status Bar Right ....................The voice name for the MIDI channel under the mouse pointer.
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Channel Pop-up Menu
If you click the right mouse button anywhere on a channel unit, a pop-up menu for the channel unit will
be displayed.You can select the needed command from this menu.

Initialize Channel Data ........Initialize the settings for the channel unit where you clicked.The initialize settings will
be as follows:
Pgm ................1
Eq ....................Center (zero position)
Rev ..................40 position
Cho, Var ........All the way left (zero postion)
Solo, Mute ......OFF
Pan ..................Center position
Volume ..........100
Properties ..............................Opens the Channel Properties dialog for the channel unit you clicked.

Channel Properties Dialog

Ch. No. (MIDI Channel Number) ..Displays the number of the channel where you clicked the right mouse button
and opened this properties dialog.
Program ....................................Displays the voice name for the MIDI channel that is currently displayed in the
Ch. No. box. In the MSB/LSB/Program No. spin boxes, the bank select MSB/LSB
numbers and the program number are displayed. See the voice list section of
the owner’s manual for your XG tone generator for the correct MSB/LSB
numbers and program number when selecting an XG voice.
n Since the numbers used for the program number (1-128) and the MIDI program change number (0-127) are each
different by one, be careful. In XGworks, don’t enter the MIDI program change number (0-127). Enter the program
number (1-128) instead.

Mute............................................ON or OFF for the Mute button is displayed. If there is a check mark, Mute is ON.
Solo ............................................ON or OFF for the Solo button (SL) is displayed. If there is a check mark, Solo is ON.
EQ Gain......................................The current Hi and Lo values set with the Eq knob are each displayed. (-64 to 0
to 63)
Reverb ........................................The current reverb depth value set with the Rev knob is displayed. (0 to 127)
Chorus ......................................The current chorus depth value set with the Cho knob is displayed. (0 to 127)
Variation ........................................The current variation effect depth value set with the Var knob is displayed. (0 to 127)
Pan..............................................The current pan value set with the Pan knob is displayed. (-64 (most left) to 0
(center) to 63 (most right))
AC (Assignable Controller) ..The current Control Change value set with the fader is displayed. (0 to 127)
Any of the values displayed in the Channel Properties dialog can be changed by clicking with the mouse or
typing from the computer keyboard.When values have been changed, clicking on [OK] will cause the properties
dialog to close and the changed values will immediately be applied in the Mixer Window. If you click [Apply], the
changed values will be applied in the Mixer Window without the dialog being closed. If you want to cancel
making changes, click [Cancel] and the dialog will close and the settings will be left as they originally were.
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Master Channel Pop-up Menu
If you click the right mouse button anywhere in the Master Channel Unit, the master channel pop-up
menu will be displayed.You can select the needed function from the menu.

Initialize Master Channel ....Initializes the settings for the Master Channel Unit. (The master volume will be set
at 127.)
Properties ..............................Opens the Master Channel Properties dialog.

Master Channel Properties Dialog

Master Volume....................The current volume value for the song as a whole, set with the Master Fader, is
displayed in a range of 0-127.
The value can be changed by clicking on the scroll buttons or typing from the computer keyboard. If the value
has been changed, clicking on [OK] will cause the properties dialog to close and the changed value will
immediately be applied as the Master Fader setting. If you click [Apply], the changed value will be applied as the
Master Fader setting without the dialog being closed. If you want to cancel making changes, click [Cancel] and
the dialog will close and the setting will be left as it originally was.

Working with the Computer Keyboard
You can also operate the controls using the computer keyboard.

1. You can use the <ß> <à> <á> <â> keys of the computer keyboard to select the control you

want to operate by moving the highlight for the controls up or down, left or right. However, you
can’t select the Solo or Mute buttons or the Hi/Lo buttons.

n By pressing the <Home> or <End> key, you can move the highlight between the Program Number Indicator for Channel 1
and the Master Fader, respectively. By pressing the <Tab> key, you can switch the highlight between currently selected
control in the Channel Unit section and the Master Fader.

2. By pressing the <Page Up> and <Page Down> keys, you can increase/decrease the value by 1.
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XG Editor Window
The XG Editor Window features a unique interface that arranges all the parameters for your XG tone
generator in an intuitive visual format.With it you have the power to tailor your sound exactly as you
like, because it gives you easy access to all the different settings for your XG tone generator’s voices and
effects.
Variation Unit

Insertion 1 Unit

Insertion 2 Unit

Title Bar
Toolbar

Part Unit

Reverb Unit

Chorus Unit
System Variation Unit

System Unit

Drum Unit

Equalizer Unit

●

Units that correspond to every type of parameter in your XG tone generator are arranged in an easy-tograsp visual layout.

●

The Part Unit displays the voice names for each XG tone generator part, together with the insertion
effects, drum setups and other settings assigned to them. Here you can also edit the voice assigned to each
part. If you are using an optional plug-in board (PLG100 series), settings for that board will also be
supported.

●

In the System Unit, you can set the system parameters of your XG tone generator.

●

The Drum Unit gives you control of the parameters for drum setups, and lets you assign them to any part.

●

In the Insertion 1 and 2 Units, you can set the parameters for Insertion Effects, and assign them to any
part.

●

The Variation Unit is handy when you are using Variation effects as Insertion Effects.You can set the
parameters for Variation effects, and assign them to any part.

●

In the Chorus and Reverb Units, you can set the parameters for Chorus and Reverb effects. Since they are
both System Effects, the settings made here will be reflected in all the parts of the XG tone generator.

●

The System Variation Unit is really useful when you are using Variation effects as System Effects.You can
set the parameters for Variation effects.

●

With the Equalizer Unit you can set equalizer parameters and adjust the overall tone of your XG tone
generator.

●

The settings you make in the XG Editor Window can be sent through MIDI to the XG tone generator.

●

With the XG Editor Window, you can either enter your settings at the beginning of the song as setup data,
or you can add them as events midway through the song.

●

Operation in the XG Editor can also be recorded in realtime.This is especially useful because you can
create data that automatically changes the sound and effects while the song is playing back.

●

XG event settings that have already been entered into the song can be read into the XG Editor Window
and edited there.

●

You can save your XG Editor Window settings separately from the song data in a special XG parameter file
(extension .SYX).

X-1

XGw3/E10.QX

2/1/99

5:11 PM

Page 2

System and Insertion Effects
To make the most of the XG Editor Window, we recommend that you understand something of the basic
setup for effects in an XG tone generator. We’ll begin with a simple explanation of System Effects and
Insertion Effects.
System Effects are applied equally to all of the XG tone generator parts (channels). They are effects, like
Reverb, that are used to determine the overall atmosphere of the song. Actually, by changing the effect
send level for each part, you can adjust the depth of the effect for each part.
Insertion Effects are applied exclusively to a specific part (channel), or a voice. As in the diagram, they
are used in cases such as giving the organ part a rotary speaker effect, and the guitar part an Auto Wah
effect.
Signal Flow
XG Tone Generator
Insertion Effect
Part 1
Part 2
Part 3
Part 4
•
•
•
Part 16

Piano
Organ
Guitar
Bass
•
•
•
Strings

System Effect

Speakers
OUT L

Rotary Speaker
Auto Wah
Reverb, etc.
OUT R

In the XG Editor Window, you can use the Reverb Unit and the Chorus Unit for System Effects, and the
Insertion 1 Unit and Insertion 2 Unit for Insertion Effects. Besides them, there is the Variation Effect Unit
that can be used for either System or Insertion Effects, depending on your purpose.
n For details about the XG tone generator, see the owner’s manual that came with the XG tone generator you are using. Your
XG tone generator might not be compatible with some of the parameters in the XG Editor Window. For information on
which parameters are compatible with it, see the MIDI data format in its owner’s manual.

How to Open the XG Editor Window
Opening Method (A)
Click on the XG Editor Window button on the Application Window Toolbar.

Opening Method (B)
Click on the [Window] menu in the Menu Bar of the Application Window, then select [XG Editor] from
the pull down menu.
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The Name and Function of Every Part
Title Bar
On the Title Bar, there are the Application icon and the Minimize, Maximize and Close buttons. For
details, see page XI-1.

Toolbar
Buttons for executing a variety of functions, such as XG Editor Setup, are provided on the toolbar.
1 2 34 5 6 78

9)

1 Open button
Clicking this button will display the [Open] file dialog, where you can select a saved XG parameter file
and open it in the XG Editor Window.This dialog is used in the same way as the [Open] dialog explained
later (→P. XI-3).
n In the File of type box, you can select either .XGP or .SYX files.The .XGP file type was the file format used in XGworks up to
version 2.0.

2 Save button
Clicking this button opens the [Save As] dialog.The settings made in the XG Editor Window can be saved
as an XG parameter file.This dialog is used in the same way as the [Save As] dialog explained later
(→P. XI-4).
n Only the .SYX file type can be selected. From XGworks version 3.0 and later, all XG parameter files will be saved in the .SYX
file format.The .XGP file format cannot be saved.

3 XG Editor Setup button
Clicking this button will open the XG Editor Setup dialog. Settings can be made for the XG Editor
Window controls. For details see page X-28.

4 Model Setup button
Clicking this button will open the Model Setup dialog. It is used to set up the tone generator that will be
controlled with the XG Editor Window. For details see page X-27.

5 Transmit XG System On button
Clicking this button will transmit XG system On data (a message that switches the XG tone generator
into XG mode) to the connected XG tone generator.

6 Transmit XG Parameter button
Clicking this button will transmit settings made in the XG Editor Window to the connected XG tone
generator.

7 Receive XG Bulk button
Clicking this button will open the Receive XG Bulk dialog.This function gathers together settings made
in the connected XG tone generator and receives them in bulk into the XG Editor Window. For details
see page X-31.

8 Load XG Parameter button
Clicking this button will open the Load XG Parameter dialog. Using this dialog, you can extract XG event
settings that have been entered into the currently open song, and have them displayed in the XG Editor
Window. For details see page X-31.

9 Insert XG Parameter button
Clicking this button will open the Insert XG Parameter dialog. Using this dialog you can insert the
current value for any parameter in the XG Editor Window into your song as a system exclusive data
event. For details see page X-30.
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) XG Parameter Realtime Recording button
You can record in realtime the operation of each control in the XG Editor Window. For details see page
X-32.
n These functions can also be executed from the [Edit] menu or [Setup] menu on the Application Window menu bar.

Part Unit
In the Part Unit, you can set voices, and assign Variation Unit, Insertion 1 Unit, Insertion 2 Unit, Drum
Unit or Plug-in settings to any part. By clicking the [DETAIL] button, you can make precise settings and
do detailed voice editing for each part.
2 9
1

3
!

4

6 8 )
5 7

1 [1-16], [17-32], [33-48], [49-64], [A/D (or AUDIO)] tabs
Clicking on any of the tabs changes the parts that are displayed.The parts 1-16, 17-32, 33-48, and 49-64
indicate MIDI Multi Parts.The A/D parts indicate the external audio input parts of the XG tone generator.
The AUDIO parts indicate the audio parts for the SW1000XG sound card.
n The number of parts that you can use in your XG tone generator may be different.The XG tone generator you will be using
should be selected beforehand in the Model Setup dialog (→P. X-27).

2 Plug-in icons
This shows the plug-in boards (PLG100 series) that are currently available for use.You can drag-and-drop
these icons into Part Unit and assign the functions of those plug-in boards to any desired part.

3 Part
The part numbers are shown here.

4 Voice
The voice for every part is displayed here. By double-clicking on any of the voice names, you can open a
Voice List dialog and select which voice to set for each part.
n For information about the Voice List dialog, see page I-11.

With AUDIO parts, if you double-click on the effects display in the voice column (left side display) the
voice list dialog will be opened.There you can select the effects that will be applied to each AUDIO part.
n The AUDIO parts will be displayed if SW100XG is selected in the Model Setup dialog (→P. X-27).

If you double-click the category display (right hand side) of the voice column for AUDIO parts, the Audio
Input Category dialog will be displayed.There you can set up the audio part category.
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Audio Input Category Dialog

Category
For each of the parts 1 to 16 displayed in the Part Unit, select the category of the audio signal to be sent to the
sound card. By clicking the up and down scroll buttons, you can select from categories such as Off,Analog, or
PCI.
When using the SW1000XG sound card, select Analog or PCI.Analog is used when an audio signal from the
external audio input (A/D input) terminal of the SW1000XG sound card is input to the SW1000XG Mixer. PCI is
used when an audio signal from an XGworks WAVE track is input to the SW1000XG Mixer.
Serial Number
Select the part number for the category of audio signal that was selected in the Category box. Click the up and
down scroll buttons, and select a number from 1 to 128. Make the settings as follows when using the SW1000XG
sound card:
When “Analog” is selected for the category, select 1 or 2.This is because a maximum of two external audio input
parts can be received by the SW1000XG sound card.
When “PCI” is selected for the category, select it in the range of 1 to 12.This is because XGworks wave track data
can be sent to the SW1000XG sound card’s maximum of 12 audio parts.
After setting up each item, click [OK].The dialog will close and the settings will take effect. If you want to cancel
the operation, click on [Cancel].The dialog will close, and the settings will return to their original state. If you
click [Default], the Category and Serial Number for the parts will return to the default settings.
n Use the default settings whenever possible.When the default settings are selected, Part 1 will be 1 of Analog, Part 2 will

be 2 of Analog, Part 3 will be 1 of PCI, Part 4 will be 2 of PCI, continuing until Part 14 is part 12 of PCI. (Part 15 and 16
will be OFF.)
n If settings besides the default ones are made, it will no longer be possible to correctly control volume and stereo balance

for the parts with the Windows standard mixer (the “Volume Control” activated by double-clicking on the speaker icon
on the task bar).
n For any category, settings besides “Analog” and “PCI” can be selected. However, since these selections were added for the

sake of keeping capability with future devices that have many types of audio parts, there is no ordinary need to select
them.
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5 V (Variation)
A “V” icon will be displayed in the box here for the part that has been assigned the Variation Effects that
are set in the Variation Unit.
n You can assign Variation Effects to any single part, but only when using Variation Effects as an Insertion Effect. For information
about Insertion Effects, see page X-2.

6 i1 (Insertion 1)
An “i1” icon will be displayed in the box here for the part that has been assigned the Insertion Effects
that are set in the Insertion 1 Unit.
n Depending on the XG tone generator you are using, it may not be compatible with Insertion 1 effects.

7 i2 (Insertion 2)
An “i2” icon will be displayed in the box here for the part that has been assigned the Insertion Effects
that are set in the Insertion 2 Unit.
n Depending on the XG tone generator you are using, it may not be compatible with Insertion 2 effects.

8 Dr (Drum)
A “Dr” icon will be displayed in the box here for each part that has been assigned a drum setup that is
set in the Drum Unit.

9 PLG
Plug-in icons are displayed in the part boxes for parts that have plug-in board (PLG100 series) functions
assigned to them. Double-clicking on these icons opens each plug-in board's editor.
n Plug-in board (PLG100 series) editors must be installed before they can be opened.
n To learn how to assign the settings from each unit to the parts, see page X-29.

) DETAIL Button
Click here and the Part Properties dialog will open.The parameters you can set with this dialog will
differ according to whether the MIDI Multi Parts (1-64) or A/D (or AUDIO) Parts has been selected.
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Multi Part Properties Dialog
With any of the parts from 1 to 64 selected by clicking with the mouse (the Voice column of the part will be
yellow), click on the Detail button and the properties dialog will open for the selected part.The Multi Part
Properties dialog has two screens: the Detail screen where you can make detailed settings for each parameter,
and the Quick Edit screen, where settings can be made quickly in a graphical format.The Detail screen will
display if “Detail” is selected as the display mode in the [XG Editor Setup] item on the [Setup] menu.The Quick
Edit screen will display if “Quick” is selected.

● Detail Screen
You can set every parameter for each part in the XG tone generator’s MIDI Parameter Change Table (MULTI
PART). For information about the MIDI Parameter Change Table (MULTI PART), see the MIDI data format in the
owner’s manual for your XG tone generator.

1. Select the page for the parameter item you want to set by clicking on an item name tab at the very top of
the dialog.

2. By dragging the slider for each item right and left or by clicking on radio buttons, you can set each
parameter.You can also enter settings by clicking the box to the left of each slider and typing directly from
the computer keyboard.
n For information about each parameter item page, see below.

3. When necessary, click on another item tab to switch to setting different parameter items.
4. When you click on the close button [X] at the upper-right of the window, the dialog will close and
parameter setting for the selected part will be finished.
n If you click the right mouse button over any box, an edit pop-up menu will appear which will allow you to do things
like copy or delete values.

The Parameter Items pages listed below are in the Multi Part Detail screen. For details about setting values for
each parameter, see the MIDI Parameter Change Table (MULTI PART) in the owner’s manual that came with your
XG tone generator.

General ..................................................For making general settings such as voice selection, MIDI receive
channel settings, note limit (note range), and velocity sensitivity.
Pitch, Level ............................................For making settings such as each part’s note shift and volume, also effect
send level,vibrato and portamento.
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Filter, EG (Envelope Generator) ........For making settings such as sound brightness and shape (how the sound
changes from the start until it fades).
EQ (Equalizer) ......................................For setting the tone.
MW, Bend (Modulation, Pitch Bend)........For setting modulation wheel and pitch bend effects.
AT (After Touch) ..................................For setting after touch effects.“CAT” refers to channel after touch, and
“PAT” refers to polyphonic after touch.
AC1, AC2 (Assignable Controller 1, 2)......For settings associated with assignable controller functions.
Scale ........................................................For scale tuning settings.
Rcv ..........................................................For setting whether or not each channel message will be received.
VL-1, VL2 ................................................This is used for setting the unique Multi Part parameters for VL-VG
voices. Details are written in the owner’s manuals for VL-XG compatible
tone generators (such as VL70-m or PLG100-VL). See the Current
Voice/Common Part Parameter or Multi Part Parameter information in
the MIDI data format section.

● Quick Edit Screen
A set of basic parameters in the MIDI Parameter Change table (MULTI PART) for the XG tone generator can be
graphically set using this screen.

1 Part No. (Part Number)
The number for the part that is currently the target for editing is displayed.At first, the number for the part that
was selected when the Quick Edit screen was opened will be displayed.The part that is the target for editing can
be switched using the buttons marked BLOCK A-D and the PART 1 through 16 buttons immediately to the right
of the part number.

2 BLOCK/PART buttons
By combining these two types of buttons, you can switch between parts 1 through 64, and select the part you
will be editing. BLOCK A/PART 1-16 correspond to parts 1-16, BLOCK B/PART 1-16 to parts 17-32, BLOCK
C/PART 1-16 to parts 33-48, and BLOCK D/PART 1-16 to parts 49-64.

3 DETAIL button
Clicking the DETAIL button switches to the DETAIL screen, where you can do more detailed editing.

4 VOICE LIST button
Clicking here displays the Voice List dialog.You can change the voice for the selected part.The selected voice
name will be displayed in the voice name display box below the keyboard display.
n To learn how to use the Voice List dialog, see page I-11.
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5 POLY/MONO
When [POLY] is clicked, the system will enter poly mode, and performance with chords will be possible.
Clicking [MONO] enters mono mode, and only monophonic performance will be possible. Use this mode for
situations such as when portamento is applied to the synth lead.

6 Keyboard button
By clicking or dragging the keyboard buttons you can monitor the results of your editing.You can raise and
lower the pitch of the keyboard buttons by right-clicking on the keyboard and selecting [Octave Up] or [Octave
Down] from the pop-up menu that is displayed. Clicking [Default] will return the keyboard to its original pitch.

7 Voice Name display
This box displays the name of the currently selected voice.

8 Volume/Pan sliders
You can adjust the volume and orientation of the voice for this part by dragging the appropriate slider with the
mouse.The current value is displayed in the box to the left of the slider.You can also set the value by typing
directly into this box.

9 Preset Data Icon Setup box
You can set the voice for the part you are currently editing by dragging and dropping one of the preset data
icons from below into the Preset Data Icon Setup box.

) Preset Data
A wide variety of voices are available here as icons. In the Quick Edit screen, you can set any desired voice by
simply dragging and dropping its icon into the setup box immediately above.
n Using the scroll bar below the preset data box, you can display preset icons that are not currently visible.

! Vibrato graph
The vibrato graph is used to set the quality of vibrato applied to the part. By dragging the square mark on the
left horizontally, you can set the interval between the time when the sound itself starts and the time when the
vibrato is applied (Vibrato Delay). Dragging the center square mark vertically lets you set the degree of change in
pitch caused by vibrato (Vibrato Depth). By dragging the right-hand mark horizontally, you set the length of one
cycle of the vibrato effect (Vibrato Rate).

@ 2 band-EQ (Equalizer) graph
This sets the tonal quality of the sound.The low sounds (Bass) are set with the square mark on the left.The high
sounds (Treble) are set with the square mark on the right. By dragging each of these square marks sideways the
frequency can be specified. Dragging them up and down sets the gain within the specified frequency.

# EG (Envelope Generator) graph
EG sets the way in which the sound is output (the way the sound is modified from start until it fades away).
Dragging the square mark on the left horizontally sets the time in which the note rises to its fullest sound (EG
Attack Time). Dragging the center square mark horizontally sets how the note is sustained while the key is held
down (EG Decay Time). Dragging the square mark on the right horizontally sets the way in which the sound
fades away after the key is released (EG Release Time).

$ Filter graph
The filter graph sets the brightness and character of the sound. By dragging the mark horizontally, you can
change the value of the cutoff frequency (Low Pass Filter Cutoff Frequency), which establishes the brightness of
the sound. Dragging the mark upward raises the volume of the frequencies around the cutoff frequency, adding
overtones (Resonance).This gives an effect like an analog synthesizer to the sound.

% Pitch EG (Pitch Envelope Generator) graph
This sets the change in pitch of the note from the time it starts until it fades away.The square mark of the left is
the setting for when the note starts.The square mark on the right is the setting for the time from when the key
is released until the note fades away. By dragging each square mark horizontally, you can set the time in which
the pitch changes (Attack and Release Time). Dragging the marks vertically sets the amount of change in pitch
(Initial and Release Level).
n On each graph described above the setting of the square mark (green) is relative to the initial value (gray) in the preset
voice.

^ SYSTEM DETAIL
When this is clicked it opens the System Parameter dialog.
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& EQ DETAIL (Equalizer Detail)
When this is clicked it opens the EQ dialog.

* INSERTION EFFECT
This displays the insertion effects set for the part that is currently being edited.When the indicator to the side of
each box is lit, it indicates that the effect is being assigned to the part. Clicking on one of the DETAIL buttons
will open the Quick Edit screen for that effect.

( To System Effect
This sets the send level for each system effect from this part. It can be adjusted by dragging the sliders for Dry,
Rev Send (reverb send), Cho Send (chorus send), and Var Send (variation effect send), or by clicking the boxes
and directly entering a number from the computer keyboard.
If you are using the current variation effect as an insertion effect, it will be displayed in reverse and cannot be
used. Clicking on one of the DETAIL buttons will open the Quick Edit screen for that effect.
n You can do things like copying or deleting values by clicking on one of the boxes with the right button of the mouse
and using the pop-up edit menu that is displayed.

When you click on the close button [X] at the upper-right of the window, the dialog will close and parameter
setting will be finished.

A/D or AUDIO Part Properties Dialog
With any of the A/D or AUDIO parts in the Part Unit selected by clicking with the mouse (the Voice column of
the A/D or AUDIO part will be yellow), click on the Detail button and the properties dialog will open for the
selected A/D or AUDIO part.You can set every parameter in the XG tone generator’s MIDI Parameter Change
Table (A/D PART or AUDIO PART). For information about the MIDI Parameter Change Table (A/D PART or AUDIO
PART), see the MIDI data format in the owner’s manual for your XG tone generator.
n If your XG tone generator doesn’t have an A/D Input function, you won’t be able to control your XG tone generator
with these parameters.

1. By dragging the slider for each item right and left or by clicking on radio buttons, you can set each parameter.You
can also enter settings by clicking the box to the left of each slider and typing directly from the computer keyboard.

2. When you click on the close button [X] at the upper-right of the window, the dialog will close and
parameter setting for the selected A/D part will be finished.
n If you click the right mouse button over any box, an edit pop-up menu will appear which will allow you to do things
like copy or delete values.
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! Assignable Sliders/Buttons
By assigning any desired parameters in the Part Unit to sliders or buttons, you can control those
parameters for each part. Dragging the slider to the right will increase the value of the parameter
assigned to the slider. Dragging it to the left will make the value smaller. Clicking on a button to the left
side of the sliders will switch between ON and OFF for the parameter assigned to the button. (When the
button is green, the parameter is ON, when the button is black, the parameter is OFF.) You can switch
between the parameters that are assigned to the sliders and buttons by clicking one of the four switches
to the right of the sliders.
To assign parameters to each of the four switches, use the XG Editor Assignable Setup dialog that can be
opened by clicking on the [ASSIGN] button.

XG Editor Assignable Setup
Up to four pairs of parameters can be set up for the assignable sliders and buttons. Click on the [ASSIGN] button
located above the Preset 1-4 switches, and the dialog box shown below will be displayed.

n You can also open this dialog box by selecting [XG Editor Assignable Setup] item on the [Setup] menu.

[Part 1-64] and [A/D (or AUDIO)] Tabs
Clicking on these tabs lets you switch between assigning parameters to Multi Part or A/D (AUDIO) Part.
Preset Name
You can type in names here to fit the pair of parameters you have assigned to each assignable slider and button.
The names you type will be shown on the four switches to the right of the assignable sliders.
Button
Select the parameters to assign to the assignable buttons.
Slider
Select the parameters to assign to the assignable sliders.
After setting up each item by clicking and typing, click [OK].The dialog will close and the changes you made
will be applied. If you want to cancel your changes, click on [Cancel].The dialog will close, and the settings will
remain unchanged.
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System Unit
This is used for setting system parameters for the XG tone generator. By dragging the VOL (volume),
TUNE, and KEY knobs and rotating them, you can make volume, tune and key settings for the entire XG
tone generator.You can also enter values by clicking on a box, then typing directly from the computer
keyboard.When you want to make more detailed settings, you can do it by clicking on the [DETAIL]
button and opening the System Parameter dialog.
n If you click the right mouse button over any box, an edit pop-up menu will appear which will allow you to do things like
copy or delete values.

The parameters for the System Unit are as follows:
4

1

2

3

1 VOL Knob
Sets the volume for the entire system (master volume).

2 TUNE Knob
Sets the pitch (tuning) for the entire system in 0.1 cent units. If +100 is set, the entire system’s pitch will
rise by one semitone.

3 KEY Knob
Sets the pitch for the entire system by semitones. If +12 is set, the entire system’s pitch will rise by one
octave.

4 DETAIL Button
Click here and the System Parameter dialog will open.

System Parameter Dialog
You can set the parameters in the XG tone generator’s MIDI Parameter Change Table (SYSTEM). For information
about the MIDI Parameter Change Table (SYSTEM), see the MIDI data format in the owner’s manual for your XG
tone generator.

1. By dragging the slider for each item right and left, you can change the settings in each box.You can also
enter settings by typing directly from the computer keyboard.

2. Click on the close button [X] at the upper-right of the window.The dialog will close and parameter setting
will be finished.

n The Master Tune, Master Volume and Transpose settings made in the System Parameter Dialog will be reflected in the
TUNE,VOL, and KEY displays in the System Unit.
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Drum Unit
Used to set parameters for Drum Setups.The parameters settings made here can be assigned to any part
(that is being used as a drum part).
3
1
2

1 SETUP
The currently selected Drum Setup is displayed. Click on the box and a drop-down list will appear.You
can select the drum setup you want to use from the list.
n The number of drum setups you can select will depend on your XG tone generator.

2 Dr Icon
By dragging this icon to the part unit and dropping it, the drum setup currently displayed in the SETUP
box can be assigned to any part.You can assign multiple parts by repeating the drag and drop operation.
n The icon (Dr or D1 to D4) displayed on the part unit will vary according to the setup (Drum or Drum S1 to S4) selected in
SETUP.

3 DETAIL Button
When Drum S1-S4 are selected in the SETUP box, click here and the Drum Properties dialog will open.

Drum Properties Dialog
The Drum Properties dialog has two screens: the Detail screen where you can make detailed settings for each
parameter, and the Quick Edit screen, where settings can be made quickly in a graphical format.The Detail
screen will display if “Detail” is selected as the display mode in the [XG Editor Setup] item on the [Setup] menu.
The Quick Edit screen will display if “Quick” is selected.

● Detail Screen
You can set parameters in the XG tone generator’s MIDI Parameter Change table (DRUM SETUP). By clicking on
the Drum-P1 and Drum-P2 tabs, you can change pages. For information about the MIDI Parameter Change table
(DRUM SETUP), see the MIDI data format in the owner’s manual for your XG tone generator.

1. Select the page clicking on one of the two tabs at the very top of the dialog.
2. Click on the instrument name box at the top of the parameters, and select the name of the rhythm
instrument you want to edit from the drop-down list that will be displayed.

3. By dragging the slider for each item right and left or by clicking on radio buttons, you can set each
parameter.You can also enter settings by clicking the box to the left of each slider and typing directly from
the computer keyboard.

4. Repeat steps 1, 2, 3 above as needed to set the parameters for other rhythm instruments.
5. When you click on the close button [X] at the upper-right of the window, the dialog will close and
parameter setting will be finished.
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● Quick Edit Screen
A set of basic parameters in the MIDI Parameter Change table (DRUM SETUP) for the XG tone generator can be
set graphically using this screen.
Graph Display

1

List Display

2 1
3
4

2

8

5

6
7

6
7

1 SETUP 1-4 Tab
Clicking one of these tabs selects the drum setup (1-4) that will be the target for editing.

2 VIEW/LIST button
Clicking the VIEW button changes to the Graph Display screen. Clicking the LIST button changes to the List
Display screen. On the Graph Display screen, parameters for the single currently specified rhythm instrument are
displayed graphically. In the List Display screen, parameters for multiple rhythm instruments are displayed as
numerical values.

3 Rhythm Instrument Name
This box displays the note number and name of the rhythm instrument that is currently selected as the target for
editing.

4 Keyboard
Clicking one of the keys on the keyboard causes the rhythm instrument assigned to the key to be selected as the
target for editing.The settings for the currently selected rhythm instrument will be displayed graphically below.
n The note name for each key is displayed when the mouse pointer is moved above the keys.
n The rhythm instrument for each key (note number) varies according to the drum kit. For details, see the XG drum voice
list in the owner's manual for the XG tone generator you are using.

5 Graph
Among the drum setup parameters, settings for the following are displayed here graphically: Pitch (Coarse, Fine),
Low Pass Filter (Cutoff Frequency, Resonance), EG Rate (Attack, Decay 1/2), and Output (Level, Pan).The settings
for the parameters can be changed by dragging the square marks.
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Pitch: This sets the tuning.When you drag the lower mark sideways, you can set the pitch in semitone units
(Coarse). Dragging the upper square mark sideways fine-tunes the pitch already set in semitone units (Fine).
Low Pass Filter: This sets the brightness and character of the sound. By dragging the square mark horizontally,
you can change the value of the cutoff frequency (Low Pass Filter Cutoff Frequency), setting the brightness of
the sound. Dragging the mark upward raises the volume of the frequencies around the cutoff frequency, adding
overtones (Resonance).This gives character to the sound.
EG Rate: This sets the way in which the sound is output (the change in the sound from its start until it fades
away). Dragging the square mark on the left horizontally sets the time in which the note rises to its fullest sound
(EG Attack Rate). By dragging the center mark horizontally, you can set the way the sound fades away (EG Decay
Rate 1). By dragging the right-hand mark horizontally, you can set EG Decay Rate 2.
Output: This sets the volume and the right and left orientation (pan). By dragging the mark horizontally, you can
set the pan. Dragging it vertically will set the volume.
n The setting of each square mark (green) is relative to the initial value (gray) in the preset voice.

6 Drum Set Illustration
The Drum Set Illustration is used for selecting the rhythm instrument that will be the target for editing.When
you are using the List Display screen, clicking on one of the rhythm instruments in the illustration will make the
cursor on the parameter list move to the rhythm instrument that was clicked. In the Graph Display screen, the
current settings for the selected rhythm instrument will be displayed on the graphs.
n When you click the picture of a rhythm instrument in the illustration, the instrument's sound will play. Since the sound
you hear reflects the settings currently made on the Quick Edit screen, you can use it to monitor the results of your
editing efforts.

7 Kit Name
The name of the currently selected drum kit is displayed here.To change the kit, go to the part in the Part Unit
that was assigned with the Drum Setup, and change the drum voice there.

8 Parameter List
The parameter list shows the current status of all the drum settings. In the NOTE column on the left is displayed
the note number. Next to it in the INST NAME column is the name of the rhythm instrument that corresponds to
that note.You can change the order of the note numbers by dragging them up and down. By clicking the name
of the rhythm instrument, you can listen to it. Since the sound you hear when you click on the instrument
reflects the settings currently made on the Quick Edit screen, you can use it to monitor the results of your
editing efforts.
n The rhythm instrument that corresponds to each note number will vary for each drum kit. For details, see the XG drum
voice list in the owner's manual for the XG tone generator you are using.

The parameter names for the drum setup are displayed along the top row of the list. See the MIDI Parameter
Change Table (DRUM SETUP) in the MIDI Data Format section of the owner's manual for your XG tone
generator.
When you double-click on a setting, a spin box will appear. Clicking on the up and down control buttons lets
you adjust the value for that parameter.
Among the drum setup parameters, the ones for Pitch (Coarse, Fine), Output (Level, Pan), Low Pass Filter (Cutoff
Frequency, Resonance), and EG Rate (Attack, Decay 1/2) are displayed graphically in the lower left area of the
List Display screen, the same as in the Graph Display screen. Settings for the parameters in the list can be
changed by dragging the square marks on the graph.You can change the graph that is displayed by clicking in
the parameter list on the setting for Pitch (P.Co, P.Fi), Output (Levl, Pan), Low Pass Filter (LF.Cut, LF.Res), or EG
Rate (Attk, Dec1, Dec2).
When you click on the close button [X] at the upper-right of the window, the dialog will close and parameter
setting will be finished.

X-15

XGw3/E10.QX

2/1/99

5:11 PM

Page 16

Insertion 1 Unit
Used for setting parameters for Insertion Effect 1.The parameters set here can be assigned to any single
part.
3
1
2

1 Effect Type
The currently selected Insertion Effect 1 type is displayed. Click on the box and a drop-down list will
appear.You can select the effect type you want to use from the list.
n Depending on the XG tone generator you are using, it may not be compatible with Insertion 1 effects. Please refer to the
effect type list in the owner’s manual for your XG tone generator.

2 i1 Icon
By dragging this icon to the part unit and dropping it, the currently selected effect can be assigned as an
Insertion Effect to any single part.

3 DETAIL Button
Click here and the Insertion dialog will open.

Insertion Dialog
Two different screens are available in the Insertion dialog: a Detail screen where settings for each parameter can
be made very precisely, and a Quick Edit screen where you can set the parameters quickly and simply.The Detail
screen will display if “Detail” is selected as the display mode in the [XG Editor Setup] item on the [Setup] menu.
The Quick Edit screen will display if “Quick” is selected.

● Detail Screen
You can set many different parameters for Insertion Effect 1.

1. Click on the Type box at the top of the parameters, and a drop-down list will be displayed. Select the effect
type you want to edit from the list.

2. By dragging the slider for each item right and left, you can change the parameter value in each box.You can
also click on the box and enter settings by typing directly from the computer keyboard.

3. When you click on the close button [X] at the upper-right of the window, the dialog will close and
parameter setting will be finished.
n The parameters you can set will vary depending on the effect type. For information on each effect type and its
parameters, see the effect type list and effect parameter list in the owner’s manual that came with your XG tone
generator.

X-16

XGw3/E10.QX

2/1/99

5:11 PM

Page 17

● Quick Edit Screen
Several of the parameters for Insertion Effect 1 can be graphically set on the Quick Edit Screen.

1 Effect Type
This displays the type of effect that is currently the target for making settings.To change the effect type
displayed here, click on the box and select the effect category you desire from the drop-down list that is
displayed.A sub-menu for that category will be displayed, and there you can choose the effect type you want.

2 Graph
The parameters for the effect currently selected will be displayed graphically on the screen.You can change the
parameter settings by dragging the square mark in the graph.The type of graph will vary according to the effect
you have selected, but regardless of the parameter you are working on, the graph has been designed to let you
work more intuitively than you could if you were just setting numerical values.
n In the graphs explained above, the value of the mark setting is expressed relative to the initial value.

3 DETAIL button
Clicking the DETAIL button opens the detail screen.
h The Detail screen and the Quick Edit screen are linked to each other, so that settings made in either screen will be
reflected immediately on the other. If you make settings with both screens open at the same time, you can make use of
the best features of both screens and work more efficiently.

4 PART
This box displays the currently assigned part for this insertion effect. If you drag the slider below the display
box, you can change to another part.

5 DRY/WET
This sets the balance between dry and wet signals. It may not be available for use in some cases, depending on
the effect type you have selected.

6 FEEDBACK LEVEL
This sets the level at which the signal output from the unit is returned to the unit as feedback. By adjusting the
feedback level, you can create oscillation and resonance effects.This function may not be available for use in
some cases, depending on the effect type you have selected.
When you click on the close button [X] at the upper-right of the window, the dialog will close and parameter
setting will be finished.
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Insertion 2 Unit
Used for setting parameters for Insertion Effect 2.
The functions and operations of the Insertion 2 Unit are the same as Insertion 1 Unit. See above.
n Depending on the XG tone generator you are using, it may not be compatible with Insertion 2 effects. Please refer to the
effect type list in the owner’s manual for your XG tone generator.

Variation Unit
Used to set effect parameters for Variation Effects when they will be used as Insertion Effects and
assigned to one of the parts.
n You can use the Variation Unit when the [INS] button on the System Variation Unit is ON.When the Variation Unit is gray and
can’t be used, click on the [INS] button on the System Variation Unit to turn it ON . (It will light up.)

3

INS button

1
2

1 Effect Type
The currently selected Variation Effect type is displayed. Click on the box and a drop-down list will
appear.You can select the effect type you want to use from the list.
n For information about which effect types can be selected, see the effect type list in the owner’s manual that came with your
XG tone generator.

2 V Icon
By dragging this icon to the part unit and dropping it, the currently selected Variation Effect can be
assigned as an Insertion Effect to one part.

3 DETAIL Button
Click here and the Variation dialog will open.

Variation Dialog
Two different screens are available in the Variation dialog: a Detail screen where settings for each parameter can
be made very precisely, and a Quick Edit screen where you can set the parameters quickly and simply.The Detail
screen will display if “Detail” is selected as the display mode in the [XG Editor Setup] item on the [Setup] menu.
The Quick Edit screen will display if “Quick” is selected.

● Detail Screen
You can set many different parameters for Variation Effects.

1. Click on the Type box at the top of the parameters, and a drop-down list will be displayed. Select the effect
type you want to edit from the list.

2. By dragging the slider for each item right and left, you can change the parameter value in each box.You can
also click on the box and enter settings by typing directly from the computer keyboard.

3. When you click on the close button [X] at the upper-right of the window, the dialog will close and
parameter setting will be finished.
n The parameters you can set will vary depending on the effect type. For information on each effect type and its
parameters, see the effect type list and effect parameter list in the owner’s manual that came with your XG tone
generator.
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● Quick Edit Screen
Several of the parameters for Variation Effect can be graphically set on the Quick Edit Screen.

n Items 9 through @ will be displayed only when item 5 (the SYS button) or the DETAIL button on the System Variation
Unit (→P. X-21) has been clicked.

1 Effect Type
This displays the type of effect that is currently the target for making settings.To change the effect type
displayed here, click on the box and select the effect category you desire from the drop-down list that is
displayed.A sub-menu for that category will be displayed where you can choose the effect type you want.

2 Graph
The parameters for the effect currently selected will be displayed graphically on the screen.You can change the
parameter settings by dragging the square mark in the graph.The type of graph will vary according to the effect
you have selected, but regardless of the parameter you are working on, the graph has been designed to let you
work more intuitively than you could if you were just setting numerical values.
n In the graphs explained above, the value of the mark setting is expressed relative to the initial value.

3 DETAIL button
Clicking the DETAIL button opens the detail screen.
h The Detail screen and the Quick Edit screen are linked to each other, so that settings made in either screen will be
reflected immediately on the other. If you make settings with both screens open at the same time, you can make use of
the best features of both screens and work more efficiently.

4 INS (Insertion) button
When you click this button and turn it on, variation effects will be used as insertion effects.You will not be able
to use them as system effects.The layout of some parameters will be changed, and parameters for insertion
effects will be set.

5 SYS (System) button
When you click this button and turn it on, variation effects will be used as system effects.You will not be able to
use them as insertion effects.The layout of some parameters will be changed, and parameters for system effects
will be set.

X-19

XGw3/E10.QX

2/1/99

5:12 PM

Page 20

6 PART
This box displays the currently assigned part for this variation effect. If you drag the slider below the display
box, you can change to another part.This can only be set when variation effects are being used as insertion
effects.

7 DRY/WET
This sets the balance between dry and wet signals.This can only be set when variation effects are being used as
insertion effects. It may not be available for use in some cases, depending on the effect type you have selected.

8 FEEDBACK LEVEL
This sets the level at which the signal that is output from the unit is returned to the unit as feedback. By
adjusting the feedback level, you can create oscillation and resonance effects.This function may not be available
for use in some cases, depending on the effect type you have selected.

9 RETURN
RETURN sets the return level when you are using variation effects as system effects.The return level that applies
to the variation send from each part is adjusted here.This is the same parameter as RTN in the System Variation
unit.
n The variation send from each part can be set by clicking the DETAIL button in the Part Unit, opening the properties
dialog (detail screen) for the part and making the setting on the Pitch, Level page. (This can also be set on the Quick Edit
screen.) The depth of the effect is determined by the combination of the send level and the return level.

) PAN
When variation effects are being used as system effects, this sets the pan. It is the same parameter as PAN in the
System Variation unit.

! To Reverb
To Reverb is the send level to the Reverb unit when variation effects are being used as system effects. It is the
same parameter as to REV (send to reverb) in the System Variation unit.

@ To Chorus
To Chorus is the send level to the Chorus unit when variation effects are being used as system effects. It is the
same parameter as to CHO (send to chorus) in the System Variation unit.
When you click on the close button [X] at the upper-right of the window, the dialog will close and parameter
setting will be finished.
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System Variation Unit
When you use Variation Effects as System Effects, they are applied equally to all of the XG tone generator
parts (channels).
n When the [SYS] button is on, you can use the System Variation Unit.When the System Variation Unit is gray and can’t be used,
click on the [SYS] button on the System Variation Unit to turn it ON. (It will light up.)

1 INS Button
When you click on this button and turn it ON,Variation Effects will be used as Insertion Effects. In that
case, set the parameters for Variation Effects in the Variation Unit previously mentioned.

2 SYS Button
When you click on this button and turn it ON,Variation Effects will be used as System Effects. In that
case, you can set the parameters for Variation Effects in the System Variation Unit.At the same time, the
Variation Unit will be gray and can’t be used.

3 TYPE (Effect Type)
The currently selected system Variation Effect type is displayed. Click on the box and a drop-down list
will appear.You can select the effect type you want to use from the list.
n For information about which effect types can be selected, see the effect type list in the owner’s manual that came with your
XG tone generator.

4 PAN Knob
This is used for making Pan settings for system Variation Effects. Set the pan position by dragging the
knob to rotate it.You can also click on the box and directly type in a value from the computer keyboard.
Setting Value ............ L63-C (Center)-R63

5 RTN Fader (Return)
Used for setting the return level for system Variation Effects. Here you can adjust the return level for each
part’s Variation send level.You can set the value by dragging the slider up or down, or by clicking on the
box and entering a value directly from the computer keyboard.
Setting Value .......... 0-127
n To adjust the Variation send level on each part, click on the Part Unit [DETAIL] button, open the Part Properties dialog (Detail
Screen) and set them on the Pitch, Level page (it can also be set on the Quick Edit Screen).The effect depth is determined by
the send level and the return level together.
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6 to REV Fader (Send to Reverb)
Used for setting the send level to the Reverb Unit for system Variation Effects.You can set the value by
dragging the slider up or down, or by clicking on the box and entering a value directly from the
computer keyboard.
Setting Value ..........0-127

7 to CHO Fader (Send to Chorus)
Used for setting the send level to the Chorus Unit for system Variation Effects.You can set the value by
dragging the slider up or down, or by clicking on the box and entering a value directly from the
computer keyboard.
Setting Value .......... 0-127

8 DETAIL Button
Click here and the Variation dialog will open.You can set many different parameters for the Variation
Effects.The method for setting them is the same as for the Variation Unit mentioned previously
(→P. X-18). Please see there.

Reverb Unit
Used for selecting the Reverb effect type and making various parameter settings for it. Since the Reverb
effect selected here will be used as a System Effect (→P. X-2), its settings will apply to all of the parts of
the XG tone generator.

1 TYPE (Effect Type)
The currently selected Reverb effect type is displayed. Click on the box and a drop-down list will appear.
You can select the effect type you want to use from the list.
n For information about which Reverb effect types can be selected, see the effect type list in the owner’s manual that came
with your XG tone generator.

2 PAN Knob
This is used for making pan settings for Reverb effects. Set the pan position by dragging the knob to
rotate it.You can also click on the box and directly type in a value from the computer keyboard.
Setting Value ..........L63-C (Center)-R63

3 RTN Fader (Return)
Used for setting the return level for Reverb effects. Here you can adjust the return level for each part’s
Reverb send level.You can set the value by dragging the slider up or down, or by clicking on the box and
entering a value directly from the computer keyboard.
Setting Value ..........0-127
n To adjust the Reverb send level on each part, click on the Part Unit [DETAIL] button, open the Part Properties dialog (Detail
Screen) and set them on the Pitch, Level page (it can also be set on the Quick Edit Screen).The Reverb depth is determined
by the send level and the return level together.

4 DETAIL Button
Click here and the Reverb dialog will open.You can set many different parameters for each Reverb type.
The method for setting them is the same as for the Variation Unit mentioned previously (→P. X-18). Please
see there.The parameters you can set will vary depending on the Reverb type. For information on each
Reverb type and its parameters, see the effect type list and effect parameter list in the owner’s manual
that came with your XG tone generator.
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Detail Screen

Quick Edit screen

n The layout at the bottom half of the Quick Edit screen is slightly different from the layout of the Variation Effect Quick Edit
screen.The Reverb Quick Edit screen has RETURN, PAN, and FEEDBACK LEVEL parameters. RETURN and PAN are the same
parameters as those in the Reverb Unit.

Chorus Unit
Used for selecting the Chorus effect type and making various parameter settings for it. Since the Chorus
effect selected here will be used as a System Effect (→P. X-2), its settings will apply to all of the parts of
the XG tone generator.

1 TYPE (Effect Type)
The currently selected Chorus effect type is displayed. Click on the box and a drop-down list will appear.
You can select the effect type you want to use from the list.
n For information about which Chorus effect types can be selected, see the effect type list in the owner’s manual that came
with your XG tone generator.

2 PAN Knob
This is used for making Pan settings for Chorus effects. Set the pan position by dragging the knob to
rotate it.You can also click on the box and directly type in a value from the computer keyboard.
Setting Value ..........L63-C (Center)-R63

3 RTN Fader (Return)
Used for setting the return level for Chorus effects. Here you can adjust the return level for each part’s
Chorus send level.You can set the value by dragging the slider up or down, or by clicking on the box
and entering a value directly from the computer keyboard.
Setting Value .......... 0-127
n To adjust the Chorus send level on each part, click on the Part Unit [DETAIL] button, open the Part Properties dialog (Detail
Screen) and set them on the Pitch, Level page (it can also be set on the Quick Edit Screen).The Chorus depth is determined
by the send level and the return level together.
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4 to REV Fader (Send to Reverb)
Used for setting the send level to the Reverb Unit for Chorus effects.You can set the value by dragging
the slider up or down, or by clicking on the box and entering a value directly from the computer
keyboard.
Setting Value ..........0-127

5 DETAIL Button
Click here and the Chorus dialog will open.You can set many different parameters for each Chorus type.The method
for setting them is the same as for the Variation Unit mentioned previously (→P.X-18).Please see there.The parameters
you can set will vary depending on the Chorus type.For information on each Chorus type and its parameters,see the
effect type list and effect parameter list in the owner’s manual that came with your XG tone generator.

Detail Screen

Quick Edit screen

n The layout at the bottom half of the Quick Edit screen is slightly different from the layout of the Variation Effect Quick Edit
screen.The Chorus Quick Edit screen has RETURN, PAN,To Reverb, and FEEDBACK LEVEL parameters. RETURN, PAN, and To
Reverb are the same parameters as those in the Chorus Unit.

Equalizer Unit
Equalizing (tone adjustment) settings that affect all of the parts of the XG tone generator are made in the
Equalizer Unit. It has a graphical-style equalizer interface that lets you adjust the gain for five frequency
bands. There are also several different types of preset equalizer settings that you can choose from. Just
by making slight adjustments to one of those types, you can easily set up the equalizer for any situation.
If you want to make more detailed settings, you can click on the detail button and open the EQ dialog.
n Depending on your XG tone generator, some or all of the equalizer settings here may be incompatible. See the MIDI data
format in your XG tone generator owner’s manual.

2
7
1
3
5

4

6

1 TYPE (EQ Type)
The currently selected equalizer type is displayed. Click on the box and a drop-down list will appear.
You can select the equalizer type you want to use from the list. The settings for each band in the
equalizer type you selected will be displayed as a bar graph.
n There are five equalizer types you can choose from: FLAT, JAZZ, POPS, ROCK and CONCERT. Depending on your XG tone
generator, there may be an EQ type identified as “CLASSIC” in the MIDI data format of the owner’s manual. The “CONCERT”
EQ type available here is equivalent to it.
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2 Bar Graph Display
The equalizer gain settings for each band are displayed here as a bar graph. The gain settings for each
band are shown by three of the fifteen bars. The three bars farthest on the left correspond to Band 1,
while the three farthest on the right correspond to Band 5. The bars show the gain of each frequency.
As each bar gets longer, the gain is larger. As the bar gets shorter, the gain is smaller.

3 FREQ (Frequency)
The frequency of the currently selected band is displayed. By clicking on the box, you can directly enter
a value by typing on the computer keyboard, and set the frequency for that band. For information about
the possible frequency settings for each band (1-5), see the MIDI Parameter Change Table (MULTI EQ), in
the MIDI data format of the owner’s manual for your XG tone generator.

4 BAND (Frequency Band) Knob
Use this to select the band you want to adjust the settings for, from among the five equalizer bands. The
band number will be displayed in the box as you drag the knob and rotate it. If you click on the box,
you can type in the band number directly from the computer keyboard. The frequency of the currently
selected band will be displayed in the FREQ box.
Setting Values ........1-5

5 Frequency Select Slider
By moving this slider left and right, you can choose the frequency for the currently selected band. The
frequency you select will be displayed in the FREQ box.
n For information about the possible frequency settings for each band (1-5), see the MIDI Parameter Change Table (MULTI EQ),
in the MIDI data format of the owner’s manual for your XG tone generator.

6 GAIN Knob
This is used to adjust the gain of the currently selected band frequency. As you rotate the knob by
dragging it, the value will be displayed in the box. If you click on the box, you can type in the gain
directly from the computer keyboard. The results of your gain adjustments will appear in the bar graph
display in realtime. As you increase the gain, the frequency band will be emphasized, and a peak will
appear on the bar graph display. On the other hand, if you decrease the gain, the frequency band will be
lowered, and a valley will appear in the bar graph.
Setting Values ........-12 to 0 to 12
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Equalizer Adjustment
Follow these steps to adjust the equalizer:

1. Select the equalizer type with the TYPE box.
2. Select the frequency band you wish to adjust, using the BAND knob.
3. Use the either the Frequency Select slider or the FREQ box (whichever suits your purpose) to set the
frequency you want to adjust.

4. Make adjustments using the GAIN knob.
5. As necessary, repeat steps 2-4 above and adjust the gain for other frequency bands.
7 DETAIL Button
Click here and the EQ dialog will open.
EQ Dialog
You can set various parameters for each equalizer type.

1. Click on the Type box at the top of the parameters, and a drop-down list will be displayed. Select the
equalizer type you want to edit from the list.

2. By dragging the slider for each item right and left, you can change the parameter value in each box. You can
also click on the box and enter settings by typing directly from the computer keyboard.

3. When you click on the close button [X] at the upper-right of the window, the dialog will close and
parameter setting will be finished.
n For information about equalizer parameters, see the MIDI Parameter Change Table (MULTI EQ), in the MIDI data format
of the owner’s manual for your XG tone generator.
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Working with the XG Editor Window
General Flow of Operations
The XG Editor Window is made up of a lot of different units, and so there is no absolute set of steps for
operating in it.You can start with any unit and go from there. Look over the following flow of operations
and make the settings that suit your purpose.
n When needed, XG event settings that have already been entered into the song can be read into the XG Editor Window and
displayed there (→P. X-31).Also a Receive XG Bulk procedure can be done to receive the settings from a connected XG tone
generator and display them in the XG Editor Window (→P. X-31).

1. Click on the Model Setup button on the Toolbar to open the Model Setup dialog. Select the model for
the XG tone generator you will be using (see below).

n This dialog can also be opened by selecting [Model Setup] from the [Setup] menu on the Application Window menu bar.

2. In order to make your operations in the XG Editor Window valid for your XG tone generator, you

must click the Setup button on the Toolbar and open the XG Editor Setup dialog, where you can set
the output device and make other necessary settings (→P. X-28).

3. Set each part’s voice in the Part Unit and assign Insertion Effects, drum setups and Plug-ins
(→P. X-29).

n You can also set detailed parameters for the parts, using the assignable sliders and buttons (→P. X-11) or the Part Properties
dialog (→P. X-7).

4. Select the System Effects types in the Reverb and Chorus Units (and the System Variation Unit), and
set the effect parameters (→P. X-21).

n If you are using Variation effects as Insertion Effects, you can’t make settings in the System Variation Unit.

5. Select the Insertion Effect types in Insertion Units 1 and 2 (and the Variation Unit) and set the effect
parameters (→P. X-16).

n If you are using Variation effects as System Effects, you can’t make settings in the Variation Unit.

6. Set the parameters for the drum setups in the Drum Unit (→P. X-13).
7. Adjust the overall tone using the Equalizer Unit (→P. X-24).
8. Enter the settings made in the XG Editor Window into the song data (→P. X-30).
n You can record your XG Editor Window operations in realtime whenever necessary (→P. X-32).

9. As needed, save the current settings into an XG parameters file (→P. XI-5).
n You can read saved XG parameters file into the XG Editor Window at anytime.

Model Setup
Set the model for the tone generator you will be using. Doing this will set up the parameters in the XG
Editor Window to match those of your tone generator model. Click on the Model Setup button on the
Toolbar or select [Model Setup] from the [Setup] on the Application Window menu bar.This will display
the Model Setup dialog.
Each item is set by clicking. Clicking [OK] closes the dialog and makes the settings valid.To cancel the
operation before finishing it, click on [Cancel].The dialog will close and the settings will stay as they
originally were.
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Tone Generator
The model of the currently selected tone generator is displayed here. Click the box and select the
desired tone generator model from the drop-down list that is displayed.

Auto Check button
When this is clicked, XGworks V3.0 will automatically detect the model of the connected tone generator.
The detected model will be displayed in the Tone Generator box.

Plug-In (Slots 1-3)
Use this to set any plug-in boards (PLG100 series) installed on the XG tone generator that is displayed in
the Tone Generator box. Click on the box and select the plug-in boards you are using from the dropdown list that is displayed.

XG Editor Setup Dialog
This is used to setup the output port so that the operations done in the XG Editor Window will be
transmitted to the XG tone generator you are using.The effect and equalizer settings you make will be
sent to the XG tone generator in realtime and you can check the setting status while the XG tone
generator is playing the song.You can also make basic settings here for entering your XG Editor settings
into the song data.
Click on the XG Editor Setup button on the toolbar or select [XG Editor Setup] in the [Setup] menu on
the Menu Bar of the Application Window, and the XG Editor Setup dialog will open.
Set each item by clicking or typing, then click on [OK].The dialog will close and the settings will
become valid. If you decide to stop making settings, click on [Cancel] and the dialog will close, leaving
the settings as they originally were.
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MIDI Output Port ......Click on this box and a drop-down list will appear. Select the output ports you will use from
the list.The MIDI tone generator that corresponds to the port you have set will become valid
for control by the XG Editor Window.
Offset/All ....................This is used to select the data entering method when inserting system exclusive data into the
song. If [Offset] is checked, only the changes made to the initial XG settings (the reset values
for each parameter when XG System ON is transmitted) will be inserted into the song. If [All]
is checked, all the XG parameter data will be inserted into the song, including the parameters
that haven’t been changed from the initial settings.
n Since there is a huge number of parameters in the XG Editor, it’s better to select [Offset] whenever possible.When this is
done, it is necessary to insert an XG System ON at the top of the song.

Interval ......................When multiple system exclusive data are being inserted into the song data, this is used to set
the interval between each one, using clock units.
n If the setting made here is too short, errors may occur in the playback of the song where the system exclusive data is
entered.

Device Number..........Set for sending and receiving system exclusive data to and from the connected XGtone
generator. It should be the same device number as that of the XG tone generator you are
using.
Display Mode ............Select the method for displaying the Multi Part, Drum or Effect’s Properties dialogs. If you
check [Detail], the Detail Screen will be opened and you can make detailed settings. If you
check [Quick], the Quick Edit Screen will be displayed and you can edit the parameters
graphically.
Recording Track........This sets the track (MIDI) for entering data when doing realtime recording (→P. X-32) of
operations in the XG Editor.
Play Monitor ..............When you click on this box and place a checkmark in it, XG parameter events entered into
the song while it was playing back will be read.Those events will movethe XG Editor knobs
and sliders in realtime.When the checkmark is removed, the events in the song will not be
read.

Assigning Insertion Effects, Drum Setups and Plug-ins to Each Part
Insertion Effects, drum setups and plug-ins are assigned to each part as needed.The parts assigned with
Insertion 1 and 2 effects can have not only systems effects, but can also independently use the Insertion
Effects 1 and 2.Also, the part assigned with a Variation Effect can use it when the Variation Effect is used
as an Insertion Effect. (Each Insertion Effect can be assigned to one of the parts.) The drum parts
assigned with drum setups will reflect the settings made in the Drum Unit. Plug-in board functions can
be used on parts assigned to plug-in boards when there are plug-in boards (PLG100 series) installed in
your XG tone generator.
n You can assign the same or different drum setups to multiple parts.The types of setups you can use will vary according to
your tone generator.

To make assignments, drag the appropriate icon for the Variation Unit, Insertion 1 Unit, Insertion 2 Unit,
Drum Unit or Plug-in to the part box where you want to assign it and drop it there, as in the picture.
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To change assignments, drag the appropriate icon in the Part Unit and move it to another box.To clear
assignments, drag the appropriate icon to the outside of the Part Unit and drop it there.

n You can also cancel assignments by clicking the right mouse button over the assignment, then selecting Delete from the
menu that appears.

Inserting Parameter Settings into the Song Data
You can enter settings made in the XG Editor Window into the song data.

1. Click the Insert XG Parameter button on the Toolbar to display the Insert XG Parameter dialog.
2. Specify the track number where you want to enter the data using the spin box.
3. Click [OK] and the settings made in the XG Editor Window will be inserted at the beginning of the
specified track.

To cancel this operation, click on [Cancel] and the dialog will close and the XG parameters won’t be
inserted.

n Use the XG Editor Setup (→P. X-28) dialog to set whether all the XG Editor settings will be inserted into the song, or whether
only the parameter settings that have been changed from the initial settings (the reset values for each parameter when XG
System ON is transmitted) will be inserted into the song. If you want all the settings entered, select [All]. If you only want the
changed settings entered, select [Offset]. Since there is a huge number of parameters in the XG Editor, it’s better to select
[Offset] whenever possible.
When multiple system exclusive data are being inserted into the song data, the interval between each one is decided by the
XG Editor Setup [Interval] command. If the interval is too short, errors may occur during playback of the song where the
system exclusive data is entered.
h You can also save the settings made in the XG Editor Window in an XG parameter file. Since you can read the settings you
saved in the XG Parameters file whenever you need them, you can use them in other songs. It’s handy because if you make
several XG Parameter files, you can use them as XG parameter templates when making new songs. For information about
saving and reading these files see page XI-5.

You can also easily insert the parameters from just one of the XG Editor Window units into the song
data.

1. Use the List Window to open the block that you want to insert the XG Editor Window parameters
settings into.

2. Open the XG Editor Window and make it the active window.
3. Click on the unit name (PART, SYSTEM, DRUM,VARIATION, INSERTION 1, INSERTION 2, CHORUS,
REVERB, EQ) of the unit that has the parameters you want to insert and drag the name to the List
Window that you opened in step 1. Drop the name there and the Insert dialog will open.
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4. Set the location where you want to insert the data and click [OK].The XG parameter settings that
you dragged to the List Window will be inserted.

n XG Editor Setup (→P. X-28) is used to determine whether all the parameters for the selected unit will be entered, or only
those that are modified from the initial settings (settings at XG System ON). If only the [Offset] settings from XG System ON
are to be entered, it is necessary to insert an XG System ON beforehand in the song.
When multiple system exclusive data are being inserted into the song data, the interval between each data event is
determined by the [Interval] setting in XG Editor Setup. If this setting is too short, errors may occur in the playback of the
song where the system exclusive data is entered.

Loading XG Parameters
You can extract XG event settings that have been entered into the currently open song, and have them
displayed in the XG Editor Window.

1. Click the Load XG Parameter button on the Toolbar.The Load XG Parameter dialog will open.
n This dialog can also be opened by selecting [Load XG Parameter] from the [Setup] menu on the Application Window menu
bar.

2. Using the spin boxes in the Load XG Parameter dialog, set the area (start position and end position)
in the song that has the XG events you want to load.

3. Click [OK].The XG event settings within the specified range in the song will be displayed in the XG
Editor Window.

Click [Cancel] to cancel this operation.The dialog will close and the XG events will not be loaded.

From............................Set the start position for extracting XG event settings from the song, using measure, beat and
clock units.
To ................................Set the end position for extracting XG event settings from the song, using measure, beat and
clock units.

Receive XG Bulk
You can gather together settings made in the connected XG tone generator and receive them in bulk.
They will be read into the XG Editor Window.

1. Click the Receive XG Bulk button on the Toolbar.The Receive XG Bulk dialog will open.
n This dialog can also be opened by selecting [Receive XG Bulk] from the [Setup] menu on the Application Window menu bar.
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2. In the Set Dump Request section, click on either [Output] or [Not Output] and select the receive

bulk method.
If you check [Output], the receive bulk will be started by transmitting a dump request to the
connected XG tone generator. If [Not Output] is checked, the receive bulk will be started by a bulk
dump operation from the connected XG tone generator.

3. If [Output] is selected as the dump request setting, click on [Type] and use the drop-down list to

specify the type of dump request you want to transmit. If you have selected [Not Output], you won’t
be able to specify a type of dump request.

4. If [Output] is selected as the dump request setting, click on [Start] and the specified dump request

will be sent to the connected XG tone generator, and the receive bulk operation will begin. If you
have selected [Not Output] as the dump request setting and clicked on [Start], the bulk receive will
start when the connected XG tone generator does the bulk dump operation.
You can check the data receiving status of the operation by looking at the bar display in the Receive
Bulk section.
If [Output] is selected as the dump request setting, when the bar display reaches the end, the bulk
receive is finished. If you click the [Stop] button midway through the operation, the bulk receive will
be stopped at that point. If [Not Output] is selected as the dump request setting, XGworks will be in
bulk receiving status from when the [Start] button is pressed until the [Stop] button is pressed.

5. Click [Exit] and the dialog will close and the bulk receive operation will be finished.
n You can set the receive buffer size for bulk data by opening the System Setup dialog from the [Setup] menu on the
Application Window menu bar, then making the appropriate setting on the System Exclusive page.

Recording XG Editor Operations in Realtime
The operations of each fader and knob in the XG Editor Window can be recorded in real time. By doing
this you can create data that will automatically change the XG parameters for effects and sound quality
when the song is played back.

1. Click the XG Editor Setup button on the toolbar to open the XG Editor Setup dialog. In the

Recording Track box in the dialog, set the track where the XG Editor operations will be recorded in
realtime (see above).

n Data for every part is recorded on the same recording track.

2. Click the XG Parameter Realtime Recording button on the toolbar. Realtime recording will start.
3. Use the mouse to click and drag the sliders and knobs and control the sound quality, effects, and
other parameters as required.

4. Click the XG Parameter Realtime Recording button one more time to stop realtime recording.The
operations of each control (settings made in realtime) will be recorded in the specified track.
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Title
Bar
The standard Windows Title Bar is displayed at the top of the Application Window and every edit
window. On it are the application name and functions that are related to the display of the window.
Minimize Button
Close Button
Application Icon

Maximize/Restore
Button

Application Icon
Next to the icon, the application name and file name are displayed. When the Title Bar is for an edit
window, the name of the window is displayed.
When you click on the icon, the Icon pop-up menu will open.

Icon Pop-up Menu

Restore ....................If this window has been maximized, this will return it to its original size.
Move ........................Changes the mouse pointer into the Move tool. If you drag the title bar with this tool, you
can easily change the window position. This item can be selected when the window isn’t
maximized.
Size ..........................Changes the mouse pointer into the Sizing tool. You can easily change the size of the
window by clicking the pointer over one of the lines on the top, bottom, left, or right, and
then dragging the line. This item can be selected when the window isn’t maximized.
Minimize ................Minimizes this window (changes it to an icon).
Maximize ................Maximizes this window. This item can be selected when the window isn’t maximized.
Close........................If you click this on the Application Window, the window will close and the application will
shut down. If you click it on an edit window, that individual window will close.
Next ........................When there are multiple edit windows open, this will change the active window. This
command only appears on the icon pop-up menus for edit windows.

You can open the icon pop-up menu for the Application Window by clicking the right mouse button
anywhere on the Title Bar.

Minimize Button
If you click here, this window will be minimized (changed to an icon).

Maximize Button/Restore Button
If you click here, this window will be maximized. If the window is already maximized, this button will
become the Restore button, and clicking on it will restore the window to its original size.
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Close Button
If you click here on the Application Window Title Bar, the window will close, and the application will
shut down. If you click it on an edit window, that individual edit window will close.

Menu Bar
There are seven different menus on the Menu Bar of the Application Window that allow you to execute
many different functions. Some of the items available on each menu will be different according to which
window you are currently working in.
n Depending on the window and operation, the function names of the commands you can’t currently use will either disappear
from the menu or be displayed in gray. Commands and functions that are only needed in particular windows will be added to
the menu when those windows are active. Information on the items which are added to the menus is given below in the
explanation about the contents of each menu.

File

New : Ctrl+N
Used to open a new Track View Window. “Untitled” will be displayed on the Title Bar of the Application
Window.
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Open : Ctrl+O
Displays the [Open] (file open) dialog and you can select from XGworks files (extension .XWS) or
SMF/XF files (extension .MID). The file you select will be opened in the Track View Window. You can’t
have multiple files open at one time.
2 3 4 5

1

6

8

7

9

1 Look In ..........................Click here, and you can select the folder where your file is located from a drop-down list.
2 Up One Level Button ........Click here, and you can select from the folder one level higher.
3 Create New Folder Button Click here, and you can create a new folder.
4 List Button ......................Click here, and the display will become a list showing only folders and file names.
5 Details Button..................Click here, and the display will become a detailed list.
6 File name ........................The name of the file selected in the list above is displayed here.
7 Files of type ....................Click here, and the type of file to be displayed in the list above can be selected from a
drop-down list.
8 Open ..............................Opens the file selected in the list above.
9 Cancel ............................Cancels file selection and closes the dialog.

Close
Closes the file currently displayed. If the file hasn’t been saved, a save confirmation message will be
displayed.

Save : Ctrl+S
Saves the currently open file, overwriting any previously saved version. If the file is a newly created one,
the Save As dialog will be opened.
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Save As
Opens the Save As dialog. You can name the file and save it. If the file has already been saved, you can
give it a new name.
2 3 4 5

1

6

8

7

9

1 Save in ............................Click here, and you can select the folder where you want to save your file from a dropdown list.
2 Up One Level Button ........Click here, and you can select the folder one level higher.
3 Create New Folder Button Click here, and you can create a new folder.
4 List Button ......................Click here, and the display will become a list showing only folders and file names.
5 Details Button..................Click here, and the display will become a detailed list.
6 File Name ........................Type the name you want to give to the file here.
7 Save as Type ....................Click here, and select the type of file (song file format) you want to save from the dropdown list.
8 Save ................................Saves the file that you gave a name to.
9 Cancel ............................Cancels the operation and closes the dialog.

Recent Files
The names of song files you have recently accessed are displayed here. You can select any file from the
list and open it directly. If you are working on a newly created file, and it hasn’t been saved yet, a save
confirmation message will be displayed before the file you selected is opened.

Exit
This closes the window and shuts down the application. If you are working on a newly created file that
hasn’t been saved yet, a save confirmation message will be displayed.

Items Added in the Staff Window
In the Staff Window, the following menu items are added.

Print : Ctrl+P
When the Staff Window is active, this opens the Print Preview Window. You can print out the musical
staves displayed in the Staff Window. For details, see page V-14.

Printer Setup
Opens the standard Windows printer setup window.
n The Print command can only be used when the Staff Window is active.

XI-4

XGw3/E11.QX

2/1/99

5:15 PM

Page 5

Items Added in the XG Editor Window
In the XG Editor Window, the following menu items are added.

Open XG Parameter File : F2
Displays the Open (file open) dialog and you can select an XG Parameter file.The file (XG Editor Window
settings) you select will be opened in the XG Editor Window. Using this dialog is the same as the Open
dialog explained above.
n In the File of type box, you can select either .XGP or .SYX files.The .XGP file type was the file format used in XGworks up to
version 2.0.

Save XG Parameter File : F3
Displays the Save As dialog.You can give your XG Parameter file (XG Editor Window settings) a name and
save it. Using this dialog is the same as the Save As dialog explained above.
n Only the .SYX file type can be selected. From XGworks version 3.0 and later, all XG parameter files will be saved in the .SYX
file format.The .XGP file format cannot be saved.

Edit

Undo : Ctrl+Z
Undoes the most recent edit operation. With this command, you can trace back from your most recent
edit operation through past ones, undoing each in turn. Using the next item, the [Redo] command, you
can redo the operations you have undone.
n If you have saved your file, you can’t undo any of the edit operations you did before you saved it.

Redo : Ctrl+Y
You can redo operations that you have undone. You can redo as many operations as you have undone
using the command above.
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Cut : Ctrl+X
You can cut the selected block (Track View Window), MIDI event (Piano Roll, Staff, Drum, List, Master
Track Window) or other data from the screen and copy it to the clipboard. If there is no target selected
that can be cut with this command, it will display in gray.

Copy : Ctrl+C
Without changing the source data, the selected block (Track View Window), MIDI event (Piano Roll, Staff,
Drum, List, Master Track Window) or other data will be copied to the clipboard. If there is no target
selected that can be copied with this command, it will display in gray.

Paste : Ctrl+V
The data on the clipboard will be pasted in the specified place in the active window.

Delete : Del
The selected block (Track View Window), MIDI event (Piano Roll, Staff, Drum, List, Master Track Window)
or other data will be deleted.

Select All : Ctrl+A
All of the blocks (Track View Window), MIDI events (Piano Roll, Staff, Drum, List, Master Track Window)
or other data in the active window will be selected. In the Piano Roll, Staff, and Drum Windows, another
submenu will be displayed.

Select Note : Ctrl+A
Selects all the MIDI notes.

Select Control Section 1
Select the data displayed in the first Control Section from the bottom.

Select Control Section 2
Select the data displayed in the second Control Section from the bottom.

Select Control Section 3
Select the data displayed in the third Control Section from the bottom.
n The number of menus you can select will depend on the number of Control Sections you currently have displayed.
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Items Added in the Track View Window
In the Track View Window, the following menu items are added.

History
This opens the History dialog box. It displays a list of all the edit operations that have been executed
since the file was opened.

When you click on any of the edit operations displayed above the ––– mark, then click [OK], you can
undo that edit operation and all the ones that came after it.The dialog will close.The edit operations that
were undone will appear below the ––– mark the next time the History dialog box is opened.
When you click on any of the edit operations displayed below the ––– mark, then click [OK], you can
redo that edit operation and all the ones that were undone after it.The dialog will close.The edit
operations that were redone will appear above the ––– mark the next time the History dialog box is
opened.
When you click [Delete All], all edit operations will be deleted from the list.There will be no targets left
for the undo and redo operations.
When you click [Exit], the History dialog box will close.

Initialize Master Track
This deletes all data from the Master Track except for the Tempo and Time Signature settings inserted at
the start.

Add Marker
This opens the Add Marker dialog box. Use the spin box to enter the location where you want to insert
the marker and type in the marker name from the computer keyboard.When you click the [Add] button,
the marker will be inserted on the Master Track.
n For details about the marker function, see page III-23.

Marker List
This displays the marker list.You can use this to change marker locations or names, or to delete markers.
For details, see page III-23.
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Create Block
This opens a dialog for creating blocks. You can create a new empty (no data) block on any track at any
location you wish.

Track ................................Click or type in the track number where you want to create the new block.
Type..................................Click and a drop-down list will be displayed. Select the type of block (MIDI or Wave) you want to create.
From ................................Click or type in the starting location for the block you want to create, using Meas/Beat/Clock units.
Thru..................................Click or type in the ending location for the block you want to create, using Meas/Beat/Clock units.

When you click [Insert], a new block will be created on the track within the range you specified. When
you click [Exit] the dialog will close and the operation will be finished.
n If the block created here is a Wave block, the file Open dialog will automatically be displayed when you click [Insert], and you
can insert a .WAV file. Select any .WAV file, click [Open], then click [Exit] in the Create Block dialog. For information about
the file Open dialog, see page XI-3.

Repeat Block
This opens the Repeat dialog box.You can repeatably copy blocks within a particular range on tracks 1
to 100 to any desired location.

From ................................Specify the start location for the copy source by clicking or typing.
To ......................................Specify the end location for the copy source by clicking or typing.
Insert Position................Specify the destination location for copying by clicking or typing.
Time ................................Specify the number times for copying by clicking or typing.

When you click [OK], the blocks in the specified range will be continuously copied from the specified
insert location, for the number of times specified.To cancel the operation, click on [Cancel].
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Move Block
This opens the Move Block dialog. You can move the currently selected block to a specified
Meas/Beat/Clock location.

Move To..........................................If you check this radio button, you can specify the place you want to move the block to by
clicking or typing in a Meas/Beat/Clock location.
Move Amount................................If you check this radio button, you can specify the place you want to move the block to by
clicking or typing in the amount of clock units by which you want to shift the block. If the value
is negative, the block will move earlier in the song by the number of clock units you specified. If
the value is positive, the block will move later in the song.

If you click [OK], the dialog will close, and the block will move to the specified location. If you click
[Apply], the block will move, but the dialog won’t close. If you want to cancel moving the block, click
on the [Cancel] button.

Create Link Block
This creates a link block in the Block Section immediately after the selected block. For details about the
link block function, see page III-17.

Rename Block
This opens the name edit box for the block that is selected in the Block Section.You can type in a new
name for the block from the computer keyboard.
n For details about the block name, see page III-16.

Insert Chord
This opens the Insert Chord dialog box.You can set the root, and type (such as major, minor, seventh) for
the chord you want to enter on the Chord Track, and its insert position.You can also enter On Bass. For
details, see page III-28.

Repeat Chord
This opens the Repeat dialog box.You can repeatably copy chords within a particular range on the chord
track to any desired location. For details on using the Repeat dialog box, see [Repeat Block] on page XI-8.

Create Style Block
This opens the Create Style Block dialog box.You can set the auto accompaniment style and section (like Intro,Main,or
Ending) you want to enter on the Style Track,and its insert position.For details,see page III-27.

Repeat Style Block
This opens the Repeat dialog box.You can repeatably copy style blocks within a particular range on the style track to
any desired location.For details on using the Repeat dialog box,see [Repeat Block] on page XI-8.

Expand to MIDI Track
This expands contents of the currently selected style block into MIDI tracks (tracks 1 to 100).This is the
same as the [Expand to MIDI Track] command that appears on the pop-up menu that is displayed when
you click the right mouse button on a selected style block. For details, see page III-32.

Replace Style
This opens a submenu. By choosing [Select Style] or a section (like Main A or Fill In AA), you can replace
the currently selected style block.This is the same as the [Replace Style] command that appears on the
pop-up menu that is displayed when you click the right mouse button on a selected style block. For
details, see page III-32.
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Items Added in the Piano Roll, Staff, and Drum Windows
In the Piano Roll, Staff, and Drum Windows, the following menu item is added.

Repeat
This opens the Repeat dialog box.You can repeatably copy MIDI events within a particular range in the
block displayed in the Block Name box on the Toolbar to any desired location. For details on using the
Repeat dialog box, see [Repeat Block] on page XI-8.
n If MIDI events are already selected when the Repeat dialog is opened, only those events will become the target for the repeat
copy.

Items Added in the Piano Roll/Staff Window
In the Piano Roll/Staff Window, the following menu item is added:

Insert Pitch Bend : Alt+D
This opens the Pitch Bend Window. Here you can easily enter a wide variety of guitar nuances. For
details about the Pitch Bend Window, see page IV-30.

Items Added in the List and Master Track Windows
In the List and Master Track Windows, the following menu items are added.

Insert Event
This will display a submenu from which you can select the type of event you want to insert. When you
make your selection, the insert dialog for that type of event will be opened and you can enter the
location where you want the event inserted and the needed values. When you click [Input], a new event
will be inserted. For information about inserting events, see page VII-16.

Select Same Event : Alt+F1
This will select the events that are the same as the currently selected event. For example, if you execute
this command when a note event is selected, all the note events with the same note number (pitch) will
be selected.

Select Same Event Type : Alt+F2
This will select the events of the same type as the currently selected event. For example, if you execute
this command when a note event is selected, all the note events with the same note number (pitch) and
those of that pitch but in different octaves will be selected.

Invert Selection : Alt+F3
This will select all events not currently selected and displayed in green.

Items Added Only for the List Window
The following menu items are only added for the List Window.

Convert to Normal Block
This can be used to convert link blocks into normal blocks. Since link blocks can’t be edited, there may
be times when you want to convert one into a real block so that you can edit it. This command lets you
do that easily.

Show Link Source
This displays in the List Window the real block (normal block) that is the source for a link block. Since
link blocks can’t be edited, there may be times when you want to display the source block in the List
Window so that you can edit it. This command lets you do that easily.
n For information about link blocks, see page III-17.

Select Block to Be Edited : Alt+F5
When multiple blocks are selected, and they are being displayed in a single List Window, the events of
the blocks that aren’t selected in the Block Name box will be displayed in gray. If you execute this
command after selecting any of the events displayed in gray, the block that includes those selected gray
events will become the target for editing.
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Items Added in the Mixer Window
In the Mixer Window, the following menu items are added:

Insert Mixer Parameter : F4
This opens the Insert Setup dialog. It inserts the current settings for each parameter from the Mixer
Window into the song. It has the same function as the Insert Mixer Parameter button on the toolbar in
the Mixer Window. For details, see page IX-6.

Record Mixer Parameter : F5
The movements of each control in the Mixer Window can be recorded in realtime. It has the same
function as the Record Mixer Parameter button on the toolbar in the Mixer Window. For details, see
page IX-6.

Items Added in the XG Editor Window
In the XG Editor Window, the following menu items are added:

Insert XG Parameter: F10
This opens the Insert XG Parameter dialog. It has the same function as the Insert XG Parameter button
on the toolbar in the XG Editor Window. For details, see page X-30.

Record XG Parameter : F11
This starts realtime recording for the XG Editor Window. It has the same function as the XG Parameter
Realtime Recording button on the toolbar in the XG Editor Window. For details, see page X-32.

Setup
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System Setup : Ctrl+U
This opens the System Setup dialog.You can select device drivers and make other important system
settings.When you click on one of the tabs at the top of the dialog, the corresponding page of settings
will be displayed.You can set any of the items by clicking with the mouse, selecting from a drop-down
list, or by placing check marks.After setting the values, click on [OK] and the dialog will close and the
settings you made will be applied to the system. If you select [Apply], the settings will be applied to the
system, but the dialog won’t close. If you want to cancel making settings, click on [Cancel].The dialog
will close and the system will be left unchanged.

Device

MIDI IN....................................This box is for selecting the MIDI input device.The external MIDI keyboard or other
input device that corresponds to the device driver selected here will be the MIDI
input device.
MIDI Thru ..............................The Thru output MIDI device is selected here.The MIDI signal sent from the external
MIDI device will pass through the device selected here before being sent to the tone
generator.
MIDI Out 1-6 ..........................The MIDI output device is selected here.The external MIDI devices corresponding to
the device drivers selected here will be used as the tone generators that play the
sounds. Up to six types can be registered, and a different one of them can be selected
separately for each track in the Track View Window.You should select the device you
use most as MIDI Out 1 since the default device selected and displayed for each track
when a new file is opened in the Track View Window will be MIDI Out 1.
n When using a Yamaha XG tone generator connected as explained on page 7, select Yamaha CBX Driver for MIDI In. Select
Yamaha CBX A Driver for MIDI Thru and MIDI Out (for any of 1-6).When using a Multiport compatible XG tone generator
(such as the MU128), you can also play sounds by selecting Yamaha CBX B-E Driver.

Wave In....................................The input device for Wave files is selected here.The audio signal will come in through
Mic In or another input terminal of this device.
Wave Out 1-6 ..........................The output device for Wave files is selected here.The audio signal being sent out will
pass through Line Out or another output terminal of this device. Up to six types can
be registered, and a different one of them can be selected separately for each track in
the Track View Window.

XI-12

XGw3/E11.QX

2/1/99

5:15 PM

Page 13

MIDI Out Filter
Placing a check mark next to an event type on this page will cause that event to be filtered (deleted)
from the MIDI output. Using this function, you can limit the output of unneeded MIDI events.

n For the meaning of each event, see the corresponding page number below.

Note (MIDI Note ON/OFF) ......(P.VII-12)
Poly After Touch ......................(P.VII-12)
Control Change ........................(P.VII-12)
Program Change ......................(P.VII-12)
After Touch................................(P.VII-13)
Pitch Bend ................................(P.VII-13)
System Exclusive......................(P.VII-13)
Realtime Message ....................(See Below)
n Realtime message information is XGworks stop, start and song position information, and if a song is played back on the
XGworks side, that information will be sent as MIDI output in realtime. (It will be output on MIDI Out port number 1 set on
the Device page of the System Setup dialog.) If a MIDI keyboard with a built in sequencer is used as a tone generator, the
built in sequencer in the keyboard will play back in sync with the XGworks playback. If synchronized playback is not
required, this box should be checked.
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MIDI Thru Filter
Placing a check mark next to an event type on this page will cause that event to be filtered(deleted)
from the MIDI Thru output. Using this function, you can limit the Thru output of unneeded MIDI events.

n For the meaning of each event, see the corresponding page number below.

Note (MIDI Note ON/OFF) ......(P.VII-12)
Poly After Touch ......................(P.VII-12)
Control Change ........................(P.VII-12)
Program Change ......................(P.VII-12)
After Touch ................................(P.VII-13)
Pitch Bend..................................(P.VII-13)
System Exclusive ......................(P.VII-13)

MIDI In Filter
Placing a check mark next to an event type on this page will cause that event to be filtered (deleted)
from the MIDI input. Using this function, you can limit the input of unneeded MIDI events when doing
realtime recording from the external MIDI keyboard or sequencer.

n For the meaning of each event, see the corresponding page number below.

Note (MIDI Note ON/OFF) ......(P.VII-12)
Poly After Touch ......................(P.VII-12)
Control Change ........................(P.VII-12)
Program Change ......................(P.VII-12)
After Touch ................................(P.VII-13)
Pitch Bend..................................(P.VII-13)
System Exclusive ......................(P.VII-13)
Realtime Message......................(See Below)
n Realtime message information includes stop, start and song position information, and if a song is played back on the external
sequencer side, that information will be sent to XGworks as MIDI input in realtime. (It will be input through MIDI In port set
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Sync.
This is used to set whether XGworks will use its internal clock signal or a clock signal from an external
MIDI device during playback.

Internal ............................ XGworks will follow its own internal clock signal during playback. Normally this box
should be checked.
MIDI .................................. XGworks will follow the clock signal from an external MIDI device during playback. You
can synchronize XGworks with the performance of an external sequencer or rhythm
machine. When this box is checked, you won’t be able to use the XGworks Play Control
to control playback.

Synchronized Playback with External MIDI Devices

1. Place a check mark in the MIDI box on the Sync. setup page above.
2. Click on the Play button of the Play Control.
3. When the external MIDI device connected to MIDI In on the Device page above begins playback, XGworks
will synchronize its own playback with the MIDI clock signal from that device.

Wave Format
When you click here, a drop-down list will appear. From it you can select the Wave data format for
digital audio recording (sampling frequency, stereo/mono, number of bits).

n Depending on your audio card (sound card), the Wave formats available for selection may vary. See the owner’s manual that
came with your sound card for information on the formats it can handle.
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System Exclusive
This sets the buffer size and transmit interval when system exclusive messages are transmitted or
received.

Reception Buffer Size ..........Click on this box and select the required reception buffer size from the drop-down
list that is displayed.The buffer size set here represents the amount of data that can be
received at a time.
Transmission Buffer Size ....Click on this box and select the required transmission buffer size from the drop-down
list that is displayed. System exclusive messages that are larger than this size will be
divided before being sent.
Transmission Interval ..........Click on this box, and from the drop-down list that is displayed, select the time
interval used when sending divided system exclusive data.
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Metronome : Ctrl+M
This opens the Metronome dialog. Using it, you can set the click sound and accent played by the
metronome during song playback and recording. After making the desired settings using the drop-down
lists and spin boxes, click [OK] and the settings will be applied. If you decide to cancel making settings,
click [Cancel].

Port ..........................................Select the MIDI output device for the tone generator used by the metronome. The
click sound of the metronome will play through the external MIDI device
corresponding to the device driver set here.
MIDI CH (MIDI Channel) ....Select the MIDI channel for sending the metronome to the MIDI tone generator, from
channels 1-16. When using a drum kit in an XG or GM tone generator, select channel
10.
Down (note number/velocity)......Select the instrument (note numbers 0-127) and sound strength (velocity value 1-127)
of the metronome click for the downbeat.
Speaker Button ......................If you click here, you can hear the click sound set with the Down boxes.
Up (note number/velocity) ......Select the instrument (note numbers 0-127) and sound strength (velocity value 1-127)
of the metronome click for the unaccented beats after the downbeat.
Speaker Button ......................If you click here, you can hear the click sound set with the Up boxes.

Record/Playback Settings : Ctrl+R
This opens the Record/Playback Settings dialog. You can make settings for recording and playback using
drop-down lists, spin boxes and check marks. When you finish, click [OK] and the settings will become
valid. If you decide to cancel the operation before finishing, click [Cancel].
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Record Mode
Realtime/Step ........................When doing recording using an external MIDI keyboard, select Realtime if you are
recording in realtime. If you are doing step recording, select Step. You will be able to
use whichever method is checked.
n For details on Realtime and Step Recording, see page I-7.

Wave File Folder
When you do digital audio recording (→P. I-19) with XGworks, the resulting files are saved in the
XGworks folder, which is in the Yamaha folder of the Program Files folder on your hard disk. If you want
to change the folder where newly recorded .WAV files will be stored, type the path of the folder where
you want to save them into this box.
Example: C:\Wave (Drive:\Folder Name)
Play
Scroll........................................If a check is placed here, the screen will scroll along with the song position during
playback.
Loop From ..............................You can use this to set the start position (“S” mark) for loop playback in
Meas/Beat/Clock units.
Loop Thru ..............................You can use this to set the end position (“E” mark) for loop playback in
Meas/Beat/Clock units.
n For information about loop range settings and playback, see page III-22.

Playback Position
Output MIDI Program Change..When you change position in a song, all the valid program change messages up to the
point that you changed to will immediately be sent to the external MIDI device if this
box is checked. Valid data up to that point such as control change and pitch bend
data messages will also be sent together to the external MIDI device.

Tools
A submenu will open that lets you choose the tool you want to use. This menu appears only when the
Track View, Piano Roll, Drum or Staff Window is the active window.

n The tools that you can select will vary depending on the currently active window and system status. For information on each
tool, see the explanation for each window.

Zoom
By selecting any of the zoom commands shown in the submenu (Zoom In Horizontally, Zoom Out
Horizontally, Zoom In Vertically and Zoom Out Vertically), the display area of currently active window
can be expanded or contracted. If the window reaches maximum magnification or reduction, the item
on the menu will become gray and stop functioning. This menu item appears only when the Track View,
Piano Roll, Drum or Staff Window is the active window.

n There is no vertical zoom in or zoom out function in the Track View Window.
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Grid
A submenu will open and you can select [Note], [Dotted], or [Tuplet]. Depending on which you choose,
you can set the grid for various note units. You can also set the grid for some units that aren’t available
on the Grid buttons on the Toolbar in the Piano Roll, Drum or Staff Windows. This menu item appears
only when the Piano Roll, Drum or Staff Window is the active window.
n For information about the grid, see page IV-10.

Note Grids

Tuplet Grids

Note..........................................Opens a submenu that lets you select any grid unit from a whole note to a thirtysecond note by placing a check mark next to it. If you select [Free], the grid will be
canceled.
Dotted ......................................This will extend the currently selected grid unit into a dotted note of the same value.
Place a check mark next to this item to select dotted note units for the grid.
Tuplet ......................................Opens a submenu that lets you change the currently selected grid unit into a 3/5/7
tuplet unit of the same note by placing a check mark next to the appropriate item.

Split
Opens a submenu where you can select [Add Control Section] or [Delete Control Section] and increase
or decrease the number of Control Sections in the current window by one. This menu item appears only
when the Piano Roll, Drum or Staff Window is the active window.

Add Control Section..............Adds one more Control Section. A maximum of three Control Sections can be
displayed at the same time.
Delete Control Section ........Deletes one Control Section. When only one Control Section is displayed, this menu
item will become gray and it won’t function.

Solo : Alt+S
Mute : Alt+M
In the List, Piano Roll, Drum or Staff Window, you can cause a particular block to play solo or to be
muted during playback. It’s handy because you don’t have to go back to the Track View Window and set
the Solo or Mute buttons for the track/block is on. This menu item only appears when the above
mentioned windows are displayed.
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Items Added in the Track View Window
The following menu items are added only when the Track View Window is active.

Default Window
This opens a submenu that lets you choose the List, Piano Roll, Drum or Staff Window as your default
window. The default window is the one that automatically opens when you double-click on any of the
blocks in the Track View Window. Select one of the windows in the submenu, and a ● mark will appear
next to its name, identifying it as the default window. It’s handy to set the window you use most often
during editing as the default window.

Block Color Setup
This opens a dialog for setting the block color. You can have each separate channel in the Track View
Window display in one of eight different colors by using this menu. Click on the box for each channel,
then select its display color from the drop-down list that is displayed. After selecting each color, click
[OK] and the settings will become valid. If you want to cancel this operation, click [Cancel].

Style Block Color Setup
This opens the Style Block Color Setup dialog.You can select from eight different colors to use for
displaying each different section of the style blocks in the Track View Window. Click the box for each
section, then select the desired color for that section from the drop-down list that will be displayed. Click
[OK] and the settings will be applied.To cancel the operation, click [Cancel].

XI-20

XGw3/E11.QX

2/1/99

5:15 PM

Page 21

Items Added in the Staff Window
The following menu items are added only when the Staff Window is active.

Display Quantize
A submenu will open and you can select the note size for Display Quantize from quarter, eighth,
sixteenth and thirty-second notes. Display Quantize is a function to change the display of the notes on
the staff without actually having any effect on the MIDI data.The note size that you choose here will
become the minimum size note that will be displayed on the staff. For example, if too many sixteenth
notes connected by tie marks make the staff messy and hard to read, you can set the Display Quantize
function for eighth notes and make the staff a lot neater.This function is also effective when printing the
staves.

Select the 16th note

Select the 8th note

Display Size of Notes
A submenu will open and you can set the note display size to Large, Medium, Small or Smallest.

Key/Time Signature Settings
This opens the Key/Time Signature Settings dialog, where you can set the key and time signature. For
details, see page V-12.

Layout
This opens the Layout dialog, where you can set the number of staves displayed in the Staff Section. For
details, see page V-13.
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Items Added in the List and Master Track Windows
The following items are added only for the List or Master Track Window.

Play Control : Alt+F7
This lets you hide the Play Control (not display it). If you execute this command a second time, the Play
Control will display again.

Track View : Alt+F8
Makes the Track View Window the active window.

Location : Alt+F9
This opens a submenu that allows you to select the display format for the Location columns in the List
Window. If you select [Measure], the L1/L2/L3 items will show Meas/Beat/Clock units respectively. If
you select [Time], they will show Min/Sec/Msec units.

XG : Alt+F10
This opens the XG Settings dialog. This determines whether or not the Type and Value displays (such as
MIDI event names, or control change types) of the MIDI events in the List Window will be displayed
using the names defined in the XG format. For information about the XG Settings dialog, see page VII-6.
When the XG display function is being used, a check mark will appear beside the [XG] menu item.

Display Filter : Alt+F11
This opens the Filter dialog. You can set the display in the List Window so that instead of seeing many
event types all mixed together, only the events you want to edit or check will be displayed. For
information about the Filter dialog, see page VII-6. When the Display Filter function is being used, a
check mark will appear beside the [Display Filter] menu item.

Font : Alt+F12
Opens the Font dialog. This has the same function as the Font button in the List Window. For details, see
page VII-2.

Move Location : Ctrl+L
This changes the song location (position to start playing) to the location of the event selected in the List
Window. For example, if you execute this command when an event located at 3:3:250 is selected in the
List Section, the song location will move to 3:3:250. The same change will be displayed in the Play
Control Location Indicator.
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Items Added Only for the List Window
The following menu items are added only for the List Window.

Note Monitor
This displays a submenu that lets you choose either [Mono] or [Poly] and select the mode for the MIDI
note monitor function. A check mark will appear beside the menu item of the currently selected mode.
The function of each item is the same as the [Mono Monitor] and [Poly Monitor] buttons in the List
Window. For details, see page VII-3.

Wave Monitor
This turns the Wave Monitor function ON. Its function is the same as the [Wave Monitor] button in the
List Window. For details, see page VII-3.

MCI Monitor
This turns the MCI Monitor function ON. Its function is the same as the [MCI Monitor] button in the List
Window. For details, see page VII-3.

Cursor Monitor
This selects the timing for when you monitor note events (or wave and MCI events)by using down
[↓]cursor on the computer keyboard to move the cursor line over them.
If you select [Monitor Before Moving Cursor], the note events (or wave and MCI events) will play
immediately before the cursor is moved over them. If you select [Monitor After Moving Cursor], the note
events (or wave and MCI events) will play immediately after the cursor is moved over them.
n For details about the monitor function, see page VII-4.

Items Added in the Mixer Window
The following menu items are added only for the Mixer Window.

Mixer Setup : F2
This opens the Mixer Setup dialog. For details, see page IX-5.

Transmit Mixer Parameter: F3
This is used to transmit all the parameters in the Mixer Window to the tone generator. It has the same
function as the Transmit Mixer Parameter button on the toolbar in the Mixer Window. For details, see
page IX-2.

Items Added in the XG Editor Window
The following menu items are added only for the XG Editor Window.

Model Setup : F5
This opens the Model Setup dialog. For details, see page X-27.

XG Editor Setup : F4
This opens the XG Editor Setup dialog. For details, see page X-28.

XG Editor Assignable Setup
This sets the parameters assigned to the part unit assignable sliders and buttons. For details, see page X-11.

Transmit XG System On : F6
This transmits XG System ON data to the connected XG tone generator.

Receive XG Bulk : F8
This opens the Receive XG Bulk dialog. Using this dialog, you can have the setup data from the
connected XG tone generator received and loaded into the XG Editor Window. For details, see page X-31.
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Load XG Parameter : F9
Clicking this button will open the Load XG Parameter dialog. Using this dialog, you can extract XG event
settings that have been entered into the currently open song, and have them displayed in the XG Editor
Window. For details see page X-31.

Transmit XG Parameter : F7
Transmits the settings in the XG Editor Window to the connected XG tone generator.

Job

n This menu becomes gray and can’t be used when the Mixer Window or XG Editor Window is active.

Transpose
This opens the Transpose dialog. You can use this to transpose (change the pitch of) the MIDI notes on a
particular track.
Specify the values by clicking or typing, then click [OK] to execute the transpose function. If you want
to cancel the operation, click on [Cancel].

Track (Target Track)....................Specify the target track for the transpose operation.
Target Range ................................Enter the values of the range you want to transpose into the Meas From (start
location) and Thru (end location) boxes, using Meas/Beat/Clock units.
Target MIDI Note Range..............Enter the note numbers (note names) for the range of MIDI notes you want to
transpose into the Note From (lowest target pitch) and Thru (highest target pitch)
boxes. When you only want to transpose the notes of one particular pitch, enter
the same pitch into both boxes. This is especially handy for changing instruments
on rhythm tracks.
Transpose (Transpose Amount) ....Enter a value within the range of -127 to 0 to 127 to indicate the number of
semitones by which to want to transpose the MIDI notes (+/-1= one semitone).
n If you have selected the particular block or MIDI notes you want to transpose before opening this dialog, you won’t be able
to specify the Track, or target range Meas From and Thru values.
n The note numbers specified by MIDI are from 0 to 127. If the transpose operation creates MIDI notes that exceed the upper
or lower limits of the note number range, they will be changed to have the same note name in the highest or lowest octave.
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Velocity Modify
This opens the Velocity Modify dialog. You can use this to modify the velocity values of the MIDI notes
on a particular track.
Specify the values by clicking or typing, then click [OK] to modify the velocity values. If you want to
cancel the operation, click on [Cancel].

Track (Target Track) ..................Specify the target track for the modifying the velocity values.
Target Range ................................Enter the values of the range you want to modify into the Meas From (start
location) and Thru (end location) boxes, using Meas/Beat/Clock units.
Target MIDI Note Range..............Enter the note numbers (note names) for the range of MIDI notes you want to
modify into the Note From (lowest target pitch) and Thru (highest target pitch)
boxes. When you only want to modify the velocities of the notes of one particular
pitch, enter the same pitch into both boxes.
Velocity Specification Method ........Select either [Absolute] or [Relative] as the velocity specification method.
Rate ................................................Specify a rate of velocity modification between 0 and 200 percent. This is only
valid when you have selected [Relative] as the velocity specification method.
Value/Offset ..................................When you have selected [Absolute] as the velocity specification method, you can
enter a velocity value between 1 and 127. When you have selected [Relative], you
can enter an offset value in the range of -127 to 0 to 127.

Modifying the Velocity Value Using Absolute
The velocity of all the target MIDI notes will be changed to the value specified in the Value box.

Modifying the Velocity Value Using Relative
The velocity of all the target MIDI notes will be changed by the percentage entered into the Rate box. The
original velocity value of the notes will be increased or decreased by the amount entered into the Offset box.
The Rate and Offset specifications can be used together.
n If you have selected the particular block or MIDI notes for which you want to modify the velocity before opening this dialog,
you won’t be able to specify the Track, or target range Meas From and Thru values.
n The upper limit for velocity values is 127 and the lower limit is 1. The velocity value can’t be modified to exceed these limits.

XI-25

XGw3/E11.QX

2/1/99

5:15 PM

Page 26

Gate Time Modify
This opens the Gate Time Modify dialog. You can use this to modify the gate time (length) values of the
MIDI notes on a particular track.
Specify the values by clicking or typing, then click [OK] to modify the gate time values. If you want to
cancel the operation, click on [Cancel].

Track (Target Track) ..................Specify the target track for the modifying the gate time values.
Target Range ................................Enter the values of the range you want to modify into the Meas From (start
location) and Thru (end location) boxes, using Meas/Beat/Clock units.
Target MIDI Note Range..............Enter the note numbers (note names) for the range of MIDI notes you want to
modify into the Note From (lowest target pitch) and Thru (highest target pitch)
boxes. When you only want to modify the gate time values of the notes of one
particular pitch, enter the same pitch into both boxes.
Gate Time Specification Method......Select either [Absolute] or [Relative] as the gate time specification method.
Rate ................................................Specify a rate of gate time modification between 0 and 200 percent. This is only
valid when you have selected [Relative] as the gate time specification method.
Value/Offset ..................................When you have selected [Absolute] as the gate time specification method, you can
enter a gate time in clock units. When you have selected [Relative], you can enter
an offset value in clock units.

Modifying the Gate Time Value Using Absolute
The gate time of all the target MIDI notes will be changed to the value specified in the Value box.

Modifying the Gate Time Value Using Relative
The gate time of all the target MIDI notes will be changed by the percentage entered into the Rate box. The
original gate time value of the notes will be increased or decreased by the amount entered into the Offset box.
The Rate and Offset specifications can be used together.
n If you have selected the particular block or MIDI notes for which you want to modify the gate time before opening this
dialog, you won’t be able to specify the Track, or target range Meas From and Thru values.
n The lower limit for gate time values is 1. The gate time value can’t be modified to go below this limit.
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Shift Clock
This opens the Shift Clock dialog. You can use this to shift the location of the MIDI events on a
particular track by clock units.
Specify the values by clicking or typing, then click [OK] to shift the MIDI events. If you want to cancel
the operation, click on [Cancel].

Track (Target Track) ............Specify the target track of the events you want to shift.
Target Range ..........................Enter the range values for the events you want to shift into the Meas From (start
location) and Thru (end location) boxes, using Meas/Beat/Clock units.
Clock........................................Specify the number of clock units by which you want to shift the events. If you enter
a positive value, the events will be moved later in the song by the number of clock
units you specified. If the value is negative, the events will be shifted earlier in the
song from their current position.
n If you have selected the particular block or MIDI events that you want to shift before opening this dialog, you won’t be able
to specify the Track, or target range Meas From and Thru values.

Sort Chord
This opens the Chord Sort dialog. When there are multiple MIDI notes in the same location on a
particular track, you can sort them in the List Window from the lowest pitch to the highest, or sort them
in reverse from the highest pitch to the lowest.

Before Execution

After Execution

This command only changes the order of the notes in the List Window display, but when you execute the
Separate Chord command (the next on the menu) after executing Sort Chord, you can easily arrange the
notes of the chord so that their sounds play slightly one after another from the lowest pitch to highest
(or the opposite), like a guitar chord.
Specify the values by clicking or typing, then click [OK] to execute Sort Chord. If you want to cancel
the operation, click on [Cancel].
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Track (Target Track) ............Specify the target track for Sort Chord.
Target Range ..........................Enter the range values for the notes you want to sort into the Meas From (start
location) and Thru (end location) boxes, using Meas/Beat/Clock units.
Type ........................................Select the type of chord sort. If you check [Normal], the multiple notes in the same
location will be sorted from lowest pitch to highest. If you check [Reverse], the
multiple notes in the same location will be sorted from highest pitch to lowest.
n If you have selected the particular block or MIDI notes that are the target for the chord sort operation before opening this
dialog, you won’t be able to specify the Track, or target range Meas From and Thru values.

Separate Chord
This opens the Separate Chord dialog. When there are multiple MIDI notes in the same location on a
particular track, you can stagger each note by a specified clock value. Because it lets you slightly stagger
the playing of each note in a chord, when this command is used together with the Sort Chord command
above, you can make chords that sound like guitar chords, for example, with a small difference in time
between the playing of the notes. Also, depending on the voice used, this command is handy, for
example, when you want to create more a natural feeling of playing chords on the piano by slightly
shifting each note.

Before Execution

After Execution

Guitar Downstroke Simulation
After using the [Quantize] command to insure the timing of the notes is exact, use the previous item,
[Sort Chord], with the [Normal] parameter set, then execute the Separate Chord command. Like a guitar
downstroke, there will be a slight stagger in the playing time of the notes. Compare the before and after
pictures.
Specify the values by clicking or typing, then click [OK] to execute Separate Chord. If you want to
cancel the operation, click on [Cancel].

Track (Target Track) ............Specify the target track for Separate Chord.
Target Range ..........................Enter the range values for the notes you want to separate into the Meas From (start
location) and Thru (end location) boxes, using Meas/Beat/Clock units.
Clock........................................Enter the time in clock units of the interval by which you want each note in the same
location staggered when you execute Separate Chord.
n If you have selected the particular block or MIDI notes that are the target for the separate chord operation before opening
this dialog, you won’t be able to specify the Track, or target range Meas From and Thru values.
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Thin Out
This displays the Thin Out dialog. With it you can thin out continuous changing data like pitch bend or
After Touch events. Depending on the tone generator and the type of data you’ve created, if too much
data like pitch bends has been entered, a delay in data transmission might cause playback of MIDI notes
to be late. You can avoid this type of problem by using this Thin Out function to reduce the number of
MIDI events of the type that is causing trouble.

Before Execution

After Execution

Specify the values by clicking or typing, then click [OK] to execute Thin Out. If you want to cancel the
operation, click on [Cancel].

Track (Target Track) ............Specify the target track for Thin Out.
Target Range ..........................Enter the range values you want to thin out into the Meas From (start location) and
Thru (end location) boxes, using Meas/Beat/Clock units.
Type ........................................Select the type of MIDI events you want to thin out from the drop-down list. There
are four event types you can choose from: Control Change, Poly After Touch, Ch After
Touch, and Pitch Bend.
Control Change ....................Select the type of control change event you want to thin out from the drop-down list.
You can make this selection only when Control change has been selected as the target
MIDI event type for the Thin Out command.
n If you have selected the particular block or MIDI events that are the target for the thin out operation before opening this
dialog, you won’t be able to specify the Track, or target range Meas From and Thru values.
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Quantize
This opens the Quantize dialog. You can quantize the MIDI notes on any particular track. When
recorded MIDI notes are somewhat off in their timing, this command lets you fix them. It also lets you
give the music some swing or a groove feeling. For example when the Quantize function is applied to
the notes in picture (a), which are a little off in their timing, it corrects the timing so that they all lined
up with a particular interval as in picture (b). You can decide the units for correcting the timing by
setting the Quantize grid for eighth, sixteenth or other note units, according to your purpose. Quantize
can not only be used for simply moving the notes to match the Quantize grid value. You can use it to
create a rhythm with a more human feeling by applying the strength and sensitivity controls of the
Quantize function, by adjusting swing rate or by applying the gate time and velocity modification
functions.
(b)

(a)

After Execution

Before Execution

Specify the values by clicking or typing, then click [OK] to execute the Quantize command. If you want
to cancel the operation, click on [Cancel].

Track (Target Track) ............Specify the target track for the Quantize operation.
Target Range ..........................Enter the values of the range you want to quantize into the Meas From (start location)
and Thru (end location) boxes, using Meas/Beat/Clock units.
Target MIDI Note Range ......Enter the note numbers (note names) for the range of MIDI notes you want to
quantize into the Note From (lowest target pitch) and Thru (highest target pitch)
boxes. When you only want to quantize the notes of one particular pitch, enter the
same pitch into both boxes.
Quantize ..................................Select a Quantize grid value. The values you can set here are: thirty-second note,
sixteenth note triplet, sixteenth note, eighth note triplet , eighth note, quarter note
triplet, quarter note, eighth note plus eighth note triplet, and sixteenth note plus
sixteenth note triplet.
Strength ..................................Set the strength of the Quantize (shift rate) by entering a percentage value between 0
and 100. If the value set is 0 percent, the original timing will be kept without shifting
the notes. If the value is 100 percent, the notes will be shifted to match the Quantize
grid.
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Quarter note length

Original data

After applying q quantize to the original data
Quantize strength = 100%

Quantize strength = 50%

Sensitivity ..............................Set the sensitivity of the Quantize (range of application for quantize) by entering a
percentage value between -100 and 100. As the percentage value increases from zero,
the range of target notes will expand from the grid line toward the center between
the grid lines. At 100 percent, all the notes will be included. As the percentage value
decreases from zero into negative numbers, the range of the Quantize will increase
from the center between the grid lines, expanding toward the grid, and including
more and more of the space between the grids. At -100 percent, all the notes will be
included.
Quantize Grid
100%

70

50

30

30

50

70

100%

Sensitivity = 100%
Sensitivity = 50%
Sensitivity = 30%
Sensitivity = -30%
Sensitivity = -50%
Sensitivity = -100%
Range where Quantize will be applied

Swing Rate ..............................Set the Swing rate by entering a value between 50 and 100 percent. The Swing rate
applies only to the notes that fall within the range selected by the Sensitivity value,
and then only for the even numbered beats according to the grid value that is set. The
affected notes will be moved later in the song according to the percentage of the
Swing value. If the value is 50 percent, they will be placed on the grid as usual. If the
value is 100 percent, they will be placed on the next grid later in the song.
Original timing

Quantize value = e (swing rate 50%)

Quantize value= e (swing rate 60%)

n If a triplet note is selected as the Quantize grid value, the third beat of the triplet will become the target for the swing rate. If
the swing rate is set to 66%, the target notes will be moved to the triplet’s third beat on the Quantize grid (no swing). If set to
100%, they will be moved to the timing of the next Quantize grid.
n If e + e3 or x + x 3 are selected for the Quantize grid value, the note for the e or x even beat will be the target for the swing rate.
If the Swing rate is set to 50%, movement will be to the even beat on the Quantize grid (no swing). If set to 66%, the
movement will be to the position of the triplet’s third beat on the Quantize grid.
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Gate Time ................................Set the gate time change rate by entering a percentage value between 0 and 200. The
MIDI notes falling within the Quantize Sensitivity on the even numbered beats of the
Quantize grid will have their gate times modified by the rate specified here.
Velocity....................................Set the velocity change rate by entering a percentage value between 0 and 200. The
MIDI notes falling within the Quantize Sensitivity on the even numbered beats of the
Quantize grid will have their velocity values modified by the rate specified here.
n If a triplet note is selected as the Quantize grid value, the third beat of the triplet will become the target for Gate
Time/Velocity. If e + e3 or x + x3 are selected for the Quantize grid value, the note for the e or x even beat will be the target for
Gate Time/Velocity.
n When you creatively use all of the different settings from Quantize to Velocity together, you can create a broad range of
feelings in your rhythms, from a mechanical beat to a very human beat.
n If you have selected the particular block or MIDI notes that are the target for the Quantize operation before opening this
dialog, you won’t be able to specify the Track, or target range Meas From and Thru values.

Voice To Score
This opens the Voice To Score dialog.
Melodies saved as a wave files can be converted into MIDI notes, and used in creating a MIDI track.
n The way this Voice To Score function manages conversion is different from the Voice To Score R plug-in available in the [Plugin] Menu on the Application Window menu bar. In this Voice To Score, an already recorded wave block is selected, and its data
is converted into MIDI data. In the plug-in Voice To Score R, sound is recorded directly from a connected microphone or
other device, and then converted to MIDI data in realtime.We suggest you consider the merits of both, and use the one that is
appropriate for your circumstances.

Specify each value by clicking or typing, and then click the [Convert] button.Voice To Score will convert
the wave data into MIDI notes.You can monitor the results of the conversion. Click [Close] to close the
Voice To Score dialog.

n Before opening this dialog a single wave block must be selected as the source for data to convert into MIDI notes.

Output
The Output section of the dialog is where you make settings that apply to the track where the MIDI data
will be written after conversion of the wave data.
Track No. ................................Specify the MIDI track that will be the destination for the MIDI data resulting from the
conversion.
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Block Name ............................In this box, you can give a name to the MIDI block that will be the destination for the
converted data.
Number of Blocks..................If the track that is selected as the destination for the converted MIDI notes already
contains data, this box will display the number of the blocks within that track that are
in the same range (from start position to finish position) as the source wave data.
Replace All ..............................If you check this box, the existing blocks in the target area will all be deleted and
replaced with the MIDI data created by the conversion. If the check is removed, the
previously existing blocks will be overlaid by the MIDI block created in the
conversion process.The blocks will not be merged.

Input
This section displays information about the wave data that is to be converted to MIDI data.
Wave Track ............................This box displays the track number for the wave block that you selected before
opening this dialog.The target for conversion will be the wave block located in the
track with its number displayed here.
Format ....................................This section displays the format of the wave block that will be converted (sampling
frequency, bit number, and stereo/mono).
STEREO....................................If the wave block to be converted is in stereo format, specify the channel to be
converted by clicking on one of the three radio buttons: Lch (left channel)/MIX (left,
right channels mixed)/Rch (right channel).

Monitor
Before closing the Voice To Score dialog, you can listen to the results of the conversion.
Start..........................................Playback begins when you click here.
Stop ..........................................Playback stops when you click here.
Converted MIDI Track ..........Click this box to play back the track that contains the converted MIDI data.You can
hear the results of the conversion from wave data to MIDI notes.
Input Wave Track ..................Click this box to play back the wave track that was the source for the converted data.
Other MIDI Tracks ................Click this box to play back MIDI tracks other than the source wave track and the track
with the converted MIDI data.
n More than one box can be clicked at the same time.

Parameters for Conversion
This section is for setting several necessary conditions for converting wave data into MIDI data.
Quantize Grid ........................Check one of the radio buttons (6/8/12/16) to specify the grid that determines the
note ON position for the converted MIDI notes.This should be set to the smallest note
size in the melody of the wave data that is to be converted. In a song with four
quarter note beats per measure, the smallest note size will be an eighth note if 8 is
selected, and will be a sixteenth note if 16 is selected.
Pitch of Converted Notes ....Specify the pitch for the converted MIDI notes. If you check All, MIDI notes will be
converted into any of the note pitch without regarding the key. If you check the Key
Scale button, the key for the melody in the wave data will be automatically extracted,
and the MIDI notes will be converted into notes on the scale for that key.
Pitch Range ............................This displays the pitch range in the melody line that will be detected when the MIDI
notes are converted. Conversion of wave data into MIDI notes will be done roughly
within the range displayed here.The pitch range to be detected can be set by clicking
on the [Setup] button and making the appropriate settings in the Pitch Range dialog
that will be displayed.
n The pitch range set here is only a rough standard. Notes outside of the range may sometimes also be converted into MIDI
notes.
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Pitch Range Dialog
This sets the pitch range that will be detected for conversion to MIDI notes. Check one of the following pitch
range buttons to specify the pitch range:All, Bass, Baritone,Tenor,Alto, Soprano, and Custom setup.
The note names and note numbers for each pitch range are displayed on the right of the button.
Click [OK] and the dialog will close.The pitch range you selected will be set as the Pitch Range displayed in the
Parameters for Conversion.To cancel this operation, click [Cancel].
Custom Setup ....................The pitch range to be detected can be freely set only when the Custom button is
checked. Specify the values for the lowest note and the highest note (note number
from 40 to 84) in the appropriate boxes. Click [Apply] and the specified pitch range
will become the valid custom settings (the note names and note numbers will be
displayed to the right side of the Custom button). If you click the monitor button to
the right side of the lowest note and highest note in the pitch range, the notes will
play in the voice set for the track that is the destination for conversion.This lets you
check the pitch while making the setting.

Adjustment
Using these sliders, you can make fine adjustments related to MIDI note detection.
Sensitivity ..............................As you move this slider towards [High], finer changes in the notes will be detected.
Longer notes will be divided and the number of shorter notes will increase.As you
move the slider towards [Low], finer changes in the notes will not be detected and
shorter notes will be connected into longer ones.
Duration..................................As you move this slider towards [Short], shorter notes will be extracted and the
number of notes will increase.
Adjusting Note-on Delay ......Before MIDI notes are placed on the grid established by the Quantize Grid setting,
their note-on timing will be corrected. Correction will be made within a range from
zero (no correction) to one measure.This setting should usually be kept at zero.

Advice
Clicking this button will open the Advice dialog, where you can see various hints and important points
about using the Voice To Score function.When you click [OK], the dialog will close.

Explanation
When you click this button, it will open a Parameter Explanation dialog where an explanation about the
main parameters will be displayed.When you click [OK], the dialog will close.
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XF Information Editor
This opens the XF Information Editor dialog. In this dialog, the song name, the names of the
composer/lyricist/arranger, and the name of the performer or programmer (the person who created the
data) can be entered.The entered data is saved in the top position of the Master Track as the XF
Information Header.
n Files with entered XF information headers must be saved as XF files.

Karaoke
This display is used for entering information for karaoke song data.The character information entered
here will be inserted into the top position (1:1:000 position) of the XGworks Master Track Window as a
Text Event. In addition, information about the name of the song, composer, lyricist, and singer/performer
will be displayed at the beginning of the song (while the intro is playing) when a song is played back
using XF playback software.

Song Name ............Enter the title of the song.
Composer ..............Enter the name of the composer.
Lyricist ....................Enter the name of the lyrics writer.
Arranger ................Enter the name of the arranger.
Performer ..............Enter the name of the singer or performer.
Programmer ..........Enter the name of the person who created the song data.

Use the computer keyboard to type information into each of the boxes mentioned above.
n The colon character (:) cannot be entered.

Language ................Click this box and select the character encoding from the drop-down list that will be displayed.
If the XF playback software supports the selected character encoding, the character information
entered into each parameter above (Song Name, Composer, Lyricist,Arranger, Performer, and
Programmer) will be displayed in the screen by the playback software. If the XF playback
software does not support the character encoding selected here, the character information
entered into the Composer, Lyricist,Arranger, Performer, and Programmer on the [Song
Information] page and the Sequence Name on the [Others] page will be displayed on the screen
by the playback software.
n This is not a function for automatically switching display of characters entered into the boxes for the above parameters (Song
Name, Composer, Lyricist,Arranger, Performer, and Programmer).
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Song Information
Enter the XF information that relates to the entire song.The character information entered here will be
inserted into the top position (1:1:000 position) of the XGworks Master Track Window as a Text Event.

Year/Month/Date ..................Enter the year, month, and date that the song data was created.
n Separate the year, month, and date with a slash mark as in this example:“99/5/8”.

Country ..................................Select the location where the song data was created from the drop-down list.
Category ..................................Select the genre of the song from the drop-down list.
Beat ..........................................Select the type of rhythm in the song from the drop-down list.
Instrument (GM)....................Use the spin box to select the voice used for performing the melody part of the song.
You can select any of the program numbers (1-128) supported by GM (General MIDI).
For information on the voices that correspond to each program number, refer to the
voice list in the owner’s manual that came with your XG/GM tone generator.
Vocal Type ..............................Select the vocal type (such as male voice/female voice, etc.) from the drop-down list.
Composer ..............................Type in the name of the composer.
Lyricist ....................................Type in the name of the person who wrote the lyrics.
Arranger..................................Type in the name of the arranger.
Performer ..............................Type in the name of the singer or performer.
Programmer ..........................Type in the name of the person who created the song data.

Characters and symbols may be entered into the boxes from Composer to Programmer above.
n The colon character cannot be entered.
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Others
Data besides that in the [Karaoke] and [Song Information] mentioned above is entered on this page.

Sequence Name......................Enter information such as the name of the song.The character information entered
here will be inserted into the top position (1:1:000 position) of the XGworks Master
Track Window as a Sequence Name.
n Characters and symbols may be entered.

Copyright................................Type in the name of the copyright holder.The character information entered here will
be inserted into the top position (1:1:000 position) of the XGworks Master Track
Window as a Copyright Notice.
n Characters and symbols may be entered.

Time Signature/Tempo
Time Signature ......................This sets the time signature for the song.The information entered here will be
inserted into the top position (1:1:000 position) of the XGworks Master Track Window
as a Time Signature.
The number of beats (numerator) is set with the spin box or typed in.
Setting values: 1-255 notes
The size of beat (denominator) is selected from the drop-down list.
Setting values: 1, 2, 4, 8, 16, 32
Tempo......................................Set the tempo of the song.The information entered here will be inserted into the top
position (1:1:000 position) of the XGworks Master track window as the Tempo.The
tempo is set with the spin box or typed in.
Setting values: 20-300
n There are some songs that have Time Signature or Tempo data entered part way through the song.The settings made here do
not change those midway settings for Time Signature or Tempo.
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Lyric Information
Melody1 CH /Melody2 CH ........MIDI channels (1-16) for the melody parts are selected from the drop-down list.When
there are two tracks in which the melody has been entered, a separate MIDI channel
can be set for each of those tracks (Melody 1 and Melody 2).
Lyrics Display Offset ............When karaoke song data created in XGworks is played back with XF playback
software, this setting is used to determine how fast the Lyrics display is wiped (the
change in the color of the lyrics in time with the melody). Increasing the value speeds
up the wipe timing.
Language (Lyrics) ..................Select the character encoding from the drop-down list. If the XF playback software
supports the selected character encoding, the lyrics entered into XGworks will be
displayed in the screen by the playback software. If the XF playback software does not
support the character encoding selected here, the lyrics cannot be displayed on the
screen by the playback software.
n This is not a function to automatically switch character display of lyrics entered in XGworks.

Wave Editor TWE
This opens the Wave Editor TWE.You can use this to edit the waveform data (.WAV files) of wave tracks.
For details click on the [Start] menu on the Windows taskbar, then select [Programs], [YAMAHA XGworks
Ver. 3.0], then [Wave Editor TWE Manual]. Refer to the online manual (PDF) that will be opened.
n Before opening Wave Editor TWE, the single wave block that you will be editing must first be selected.

Plug-in
If you have plug in modules, their names will be shown on this Plug-in menu. By selecting the module
name, you can start it.
The following plug-ins are installed in the standard version of XGworks V3.0.
●
●
●
●
●
●

Auto Arranger
Voice To Score R
Guitar Arranger
Auto play
Importer
SW1000XG Mixer

For details about how to use any of the plug-ins, start the plug-in, click on the [Help] menu and refer to
the online help.You can also open the help file by clicking on the Windows [Start] button, then selecting
it from the [YAMAHA XGworks Ver. 3.0] of the [Programs] menu.
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Window

Cascade
When you have multiple windows open, this causes them to cascade down the screen. Each window
will be offset enough that you can see the Title Bar of the one below.

Tile Horizontally
When you have multiple windows open, this causes each window to occupy an equal amount of space
horizontally across the screen.

Tile Vertically
When you have multiple windows open, this causes each window to occupy an equal amount of space
vertically across the screen.

Close All
This closes all windows except for the Track View Window.

Arrange Icons
When each edit window has been minimized and the icons are scattered around the Application
Window, this command will cause them to line up neatly at the bottom of the window.

Piano Roll
This opens the block selected in the Track View Window into the Piano Roll Window. If multiple blocks
are selected, they can be displayed together in one single Piano Roll Window. If this command is chosen
when no block is selected, a message will appear telling you to select a block.

Drum
This opens the block selected in the Track View Window into the Drum Window. If multiple blocks are
selected, they can be displayed together in one single Drum Window. If this command is chosen when
no block is selected, a message will appear telling you to select a block.

Staff
This opens the block selected in the Track View Window into the Staff Window. If multiple blocks are
selected, only one at a time can be displayed on the staff. However, you can switch which of the blocks
will be displayed. If this command is chosen when no block is selected, a message will appear telling
you to select a block.
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List
This opens the block selected in the Track View Window into the List Window. If multiple blocks are
selected, they can be displayed together in one single List Window. If this command is chosen when no
block is selected, a message will appear telling you to select a block.

Master Track
Opens the Master Track Window.

Mixer
Opens the Mixer Window.

XG Editor
Opens the XG Editor Window.
n If there is no file open (if the Track View Window is not displayed on the Application Window), none of the above commands
will work.

Toolbar
Switches between displaying and not displaying the Application Window Toolbar. When the Toolbar is
displayed, there will be a check mark next to [Toolbar] on the menu.

Status Bar
Switches between displaying and not displaying the Application Window Status Bar. When the Status Bar
is displayed, there will be a check mark next to [Status Bar] on the menu.

Edit Window List
A list of the editing windows currently displayed in the Application Window will be displayed. A check
mark will be displayed next to the window that is the current active one. By selecting any of the
windows on the list, you can make that window become the active one.

Help

Contents
Starts the online help function and displays the help contents.

Search Topics
Opens the [Search Topics] dialog for XGworks online help.

About
Displays version information about XGworks.
n The online manual for XGworks (except for Plug-in software) is provided as a PDF file, not the help file.
To open the PDF manual, click on the Windows [Start] button, then select it from the [YAMAHA XGworks ver. 3.0] of the
[Programs] menu.
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Q&A
Trouble
Q:
A:

Program doesn’t start.

Q:
A:

Can’t install the program.

Q:
A:
Q:
A:
A:
A:

When I connect the tone generator, the screen freezes up.

A:

Is a suitable driver for the tone generator selected in the Port display in the Parameter Section of the Track View
Window? (→P. III-3) If you are using a Yamaha MIDI tone generator (such as MU series) select the Yamaha CBX
Driver (A-E).

A:

Is there a check mark next to the Note item on the [Midi Out Filter] tab on the System Setup dialog in the
[Setup] menu? (If so, click the box to remove it.) (→P. XI-13)

A:

Is the [M] (mute) button set ON in the Parameter Section of the Track View Window? (If so, click it to turn it
OFF.) (→P. III-4)

Q:
A:

When I play the MIDI keyboard, there is no sound.

A:

Is a suitable driver for the tone generator selected in the MIDI Thru parameter on the [Device] tab of the System
Setup dialog in the [Setup] menu? (→P. XI-12) If you are using a Yamaha MIDI tone generator (such as MU series)
select the Yamaha CBX Driver (A-E).

A:

Is there a check mark next to the Note item on the [Midi Thru Filter] and [Midi In Filter] tab on the System
Setup dialog in the [Setup] menu? (If so, click the box to remove it.) (→P. XI-14)

A:

Are the MIDI external keyboard and other external MIDI devices such as the MIDI interface properly connected
to each other? (→P. 7 and the owner’s manuals for the external devices.)

Q:
A:

I can’t record Wave data.

XGworks is distributed on disks in a compressed format. It can’t be used by simply copying it to the hard disk.
It’s necessary to run the installation program from the beginning (→P. 9).

Does your hard disk have enough empty space? To install XGworks, your hard disk must have at least 30 MB of
empty space.

Is the HOST SELECT switch on the tone generator set correctly for the type of computer you are using? (→P. 7)
No sounds come from the tone generator.
Is the driver for the tone generator set correctly? (→P. 10)
Is the COM port set correctly? (→P. 10)
Are the tone generator and other external MIDI devices connected correctly? (→P. 7, and the owner’s manual for
the external MIDI device)

Is a suitable driver for the tone generator selected in the MIDI In parameter on the [Device] tab of the System
Setup dialog in the [Setup] menu? (→P. XI-12) If you are using a Yamaha MIDI keyboard (such as CS1x) select the
Yamaha CBX Driver.

Is the Wave In parameter on the [Device] tab of the System Setup dialog in the [Setup] menu correctly set?
(→P. XI-12)
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I can’t play Wave data.
Is the Wave Out parameter on the [Device] tab of the System Setup dialog in the [Setup] menu correctly set?
(→P. XI-12)

Q:

Even though I enter a sixteenth note in the Staff Window, a different note such as a quarter note is displayed on the
screen.

A:

Is Quarter Note set on the [Display Quantize] menu of the [Setup] menu? (→P. XI-21) When there are too many
small notes, it’s usual to set Display Quantize for sixteenth or thirty-second notes.

Q:
A:

Even though I click the Play button on the Play Control, playback doesn’t start.

Q:
A:
A:
Q:
A:
Q:
A:

Is Internal selected for the [Sync.] tab of the System Setup dialog of the [Setup] menu? (→P. XI-15) If the Sync. is
set to MIDI, play won’t start until a clock signal is received from an external MIDI device.
The metronome doesn’t sound.
Is the Metronome button on the Play Control turned ON? (→P. II-5)
Is a suitable driver for the tone generator selected for the output port on the Metronome dialog in the [Setup]
menu? (→P. XI-17) If you are using a Yamaha MIDI tone generator (such as MU series) select the Yamaha CBX
Driver (A-E).
Meaningless characters appear in the List Window.
Has a font that can’t display letters (such as XGmusic) been selected on the [Font] item of the [Setup] menu?
(→P. XI-22)
Strange pictures and symbols appear in the Staff Window instead of notes.
If the XGmusic font icon isn’t in the Font folder in the Control Panel, the system won’t be able to recognize the
XGmusic font. Don’t move the XGmusic font out of the Font folder in the Control Panel.

Q:
A:

When I change the value in the Trans. (Transpose) Indicator box of the Play Control, the drum sound changes too.

Q:
A:

The Mixer Window display is different from the actual song data during playback.

Q:
A:
Q:
A:

Are the Trns values for the drum parts in the Track Parameter Section of the Track View Window set for
something besides OFF? (→P. III-5)

You should start playback from the first measure of the song after you have already opened the Mixer Window.
The Mixer will then be able to reflect the settings from the start of the song.
Even though I change settings in the Mixer Window, the sound I hear doesn’t change.
Is a suitable driver for the tone generator selected for the output port on the Mixer Setup dialog in the [Setup]
menu? (→P. XI-23) If you are using a Yamaha MIDI tone generator (such as MU series) select the Yamaha CBX
Driver (A-E).
Even though I change settings in the XG Editor, the sound I hear doesn’t change.
Is a suitable driver for the tone generator selected for the output port on the XG Editor Setup dialog in the
[Setup] menu? (→P. XI-23) If you are using a Yamaha MIDI tone generator (such as MU series) select the Yamaha
CBX Driver (A-E).

Q:
A:

The XG Editor Window display is different from the actual song data during playback.

Q:
A:

When I select [Open] from the [File] menu, the file I want isn’t displayed.

Q:
A:

I can’t save the Mixer Window settings.

You should start playback from the first measure of the song after you have already opened the XG Editor
Window.The XG Editor will then be able to reflect the settings from the start of the song.

Is the Files of type box in the Open dialog set to “XGworks & SMF & XF File” (*.XWS & *.MID)? (→P. XI-3)

Save the song after running Insert Mixer Parameter (→ P. IX-6) in the Mixer Window.
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There are some events that aren’t being displayed in the List Window.
The events checked in the Display Filter dialog on the [Setup] menu won’t be displayed in the List Window.

Recording
Q:
A:

How can I easily create a block?

Q:
A:

I can’t do step recording from the MIDI keyboard.

Q:
A:

I want to start recording midway through a song.

Q:
A:

I want to do loop recording.

Q:
A:

I want to be able to paste notes anywhere I want in the Piano Roll Window, Staff Window, and Drum Window.

Q:
A:

I want to set the volume balance for each individual instrument in the Drum Window.

Select the Pencil tool from the Toolbar in the Track View Window. Drag it over a track, and a block will be
created (→P. III-19).

First click the Step radio button to select it on the Record/Playback Settings dialog in the [Setup] menu, next
place an “R” mark in the Rec column for the track you want to record in the Track View Window Parameter
Section, then start recording with the Play Control (→P. I-8).

Set the Location Indicator on the Play Control to the position where you want to start recording, then you can
begin.

Set the start and end locations of the loop you want to record using the “S” and “E” marks in the Master Track
Section (or use the Loop From and Loop Thru boxes in the Record/Playback Settings dialog in the [Setup]
menu), set the [Loop] button in the Play Control to ON, then start recording (→P. III-22).

Is the grid set so that you can paste the notes where you want? (→P. IV-10) If not, you can change the note value
for the grid so that it appears where you want to paste, or you can set it to Free.

Using the [Velocity Modify] command on the [Job] menu, you can modify the velocity for each individual note
number (instrument), and adjust the volume (→P. XI-25).

Q:
A:

I want to easily enter guitar chord strokes.

Q:

I want to reduce the amount of data that was entered with the modulation or pitch bend wheels during realtime
recording.

A:

By executing the [Thin Out] command on the [Job] menu, you can thin out alternative events in the data you
specify. If you want to thin out the data even more, you can repeat the operation.

Q:
A:
Q:
A:
Q:
A:

I want to write the settings I made in the XG Editor Window into the song as setup data.

Q:
A:

I want to record quintuplets and septuplets.

After entering the chord, use the [Sort Chord] command on the [Job] menu to put the notes making up the
chord into order (→P. XI-27). Next use the [Separate Chord] on the [Job] menu to stagger each note in the chord
by a set amount of clock units and you can make a guitar chord stroke (→P. XI-28).

Open the [Edit] menu in the XG Editor Window, and execute the [Insert XG Parameter] command.
I want to write the settings I made in the Mixer Window into the song as setup data.
Select [Insert Mixer Parameter] on the [Edit] menu in the Mixer Window.
I want to copy a block to a different track in the Track View Window.
If you drag the block you want to copy to the destination track while holding down the <Ctrl> key, you can
create an exact copy of the source block there.

Right-click on the Tuplet button on the Note Palette, and change it to quintuplets or septuplets, then select it by
left-clicking. Next, select quintuplets or septuplets from the [Tuplet] submenu of the [Grid] command on the
[Setup] menu.This changes the grid so that you can enter quintuplets or septuplets.
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Q:
A:

I want to enter tuplets besides triplets, quintuplets or septuplets.

Q:
A:

I want to change the time signature midway through the song.

Q:
A:

I want to change the key midway through the song.

Q:
A:

In the Staff Window, I want to delete time signature or key marks inserted into the middle of a song.

You can enter quarter note sextuplets by dividing them into two eighth note triplets.You can enter half note 11tuplets (chain of 11 notes in the time) if you divide them by using eighth note triplets twice and then using
quarter note quintuplets.

Right-click the mouse on the staff in the Staff Window, then select [Key/Time Signature Settings] from the popup menu that appears. Enter the insert measure and time signature settings into the Key/Time Signature Settings
dialog, then click OK.The time signature of the song will change from the measure you entered (→P.V-12).

Right-click the mouse on the staff in the Staff Window, then select [Key/Time Signature Settings] from the popup menu that appears. Enter the insert measure and key settings into the Key/Time Signature Settings dialog,
then click OK.The key of the song will change from the measure you entered (→P.V-12).

Immediately after you have entered the key or time signature marks, you can delete them by using the [Undo]
button on the Toolbar, or the [Undo] command from the [Edit] menu. If you have already done another edit
operation after inserting them, you can open the Master Track Window, select the key or time signature event
you don’t want, and delete it.

Q:
A:

I want to enter a rest when I’m doing step recording with an external keyboard.

Q:
A:

The Play Control and Note Palette are getting in the way.

On the Note Palette, select the note that is the same length as the rest you want to enter, then press the <Space>
key on the computer keyboard.

You can move the Play Control and Note Palette anywhere you want by dragging them.You can even place them
outside the Application Window.

Basic Operations
Q:
A:

I want to easily change the location to begin playback.
You can change the location for beginning playback by changing the value in the Location Indicator on the Play
Control.
To change the value, there are two methods, as follows:
1. Double-click on the Location Indicator, type in the measure, beat and clock value using the computer number
keypad, then press <Enter>.You can separate the Meas/Beat/Clock units with periods [.] or colons [:].
2. Click on the spin control of the Location Indicator. (One click equals one measure unit, one click while hold
ing down the <Shift> key equals one beat unit, and one click while holding down the <Ctrl> key equals one
clock unit.)
You can also change the start location for song playback using the methods below.
1. Click the Top, Fwd or End buttons on the Play Control.
2. Click in the Location Section of any window (the Master Track Section of the Track View Window), and move
the Song Position Pointer/Line.
3. If there are markers entered onto the Master Track, double-click the marker located at the place where you
want to start the playback.

Q:
A:

In the Track View, Piano Roll, Drum, or Staff Window, I want to repeatedly copy and paste the data in one particular range.
With the [Repeat] (or [Repeat Block], [Repeat Chord], [Repeat Style Block]) command on the [Edit] menu, enter
the start and finish location of the data you want to copy, and the insert location where you want to paste it. Set
the number of times you want the data pasted, and you can repeatedly copy at one time.
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I want to smoothly switch from window to window when I have a lot of them open.
Select the window you want to make active from the Edit Window List displayed at the bottom of the [Window]
menu.The window you selected will be displayed in front of all the others.

A:

Make sure that you click the Minimize button of all the windows you aren’t using, making them into little menu
bars (icons). Make only the windows you are using big, by clicking the Restore or Maximize buttons.

Q:
A:

The display in the list window is hard to read because the letters are too small.

Q:
A:

I want to display multiple Control Sections in the Staff, Piano Roll or Drum Window.

Q:
A:
Q:
A:

I want to set the grid for thirty-second note units.

Q:
A:

With the Size item on the Font dialog displayed from the [Setup] menu, select a slightly larger size. If the letters
are hard to read because they are bold, select Regular in the Style box. If they are still hard to read after you
change the size and style, try selecting a different font name (→P.VII-2).

Click on [Split] then [Add Control Section] in the [Setup] menu or click on the [Add Control Section] button on
the Toolbar of the window.You can display up to three Control Sections at one time (→P. XI-19).

Select [32nd note] from the [Note] submenu of the [Grid] command on the [Setup] menu (→P. XI-19).
I want to delete multiple notes with the Eraser tool at one time.
With the Eraser tool selected, specify the range of notes you want to delete by dragging, then click on one of the
specified notes, deleting them all at the same time.
I want to add accidentals to already recorded notes in the Staff Window.
After selecting the note, right-click and select Semitone Up or Semitone Down from the pop-up menu that is
displayed.

Application
Q:
A:

I want to select all the notes of the same pitch in the Piano Roll Window.

Q:
A:

I want to enter lyrics in time with the notes of the melody.

Double-click on the keyboard display on the left side and all the notes of that pitch will be selected.Also, by
dragging the keyboard, you can select all the notes of multiple pitches (→P. IV-8).

In the Piano Roll Window or the Staff Window, select Lyric from the Control Select box in the Control Section.
Select the Pencil tool from the Control Section Toolbar, and click on the Control Section.The Insert Lyrics dialog
will be displayed. If you place the character [|] between the words or syllables when you enter them, the words
or syllables separated by the [|] will automatically be assigned one to a note.When you do this, select “Yes” in
the Following Note On section by checking it (→P. IV-28). For example, if you enter “Somebody | is | calling |
me” then “Somebody”“is”“calling”“me” will be inserted below each note.

Q:

I want to enter the bass part as shown in the score, and then play back the notes at the real pitch (generally the bass staff
is one octave higher than the real notes).

A:

Using the [Transpose] command on the [Job] menu, select the track number with the bass part and the
transpose value (for one octave lower, enter -12) (→P. XI-24).

A:

Use the [Trns] parameter in the Track Parameter Section of the Track View Window to set the transpose value
(-12 to go down one octave) for the track where the bass notes have been entered.

Q:
A:

I want to set the Staff Window to display when I double-click on a block in the Track View Window.

Q:
A:

I want to change the order of the instrument buttons in the Drum Window.

Place a check mark next to Staff on the submenu of the [Default Window] command on the [Setup] menu
(→P. XI-20).

You can change the order of the instrument buttons by dragging them.
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I want to enter a Drum Part easily by repeating the same measure many times.
There are two methods for entering a repeating part.You can either copy the actual block or you can copy link
blocks.When you create the repeating part with link blocks, every time you edit data on the source block, the
link blocks will automatically be changed in the same way. It’s handy.
If you use the method of copying actual blocks, first you create the source block, then record the performance
on it. Select that block in the Track View Window. Next select the [Repeat Block] command on the [Edit] menu
and enter the number of times you want to repeat the block into the Times item in the dialog and click [OK].
If you use the copy method involving link blocks, first you create the source block, then record the performance
on it. Select that block in the Track View Window, then right-click on it and select [Create Link Block] from the
pop-up menu that appears. Next select the link block you created, and execute the [Repeat Block] command on
the [Edit] menu after entering one less than the number of times you want to repeat the block into the Times
item in the dialog.

Q:
A:

I want to record the snare, hi-hat and other instruments onto the separate tracks.
In the Track View Window, set Ch/Pan in the Track Parameter Section to the same channel for all the tracks that
will be used as drum parts. If you are using an XG/GM tone generator, all the tracks that have 10 set for the
Ch/Pan value will be drum tracks (→P. III-3).

Q:

I want to change the setting in the Port display of the Track Parameter Section of the Track View Window for multiple
tracks at the same time.

A:

Specify the range of tracks that you want to change the Port setting for by dragging their Port displays.When you
click the Port display of the track at the bottom of the range, a drop-down list will appear and you can select the
port assignment from it.The same value will be set at the same time for all the tracks you selected.

Q:
A:

In the List Window, I want to be able to choose the events that are displayed.

Q:
A:

I want to display the lyrics that are set in XF data.

Q:
A:

I want to have XGworks synchronize with an external sequencer.

The events that are checked in the Display Filter dialog from the [Setup] menu won’t be displayed in the List
Window.

After reading in the XF data, select the block on a track, then open the Staff Window (the Piano Roll Window
also works). Next select Lyric in the Control Select box in the Control Section.The lyrics will be displayed in the
Control Section.

When the external sequencer will be the master, select MIDI in [Sync.] tab of the System Setup dialog of the
[Setup] menu. In this case set the clock in the external sequencer to Internal.
When the XGworks will be the master, select Internal in [Sync.] tab of the System Setup dialog of the [Setup]
menu. In this case set the clock in the external sequencer to MIDI (External).

Q:
A:

I want to easily enter notes like this

Q:
A:

I want to select all the blocks on a particular track.

Q:
A:

=

into the staff.

After entering the notes onto the staff and selecting them, select [Quantize] on the [Job] menu. Set the Quantize
value to eighth note, and the Swing rate to 66.When you execute the command, the timing of all the notes you
selected will be changed at one time.

Right-click the mouse on the Track No. display in the Track View Window Track Parameter Section. Choose
[Select All] from the pop-up menu that is displayed, and they all will be selected at once.
I want to merge the performance data from multiple tracks.
If you drag the blocks, placing them on top of one another, you can collect them all one track and play them
together. However, since they actually are on top of each other in the track, they aren’t really merged.To really
merge them, press and hold the <Ctrl> and <Alt> keys together when you are dragging the blocks and placing
them on top of one another.
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I want to separate the drum mark colors to make them easy to see.
Right-click over an instrument button to the left of the Drum Window. Select Properties from the pop-up menu,
then select the color for the drum mark from the Properties dialog (→P.VI-9).
I want to use Wave data made using other software.
Create a new empty Wave block in the Track View Window and open it in the List Window. Next, right-click in
the List Window and open the Event Type Table pop-up menu. Select Wave, and the Insert dialog will be
displayed. Click on Browse, and select the Wave file you want to use. Click [Open] then [Insert].The compatible
format files are .WAV files (→P.VII-20).
I want to save the bulk data from an external XG tone generator.
In the XG Editor Window, use the [Receive XG Bulk] command on the [Setup] menu to read the bulk data from
the XG tone generator into the XG Editor (→P. XI-23).You can save the data by selecting the [Save XG Parameter
File] command from the [File] menu (→P. XI-5). Since you can read the data from the XG Parameter File
(extension .XGP or .SYX) into the XG Editor Window, you can insert the data into a song and apply the settings
(→P. XI-11).
I want to edit a Wave file I’ve recorded.
You can edit the waveform of the wave file using Wave Editor TWE in the [Job] menu.
I want to see what the musical staff will look like if I print it.
Display the block you want to see using the Staff Window. Select [Print] from the [File] menu, and the Print
Preview Window will open.You can see what each page will look like when it is printed.

Q:
A:

When I print the musical staff, I want to include the lyrics.

Q:

here are some phrases and rhythm patterns I like in a commercially available SMF file and I want to insert them into a
song I’m making.

A:
A:

Use [Importer] in the [Plug-in] menu.

You can set XGworks to print the lyrics in your song by checking the [Print Lyrics] box in the Staff Print Setup
dialog. Click [Print] in the [File] Menu, then click the [Setup] button on the screen. However, if the lyrics aren’t
already entered in the song, they aren’t going to print.

You can copy the phrases and rhythm patterns you like from a song data collection by reading the data into
XGworks, then using the [Copy] function on the [Edit] menu to put them on the clipboard. Close the source
song and open the song you are making.You can then use the [Paste] command from the [Edit] menu to insert
the data on the clipboard into any location in your song.
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Table of Shortcut Keys
You can use the shortcut keys below to speed up your operations in XGworks.
n When “+” appears in an item, it means to hold down that key while pressing another. For example, <CTRL> + <F4> means to
press the <F4> key while holding down the <CTRL> key.

Shortcut Keys that Can Be Used in Any Window
<F1>
Start Online Help, open its Table of Contents.

<ESC>
Cancel an edit operation.

<DEL>
Delete the selected event or other item.

<CTRL> + <F4>
Close the active edit window.

<CTRL> + <F6> or <TAB>
Switch the active window around the edit windows open in the Application Window.

<ALT> + <TAB>
When the XGworks application is minimized, this opens the Application Window.

<ALT> + <Space>
Opens the icon pop-up menu from the Application Window title bar.

<ALT> + <-> (Hyphen)
Opens the icon pop-up menu from the title bar of the active editing window.

<ALT> + <F4>
Closes the application

Shortcut Keys that Work with the Play Control Functions
n Keys in the numeric key pad are used.

</>
Permits typed entry into the Location Indicator

<*>
Switches the Metronome button between ON and OFF.

<->
Switches the Loop button between ON and OFF.

<+>
Switches the REC button between ON and OFF.

<./Del>
Changes the playback start position to the last position where the Song Position Pointer moved.

<CTRL> + <./Del>
Changes the playback start position to the beginning of the song.
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Shortcut Keys that Work with the Menu Bar
<ALT> + Letter Key
Executes the menu item that corresponds to each letter key. For example, if you push the <E> key while
holding down the <ALT> key, the [Edit] pull-down menu will open. If you then push the <C> key, you
will select Copy.

<ALT>
Moves the cursor to the [File] menu on the menu bar. From there you can use the cursor keys on the
computer keyboard to move the cursor horizontally, open menus, and move up and down the menu
items.
There is also a shortcut key for each command on the menu bar. It is indicated to the right of each
command name when opening the pull-down menu.

Keys that Work When the Note Palette is Displayed
Pressing each of the following keys will select a note.
<F2> ..............................................Whole note
<F3> ..............................................Dotted half note
<F4> ..............................................Half note
<F5> ..............................................Dotted quarter note
<F6> ..............................................Quarter note
<F7> ..............................................Dotted eighth note
<F8> ..............................................Eighth note
<F9> ..............................................Dotted sixteenth note
<F10> ............................................Sixteenth note
<F11> ............................................Dotted 32nd note
<F12> ............................................32nd note
<CTRL> + <F1>..............................Half note triplet
<CTRL> + <F2>..............................Quarter note triplet
<CTRL> + <F3>..............................Eighth note triplet
<CTRL> + <F5>..............................Sixteenth note triplet
<CTRL> + <F7> through <F12> ....32nd note triplet
Pressing each of the following keys will select a velocity.
<SHIFT> + <F2> ............................ppp
<SHIFT> + <F3> ............................pp
<SHIFT> + <F4> ............................p
<SHIFT> + <F5> ............................mp
<SHIFT> + <F6> ............................mf
<SHIFT> + <F7> ............................f
<SHIFT> + <F8> ............................ff
<SHIFT> + <F9> through <F12> ..fff

Keys that Work in the Track View Window
<F2> ..............................................Opens the List Window.
<F3> ..............................................Opens the Piano Roll Window.
<F4> ..............................................Opens the Staff Window.
<F5> ..............................................Opens the Drum Window.
<F6> ..............................................Opens the Mixer Window.
<F7> ..............................................Opens the XG Editor Window.
<F8> ..............................................Opens the Master Track Window.
<ALT> + <1> ..................................In the Track Parameter Section, selects all the blocks from the track
where the cursor is placed.
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Keys that Work in the Piano Roll, Staff, and Drum Windows
In the Control Section, these keys switch to the types of MIDI events shown below. If more that one
Control Section is open, these keys work in the lowest Control Section on the screen.
<1>
<2>
<3>
<4>
<5>
<6>
<7>
<8>

................................................Velocity
................................................Pitch Bend
................................................Mod (Modulation)
................................................Volume
................................................Pan
................................................Exp (Expression)
................................................Program (Program Change)
................................................Lyric

When there are multiple Control Sections open, these keys switch to the types of MIDI events shown
below in the second Control Section from the bottom.
<CTRL> + <1>................................Velocity
<CTRL> + <2>................................Pitch Bend
<CTRL> + <3>................................Mod (Modulation)
<CTRL> + <4>................................Volume
<CTRL> + <5>................................Pan
<CTRL> + <6>................................Exp (Expression)
<CTRL> + <7>................................Program (Program Change)
<CTRL> + <8>................................Lyric
When there are three Control Sections open, these keys switch to the types of MIDI events shown below
in the highest Control Section.
<ALT> + <1> ..................................Velocity
<ALT> + <2> ..................................Pitch Bend
<ALT> + <3> ..................................Mod (Modulation)
<ALT> + <4> ..................................Volume
<ALT> + <5> ..................................Pan
<ALT> + <6> ..................................Exp (Expression)
<ALT> + <7> ..................................Program (Program Change)
<ALT> + <8> ..................................Lyric
Cursor entry and editing in the Piano Roll/Staff/Drum Sections can be done using the keys below.
<á>, <â>, <ß>, <à> ..................Move the cursor.
<Ctrl> + <á>, <â>, <ß>, <à>....Move the note selected at the cursor position.
<Insert> or <Enter> ......................At the cursor position, enter a note with the gate time and velocity set
on the note palette.
<Ctrl>+<Insert> or <Enter> ..........At the paste line, enter a note the same as the one immediately before
the cursor.
<Alt>+<V>......................................Connect the note selected at the cursor position and the note imme
diately before it (same pitch).
<Alt>+<B>......................................Connect the note selected at the cursor position and the note imme
diately after it (same pitch).
Cursor entry and editing in the Piano Roll/Staff Sections can be done using the keys below.
<Page Up> ......................................Move the cursor up one octave
<Page Down> ................................Move the cursor down one octave
<Ctrl>+<Page Up> ........................Move the note selected at the cursor position up one octave.
<Ctrl>+<Page Down> ....................Move the note selected at the cursor position down one octave.
Cursor entry and editing in the Staff Sections can be done using the keys below.
<Home>..........................................Enter a note one semitone higher than the cursor position
<End> ............................................Enter a note one semitone lower than the cursor position.
<Ctrl>+<Home> ............................Raise the note selected at the cursor position one semitone
<Ctrl>+<End> ..............................Lower the note selected at the cursor position one semitone
<Ctrl>+<L>
Move the Song Position Pointer/Line to the cursor position.
XII-10

XGw3/E12.QX

2/1/99

5:19 PM

Page 11

Keys that Work in the List Window
<CTRL> + <F>
Advances the location to the beginning to the next measure (the song position pointer also moves).

<CTRL> + <B>
Returns the location to the beginning to the previous measure (the song position pointer also moves).
When <Caps Lock> is OFF, pressing one of the keys shown below will change the gate time of the
selected note event.
<F2> ..............................................Whole note
<F3> ..............................................Dotted half note
<F4> ..............................................Half note
<F5> ..............................................Dotted quarter note
<F6> ..............................................Quarter note
<F7> ..............................................Dotted eighth note
<F8> ..............................................Eighth note
<F9> ..............................................Dotted sixteenth note
<F10> ............................................Sixteenth note
<F11> ............................................Dotted 32nd note
<F12> ............................................32nd note
<CTRL> + <F2>..............................Half note triplet
<CTRL> + <F3>..............................Quarter note triplet
<CTRL> + <F5>..............................Eighth note triplet
<CTRL> + <F7>..............................Sixteenth note triplet
<CTRL> + <F8>..............................32nd note triplet
<CTRL> + <F9> through <F12> ....64th note triplet
When <Caps Lock> is OFF, pressing one of the keys shown below will change the velocity of the
selected note event.
<SHIFT> + <F2> ............................ppp [8]
<SHIFT> + <F3> ............................pp [24]
<SHIFT> + <F4> ............................p [40]
<SHIFT> + <F5> ............................mp [56]
<SHIFT> + <F6> ............................mf [72]
<SHIFT> + <F7> ............................f [88]
<SHIFT> + <F8> ............................ff [104]
<SHIFT> + <F9> ............................fff [120]
<SHIFT> + <F10> through <F12> fff [127]
When <Caps Lock> is ON, pressing one of the keys shown below will insert a note in the position after
the event where the cursor line is located.
<F2> ..............................................Whole note
<F3> ..............................................Dotted half note
<F4> ..............................................Half note
<F5> ..............................................Dotted quarter note
<F6> ..............................................Quarter note
<F7> ..............................................Dotted eighth note
<F8> ..............................................Eighth note
<F9> ..............................................Dotted sixteenth note
<F10> ............................................Sixteenth note
<F11> ............................................Dotted 32nd note
<F12> ............................................32nd note
<CTRL> + <F2>..............................Half note triplet
<CTRL> + <F3>..............................Quarter note triplet
<CTRL> + <F5>..............................Eighth note triplet
<CTRL> + <F7>..............................Sixteenth note triplet
<CTRL> + <F8>..............................32nd note triplet
<CTRL> + <F9> through <F12> ....64th note triplet
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INDEX
[1-16], [17-32], [33-48], [49-64], [A/D (or AUDIO)] tabs .............. X-4
2 band-EQ (Equalizer) graph ........................................................ X-9
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About .......................................................................................... XI-40
Add Marker .................................................................................. XI-7
Adding Accidentals ...................................................................... V-11
Application Icon .......................................................................... XI-1
Application Window ...................................................................... I-2
Arrange Icons.............................................................................. XI-39
Assignable Sliders/Buttons .......................................................... X-11
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Auto Arranger ................................................................................ I-24
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BAND (Frequency Band) Knob .................................................. X-25
Bar Graph Display ...................................................................... X-25
Block Color Setup ...................................................................... XI-20
Block Merge ................................................................................ III-15
Block Name .............................................................. III-16, IV-3,VII-2
BLOCK/PART buttons .................................................................. X-8
Block Section ................................................................................ III-9
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Cascade ...................................................................................... XI-39
Ch After (Channel After Touch) ................................................ VII-13
Channel Unit ................................................................................ IX-2
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Chorus Unit ................................................................................ X-23
Close ............................................................................................ XI-3
Close All .................................................................................... XI-39
Close Button ................................................................................ XI-2
Connections ...................................................................................... 7
Contents .................................................................................... XI-40
Control (Control Change) ........................................................ VII-12
Control Section .......................................................................... IV-16
Convert to Normal Block .......................................................... XI-10
Copy : Ctrl+C .............................................................................. XI-6
Copyright Notice ...................................................................... VIII-2
Create Block ................................................................................ XI-8
Create Link Block ........................................................................ XI-9
Create New Folder Button .................................................. XI-3, XI-4
Create Style Block ........................................................................ XI-9
Cue Point .................................................................................. VIII-3
Cursor Monitor .......................................................................... XI-23
Cut : Ctrl+X .................................................................................. XI-6

D
Default Window ........................................................................ XI-20
Delete : Del .................................................................................. XI-6
DETAIL Button .. X-6, X-8, X-12, X-13, X-16, X-17, X-18, X-19, X-22, X-24, X-26
Detail Screen ...................................................... X-7, X-13, X-16, X-18
Details Button ...................................................................... XI-3, XI-4
Device ........................................................................................ XI-12
Digital Audio (Wave) Recording .................................................... I-19
Display Filter :Alt+F11 .............................................................. XI-22
Display Filter Function ................................................................ VII-6
Display Quantize .............................................................. V-10, XI-21
Display Size of Notes ................................................................ XI-21
Dr (Drum) .................................................................................... X-6
Dr Icon ........................................................................................ X-13
Drum .......................................................................................... XI-39
Drum Section ................................................................................ VI-3
Drum Set Illustration .................................................................. X-15
Drum Unit .................................................................................. X-13
Drum Window .............................................................................. VI-1
DRY/WET .......................................................................... X-17, X-20

E
Edit .............................................................................................. XI-5
Edit Window List ........................................................................ XI-40
Effect Type ........................................................ X-16, X-17, X-18, X-19
EG (Envelope Generator) graph .................................................. X-9
EQ DETAIL (Equalizer Detail) .................................................... X-10
EQ Hi/Lo Buttons ........................................................................ IX-4
EQ knob (Eq) .............................................................................. IX-3
Equalizer Unit ............................................................................ X-24
Exit .............................................................................................. XI-4
Expand to MIDI Track .................................................................. XI-9

F
Fader (Assignable Controller) ...................................................... IX-4
FEEDBACK LEVEL .............................................................. X-17, X-20
File .............................................................................................. XI-2
File name ............................................................................ XI-3, XI-4
Files of type ................................................................................ XI-3
Filter graph .................................................................................... X-9
Font :Alt+F12 ............................................................................ XI-22
Font Button ...................................................................... VII-2,VIII-2
FREQ (Frequency) ...................................................................... X-25
Frequency Select Slider .............................................................. X-25

G
GAIN Knob ................................................................................ X-25
Gate Time Modify ...................................................................... XI-26
Graph ........................................................................ X-14, X-17, X-19
Grid .................................................................................. IV-10, XI-19

H
Help .......................................................................................... XI-40
History ........................................................................................ XI-7
How to Read .WAV Files .......................................................... VII-20

I
i1 (Insertion 1) .............................................................................. X-6
i1 Icon ........................................................................................ X-16
i2 (Insertion 2) .............................................................................. X-6
Initialize Master Track .................................................................. XI-7
INS (Insertion) button ................................................................ X-19
INS Button .................................................................................. X-21
Insert Chord ................................................................................ XI-9
Insert Event ................................................................................ XI-10
Insert Mixer Parameter : F4 ...................................................... XI-11
Insert Mixer Parameter button .................................................... IX-2
Insert Pitch Bend :Alt+D .......................................................... XI-10
Insert XG Parameter button .......................................................... X-3
Insert XG Parameter: F10 .......................................................... XI-11
Inserting Parameter Settings into the Song Data ........................ X-30
Insertion 1 Unit .......................................................................... X-16
Insertion 2 Unit .......................................................................... X-18
INSERTION EFFECT .................................................................... X-10
Installing Acrobat Reader ................................................................ 11
Installing the MIDI Driver ................................................................ 9
Installing the XGworks Application Software .................................. 9
Instrument Name ...................................................................... VIII-3
Invert Selection :Alt+F3 ............................................................ XI-10
Item Buttons .............................................................................. VII-4
Items Added in the List and Master Track Windows ........ XI-10, XI-22
Items Added in the Mixer Window ................................ XI-11, XI-23
Items Added in the Piano Roll, Staff, and Drum Windows ........ XI-10
Items Added in the Piano Roll/Staff Window ............................ XI-10
Items Added in the Staff Window ...................................... XI-4, XI-21
Items Added in the Track View Window ............................ XI-7, XI-20
Items Added in the XG Editor Window .................. XI-5, XI-11, XI-23
Items Added Only for the List Window .......................... XI-10, XI-23
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J

O

Job .............................................................................................. XI-24

Open ............................................................................................ XI-3
Open : Ctrl+O .............................................................................. XI-3
Open button ................................................................................ X-3
Open XG Parameter File : F2 ...................................................... XI-5

K
KEY Knob .................................................................................. X-12
Key Signature ............................................................................ VIII-3
Key/Time Signature Settings ............................................ V-12, XI-21
Keyboard .................................................................................... X-14
Keyboard button .......................................................................... X-9
Keys that Work in the List Window .......................................... XII-11
Keys that Work in the Piano Roll, Staff, and Drum Windows .. XII-10
Keys that Work in the Track View Window ................................ XII-9
Keys that Work When the Note Palette is Displayed .................. XII-9
Kit Name .................................................................................... X-15

L
L1/L2/L3 (Location 1/2/3) .......................................................... VII-5
Layout ................................................................................ V-13, XI-21
Level Meter .................................................................................. IX-2
Link Block Function.................................................................... III-17
List ............................................................................................ XI-40
List Button .......................................................................... XI-3, XI-4
List Section ........................................................................ VII-4,VIII-2
List Window ................................................................................ VII-1
Load XG Parameter : F9 ............................................................ XI-24
Load XG Parameter button .......................................................... X-3
Loading XG Parameters .............................................................. X-31
Location :Alt+F9 ........................................................................ XI-22
Location Section .......................................................................... IV-4
Look In ........................................................................................ XI-3
Loop Function ............................................................................ III-22
Lyric .......................................................................................... VIII-3

M
Marker ........................................................................................ VIII-3
Marker Function ........................................................................ III-23
Marker List .................................................................................. XI-7
Master Channel Unit .................................................................... IX-4
Master Fader ................................................................................ IX-4
Master Track .............................................................................. XI-40
Master Track Name .................................................................... VIII-2
Master Track Window ................................................................ VIII-1
Maximize Button/Restore Button ................................................ XI-1
MCI Monitor .............................................................................. XI-23
MCI Monitor Button .................................................................... VII-3
Menu Bar .................................................................................... XI-2
Meta Event ................................................................................ VII-14
Metronome : Ctrl+M .................................................................. XI-17
MIDI In Filter ............................................................................ XI-14
MIDI Out Filter .......................................................................... XI-13
MIDI Thru Filter ........................................................................ XI-14
Minimize Button .......................................................................... XI-1
Mixer .......................................................................................... XI-40
Mixer Setup : F2 ........................................................................ XI-23
Mixer Setup button .................................................................... IX-2
Mixer Window ............................................................................ IX-1
Model Setup ................................................................................ X-27
Model Setup : F5 ........................................................................ XI-23
Model Setup button ...................................................................... X-3
Monitor Function ........................................................................ VII-4
Mono Monitor Button ................................................................ VII-3
Move Block .................................................................................. XI-9
Move Location : Ctrl+L .............................................................. XI-22
Mute :Alt+M .............................................................................. XI-19
Mute Button ................................................................................ IX-4

N
New : Ctrl+N ................................................................................ XI-2
Note .......................................................................................... VII-12
Note Monitor .............................................................................. XI-23
Note Palette.................................................................................... II-7

P
PAN ............................................................................................ X-20
PAN Knob ................................................................ X-21, X-22, X-23
Pan Knob (Pan) ............................................................................ IX-4
Part .............................................................................. X-4, X-17, X-20
Parameter List ............................................................................ X-15
Part No. (Part Number) ................................................................ X-8
Part Unit ........................................................................................ X-4
Paste : Ctrl+V .............................................................................. XI-6
Piano Roll .................................................................................. XI-39
Piano Roll Section ........................................................................ IV-4
Piano Roll Window ...................................................................... IV-1
Pitch Bend ................................................................................ VII-13
Pitch Bend Window .................................................................... IV-30
Pitch EG (Pitch Envelope Generator) graph ................................ X-9
Play Control .................................................................................. II-4
Play Control :Alt+F7 .................................................................. XI-22
PLG ................................................................................................ X-6
Plug-in ........................................................................................ XI-38
Plug-in icons .................................................................................. X-4
Poly After (Polyphonic After Touch) .......................................... VII-12
Poly Monitor Button .................................................................. VII-3
POLY/MONO ................................................................................ X-9
Port .............................................................................................. IX-4
Preparation for Recording .............................................................. I-8
Preset Data .................................................................................... X-9
Preset Data Icon Setup box .......................................................... X-9
Print : Ctrl+P .............................................................................. XI-4
Printer Setup ................................................................................ XI-4
Printing Staves .............................................................................. V-14
Program (Program Change) ...................................................... VII-12
Program Indicator ........................................................................ IX-2

Q
Q&A ............................................................................................ XII-1
Quantize .................................................................................... XI-30
Quick Edit Screen .............................................. X-8, X-14, X-17, X-19

R
Realtime Recording ...................................................................... I-15
Receive XG Bulk ........................................................................ X-31
Receive XG Bulk : F8 ................................................................ XI-23
Receive XG Bulk button .............................................................. X-3
Recent Files ................................................................................ XI-4
Record Mixer Parameter : F5 .................................................... XI-11
Record Mixer Parameter button .................................................. IX-2
Record XG Parameter : F11 ...................................................... XI-11
Record/Playback Settings : Ctrl+R ............................................ XI-17
Recording XG Editor Operations in Realtime ............................ X-32
Redo : Ctrl+Y .............................................................................. XI-5
Rename Block .............................................................................. XI-9
Repeat ........................................................................................ XI-10
Repeat Block ................................................................................ XI-8
Repeat Chord .............................................................................. XI-9
Repeat Style Block ...................................................................... XI-9
Replace Style .............................................................................. XI-9
RETURN ...................................................................................... X-20
Reverb Knob (Rev) ...................................................................... IX-3
Reverb Unit ................................................................................ X-22
Rhythm Instrument Name .......................................................... X-14
RTN Fader (Return) .................................................. X-21, X-22, X-23
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S
Save .............................................................................................. XI-4
Save : Ctrl+S ................................................................................ XI-3
Save As ........................................................................................ XI-4
Save as Type ................................................................................ XI-4
Save button .................................................................................. X-3
Save in .......................................................................................... XI-4
Save XG Parameter File : F3 ........................................................ XI-5
Saving your song .......................................................................... I-26
Search Topics ............................................................................ XI-40
Select All : Ctrl+A ........................................................................ XI-6
Select Block to Be Edited :Alt+F5 ............................................ XI-10
Select Control Section 1 .............................................................. XI-6
Select Control Section 2 .............................................................. XI-6
Select Control Section 3 .............................................................. XI-6
Select Note : Ctrl+A .................................................................... XI-6
Select Same Event :Alt+F1 ........................................................ XI-10
Select Same Event Type :Alt+F2 ................................................ XI-10
Separate Chord .......................................................................... XI-28
Sequence Name ........................................................................ VIII-2
SETUP .......................................................................................... X-13
Setup .......................................................................................... XI-11
SETUP 1-4 Tab ............................................................................ X-14
Shift Clock ................................................................................ XI-27
Shortcut Keys that Can Be Used in Any Window ...................... XII-8
Shortcut Keys that Work with the Menu Bar ............................ XII-9
Shortcut Keys that Work with the Play Control Functions ........ XII-8
Show Link Source ...................................................................... XI-10
SMPTE Offset ............................................................................ VIII-3
Solo :Alt+S ................................................................................ XI-19
Solo Button (SL) .......................................................................... IX-4
Song Playback ................................................................................ I-4
Song Recording .............................................................................. I-7
Sort Chord ................................................................................ XI-27
Specific Sequencer-Meta Event .................................................. VIII-3
Split ............................................................................................ XI-19
Staff ............................................................................................ XI-39
Staff Section.................................................................................... V-3
Staff Window .................................................................................. V-1
Status Bar ............................................................................ II-4, XI-40
Step Recording .............................................................................. I-18
Style Block Color Setup ............................................................ XI-20
Style/Chord Track Operations .................................................... III-25
Sync. .......................................................................................... XI-15
SYS (System) button .................................................................. X-19
SYS Button .................................................................................. X-21
System and Insertion Effects ........................................................ X-2
SYSTEM DETAIL ............................................................................ X-9
System Exclusive ............................................................ VII-13, XI-16
System Setup : Ctrl+U ................................................................ XI-12
System Unit ................................................................................ X-12
System Variation Unit .................................................................. X-21

T

Track View Window ...................................................................... III-1
Transmit Mixer Parameter button .............................................. IX-2
Transmit Mixer Parameter: F3 .................................................. XI-23
Transmit XG Parameter : F7 ...................................................... XI-24
Transmit XG Parameter button .................................................... X-3
Transmit XG System On : F6 ...................................................... XI-23
Transmit XG System On button .................................................... X-3
Transpose .................................................................................. XI-24
TUNE Knob ................................................................................ X-12
Type ............................................................................................ VII-5
TYPE (Effect Type) .................................................... X-21, X-22, X-23
TYPE (EQ Type) .......................................................................... X-24

U
Undo : Ctrl+Z .............................................................................. XI-5
Up One Level Button .......................................................... XI-3, XI-4

V
V (Variation) .................................................................................. X-6
V Icon ........................................................................................ X-18
Variation Knob (Var) .................................................................... IX-3
Variation Unit .............................................................................. X-18
Velocity Modify .......................................................................... XI-25
Vibrato graph ................................................................................ X-9
VIEW/LIST button ...................................................................... X-14
Voice ............................................................................................ X-4
Voice List ...................................................................................... I-11
VOICE LIST button ........................................................................ X-8
Voice Name display ...................................................................... X-9
Voice To Score .................................................................... I-21, XI-32
VOL Knob .................................................................................. X-12
Volume/Pan sliders ...................................................................... X-9

W
Wave Editor TWE ...................................................................... XI-38
Wave Format .............................................................................. XI-15
Wave Monitor ............................................................................ XI-23
Wave Monitor Button .................................................................. VII-3
Window .................................................................................... XI-39

X
XF Information Editor ................................................................ XI-35
XG :Alt+F10 .............................................................................. XI-22
XG Display Function .................................................................. VII-6
XG Editor .................................................................................. XI-40
XG Editor Assignable Setup .............................................. X-11, XI-23
XG Editor Setup : F4 .................................................................. XI-23
XG Editor Setup button ................................................................ X-3
XG Editor Setup Dialog .............................................................. X-28
XG Editor Window ........................................................................ X-1
XG Parameter Realtime Recording button .................................. X-4

Y
Yamaha CBX Driver Setup Dialog .................................................. 10

Z
Zoom ........................................................................................ XI-18

Table of Shortcut Keys .............................................................. XII-8
Tempo ........................................................................................ VIII-3
Text Event .................................................................................. VIII-2
Thin Out .................................................................................... XI-29
Tile Horizontally ........................................................................ XI-39
Tile Vertically ............................................................................ XI-39
Time Signature .......................................................................... VIII-3
Title Bar ...................................................................................... XI-1
to CHO Fader (Send to Chorus) ................................................ X-22
To Chorus .................................................................................. X-20
to REV Fader (Send to Reverb) .......................................... X-22, X-24
To Reverb .................................................................................... X-20
To System Effect ........................................................................ X-10
Toolbar ...................................... II-2, IV-3,VII-2,VIII-2, IX-2, X-3, XI-40
Tools .......................................................................................... XI-18
Track Parameter Section .............................................................. III-2
Track View :Alt+F8 .................................................................... XI-22
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SOFTWARE LICENSING AGREEMENT
The following is a legal agreement between you, the end user, and Yamaha Corporation ("Yamaha").The
enclosed Yamaha software program is licensed by Yamaha to the original purchaser for use only on the
terms set forth herein. Please read this licensing agreement with care. Opening this package indicates
that you accept all terms outlined herein. If you do not agree to the terms, return this package unopened
to Yamaha for a full refund.
1. GRANT OF LICENSE AND COPYRIGHT

Yamaha grants you, the original purchaser, the right to use one copy of the enclosed software program
and data ("SOFTWARE") on a single-user computer system.You may not use it on more than one
computer or computer terminal.The SOFTWARE is owned by Yamaha and is protected by Japanese
copyright laws and all applicable international treaty provisions.You are entitled to claim ownership of
the media in which the SOFTWARE is included.Therefore, you must treat the SOFTWARE like any other
copyrighted materials.
2. RESTRICTIONS

The SOFTWARE program is copyrighted.You may not engage in reverse engineering or reproduction of
the SOFTWARE by other conceivable methods.You may not reproduce, modify, change, rent, lease, resell,
or distribute the SOFTWARE in whole or in part, or create derivative works from the SOFTWARE.You
may not transmit or network the SOFTWARE with other computers.
You may transfer ownership of the SOFTWARE and the accompanying written materials on a permanent
basis provided that you retain no copies and the recipient agrees to the terms of the licensing
agreement.
3. TERMINATION

The licensing condition of the software program becomes effective on the day that you receive the
SOFTWARE. If any one of the copyright laws or clauses of the licensing conditions is violated, the
licensing agreement shall be terminated automatically without notice from Yamaha. In this case, you must
destroy the licensed SOFTWARE and its copies immediately.
4. PRODUCT WARRANTY

Yamaha warrants to the original purchaser that if the SOFTWARE, when used in normal conditions, will
not perform the functions described in the manual provided by Yamaha, the sole remedy will be that
Yamaha will replace any media which proves defective in materials or workmanship on an exchange
basis without charge. Except as expressly set forth above, the SOFTWARE is provided "as is," and no
other warranties, either expressed or implied, are made with respect to this software, including, without
limitation the implied warranties of merchantability and fitness for a particular purpose.
5. LIMITED LIABILITY

Your sole remedies and Yamaha’s entire liability are as set forth above. In no event will Yamaha be liable
to you or any other person for any damages, including without limitation any incidental or consequential
damages, expenses, lost profits, lost savings or other damages arising out of the use or inability to use
such SOFTWARE even if Yamaha or an authorized dealer has been advised of the possibility of such
damages, or for any claim by any other party.
6. GENERAL

This license agreement shall be interpreted according to and governed by Japanese laws.
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